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Introduction 

ManageEngine ServiceDesk Plus 7.5 is a comprehensive help desk and asset management software 
that provides help desk agents and IT managers an integrated console to monitor and maintain the 
assets and IT requests generated from the users of the IT resources in an organization. The IT help 
desk plays an important part in the provision of IT Services. It is very often the first contact the users 
have in their use of IT Services when something does not work as expected. The IT help desk is a 
single point of contact for end-users who need help. Without this, an organization could certainly face 
losses due to inefficiencies.  
 
The two main focuses of the ManageEngine ServiceDesk Plus 7.5 are IT Request tracking and Asset 
Management. Using the following modules of ServiceDesk, technicians and system administrators 
can resolve issues of complex nature in no time and thus reduce the end-user frustration arising due 
to time consuming issue resolving process. They can also keep track of the needs of the organization 
with the help of asset management and proactively allocate resources to the right user/departments, 
thus increasing the productivity of the organization.  

• Requests 
• Problem 
• Change 
• Solutions 
• Assets 
• Purchase 
• Contract 

The request module functions as the Help Desk where requests are fetched and necessary solutions 
provided by assigning technicians to resolve issues reported. 
 
When you log in to ManageEngine ServiceDesk Plus 7.5, the application displays the ServiceDesk 
Plus home page that contains information on pending requests, overdue requests, requests assigned 
to the user who has logged in, approved/unapproved changes by the logged in technician, open and 
unassigned problems assigned to the logged in technician, individual user's task list, and depending 
on the user login, the other dash board views such as Contract and Purchase Order summary also 
may be displayed. 

Requests 

Clicking on the Requests tab on the header pane takes you to the request module. This serves as the 
IT help desk module where the IT requests from individual users are fetched, tracked, technicians are 
assigned, and a solution is provided.  

Problems 

The objective of Problem Management is to minimize the adverse impact of Incidents and Problems 
on the business that are caused by errors within the IT infrastructure, and to prevent recurrence of 
Incidents related to these errors. In order to achieve this goal, Problem Management seeks to get to 
the root cause of Incidents and then initiate actions ti improve or correct the situation.  

Change 

The goal of Change Management is to ensure that standardised methods and procedures are used 
for efficient and prompt handling of all Changes, in order to minimise the impact of change-related 
incidents upon service quality and consequently to improve the day-to-day operations of the 
organization. 
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Solutions  

This module serves as a knowledge base for your IT help desk team as well as your users. Users can 
search this for solutions for issues and solve them themselves. Also when technicians resolve issues, 
they can directly convert these resolutions as knowledge base articles. To view the solutions, click the 
Solutions tab in the header pane.     

Assets 

Assets tab helps you to track & manage your assets efficiently. It tracks all your newly added assets, 
and have a record of all the assets in the organization. Assets can be categorized as IT, Non IT 
Assets & Asset Components in an organization. This includes Workstations, Printers, Routers, 
Software Licenses, Scanners, Projectors and even your air conditioning systems. Thus it offers a 
single view to track and manage all your assets in the organization.  

Purchase 

Here you can create new purchase orders and track them till the order has been delivered. The same 
details can also be maintained for future reference. Clicking the Purchase tab takes you to the 
Purchase module.  

Contract 

This module holds the details regarding the maintenance contracts between your organization and the 
vendor(s) from whom the assets of your organization have been purchased. Clicking the Contracts 
tab in the header pane takes you to the contract module. 
 
In addition to these, ServiceDesk Plus has GUI-rich reports for requests and Assets modules. There 
are predefined sets of reports that help you evaluate the efficiency and productivity of your IT help 
desk team, the load of requests handled by the team, the assets distribution, and many more. Also, 
the ServiceDesk administrator can configure various helpdesk, asset, and enterprise-related settings, 
such as the working hours of the organization, service-level agreements, user roles, departments and 
many more.  
 
Based on the permissions provided by the ServiceDesk Plus administrator to each of the users of the 
application, you will be able to access the above modules. If you do not have the access permission, 
contact your ServiceDesk Plus administrator. 
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System Requirements 

Hardware 

Parameter Base Requirement Optimal Requirement 

CPU Pentium III 800 MHz or above Intel Core Duo 1.7 GHz or above 

RAM 512 MB or above 2 GB or above 

Disk Space 5 GB 50 GB or above 

Display   

 

Operating System 

• Windows 2000 + SP4 
• Windows 2000 / 2003 Server 
• Windows XP Professional 
• Red Hat Linux 7.2 and above 
• Linux Debian 3.0 

 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 13

Installation and Getting Started 

 

• In Windows 
• In Linux 

 

In Windows 

Follow the steps given below to install and set up the ManageEngine ServiceDesk Plus application:  

1. Download the ManageEngine_ServiceDesk_Plus_Windows.exe file. 
2. Click the exe file to start the installation. The ServiceDesk Plus installation wizard appears as 

shown below, 

 

3. Click Next to proceed with the installation.    
4. The second screen displays the License Agreement. You need to accept the license 

agreement to proceed with the installation. Click Yes to accept.  
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5. On accepting the license agreement, the installation wizard provides you with the option to 
choose between the Standard, Professional and the Enterprise Edition. 
 
Standard Edition - This edition offers helpdesk management, self-service portal, knowledge 
base, SLA management and helpdesk report to help you manage and track your requests. 
Professional Edition - This edition offers Software compliance & license tracking, Product 
Catalog, NMS integration, Asset Reports and few other asset related process along with the 
features of Standard Edition.  
Enterprise Edition - This is an ITIL ready Helpdesk. It includes all features of Professional 
Edition plus Incident managment, Problem management, Change management & 
Configuration management database(CMDB).   
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A free and trial version is provided for Standard and Professional Edition. The Free Version 
never expires and is restricted to a single technician login with 25 nodes. The Trial Version is 
valid only for 30 days and allows 2 technician logins with 200 nodes. The Enterprise Edition is 
provided only with a trial version which is valid for 30 days with 5 technician logins with 200 
nodes.  
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6. The next step is choosing the installation directory. By default, the application is installed in 
C:\AdventNet\ME\ServiceDesk directory.  

 

If you want to change the installation directory, then, click the Browse button beside the 
directory path. From the file chooser window, choose the directory of your choice and click Ok. 

 

 

Note: The installation directory or its parent directories must not have any 
space character in its name. 

7. Provide a name that needs to appear in the Program Folders. By default, it is 
ManageEngine ServiceDesk Plus. Click Next. 

8. Enter the port number that has to be used to run the web server. The default port number 
provided is 8080. If you already have any application running in that port, then enter the 
number of the port that is free and can be used by the web server to run the ServiceDesk 
Plus application server and click Next.  
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7. Choose the Database between MY SQL and MS SQL. By default ServiceDesk Plus supports 
My SQL database, to switch over to MS SQL database you need to configure SQL server to 
establish connection and start the server. Enter the details as given below, 

• Host Name: Enter the IP Address/host name in which the database is available. The 
default host name is 'localhost'. 

• Port: Specify the port in the given text field. The default value is 1433.  
• Database : By default the database name will be Servicedesk in non-editable format.  
• User Name: Specify the user name to login to the server in the given text field.  
• Password: Specify the password for the username in the given text field. Click Next. 

 

Note:  To switch over to SQL database, you need to enable SQL 
authentication as Window authentication will not work.  

 

 

11. The Registration for Technical Support form is displayed. This is an optional form and it 
enables you to register for technical assistance. By registering, it helps the technical support 
team to be better informed about your organization and its specific needs and hence provide 
a more focused support. Enter the details such as Name, contact E-mail ID, Phone Number 
(helps in making calls for immediate support), Company Name, and Country. Click Next. 
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13. The details that you have provided till now will be displayed as below for your confirmation: 
Installation Directory : C:\AdventNet\ME\ServiceDesk 
Folder Name : ManageEngine ServiceDesk Plus  
WebServer Port : 8080 
 

 
If the displayed information is correct, then click the Next button, or else click the Back button 
and make the necessary changes and proceed with the installation.  
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14. After you confirm the above details, the application is installed. On successful installation, the 
following screen is displayed.  
 

 
 
If you choose to start the ServiceDesk as Service, then the ServiceDesk Server is started 
automatically and the client window opens. If you do not wish to view the readme file or start 
ServiceDesk as a windows service, de-select the options provided. 

13. Click Finish to complete the installation. 

If you had followed the instructions in the wizard and installed the application with the default settings 
suggested by the wizard, the ManageEngine ServiceDesk Plus program group is created in the 
Start menu. Also, the ServiceDesk server will be started and the client window opens with the login 
page. Enter the user name and password to log in to the application. 

To manually start the ServiceDesk Plus application 

1. Click Start -> Programs -> ManageEngine ServiceDesk Plus -> ServiceDesk Server to 
start the web server. This takes approximately 2 minutes in a Windows XP, 512 MB RAM, 
and 1.0 GHZ processor. Generally, the server is started and the web client is also launched in 
the default browser. 

2. If the web client is not launched automatically, then click Start -> Programs -> 
ManageEngine ServiceDesk Plus -> ServiceDesk Web Client to start the web client. The 
application opens the login page in your default web browser. 

3. Enter your user name "administrator" and password "administrator" to log in to ServiceDesk 
Plus. As soon as you log in the configuration wizard home page is displayed. Follow the 
instructions provided in the wizard and click the Next button. 
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To configure your application settings, refer to the Configurations section. 
 
To shut down the ServiceDesk Plus application  

1. Click Start -> Programs -> ManageEngine ServiceDesk Plus -> Shutdown ServiceDesk. 
A confirmation message is displayed. 

2. Click OK to proceed with the shut down. 

Alternatively, you can also right-click on the system tray icon  and choose Shut down Server. A 
confirmation message is displayed. Click OK to shut down ServiceDesk Plus. 

To reinitialize the server  

1. Go to <ServiceDesk>\bin directory. 
2. Execute reinitializeDB.bat to reinitialize the server. Please note that all the data in the 

server will be lost when you reinitialize. 

In Linux 

Follow the steps given below to install and setup the ManageEngine ServiceDesk Plus application:  

1. Download the ManageEngine_ServiceDesk_Plus_Linux.bin file. 
2. Execute the .bin as given below, at your command prompt: 

 
./ServiceDesk_Plus_Linux.bin   

 
Note: You need to have execute permissions for executing the .bin type files. 

3. The following screen of the installation wizard is opened and the you will be guided through 
the installation process. 
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4. Click Next and follow the steps given in the installation wizard.  
5. The second screen displays the License Agreement. You need to accept the license 

agreement to proceed with the installation. Click Yes to accept. 
6. On accepting the license agreement, the installation wizard provides you with the option to 

choose between the Standard, Professional and the Enterprise Edition. 
 
Standard Edition - This edition offers helpdesk management, self-service portal, knowledge 
base, SLA management and helpdesk report to help you manage and track your requests. 
Professional Edition - This edition offers Software compliance & license tracking, Product 
Catalog, NMS integration, Asset Reports and few other asset related process along with the 
features of Standard Edition.  
Enterprise Edition - This is an ITIL ready Helpdesk. It includes all features of Professional 
Edition plus Incident managment, Problem management, Change management & 
Configuration management database(CMDB).   
 
A trial and free version is provided for Standard and Professional Edition. The Free Version 
never expires and is restricted to a single technician login with 25 nodes. The Trial Version is 
valid only for 30 days and allows 2 technician logins with 200 nodes. The Enterprise Edition is 
provided only with a trial version which is valid for 30 days with 5 technician logins with 200 
nodes.  
  

7. The next step is choosing the installation directory. By default, the application is installed in 
home/<user>/AdventNet/ME/ServiceDesk directory. If you want to change the installation 
directory, then, click the Browse button beside the directory path.  

8. From the file chooser window, choose the directory of your choice and click Next.  
9. Enter the port number that has to be used to run the web server. The default port number 

provided is 8080. If you already have any application running in that port, then enter the 
number of the port that is free and can be used by the web server to run the ServiceDesk 
Plus application server and click Next.  

 

Note: If you wish to provide a port number lesser than 1024 as the web server 
port, then you need to be the super-user of the system to successfully install 
and run ServiceDesk Plus application. 

10. The Registration for Technical Support form is displayed. This is an optional form and this 
enables you to register for technical assistance. By registering, it helps the technical support 
team to be better informed about your organization and its specific needs and hence provide 
a more focused support. Enter the details such as Name, contact E-mail ID, Phone Number 
(helps in making calls for immediate support), Company Name, and Country. Click Next. 

11. The details that you have provided till now will be displayed as below for your confirmation: 
 
Details of Installation 
Installation Directory: home/<user>/AdventNet/ME/ServiceDesk 
Product Size           : 62.8 MB. 

If the displayed information is correct, then click the Next button, or else click the Back button 
and make the necessary changes and proceed with the installation.  

12. After you confirm the above details, the application is installed. On successful installation, the 
following screen is displayed.  
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If you do not wish to view the Readme file, de-select the check box.  

13. Click Finish to complete the installation. 

To manually start the ServiceDesk Plus application 

1. Go to the <ServiceDesk Plus>/bin directory and execute the run.sh file as given below: 
 
$ sh run.sh 

2. To start the web client, open a web browser and type the following in the address field: 
 
http://localhost:8080 
 
Here, you need to replace the localhost with the corresponding server name where the 
ServiceDesk Plus web server is running and the port number 8080 should be replaced with 
the actual port where the server is running. The application opens the login page in your 
default web browser. 

3. Enter your user name "administrator" and password "administrator" to log in to ServiceDesk 
Plus. As soon as you login the configuration wizard home page is displayed. Follow the 
instructions provided in the wizard and click the Next button. 

To configure your application settings, refer to the Configurations section. 
 
To shutdown the ServiceDesk Plus application 

execute shutdown.sh file from the bin directory as below: 

sh shutdown.sh -S 
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To reinitialize the server 

1. Go to <ServiceDesk Plus>/bin directory. 
2. Execute reinitializeDB.sh to reinitialize the server. Please note that all the data in the 

server will be lost when you reinitialize. 
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Database Configuration  

By default ServiceDesk plus supports MY SQL database to switch over to SQL database you need 
to configure SQL server to establish connection and start the server.    

Configuring MS SQL Server  

1. Execute the changeDBServer.bat [ changeDBServer.sh  for Linux] file presented under the 
ServiceDesk Home. This opens the Database Setup Wizard page. Fill in the details of the 
form to configure sql server. 

Server Type: Select the server type from the combo box. Say MS SQL.  

Host Name: Enter the IP Address/host name in which the database is available. The default 
host name is 'localhost'.  

Port: Specify the port in the given text field. The default value is 1433.  

Database : By default the database name will be servicedesk in non-editable format.  

User Name: Specify the user name to login to the server in the given text field.  

Password: Specify the password for the username in the given text field.  

2. To check the availability of connection press the Test button. A pop up window pops up 
showing 'Connection Established' message. 

3. Click OK to proceed.  
4. Click Save button to save the SQL server settings. 
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Configuring MYSQL Server 

1. If you are using a remote MySql server and do not want to use the inbuilt server then,  
2. Select Server Type as MySql server. This opens the database wizard page. 
3. Specify the Host Name, Port, User Name & Password. 
4. Click Test button and check the availability of the connection.  
5. Once the Connection is Established, Save the details and start the server.   

Non UI users  

Run the changeDBServer.bat under command prompt by passing parameter like given below 
 
>changeDBServer.bat --console 
 
It will get the DB Server necessary information from the console.  

Troubleshooting Tips 

MY SQL Connection Resolution 

Verify the following, 

• Check if the MY SQL server is running. 
• Check if the server name or the port number is misspelled or incorrect. 
• If the MY SQL server is running in a remote machine then there may be a firewall 

blocking the port number you have entered. 
• If none of the above mentioned issues matches then contact your system 

administrator.   

MS SQL Connection Resolution 

If a connection is refused and an exception is thrown by SQL Server as 'unable to connect 
the server' then there could be following reasons why this could happen such as, 

• The server name is misspelled or the port number is incorrect 
• The SQL server will not configured to use TCP/IP then in this case enable TCP/IP 

from SQL servers network utility application. 
• If there is a firewall blocking the port 1433 on the server then you will not be able to 

connect to the server. 
• To confirm the firewall block connect to TCP/IP use \"telnet<server_host>1433\"\n to 

confirm the block. 
• SQL Server Instance is not currently supported by ServiceDesk and will be available 

in the feature release. You can also connect to SQL Server named instance once if 
you know the machine name and port of the named instance.  

• Create new user with full privileges as shown below,  
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• While configuring SQL server properties select the authentication type as SQL server 
as shown below. Windows authentication is not supported by serviceDesk Plus 
currently. 
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Uninstalling ServiceDesk Plus 

 

• In Windows 
• In Linux 

 

In Windows 

To uninstall ServiceDesk Plus from Windows  

1. Click Start -> Programs -> ManageEngine ServiceDesk Plus 5 -> Uninstall ServiceDesk. 

In Linux 

To uninstall ServiceDesk Plus from Linux  

1. Go to <ServiceDesk>/_uninst directory. 
2. Execute uninstaller.bin as below: 

 
$ ./uninstaller.bin 
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Registering ServiceDesk Plus 

Once your trial evaluation period is over, you need to register the ServiceDesk Plus application. To 
purchase the application, please contact sales@adventnet.com. They will send you the registered 
license file. Using this license file, you can register the ServiceDesk Plus application.  

To register ServiceDesk Plus 

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the License link available at the right top of the application. The License window is 
opened. 

3. Click the Browse button to locate the license file sent to you when you purchased the 
application. 

4. From the file chooser window, select the license file and click Open. 
5. Click Upgrade. 

The registration of the ServiceDesk Plus application is complete. You can continue using the 
application. 
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Contacting AdventNet 

• AdventNet Headquarters 
• Sales 
• Technical Support 

AdventNet Headquarters 

Web site www.adventnet.com 

AdventNet Headquarters 

AdventNet, Inc. 
4900 Hopyard Rd., Ste 310 
Pleasanton, CA 94588, USA  
Phone: +1-925-924-9500 
Fax: +1-925-924-9600 
E-mail: info@adventnet.com 

AdventNet Development Center 

AdventNet Development Centre (I) Private 
Limited 
11 Sarathy Nagar, 
Vijayanagar, 
Velachery, Chennai 600 042 INDIA 
Phone: +91-44-22431115 (10 lines) 
Fax: +91-44-22435327 
E-mail: info@adventnet.com 

Sales 

For purchasing ManageEngine ServiceDesk Plus from any part of the world, fill out the Sales Request 
Form. A sales person will contact you shortly. You can also send us e-mail at sales@adventnet.com. 
 
You can also call the AdventNet headquarters at the following numbers: 
Phone: +1-925-924-9500 
Fax: +1-925-924-9600 and request for Sales  

Technical Support 

One of the value propositions of AdventNet to its customers is excellent support. During the 
evaluation phase, the support program is extended to users free of charge.  
 
For support, please mail to servicedeskplus-support@manageengine.com 

Alternatively, you can submit your feedback from the ServiceDesk Plus product by clicking the 
Feedback link at the top right corner just above the header tabs after logging in to the application. 
Your feedback will be sent to the ServiceDesk Plus Support Team and they will get in touch with you. 
Do not forget to provide your e-mail ID or your contact information for the team to get in touch with 
you. 
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Login Home page 

The login home page of ServiceDesk Plus has various useful information displayed that enables an 
administrator, a technician, or a requester to take necessary action. The following are the information 
available in the login home page, based on the login credentials of the user. 

1. My View, Global View, Assets View. Click the link for more information. 
2. Scheduler. Click the link for more information. 
3. License Expiry. Click the link for more information. 
4. Reminders. Click the link for more information. 
5. My Tasks. Click the link for more information. 
6. Announcements. Click the link for more information.  
7. Get Quote: This Get Quote link will not be available for the registered users (licensed users). 

This will be available only for the Demo users or the Trial version users.  
 
By filling in the specifications in the get quote form will help us to provide you the exact details 
of your requirements. 

1. Click on the Get Quote link  on the top right hand side of the page. 
The page refreshes to open the Get Quote form. 

2. Specify the details and Submit the form. You will be contacted by our sales team on 
receiving a mail. 

8. Quick Create /Search Items /Recent Items. 

Quick Create 

You can create a request quickly using the Quick Create - New Request form. This form is 
available in the ServiceDesk Plus home page and in requests list page. For more information 
refer Creating a New Request 

Search Items 

You can search items by selecting the Search in name from the combo box and by specifying 
the relevant Keyword in the given text field. 

Click Go to search for the specified details. 

Recent Items 

When you are using the ManageEngine ServiceDesk Plus application, the application tracks 
your last viewed items and lists them in the Recent Items block on the left side. This has a list 
of the last 10 items that you viewed in the application, with the latest viewed item appearing on 
the top of the list. Clicking the hyperlinked item takes you directly to the item's details. 

Other than this you have Feedback, Personalize on the top right hand side of the page. Click 
the link for more information. 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 31
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Views (My View, Global, Assets) 

My View 

ServiceDesk Plus login home displays My View page with information on the request summary of the 
requests assigned to the user who has logged in. In the case of requesters, My View displays 
information regarding the requests that have been raised by them. For more information on the 
requester login home My View, refer to the Self Service Portal help. 

My View page also displays My Tasks and Announcements. Click the link for more information. 

In the technician / administrator login of ServiceDesk Plus, My View tab displays the following 
information: 

1. Number of requests assigned to the logged in technician that are overdue.  
2. Number of requests assigned to the logged in technician that are due for that day.  
3. Number of pending requests that are assigned to him/her.  
4. Number of changes assigned to the logged in technician that are approved.  
5. Number of changes assigned to the logged in technician that are unapproved.  
6. Number of Open problems assigned to the logged in technician. 
7. Number of problems that are unassigned to technicians. 

Clicking the links to open the corresponding list view. 
  

 

 

Global View   

Global view is available depending on the login authorization permissions ( administrator, site 
administrator  ) provided to the various technicians. If you have permissions for the same, you will be 
able to see the Global View tab just beside the home page My View as soon as you login to the 
application. 
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The global view displays the following information: 

• Requests by block displays the Open, On Hold and OverDue status of the Requests by 
Technicians, Category, Level, Priority and Mode in All sites, not in any site and the sites 
configured under the admin tab. These options should be selected from the drop down 
combo box. The matrix displays the seven technicians/category/level/priority/mode with the 
most number of requests assigned. If count increases more than seven then a View All 
button appears. If you wish to view all the technicians then click View All button.   

Example: On selecting the Site and Technician from the combo box, all the available 
technicians name getting listed one after the other in the block. Against each the technicians 
name you can see the number of Open, On Hold, and Over Due requests they have. Also it 
gives the total of all the open, on hold and overdue requests finally. 

To view the all the open requests on your name, click the number specified under the open 
request title. This will open the list of all the open requests on your name.     

• Request Summary block, shows the graph of requests count that have come in during a 
specific time period such as, This Week, Last Week, This Month and Last Month requests in a 
site. You can select these options and the site from the combo box provided at the corner of 
the block. 

• Change by Type block displays all the approved changes in a pie chart. These approved 
changes are displayed based on the type, priority, urgency and impact which should be 
selected from the combo box. To view the approved change for a specific time period such as 
This week, next week, this month, next month, next 7 days, next 15 days or next 30 days 
select any of these options from the combo box. 

You can have a pictorial representation of the approved changes by viewing the change by 
block.  

• Approved Changes block lists all the changes approved by the Change Manager for a 
specific time period. This block displays the title and type of the approved changes. The 
approved changes are listed in descending order based on the scheduled start time.  

This block displays the list of all the approved changes. Where as Change by Type block 
displays the pictorial view of the approved changes. 

To view the change details, click on the title of the change to be viewed. This opens the 
Change Details page as shown below. 
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• Unapproved Changes block displays all the unapproved changes with the change title and 
type. The changes are displayed based ascending order. Click on the title of the change to 
view the change details. 

• Problem by Type block displays the pictorial view of the problem based on the type, priority, 
urgency and impact which should be selected from the combo box.   
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Asset View 

The asset dashboard can be viewed by the technicians with view permissions on asset module while 
defining the roles.    

 

All my Assets 

• On scanning, all the IT & Non-IT assets in the organization are listed below in All my 
Assets .  

• This displays each product type count across organization (Workstation, scanner 
etc.). 

• Click More link  and select the options to view the graph of 
resources by site or region or state or asset summary. 

• This also displays number of failed workstations on scanning at the bottom of the 
section. Click the Troubleshoot link for troubleshooting tips. 

Workstations 

• On scanning, Workstations shows the graph of Workstations by os, domain, 
manufacturer, processor type, department, site, region, state etc. 

• Click the More link and select the option to view the graph.   
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Software 

• On scanning Software shows the graph of Software by category, software licensing 
status, software license compliance, software vendors volume etc. 

• Click More link at the right side of the section and select the options to view the 
graph. 

 

 

Purchase & Contracts 

The purchase and contract dashboard can be viewed by the technicians with viewing 
permissions on purchase and contract module.  

• On scanning, PO & Contracts shows the graph of contract summary and purchase 
order summary. 

• Click More link  and select the option to view the graph. 
• Contracts summary shows the graph for contracts expiring in next 7days, 30 days, 

also contracts expired in last 30 days. 
• Purchase Order summary shows the graph for purchase due today, next 7 days & 

next 30 days. 
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Scheduler 

ServiceDesk Plus gives the provision of providing a schedule calender showing the number of open 
requests, problems, changes, task and reminder for a technician in a given month. The availability of 
a technician can be viewed from the technician availability chart, depending on which, the task, 
requests, problems and change can be re-assigned to other technicians. 

 

The following are available under Scheduler, 

• My Schedule 
• Technician Availability Chart 
• Mark Unavailability 
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My Schedule  

My Schedule is a calender view displaying the number of open requests, problems, changes, tasks 
and reminders assigned to a technician for a given month. The calender also shows the availability of 
the technician for a specific day in a given month. 

 

Note: The My Schedule calender can be viewed by All Technicians.   

• The administrator has the ability to view the number of open requests/ tasks/ 
problems / changes and availability of  All Technicians in All Site.  

• The Site Admin has the privilege to view the number of open 
requests/tasks/problems/changes and availability of technicians only in his 
site. 

• The Technician can view only his open requests/ tasks/ problems/ changes 
and availability.  

To view the My Schedule calender, 

1. Login to ServiceDesk Plus application using your username and password. 
2. In the home page, click Scheduler tab beside My View tab (OR) Click Quick Actions  -> My 

Schedule under the schedule block. This opens the Schedule Calender. By default, the 
calender shows the number of open requests, problems, changes, tasks and reminders 
assigned to you as shown below, 
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Schedule Calender 

• The Schedule Calender shows the current month and year along with the navigation buttons 
on the left hand side of the page. 

• The Navigation buttons helps to navigate to the previous and the forth coming months. 
• The current date is marked in separate border. 
• For an administrator all the sites should be listed along with its corresponding groups and 

technicians loaded in the drop down field.  
For a Site Admin, the site for which he is the administrator gets listed in the drop down box 
along with its corresponding groups and technicians.  
Technician can view only his open requests, problems, changes, tasks and reminders.      

• The number of Open Requests, problems, changes and task assigned to the technicians 
for a specific date in a given month can be viewed. 

• The unavailability of the technician is indicated in a different colour. 
• The company holidays and weekends is marked in a separate.  

 

 Using My Schedule, you can perform actions such as, 

• Mark Leave 
• Edit/Cancel Leave 
• Add Task 
• Add Reminders 
• Viewing requests/task/problems/change 
• Re-assigning requests/task/problem/change  

 

Mark Leave 

It is essential to keep a track of technicians on leave so that work is not assigned to them for that 
particular day. To mark leave, 

1. From My Schedule, hover over the day on which you want to mark leave. The list of icons 
gets displayed on the right hand side below the date. Click Mark Leave icon. This opens 
the Mark Unavailability pop-up window as shown below, 
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2. The name of the Technician is displayed in non-editable text. 
3. Select the Leave Type from the combo box. For ex. Casual Leave, Sick Leave etc.  
4. Select the From and To date of leave from the calender icon. 
5. Specify any relevant Comments regarding the leave.  
6. Click Save. The technicians holiday is indicated in a different colour. 

Leave can be marked to other technicians using Technician Availability Chart. You can configure your 
leave by clicking Quick Actions -> Mark Unavailability under the scheduler block. This opens the 
Mark Unavailability pop up window.  Follow the above steps to mark leave.  

Edit/Cancel Leave 

If you wish to edit or cancel a leave then, 

1. From the schedule calender, hover over on the day the technician is on leave. Click on the 
Edit leave icon on the right hand side below the date. This opens the Mark Unavailability 
pop-up window. 

2. Click Save on making the changes. 
3. If you wish to Cancel the leave then click Cancel Leave. The leave gets cancelled. 

Note: For continuous holidays, the entire series gets cancelled.  

Add Task 

You can also add, view and re-assign the tasks to other technicians. The tasks can be added to 
technicians for the current day and the forth coming days. To add task refer Add Tasks.  

Viewing Requests/Tasks/Problems/Changes 

The number open requests, tasks, problems and changes assigned to you gets listed in the calender, 
by default. To view the details of the request/tasks/problem/change, 

1. Click the link corresponding to the requests/task/problems/changes to be viewed for a specific 
day. The details of requests/tasks/problems/changes gets listed for the particular day as 
shown below, 

 

 

 

Re-assigning Requests/ Tasks/ Problems/ Changes 

The requests, tasks, problems or changes assigned to a particular technician can be re-assigned to 
other technicians. For ex. If requests are assigned to a technician for a specific day and if the 
technician is unavailable on that day, then the request can be re-assigned to other technicians. 
Similarly tasks, problems and changes can be re-assigned. 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 41

To re-assign requests/tasks/problems/changes, 

1. Click the requests/problems/tasks/changes on the day, of the corresponding technician you 
want to re-assign from the Schedule Calender. This lists out all the open request for that day. 

2. Enable the check box adjacent to the request which you want to re-assign. 
3. Select the technician from the combo box to whom the task is re-assigned. Click Re-assign 

button. The task is re-assigned to the technician.  

Reminders 

The reminder option is available only for the logged in technician, that is, if the logged in technician is 
an administrator then the reminders of other technicians cannot be viewed by him. To know more on 
reminders refer Reminders. 
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Technician Availability Chart 

The Technician Availability Chart displays the list of technicians, along with the number of open 
requests assigned to them and their availability for a given month. The chart is a matrix view, 
indicating the availability of the technician for a specific day, so that any request due on that day can 
be re-assigned to other technicians.       

 

Note: The Technician Availability Chart is available only for technicians with Admin 
privileges such as an administrator and Site Admin.  

• The administrator has the ability to view the availability and the number of 
open requests assigned to  All Technicians in All Site.  

• The Site Admin has the privilege to view the availability and the number of 
open requests of technicians only in his site. 

To view the Technician Availability Chart,          

1. Login to ServiceDesk Plus application using the username and password. 
2. In the home page, click Scheduler tab. This opens the Schedule Calender displaying the 

number of open requests, problems, changes, task and reminders assigned to you. Click the 
Tech Availability Chart link on the right hand side of the page. (OR)  
Click Quick Actions under the header pane -> Tech Availability Chart under Scheduler 
block. This opens the Technician Availability Chart. By default, the list of all the technicians 
gets listed as shown below, 

  

 

Technician Availability Chart 

• The Technician Availability Chart shows the current month and year along with the 
navigation buttons on the left hand side of the page. 

• The Navigation buttons help to navigate to the previous and the forth coming 
months. 

• The current date is marked in separate border. 
• For an administrator, the list of all the technicians gets displayed irrespective of the 

Site and Group, by default. Hence the Site along with the group can be chosen from 
the combo box to view the availability of a technician in specific site.  
For a Site Admin, the technicians available in his site gets listed irrespective of the 
group.    
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• The number of Open Requests assigned to the technicians for a specific date can 
be viewed. 

• The unavailability of the technician is indicated in a different colour. 
• The company holidays and weekends is marked in a separate colours.   

 

  Using the Technician Availability Chart, you can perform actions such as, 

• Mark Leave  
• Edit/Cancel Leave 
• View Request 
• Re-assign Requests  

 

Mark Leave 

You can mark the unavailability of a technician using the technician availability chart. This is essential 
so that work is not assigned to the particular technician for that day and can be re-assigned to other 
technicians. 

To mark leave, 

1. From the Technician Availability Chart click the day corresponding to the technician on 
leave. This opens the Mark Unavailability pop-up window as shown below, 

 

2. The name of the Technician is displayed in a non-editable text. 
3. Select the Leave Type from the combo box. For ex. Casual Leave, Sick Leave etc.  
4. Select the From and To date of leave by invoking the calender icon. 
5. Specify any relevant Comments regarding the leave.  
6. Click Save. The technicians holiday is indicated in a different colour. 

You can configure your leave by clicking Quick Actions -> Mark Unavailability under the scheduler 
block. This opens the Mark Unavailability pop up window.  Follow the above steps to mark leave.  
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Edit / Cancel Leave 

If you wish to edit or cancel a leave then, 

1. Click on the leave of the technician which you want to edit from the Technician Availability 
Chart. This opens the Mark Unavailability pop-up window. 

2. Click Save on making the changes.  
3. If you wish to Cancel the leave then click Cancel Leave. The leave gets cancelled.  

Note: For continuous holidays, the entire series gets cancelled.   

Viewing Requests 

The requests assigned to a technician for a particular can be viewed by, 

1. Click on the day of the requests, of the corresponding technician which you want to view from 
the Technician Availability Chart. 

2. From the drop down box,  select View Details. This opens the list of all open 
request due for that day. 

Re-assigning Requests 

The request assigned to a particular technician can be re-assigned to other technicians. For ex. If 
requests are assigned to a technician for a specific day and if the technician is unavailable on that 
day, then the request can be re-assigned to other technicians. 

To re-assign requests, 

1. Click on the day of the requests, of the corresponding technician you want to re-assign from 
the Technician Availability Chart. 

2. From the drop down box,  select View Details. This opens the list of all open 
request due for that day. 

3. Enable the check box beside the request which you wan to re-assign. 
4. Select the Technician from the combo box to whom the request is re-assigned. 
5. Click the Re-assign button.   

Click the name of the technician to have a detailed view about the number of requests, problems, 
changes and tasks assigned to the particular technician in My Schedule.  
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License Expiry Alert 

Just above the header tabs the license expiry alert will be displayed as show below,  

 

 

 

Click on click here link to view the licence expiry alert. The license expiry alert provides remaining 
number of days for the existing license to get expired. And also it provides the date by which the 
license has to be renewed. The option to purchase the license such as sales contact email ID, link to 
apply the upgraded license are also provided as shown below, 
  

 

 

To register ServiceDesk Plus, you can just click the link click here to apply in the license alert box. 
This opens the license upgrade window. To apply the license, refer to the topic Registering 
ServiceDesk Plus. 
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My Tasks 

My Tasks on the right hand side of the home page -> under my view tab-> next to the my requests 
summary block, shows all the Tasks assigned to you. These tasks could be added by you as a 
personal reminder of the due by tasks. Or it can be the tasks assigned to you by other technicians.    

You can also assign tasks to other technicians through this option. On adding the tasks to other 
technicians, the added tasks will be listed in their home page under the My Tasks block and the 
technicians will be able to view the tasks immediately on logging in to ServiceDesk Plus application.    

All your tasks including the requests assigned on your name can be added to this list as My Tasks, 
but you cannot maintain the log for the requests entered under my tasks list.  

To add My Tasks,   

From the ServiceDesk Plus login home page, you have My Tasks block on the right hand side of the 
home page. Click the Add New button at the down left corner of the My Tasks block. This opens the 

Tasks page. Alternatively, you can also add tasks by clicking   -> Add Task under 
the Task block. 

1. Specify the Title of the task in the given text field. This is a mandatory field. 
2. Specify relevant information about the tasks in the Description field. 
3. Select the Scheduled Start Time from the calendar button. Also select the 

Scheduled End Time for the task from the calendar button. 
4. The Actual Start Time and End Time of the task will be entered by the technician 

doing (owning) the task.  
5. The actual start time and end time is the real time schedule of the task. The 

scheduled start time and end time specified by the task owner is a tentative time 
schedule.        

6. Select the Owner (technician) of the task from the combo box. 
7. Specify the Status of the task. By default the Status of the task is Open. 
8. Specify any relevant comment about the task in the Comments field. 
9. If you wish to be reminded of the task previously then select the Email me before 

option and select the number of days from the combo box. This option will be 
selected based on the scheduled start time. 

10. Save the values. You can see the added tasks getting listed under My Tasks block in 
the home page as shown below. The tasks will be listed under the tasks tab in 
ascending order based on the scheduled start time.  
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To view the details of the tasks click the title of the task to be viewed. This opens the 
Tasks page and you can view the details. 

When you have completed the task, you can just close the task by selecting the radio 
button beside the task. Alternatively,  

1. Click the Show All link on the right hand side of the block. This opens the 
Show all Tasks page. 

2. Select the tasks which has been completed by enabling the check box. 
3. Click the Close button to close the task. You can see the tasks moved under 

closed status and in the home page you can see the tasks deleted from the 
My task block.  

To view all the added Tasks, 

To view all the tasks added to the list, click the >Show All button on the down right hand side of the 
My Tasks block. This opens the Show all Tasks page as shown below, 

 

You can also add new task through this page by clicking on the New Task button available on the top 
right corner of the page. 

To view the tasks based on the status-> click the Filter Showing combo box and select the task 
status from the list. You can see the tasks getting listed based on the selected status. 

Alternatively, you can view All tasks and tasks assigned to you in Quick Actions under the Task 
block.  

To Delete Tasks 

1. Click the >Show All button on the down right hand side of the My Tasks block. This 
opens the Show all Tasks page as shown above. 

2. Click the Delete button. A confirmation message pops up asking you confirm on the 
delete process.  

3. Click Yes to proceed. You can see the task deleted from the Show all Tasks list as 
well as from the home page.  
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Publishing Announcements 

ServiceDesk Plus allows you to publish announcements company wide or just to the technicians 
group. The announcement board is available in the login home page of the my view tab, below the My 
Summary block. Any technician can add, edit, and delete announcements.  

 

The recent announcements will be displayed in the box. To view all the announcements (even 
completed ones), click the Show All button. This will display the list of all announcements added till 
date. 

To view an announcement, click the Announcement Title to open the complete announcement 
details in a pop-up. If there are more than one announcements, then you will notice a Previous and 
Next button in the pop-up. Using this you can navigate through the announcements list and view all 
the announcements without closing the pop-up window. 

Add a New Announcement 

To add a new announcement, 

1. Login to ServiceDesk Plus using the administrator / technician user name and password. 
2. In the login home page, if you have permissions to add an announcement, you will notice the 

Add New button in the announcements box as shown above. Click the button. The Add New 
Announcement dialog pops up. 

3. Enter the Announcement Title. This can be a short statement that describes the 
announcement. This is mandatory field. 

4. Type the Announcement Content in the text box provided for the same. 
5. Select the From date and To date using the calender icon beside the respective fields. 
6. If you wish to publish the announcement only to the technicians and do not wish to expose it 

to your requesters, then select the check box Show this announcement only to 
technicians. The announcement will be displayed in the home page with a lock beside it. 

7. If you wish to Send this announcement as mail then select the corresponding option by 
enabling the check box. 

8. Click Save. At any point of time, you do not wish to add the announcement, click Cancel.  

The announcement will be added and the pop-up will display the announcement details as entered by 
you. The announcement title will be displayed in the login home in bold text in the announcement box 
with a new icon beside it.  

Edit an Announcement 

To edit an announcement 

1. Login to ServiceDesk Plus using the administrator / technician user name and password. 
2. In the login home page, click the title of the announcement that you wish to edit. The 

announcement details are displayed in a View Announcement pop-up. If you have 
permissions to edit / delete the announcements, you will see an Edit and Delete button. 

3. Click Edit button. 
4. You can change all the fields of the announcement in the Edit Announcement form.  
5. Click Save. At any point of time, you do not wish to edit the announcement, click Cancel.  
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All the changes made in the announcement will be saved. 

Delete an Announcement 

To delete an announcement, 

1. Login to ServiceDesk Plus using the administrator / technician user name and password. 
2. In the login home page, click the title of the announcement that you wish to delete. The 

announcement details are displayed in a View Announcement pop-up. If you have 
permissions to edit / delete the announcements, you will see an Edit and Delete button. 

3. Click Delete button. A confirmation dialog pops up. 
4. Click OK to delete, and Cancel to retain the announcement. 

Alternatively, 

1. Login to ServiceDesk Plus using the administrator / technician user name and password. 
2. In the login home page, click Show All button in the Announcements box. 
3. In the announcements list view, select check boxes beside the announcement Title which you 

wish to delete.  
4. Click Delete. A confirmation dialog pops up. 
5. Click OK to delete, and Cancel to retain the announcements. 

 

Note: If the announcements are open for everyone to view and not restricted to the 
technicians alone, then in the requester login, the requesters will be able to view the 
announcements by clicking the title of the announcements. Only announcements that 
have a completion time beyond the current date will be visible for the requesters.  
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Reminders 

ManageEngine ServiceDesk Plus provides you with the option of tracking your tasks everyday. The 
tasks that you add to the My Reminders list act as substitute for your sticky notes or post-it notes 
which you would use to remember your tasks for the day.  

Add Reminders 

To add new reminders, 

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click Quick Actions just below the header tabs -> Add New under the 
Reminders block. The Reminders form pops up.  
 
Alternatively, you can add a new reminder by clicking Quick Actions -> My Reminder (s). 
The My Reminder (s) form pops up as shown below,  

   

 
  

 Click +Add New link at the bottom of the my reminders form. This opens Reminders page.  

3. Enter the task summary in the text field provided.  
4. Select the Date & Time for the reminder. The date field is set to the today's date and the time 

is set by default as 11:00 AM. Change the date and time settings. To change the date, click 
the calender icon beside the date field and choose the date of your choice. From the time 
combo box, choose the time at which the task is scheduled. The values in the combo box are 
available in a gap of  5 min time interval. 

5. Click Add. The new reminder is added and is listed along with the already existing reminders 
in the ascending order based on date and time. 

Changing Status 

When you have completed a reminder, you can just strike the reminder to indicate that it is completed 
by selecting the radio button beside the reminder.   
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1. From the My Reminders form, click the status radio button  to change the task status from 
incomplete to Completed. The task is struck through to indicate that it is completed.  

 

   
2. Alternatively, you can also change the task state by executing the following steps : 

1. Click Show all at the bottom right of the My Reminders pop up window. The All 
Reminders window opens as shown below, 
 

 
2. Select the check boxes beside the Reminder Summary for which you wish to 

change the state. 
3. Select the state from the Change Reminder State To combo box, select the 

reminder state to Completed. 
4. Click Change button to change the status of the task. To indicate the change the task 

would be striked of.  

Deleting Reminders 

The reminders can be deleted by, 

1. From the My Reminders form, click Delete this reminder radio button  available beside 
the status radio button. The reminder gets deleted from the list. 

2. Alternatively, from All Reminders window, enable the check box beside the Reminder 
summary to be deleted. Click Delete. A pop up window confirming the delete operation 
appears. Click Ok to proceed. The reminder gets deleted from the list.  

The advantage of moving the reminder to completed state instead of deleting it completely is that, you 
can revert the state of the reminder to Open again and edit its attributes. But once you delete the 
reminder, it is completely removed from the application and cannot be retrieved.  

 

Note: The Reminders option is available under Quick Actions link for requesters 
accessing ServiceDesk Plus through Self-Service Portal, provided the option is 
enabled. 
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Requests 

ManageEngine ServiceDesk Plus request module helps you better manage the services provided by 
your IT services team. The requests module can be used to track outstanding and overdue requests 
that need immediate attention and thus improves the response time and resolution time of your IT 
services team. Apart from this, ServiceDesk Plus allows you to add relevant notes pertaining to the 
request that is being handled. This note can contain any information such as the exact scenario of the 
request or how the issue was resolved. Also every action performed on the request in the 
ServiceDesk Plus application is stored in the Request History. 

Clicking the Requests tab on the header pane takes you to the request module. Here the term 
request denotes any service that is requested by a user from the internal IT services team. The 
requests can be submitted to the system via mail or a web-based form. Sometimes, the requests can 
also be placed through a phone call during which, the help desk agent has to record the details of the 
phone call in the web-based form and assign priority and technician based on the urgency of the 
request. The various actions that one can perform in the request module are explained in the 
respective sections. 

To ease the process of tracking the requests posted by individual requesters, a Self Service Portal 
has been provided. This can be used by the individual requesters to track the status of their requests 
and to look up solutions from the online knowledge base. To access this self-service portal, the 
requesters need to log in to the ServiceDesk Plus application using their respective user name and 
password. For more details on self-service portal, refer to Self Service Portal topic. 
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Creating a New Request 

When system users need a service from the system administration team relating to the assets or any 
other service such as software installation and so on, they can send a request to the team. There are 
different modes of placing a request to the system administration team, such as web-based form, e-
mail notification, phone call and so on. ServiceDesk Plus provides options to log details of a request 
originating in any of the above-mentioned forms.  

To create a new request using the web-based form 

1. Log in to the ServiceDesk Plus application using your user name and password.  
2. Click the New Request link available just below the tabs in the header pane or click the New 

Request button in the Request index page. This opens the 'Default Request' Template form, 

You can also create new requests quickly and easily through Quick Create and Change 
Template explained later in the page. 

Providing Request Details 

1. In the default request form, select the Request Type from the combo box. The three default 
request types are,  

• Incident : Failure of a business service or degradation of a service for one or more 
users. E.g. Unable to print  

• Service Request: A standard request for some kind of service. E.g. Installing 
software, move from one place to another, reset password etc. A Service Request is 
not an Incident. 

• Request For Information: Request for information is basically in need of some 
information or knowledge.   

The request type can be configured in Request Type under the Admin tab. 

2. Select the Status of the request. The default entry of the Status of the request will be Open. 
3. Select the Mode of request submission, request Level and Priority of the request from the 

combo box. 
4. Select the Impact, Impact Details and Urgency of the request from the combo box.  

Selecting the Requester 

You can select the requester from the list of users using the ServiceDesk Plus application.  

5. In the Requester Details block of the Request form, beside the name field, click the 
requester lookup button ( ). The Requester List window pops up as shown below, 
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1. From the above list of requesters, click the hyper-linked requester Name to choose 
the requester.  

2. If the requester list is huge, then you can choose to view only a select group of 
requesters by clicking the alphabets at the top, or by entering a search string and 
clicking Go. Now choose the requester name. The name of the requester is displayed 
in the Name field in the Requester Details block. If there are any other details 
associated with the requester, such as Contact Number, Department, Site and 
Workstation, then the relevant details will be populated in the respective fields.  

3. You can also add new requester directly by clicking the Add Requester button from 
the requester list page. 

4. And also you can edit the requester details directly from this page by clicking the edit 
icon beside each of the requester name in the list.     

6. By default, the location of the requester gets populated in the Site text field. The requester 
can raise a request from a one site to a problem in a different site. In this case the site needs 
to be selected from combo box by the technician handling the request.  

Assigning Request to Group/Technician 

7. On selecting the site, the groups corresponding to the site gets populated under the Group 
field. The request is routed to the particular group by selecting the Group name from the 
combo box.  

8. On selecting the Group , technicians associated with the Group alone will be listed in the 
Technician drop down list.  Select the Technician for the request from the combo box. 

Classifying Request Category 

9. The request can be classified under various categories. Select the relevant category under 
which your request can be classified under the Category drop-down box.  

10. Select the relevant Sub-Category from the combo box. Also select the relevant Item from the 
combo box. 

11. Specify the subject line to be displayed while sending the request in the Subject text field. 
The subject line will be displayed as the request title hence this is a mandatory field. 

Describe Request 

12. Once you have specified the details for the request, you need to describe the request in 
detail. Provide a detailed description with any other associated details relevant to the request 
in the Description text box. 

Add Attachments to the Request 

13. In the Task Details block, below the Description text box, click the Attach file button beside 
the Attachments field to attach attachments. This opens an Attach File pop-up window as 
shown below, 
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1. Click the Browse button and select the file to be attached from the file chooser 
window and click the Open button. 

2. Click the Attach file button. The selected file will be listed below the Attachments 
heading. If you have more files to choose, follow steps 2 and 3 repeatedly till you 
have attached all the relevant files. Please ensure that the total size of the 
attachments does not exceed 10 MB. 

The attached documents can be indicated with an attachment icon beside the title of the request in 
the request list view page.  

Adding Resolution for a Request 

You also have an option to add Resolution to the request in the new request form. If you have an 
answer or solution for the request you can quickly add in the resolution text field and add it to the 
request.  

The purpose of having resolution in the new request form is, when a technician is reported about a 
problem which has been already cleared by him/her then, in this case he can create a new request, 
specify the solution in the resolution field, set the status as closed and he can close the request. Thus 
this option makes the job easier for the technician to specify the resolution and close the request 
immediately. To add resolution, 

13. Click the button  beside Resolution title in the new request form. This opens the 
Resolution text field. Specify the solution in the given text field and add to the request. The 
resolution can be viewed by click the Resolution tab while viewing the request. 

14. Once you have done all the above, click the Add request button. The request gets added to 
the list of requests and can be viewed from the request list view which can be invoked by 
clicking the Request tab in the header pane.  

Additional Request Details 

You can define your own organization-specific fields that do not appear in the New Request 
form, from the Admin module. Depending on the fields, enter the required values for the fields. 
To know more about how to add user-defined fields in the new request form, refer to the 
Configuring Additional Fields section in the request form under the Helpdesk configurations. 
The newly created fields needs to be configured in 'Default Request' under Request Template.  

Quick Create 

Quick Create is optional and can be enabled under Self Service Portal Settings. Using the Quick 
Create - New Request form, you can create a request instantly. This form is available in the 
ServiceDesk Plus home page and in requests list page as shown below, 

Enter the Requester Name, Request Title, and Description in this form and click Save. You can 
select the requester name by clicking the user look up button beside the requester name field. If 
you feel you want to add more details before submitting, then you can do so by clicking the Add more 
Details link beside the Save button. 
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The Quick Create - New Request form comes in handy when help desk agent is loaded with work. 
He/she just has to enter the requester name, request title, and description. The other details can be 
filled in by the technician who handles the request.  

Change Template 

A request can be created instantly using request template. The request form can be customised 
thereby creating individual request template for the most frequently raised requests.  

Select any one the template relevant to the request from the Change Template combo box in the 
new request form. The default request is the default template in the new request form. You also have 
the same templates listed under the New Request link. On selecting the template a request form with 
pre-filled values will be displayed, you have to just specify the Name in the form and click Add 
Request button to create a request.  

If the required request template is not listed in the combo box, then create a new request. Also you 
can create a new request template using Request Template option in the admin tab.  

Modes of Creating a Request 

You can create a new request in one of the following methods:  

1. E-mail the request to the help desk team. This e-mail will be automatically converted to a new 
request in the ServiceDesk Plus application. 

2. Call up the help desk agent and report an issue or explain the nature of your request. The 
help desk agent will manually feed in the details into the application through the web-based 
New Request form available in the Request module. 

3. Log in to the ServiceDesk Plus application using your own user name and password and fill in 
the New Request form or Quick Create - New Request yourself and submit your request. 

There can be other modes of requests also by which requests can get created. For more information 
on how to add additional modes, refer to Configuring Mode section. 
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Creating Custom Views 

You can create your own customized page to display the requests using Custom View option. You 
can specify the criteria to filter the selected requests that have accumulated in your requests list view 
page. This helps you to sort & view requests of your priority and requirement. To create your own 
custom view, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens Requests list view page. 

3. Click Create Custom View icon . This opens Add Custom View page as shown below, 

 

4. Specify the View Name in the given text field. This is a mandatory field. 
5. The administrators can make their views as private view or public view. By default the view 

will be public but to make this view as private custom view then select Make this view as 
private custom view check box.  

By default the technician without administrator log-in permissions can create only private views. 
Hence the above shown 'Make this view as a private custom view' option will not be 
available for the technician log-in.     

4. Specify the filter criteria by selecting the column and its matching criteria from the combo 
box. And select the matching data for the column by clicking the Choose button. Also select 
the AND or OR conditions by enabling either of the two radio buttons.  

5. Click Add to Filter button to save the filter criteria details. The filter criteria details will be 
listed in the Filter Set block.  

6. If you wish to add more filter conditions to this view then, select the required column, criteria & 
conditions of the filter. 

7. Save the filter criteria details. To add another custom view click Save and Add New button. 

Custom views will be listed in the Filter showing combo box in the Requests home page at the top 
below the title. On clicking the combo box the views marked as private will be listed under My View 
list and the public views will be listed under Requests list.  

Manage Custom Views 

You can view all your customized view using this option. You can also edit, delete, add new custom 
views using this option. 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens Requests list view page. 
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3. Click Manage Custom View icon . This opens Manage Custom View page with the list 
of all the created custom views.  

 

 

Editing Custom Views, 

1. Click the custom view title or click the edit icon. This opens Edit Custom View page. 
2. Edit the details and save the changes.  

Deleting Custom Views, 

1. Select the custom views to be deleted by enabling the check box. The public views can be 
deleted only by the administrators (ie: Only the administrators can make their view public 
other technicians without admin permissions can only create a private view).        

2. Click the Delete button to delete the views. A pop up window pops up to get your confirmation 
on the delete operation. 

3. Click Yes to proceed. You can see the view deleted from the list. 
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Viewing a Request 

To view a request available in the ServiceDesk Plus Request module  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Requests tab in the header pane. The next page lists all the requests available in 

the ServiceDesk Plus application in the Open status. Unassigned and assigned requests that 
have not yet been viewed by the corresponding technician even once will be in bold text, 
while the viewed requests will be in regular font. 

3. Click on the Title of the request that you want to view. This opens the View Request page. 
By default the page displays Request, Resolution, and History tabs. 
 
From the request details page, you can navigate to the previous or the next request using the 
navigation buttons on the top right hand side corner. Using this, you need not return back to 
the list view page to view the next request.  

In the request tab, the data is grouped in a logical manner. By default this page displays Subject of 
the request & Description of the request, Request Details, Requester Details and Time Elasped. 
 The Request ID is displayed on the top left corner of the page below the tabs. The Status and priority 
of the request is displayed on the top right corner of the page. 

 

Note: You also have other blocks displayed in this page such as Conversations, 
Discussion Notes  & Time Spent blocks. These blocks gets displayed on adding the 
same to the request. 

If the request is submitted for approval then the Approvals tab is viewed along with 
the Request, Resolution and the History tabs. The Approval Status is shown on the 
top right corner of the page below the Status and Priority. To know more refer Submit 
For Approval. 

Viewing Request Details 

The Request Details block displays the Status, Group, Category, Sub Category, Item, Workstation, 
Created Date, Created By, Technician, Priority, Mode, Level and Due Date of the request. You have 
inline edit option to edit all the request details under this block. To edit the details click the link 
available for each of the request details against each field. Say for ex. If you wish to change the 
technician Jeniffer Doe to John Abraham for Request ID 14 then click the name of the technician and 
select the technician name from the list.  

Viewing Requester Details   

In the Requester Details block, the details of the requester such as the Requester Name, Contact 
Number, Department, Email Address & Mobile Number of the requester are displayed. You have 
inline edit option to edit all the requester details under this block. To edit the details click the link 
available for each of the requester details against each field. 

Viewing Conversations 

Next is the Conversations block, which displays the mail transactions / threads that have been 
exchanged between the technician and the requester, related to the request.  

Click the View Requester Conversations link to view the history of all the conversations. 
Conversations are listed in the ascending order of the time. The conversation block is visible only if 
there have been any mail transactions between the requester and the technician. 
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Note: If any mail transactions/ threads has an attachment, then the same can be 
viewed under View Requester Conversation block. To know more refer Request 
Conversation. 

Viewing Discussion Notes 

Once you add a note to the request the Discussion notes gets displayed in descending order of their 
date of creation just below the Requester Details block. If you select the option "Show this notes to 
requester" then the note will be displayed as Public. Else will be listed as private.  

You also have an option to edit or delete the discussion notes. 

Asset belonging to the User, while adding users to ServiceDesk Plus in the Admin tab, you have an 
option to Associate Workstation to the user. If you have associated workstation to the user, you can 
view the list of all associated workstations under this block.  

Cost of a Request 

Finally, you can enter the time spent details for the request.  

1. Click Add Work Log button. (OR) 
 
Alternatively, you can enter the time spend details for a request by clicking Add Work Log 
option under Actions combo box from the request details page. The Add Work Log dialog 
pops up with the subject and request id of the request mentioned.  

2. Select the technician name from the Technician Resolving This Request list box. If you 
have already entered the per hour cost of the technician while creating the technician details, 
then that will be fetched and the total time spent on the request will be taken. If you wish to 
change these values, you can do so manually. 

3. Specify the time taken to resolve the request.  
4. The Technician Cost per hour will be fetched from the technician details, which is a non-

editable field. 
5. Using the above two data, the Technician Charge is calculated as Time Taken To Resolve X 

Technician's Cost per hour. 
6. Specify the Executed Time by invoking the calender icon. 
7. If you wish you can enter a description for this time spent entry. 
8. Click Save. 

The Created Date field displays the time when the request was created. Based on the priority of the 
request and SLA that is associated with the requester/workstation/department, the Due By Date is 
calculated. If you have responded to the requester then you will see the Responded Date displayed 
just below the Priority field in the Request Details block. When you add any notes to the request, it 
gets appended below the Task Details block. The Time Spent on the request will also be calculated 
and displayed. The total time spent will exclude the time that the request was on hold and then 
calculate the total time from the time of creation till the request was closed. 
 
If any notes are added to the request, they will be available below the description of the request. The 
notes are displayed in the descending order, with the latest added note displayed first and the rest 
below that. The notes can usually be added to convey any technical information related to the request 
or to convey the request status.  
 
If there are any additional user-defined fields that have been added to the new request form, they are 
grouped under the Additional Request Details head and displayed just below the Request Details 
block.  
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Viewing Resolution 

To view the resolution for the request in the view request page 

1. Click the Resolution tab next to the request tab. 
2. The current available resolution for the request is displayed in this page. You have an edit 

option on the right side of the resolution. If there are no resolutions available for the request, 
then the blank text is shown for you to add the resolution if needed. To search for resolutions 
from the solutions database, click Search Solutions button. 

3. The resolution is a documented information of how the issue was resolved. This documented 
information can be very useful for future reference. This resolution can also be added to the 
knowledge base as an article which can be searched by requesters for resolving issues faced 
by them.  

4. The status of the request can be modified while adding a resolution on selecting the status 
from Change Status To combo box. 

5. You also have an option to Add Time Entry to the resolution. Select Add Time Entry option 
by enabling the check box and specify the details.   

Viewing History 

To view the request history from the time of its creation, click the History tab in the view request 
page. The details that are displayed in the history are in the ascending order with the earliest 
performed action shown at the top of the page and the latest action at the bottom of the page.  
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Editing a Request 

To edit a request available in the ServiceDesk Plus Request module 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Requests tab in the header pane. This opens the Requests list.  
3. Click the Title of the request which you want to edit from the view list page. This opens the 

View Request page. Click the Edit tab on the top of the page to modify the request details. 
(OR) 
 
From the request list view page, click the edit icon beside the request to be edit. This 
opens the Edit Request form where you can add resolution while editing, change the status 
of the request from open to close, and so on.   

Alternatively, you also have an inline edit option to modify the request details in the view 
request page. Click the edit button beside each block which opens the request form fields in 
editable format. This comes in handy when you need to edit the values of the entire block say 
Request Details one by one.  
Note : While editing the request details block, the SLA, department and the template is in non 
editable mode. The SLA of the corresponding site selected on editing the request gets applied. 
The department of the corresponding technician selected on editing the request gets displayed.  

4. On modifying the values, click Update Request to save the changes. If you do not want to 
save the changes, click Cancel. 

 Editing more than one Requests 

You have an option to edit more than one requests simultaneously.  

1. Select the check box beside the requests to be edited from the request list view page.  
2. Click Edit Request button. This opens Edit Requests page. The title displays the requests 

number that are grouped together to edit. Edit the Request, Owner & Category details of 
the requests. 

3. Specify the Reason for Updating the request in the given text field. 
4. Click Update button to save the changes. 

This comes very useful when there are group of requests of same issue wherein the technician can 
select all the requests and edit the details in a single shot without editing each request one by one.    
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Closing Requests 

When a requester is completely satisfied that his/her request has been completely attended to and the 
reported problem has been solved, then the request can be closed.  

To close a request, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page.  
3. Click the Subject link of the request in the Requests list page. 
4. Click the Close tab under the Tasks block. The Close Request dialog box appears. Enable 

the 'Yes' radio button if the resolution has been acknowledged. else enable 'No' radio button. 
Enter relevant Comments in the field provided. Click Close to close the request. If you do not 
wish to close the request then click Cancel. (OR) 
 
Alternatively, change the status field to Closed when the request is in editable mode.  

You can reopen a request from the closed state. To do this, open the closed request that you wish to 
reopen in the editable mode and change the status field from Closed to Open. When a request is 
opened from the closed state, you can change the Due By time of the request when it is in the 
editable mode. Also, the closed date is removed once the request is reopened. When this request is 
finally closed, the completed date is updated and the Time taken to close is recalculated taking the 
reopened period into account. 

To close more than one request at a time, 

1. In the Request list view page, select the check boxes available beside the Requester Name 
field of the requests that you wish to close. 

2. Now click the Close button. The Close Request dialog box appears. Enable the 'Yes' radio 
button if the resolution has been acknowledged. else enable 'No' radio button. Enter relevant 
Comments in the field provided. Click Close to close the request. If you do not wish to close 
the request then click Cancel. 

To view the closed requests  

1. From the Request list page, select Closed Requests from the Filter drop-down menu. This 
lists all the closed requests. 

2. To view the closed requests which were assigned to you, select My Closed Requests. 
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Picking up Requests 

ManageEngine ServiceDesk Plus provides the option of self-pick up of requests that are received in 
the requests module. If there are unassigned requests in the application, then the technicians can 
themselves pick up requests. This increases the efficiency in the turnaround time of the IT help desk 
team as the requests are assigned and answered sooner and waiting time of the request till it is 
assigned is reduced.  

To pick up requests 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Requests tab in the header pane. The unassigned requests will be in bold font. 
3. Select the requests you would like to pick up by enabling the check box. Click Pick up button. 

The selected request will be assigned to you. (Or) 
4. You can also pick up requests after viewing the request details. Click the title of the request to 

open View Request page. 
5. Click Assign tab. Select Pick Up option to pick up the request. 
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Assigning a Technician for the Request 

Each request will be owned by a technician, who would be responsible for handling the request till it is 
closed.  

To assign a technician, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the Requests list. 
3. Click the Title of the request for which you have to assign a technician. This opens the view 

request page. 
4. The View Request page lists the Tasks that can be performed on the requests on top of the 

page. Here click the Assign link and select the assign option. This opens Assign Group and 
Technician page as shown below.  

Based on the issue you can assign this request to the appropriate Group and as well as to the 
Technician who belongs to that group. Or you can select either of the one. If you wish to select 
the technician alone then choose the technician from the list and click Assign button to assign 
the technician to handle the request. And when the technician logs into ServiceDesk Plus, 
he/she would see this request in the My Open Requests list.  

 

 

5. Alternatively, you can also assign technician using inline edit option. Click the technician 
name shown in the request details block. This opens the drop down box as shown below. 
Select the technician from the list and click the  icon to select the technician name else 
click cancel icon.    
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Bulk assign requests to technicians 

You can also assign more than one request at a time to a technician.  

1. In the Requests list page, select the requests to be assigned a technician by enabling the 
check box beside left side of each of the request title. 

  

2. Select the Assign to check box. Select the technician from the drop down list. 
3. Click Assign button to assign the technician. 
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Unassigning a Technician from a Request 

Each request will be owned by a technician, who would be responsible for handling the request till it is 
closed. You can unassign a request from the request and move it back to unassigned status. 

To unassign a technician 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the Requests list. 
3. Click the Title of the request for which you have to unassign a technician. This opens the 

view request page. 
4. The View Request page lists the Tasks that can be performed on the requests on top of the 

page. Click the Assign link and select the Assign option from the list. Alternatively, you can 
also unassign technician using inline edit option. Click the technician name shown in the 
request details block. This opens the drop down box as shown below. Select the technician 
name from the list and click the  icon to select the technician else click cancel icon. 

 

5. Now select the NONE option and click Assign. The request will be unassigned. If you do not 
wish to unassign the technician then you can just close the pop-up by clicking Cancel. 
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Start / Stop Request Timer 

If a technician is unable to close a request then, it could be for many reasons such as, lack of 
necessary information or and so on. If the technician is unable to continue the work then he/she can 
move the request to on hold status.  

If this is not done, then the request will remain in open state idly which will lead to the violation of SLA 
that governs the request. Also, it will show that the time taken to close the request was high and will 
reflect on the efficiency of the technician (s) handling the request. To avoid all these, move the 
request to on hold state till the time you are ready to resume work on the same.  

Alternatively, you can stop the timer when you are not working on the request. 

Stop Timer 

To stop the request timer, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page.  
3. Click the Subject link of the request in the Requests list page. 
4. Click the Stop Timer under Actions combo box. A pop-up window opens requesting you for 

the reason for stopping the timer. 
5. Enter the relevant reason to stop timer in the text area provided for the same. 
6. Click Add. 

The status of the request will be changed to On hold and the reason gets appended to the request 
history. 

Start Timer 

To restart the request timer, 

1. In the request details page, click Start Timer link under Actions combo box. A pop-up window 
opens requesting you for the reason for starting the timer. 

2. Enter the relevant reason to stop timer in the text area provided for the same. 
3. Click Add. 

The status of the request will be changed to Open and the reason gets appended to the request 
history. 

 
Note: You can stop and start timer for requests that are not overdue. 
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Adding Notes 

When you would like to add some additional information including technical information to a particular 
request based on your observations, you can use Add Notes. You can also use notes to update the 
status of the request.  

To add a note to a request, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane.  
3. Click the Title of the request to which you would like to add a note. 
4. Click the Actions menu -> Select Add Notes option. This opens Add Note page as shown 

below,  

 

5. Enter your content in the text box below the Request ID. 
6. There are two types of notes that can be added to the request such as, public & private.  

Public Notes: Public notes can be viewed by the requesters & technicians. 

Private Notes: Private notes can be viewed only by the technicians (all the technicians).  

These notes can be added to the request by both the technician and the requester. By default 
the requester can add only  public notes.  

By default the technician can add only a private note but the technician also has an option to 
make his notes public. 

If you want the notes to be visible to the requesters (public), then select the Show this notes 
to Requester also check box. Else only the technicians will be able to view the notes (private). 

5. If you want to notify the technician about the addition of the note, then select the check box, 
E-mail the technician for notes addition. 

6. Click the Add Note button. The note is added at the bottom of the request along with a date 
and time stamp. The name of the person who added the note is also displayed. 

You can add any number of notes to a request. The added notes will be displayed in the descending 
order with recently added note first. You can also edit or delete the notes that have been added. 
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Adding Tasks 

Using add tasks option you can assign different tasks to different technicians. Say if a request sent by 
the requester involves multiple technicians work then the technician whoever received the request can 
assign different tasks to the different technician. 

Example: When a new employee joins the organization a list of tasks needs to be performed such as, 
seating location, providing a system, installing operating system, connecting telephone links, entering 
his/her name in the active entry, etc. In this case you can assign different tasks to different technicians 
using add tasks option.     

To add tasks, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane.  
3. Click the Title of the request to which you would like to add tasks. 
4. Click the Actions menu -> select Add Tasks option. This opens the Tasks window.  
5. Specify the Title of the task in the given text field. This is a mandatory field. 
6. Specify relevant information about the tasks in the Description field. 
7. Select the Scheduled Start Time for the task based on the SLA from the calendar button. 

Also select the Scheduled End Time for the task from the calendar button. 
8. You can also select the Actual Start Time and End Time of the task. The actual start time 

will be the time limit for the technician to start the work. After which the technician would over 
rule the SLA. 

9. Select the Owner of the task from the combo box. 
10. Specify the Status of the task. 
11. Specify any relevant comment about the task in the Comments field. 
12. If you wish to be reminded of the task previously then select the time duration from the 

Remind me before combo box. 
13. Save the values. You can see a Tasks tab getting created next to the Resolution tab. All the 

tasks created for the request will be listed under the tasks tab in descending order. The tasks 
assigned to other technicians can be viewed in their Task summary list in the home page.    
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Merging a Request 

When two or more requests are related to each other and are from the same requester, and can be 
handled by the same technician, you can merge these requests as one and assign a single technician 
for that request. 

To merge one or more requests 

1. Login to the ServiceDesk Plus application with the user name and password of the 
administrator or technician. This opens the request list view page. 

2. From the request list view page select the requests to be merged by enabling the check box. 
Click Merge button to merge the requests. All the merged requests appear as a single 
request. (Or) 

3. Click the Title of the request that you wish to merge in the request list view page. 
4. Click Actions link -> Click Merge Request option. This opens Merge this Request form as 

shown below, 

   

 

5. You can search for specific request by providing a search string in the field provided above. 
6. To confirm if the request that you want to merge is the correct one, you can view the request 

by clicking the title of the request. 

7. Click the Merge Request icon  to merge the two requests. A dialog box pops up asking 
for your confirmation to merge requests. 

8. Click OK to merge request. All the merged requests will be displayed in the Conversations 
block of the view list page. And if you have attached notes, conversations and time-spent 
entry for the requests all the said information will be moved to the parent request. 

9. Else if you wish to cancel merging click Cancel in both the dialogs to exit the Merge Request 
form.   

You can split a thread of a request into a new request. For more information on this, kindly refer to the 
section Request Conversations. 
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Copying a Request 

When a single request has multiple issues in it that requires more than a single technician to handle 
them, then the request can be duplicated and each of the duplicated requests can have only one 
issue. This makes it easier for the technician to take ownership and complete the task independently. 

To make multiple copies of the request, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page.  
3. Click the Subject link of the request that you want to duplicate in the view list page. This 

opens the Request details page. 
4. Click Duplicate Request option under Actions combo box.  A Duplicate Request pop-up 

window opens, requesting you to give the number of copies. 
 

 
5. Enter the number of copies in the text field provided beside the Number of Copies label. The 

maximum value you can enter is 9. If you need more than 9 copies of the request, then you 
need to invoke Copy Request again. 

6. Click Copy to make the copies of the request. The new copies of the request will be assigned 
new request ID that will uniquely identify them. The rest of the information such as the request 
details and description remains as it is. 

Once you have created the copies of the request, you can edit the same to contain only the necessary 
information and assign appropriate technicians. You can modify the request copies by editing the 
copy of the request.  

While copying the request, the Notes, Tasks, Reminders, Resolution and Approval status of the 
original request (if any) will not be present in the duplicated requests. Also, the Created Date and 
Due by Date will be different from that of the original request. 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 73

Deleting Requests 

You may receive lots of mails of which some may not qualify as requests at all and hence need to be 
removed from the ServiceDesk Plus application completely. In such cases, you can delete those 
individual requests in the view request page or select a group of requests in the list view page and 
delete them together.  

To delete individual requests, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page. 
3. Click the Subject link of the request that you want to delete. This opens the request details 

page. 
4. Click Actions combo box -> Delete option. A confirmation dialog pops up. 
5. Click OK to proceed deleting. The notes, work logs and conversations ( if any ) added to the 

request gets deleted. Click Cancel to abort deletion. 

To delete more than one request at a time 

1. In the requests list view page, select the check boxes beside the request that you wish to 
delete.  

2. Click the Delete button. A confirmation dialog pops up. 
3. Click OK to proceed deleting. Click Cancel to abort deletion. 
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Add/Associate Problem to Requests 

You have an option to add, associate, view and detach problem to requests. Similar problem occurred 
to Incidents ( requests ) can be associated in order to track the problem occurred for the same 
request. You can also add new problem or detach the existing problem to a request. While 
adding/associating/detaching a problem the approval status of the request does not change. 

 
• Associating Problem to request 
• Add Problem to request 
• Viewing Associated problem 
• Detach Request from Problem  

 

Associate Problem to Request 

You can also associate the existing problem to the request. To associate problem, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page.  
3. Click the Subject link of the request for which you want to add a problem. This opens the 

request details page.  
4. Click the Actions combo box on the top right side of the page. Click Search Problems 

option. This opens Associate Incidents to problem page as shown below, 
 

 
  

4. Select the type of problem to be displayed by selecting from the Filter Showing combo box 
on the top left hand side of the page. Ex: Open Problems or All Problems and so on. On 
selecting the problem type the corresponding problems gets listed.  

5. Select any one problem to be associated with the request by enabling the radio button beside 
the title of the problem.  

6. Click Associate button to associate respective problem to the request (particular selected 
request). You can associate the same problem to different requests.  
 
Once the problem is associated to the request, the View Problem and Detach from Problem 
option appears under Actions combo box. 

Add Problem to requests 

You can add new problem to requests. To add new problem,  

1. From the request list view page, click the Subject link of the request for which you want to 
add a problem. This opens the request details page. Click New Problem button on the right 
hand side of description field. (OR) 
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Alternatively, you add a new change from the Associate Problem to Incident pop up page. 
Click New Problem button below the filter showing combo box. This opens the New Problem 
form.  

2. The details such as Status, Impact, Urgency, Priority, Category, Sub category, Item along 
with Subject and Description remains the same as of the request. If required, you can modify 
the same on selecting from the combo box. 

3. Select the Reported By requester from the list by clicking on the Requester icon .This 
opens the requester list page and click the requester title. 

4. Select the Technician from the combo box.  
5. Select the Due by Date and the Closed Date from the calender button. 
6. Select the affected IT Services from the list by clicking on the icon .This opens the 

Services Affected pop up box. Select the affected IT services and Save the changes. 
7. Select the Assets Involved with the problem by clicking the icon .This opens the Select 

Assets page. Select the Type of Assets or the category of assets to be involved from the 
combo box. Ex: Workstations, Routers, Switches and so on. Select the Available Assets 
under the selected type from the list and move to Assets involved using >> button. And 
Save the changes.   

8. If you have any file attachments for the problem click the Attach File button and attach files.  
Note: Maximum size of an attachment can be 10MB. 

9.  Save the changes. A new problem gets added in the problem list view page. 

View Associated Problems   

You have an option to view the newly added problems or the problems associated to the request.  

To view the problem, 

1. From the request list view page, click on the request for which you wish to view the problem. 
This opens the request details page. 

2. Click View Problem button on the right hand side of the request description. (OR) 
 
Click Actions combo box -> View Problem option. This displays the Problems Details page 
of the problem added/associated to the request.  

Detach Request  from Problem  

If you want to add another problem to the request then the existing problem has to be detached. 

To detach a problem, 

1. From the request list view page, click the request you wish to detach the problem. This open 
the request details page. 

2. Click Actions combo box -> Detach from Problem option. The request is detached from the 
problem.  
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Add/Associate Change to Requests 

You have an option to add, associate, view and detach change to requests. Similar change occurred 
to Incidents ( requests ) can be associated in order to track the change occurred for the same request. 
You can also add new change or detach the existing change to a request. While 
adding/associating/detaching a change the approval status of the request does not change. 

 
• Associating Change to request 
• Add Change to request 
• Viewing Associated Change 
• Detach Request from Change  

 

Associate Change to Requests 

You can also associate the existing change to the request. To associate change, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page.  
3. Click the Subject link of the request for which you want to add a change. This opens the 

request details page.  
4. Click the Actions combo box on the top right side of the page. Click Search Changes option. 

This opens Associate Change to Incident page as shown below, 
 

 
5. Select the type of change to be displayed by selecting from the Filter Showing combo box on 

the top left hand side of the page. Ex: Open Change or All Change and so on. On selecting 
the change type the corresponding changes gets listed.  

6. Select any one change to be associated with the request by enabling the radio button beside 
the title of the change.  

7. Click Associate button to associate respective change to the request (particular selected 
request). You can associate the same change to different requests. 
 
Once the problem is associated to the request, the View Change and Detach from Change 
option appears under Actions combo box. 

Add Change to requests 

You can add new change to requests. To add new change,  

1. From the request list view page, click on the subject link of the request you wish to add 
change. This opens the request details page.  

2. Click New Change button on the right hand side of the description field. This opens the New 
Change form. (OR) 
 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 77

Alternatively, you add a new change from the Associate Change to Incident pop up page. 
Click New Change button below the filter showing combo box.   

3. The details such as Status, Impact, Urgency, Priority, Category, Sub category, Item along 
with Subject and Description remains the same as of the request. If required, you can modify 
the same on selecting from the combo box. 

4. Select the Reported By requester from the list by clicking on the Requester icon .This 
opens the requester list page and click the requester title. 

5. Select the Technician from the combo box.  
6. Select the Schedule Start Time and the Schedule End Time from the calender button. 
7. Select the affected IT Services from the list by clicking on the icon .This opens the 

Services Affected pop up box. Select the affected IT services and Save the changes. 
8. Select the Assets Involved with the problem by clicking the icon .This opens the Select 

Assets page. Select the Type of Assets or the category of assets to be involved from the 
combo box. Ex: Workstations, Routers, Switches and so on. Select the Available Assets 
under the selected type from the list and move to Assets involved using >> button. And 
Save the changes.   

9. If you have any file attachments for the problem click the Attach File button and attach files.  
Note: Maximum size of an attachment can be 10MB. 

10.  Click Save. A new change gets added in the change list view page. 

View Associated Change   

You have an option to view the newly added change or the change associated to the request.  

To view the change, 

1. From the request list view page, click on the request for which you wish to view the change. 
This opens the request details page. 

2. Click View Change button on the right hand side of the request description. (OR) 
 
Click Actions combo box -> View Change option. This displays the Problems Details page of 
the change added/associated to the request.  

Detach Request  from change 

If you want to add another change to the request then the existing change has to be detached. 

To detach a change, 

1. From the request list view page, click the request you wish to detach the change. This open 
the request details page. 

2. Click Actions combo box -> Detach from Change option. The request is detached from the 
change.  
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Printing the Request 

To print a request  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane.  
3. Click the Title of the request that you want to print. 
4. Click the Print Preview link on the right side Tasks block.  
5. The print preview of the request is opened in a pop-up window. Click the Print menu item 

from the browser File menu. 
6. The default printer associated with your workstation is invoked. Set the required options and 

click OK. You can collect the printed copy of the request at the printer that is linked to your 
workstation. 
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Adding a Resolution 

You can add resolutions for the issues reported in the requests.  

To add a new resolution, 

1. Log in to ServiceDesk Plus using your user name and password. 
2. Click the Requests tab in the header pane. This opens the request list view page. 
3. Click the request Title for which you want to add the resolution. 
4. Check if a resolution already exists for the request by clicking the Resolution tab in the 

Request details page. 
5. If no resolution is available for the request, then the plain html text page is displayed. Specify 

the resolution in the text field. 
6. On specifying the resolution the status can be changed by selecting the status from the 

combo box.    
7. You can also add Time Spent Entry details for the request in this page. 
8. Save the resolution. You can see the resolution is displayed in this page. 
9. If you wish to add the specified resolution to the solutions database, then click Save and Add 

to Solutions, or else click Save. 
10. On selecting Save and Add to Solutions, you get a New Solution form. The title of the 

solution is automatically filled with the title of the request. The Contents is filled with the 
resolution. If you wish you can edit the contents. 

11. From the Topic drop-down list which contains all the available topics, select the relevant 
parent topic for the solution. 

12. Enter relevant keywords for the solution in the Keywords text box. Separate each keyword by 
a comma. This option is provided for the users to improve the search capability and get 
appropriate solution for the problem.  

13. If needed you can also attach files to the solution. 
14. Click Add. This also adds the resolution to the list of solutions. 

These added resolutions can be used for various purposes. One of them is to add these resolutions 
as knowledge base articles which can be used for future reference to solve the same issue if reported. 
The resolution of the request also helps other technicians to know the kind of solution provided to the 
reported issue. This serves as a documented proof of the way a reported issues was resolved. 
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Searching Solutions 

From the request, you can search for solutions that might help you solve the issue described in the 
request.  

To search for solutions, 

1. Log in to ServiceDesk Plus using your user name and password. 
2. Click the Requests tab in the header pane. This opens the request list view page. 
3. Click the request Title for which you need to look up the solution. 
4. In the View Request page, click the Resolution tab. 
5. Click Search Solution link. Alternatively, you can also click the Search Solutions option 

under Actions combo box in the task block.   
6. In the Search Solutions page, provide a search string in the Search field and click Search or 

press Enter. The solutions that match the search string are displayed. 
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Submit For Approval 

You can submit the request for approval to the manager using this option. To submit for approval, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page. 
3. Click the Title of a request which you want to submit for approval. This opens View Request 

page. 
4. Click the Actions tab -> select Submit For Approval option. Submit For Approval page pops 

up. 
5. Specify the To address. This is a mandatory field. 
6. Edit the Subject and specify relevant subject in the given field. This is a mandatory field.    
7. Specify the relevant Description in the given text field. $ApprovalLink is a variable. It should 

be available with the mail to replace the variable with the link where you have the request 
details.  

8. And send the mail for approval. 

 

 

The manager gets the Request for approval mail with the link. On clicking the link it opens a form with 
approve or reject option & request details as shown below, 

The manager has to approve or reject the request based on the requirement. And save the details. On 
Saving the decision you get a thank you message.    
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A notification mail will be sent to you along with the request id, approval status for request and 
comments. This is fundamental as you need not revisit the request at periodic intervals to check the 
approval status.  
 
In the Request Details page, the Approvals tab getting displayed next to History tab. It displays all 
the mails sent for approval in descending order with Sent On, Sent To & Status details of the 
requests. 

Once the request is approved by the manager the status of the request changes to Approved. If 
rejected by the manager the status of the request changes to Denied as shown below, 
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Viewing Requester Details 

When attending to a request, you may want to contact the requester to get additional information. To 
view the requester's contact details, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page.  
3. Click the Title of a request. This opens the View Request page. 
4. Click on the requester name link just below the request tab as shown below, 

 

 
 
Requester Details pops up where you can view details, such as name, designation, 
employee ID, department to which the requester belongs, e-mail ID, and phone and mobile 
numbers. Any additional fields configured will be able to view in the requester details page.  
 
Alternatively, you can also click the View Requester Details option available under Actions 
combo box in the task block.    

 

5. Once you have finished viewing the details, click the Close link available at the top right 
corner of the pop-up. 
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E-mail the Requester 

Sending a response to the requester is required when a new request is received. Also, when a 
technician is ready to close a request, the same can be notified to the requester so that if the 
requester has any concerns about the same, he/she can raise. The technician can then address the 
same and close the request after the requester is completely satisfied with the way his/her request 
has been attended to.  

To respond to the requester 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane.  
3. Click the Title of the request in the requests list page. 
4. In the View Request page, click Reply button just below the Request Description or the 

Reply the Requester link on the right-side Tasks block, under Notify. This opens the Mail to 
the Requester form. 

 

5. Edit the Subject and Description of the e-mail.  
6. Click Attach a File button to add files as attachments to the mail 
7. Click Send. An e-mail is sent to the requester. If you want to send the same information to 

more than one person, then enter the e-mail IDs of those people in the To or CC field with 
comma as a separator. 

The responses that have been sent to the requester can be viewed as conversations in the request 
details view.  
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By default, the email editor will be in HTML format. If you do not want the mail in HTML format, then 
select the radio button Plain Text. A confirmation dialog will open. Click OK to continue changing the 
editor to plain text. 

 

Note: While editing the subject of the e-mail, ensure that the request ID value remains 
intact with the # symbols beside it. Else, the threading of requests may not be proper. 
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Forward the Request 

To forward a request, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane. This opens the request list view page. 
3. Click the Title of the request in the requests list page. 
4. In the View Request page, click Forward button just below the Request Description. 

Alternatively, you can click Forward the Request option under Reply combo box. This opens 
the Forward Request form. 
 

 

 

5. Enter the e-mail ID of the person to whom you wish to forward the request in the To field. You 
can also mark a copy of the forward to others. To do this, enter their e-mail IDs in the CC 
field.  

6. Edit the Subject and Description of the e-mail.  
7. Click Attach a File button to add files as attachments to the mail 
8. Click Send. The request is sent to all those whose e-mail ID is mentioned in the To and CC 

field. The forwarded requests will be shown in the conversation block.   
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E-mail the Technician 

To e-mail a technician  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Request tab in the header pane.  
3. Click the Title of the request from the requests list page. 
4. In the View Request page, on the right-side Tasks block, under Notify, click E-mail the 

Technician. This opens the Mail to Technician form. 

 

5. Enter the E-mail ID in the To field. This is a mandatory field. 
6. Edit the Subject and Description of the e-mail.  
7. Click Attach a File button to add files as attachments to the mail. All the newly attached files 

will be listed in the Newly attached files field. 
8. Click Send. An e-mail is sent to the technician. To send the information to more people, enter 

their e-mail IDs in the To field or CC separated by comma. 
9. You also have an option to Save the mail as draft copy for later use. 
10. If you wish to send the drafted mail for review to the higher authority then click Send for 

review button.     

A technician can be notified when a new request is assigned or an already existing request is 
reassigned to him/her. 
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SMS the Technician 

ManageEngine ServiceDesk Plus enables you to notify a technician through SMS also. This option is 
available only to technician assigned requests. 

To send an SMS to a technician  

1. Log in to ServiceDesk Plus using your user name and password. 
2. Click the Requests tab in the header pane. 
3. Click the request Title which is assigned to the technician whom you wish to notify through an 

SMS. 
4. In the View Request page, on the right side under Reply, click SMS the Technician. The 

Mail to Technician window opens with the To address displayed as <mobile 
number>@<service provider>.com. You can configure the service provider details in the 
admin configurations.  

5. You can add your message to this or edit the description to contain only those information 
that you wish to send. 

6. Click Send. A message is displayed in the window, stating that the SMS is sent. 
7. Click Close. This closes the notification window. 

The SMS notification is also available under the Notifications tab of the request. You can view the 
contents of the notification by clicking the View Details link beside the notification information.  
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Request Conversations 

ServiceDesk Plus displays the mail transactions happening between the technician handling a request 
and the requester, as conversations. At times, the technicians can converse with other technicians 
regarding the request which also gets listed in the conversation block. The conversations are listed 
one below the other in the ascending order of the time when the notification (response) was sent 
(received). You can choose to view either All conversation or Requester conversations.  
  

 

   

To view all the conversation details, click the View All Conversation link at the top of this block. This 
shows all the conversation between the technician and the requester and between the technicians. If 
the conversation has any attachments, then the attachment icon can be viewed in this block. To view 
only the requester conversation, click View Requester Conversation link.    

Split As New Request 

You can choose to split the requesters conversations into a new request. To split the conversation as 
a new request, 

1. Expand the conversations by clicking on the View All Conversation link or by clicking the  
button on the left of the row which you wish to expand. 

2. Click Split as New request button at the right bottom of that conversation. 

This splits the conversation into a new request. 

Delete Conversation 

You can delete a specific requesters conversation. To delete a conversation, 

1. Expand the conversations by clicking on the Expand all link or by clicking the > button on the 
left of the row which you wish to expand. 

2. Click Delete button at the right bottom of that conversation. A confirmation pop-up opens.  
3. Click OK in the confirmation pop-up to delete the thread/conversation.  
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Viewing Requests Based on Filters 

ManageEngine ServiceDesk Plus allows you to view the list of requests and also set a time period for 
auto refreshing the request list view page. 

To auto refresh the list view page 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Requests tab in the header pane. In the Requests list page, just below the header 

links, top right corner, you will see an editable field, Refresh this page. By default, the value 
is set to Never. 

3. Click the edit icon beside the value Never. 
4. From the drop down list select the frequency of refreshing the page. 
5. Click Set. 

You can also apply various filters to this list and view only a specific group of requests that you would 
like to view. This filtering helps you focus on just the requests that you wish to look at.  
 
To view the whole list of requests available in the ServiceDesk Plus application, click the Request tab 
in the header pane. This lists all the open requests available in the ServiceDesk Plus application. You 
can set the number of requests that you would like to view in a single page:  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Requests tab in the header pane. 
3. In the Requests list page, click the drop-down box (shown in the figure below): 

 
4. From the drop-down list, select the number of records that should be displayed in a single 

page. 

You have three different filter categories to view the specific set of requests. The filter categories are, 
My Group, Requests & My Views. To view the requests listed under these specified filter categories, 

1) Click the Requests tab in the header pane. This opens the Requests list page. 

2) Select the Filter Showing combo box. You can see the list of all filters. Select the filter from the list 
based on your priority. 

My Group 

All your incoming requests can be grouped under different groups based on the classification set by 
the help desk team. The groups are created using the groups option in the admin tab. The requests 
which matches the group criteria will be listed under the particular group option as shown below, 
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Requests 

All the incoming requests will be classified under different titles. These request titles are listed under 
the Requests option. On selecting the specific title of the request, corresponding set of requests gets 
listed. 

 

 

 

My Open Or Unassigned Requests 

All your open requests & the requests that are not assigned to any technicians will be listed 
under this option.  

Unassigned Requests 

All the requests that have not been assigned to any technician will be listed under this option. 
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My Open Requests 

When you click the requests tab, this filter is selected by default and lists all the request that 
are assigned to you in the open status. 

In addition to this if you have any requests placed in Groups, then you will also have option 
to filter the requests based on a specific Group alone. You can also perform a column sort of 
the requests. 

My Requests On Hold 

All your assigned requests that are kept on hold will be listed under this option.  

My Overdue Requests 

All your assigned requests that have crossed the scheduled time will be listed under this 
option. 

My Pending Requests 

All your assigned unfinished requests are listed under this option. 

My Requests Due Today 

All your assigned requests that are due for the current day will be listed under this option. 

My Completed Requests 

All your assigned requests that are closed will be listed under this option. 

Open Requests 

All the open requests irrelevant of the technician will be listed under this option.   

Requests On Hold 

All the requests that are kept on hold irrelevant of the technician will be listed under this 
option. 

Overdue Requests 

All the requests that have passed due by time irrelevant of the technician will be listed under 
this option. 

Requests Due Today 

All the requests that are due for the day irrelevant of the technician will be listed under this 
option. 

Pending Requests 

All the unfinished requests irrelevant of the technician will be listed under this option. 
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Completed Requests 

All the closed requests irrelevant of the technician will be listed under this option. 

All Requests 

All requests on all status say (closed, pending, open) will be listed under this option. 

My Hardware View 

All the requests that are assigned to you and has hardware issues will be listed under this 
option.  

My View  

All your customized views gets listed under the my view list.  

 

 

 

Sorting Requests by Column 

To sort request by column, click the column header. Clicking it once will sort it in ascending order. 
Clicking twice will sort the column in descending order. 
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Customizing Request List View 

ManageEngine ServiceDesk Plus allows you to customize the request list view to include columns of 
your choice. 

To customize the list view 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Requests tab in the header pane.  
3. Click the column edit icon available at the corner of the request list headers. This opens the 

available columns that can be displayed in the list view. All those that are visible currently, will 
have the check box beside them selected. 

 
4. To remove a column, remove the selection from the respective check box beside the column 

name. 
5. To add a column to the list view, select the unchecked select box beside the column name. 
6. To change the column order, click the up and down arrow after selecting the column that you 

wish to move. 
7. Click Save. 

This will add only those columns which you have chosen in the list view.  
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Searching Requests 

ManageEngine ServiceDesk Plus gives you an option to search for requests using a keyword search. 
All requests that match the keyword that you have provided in the search will be displayed.  

To do a keyword search in requests  

1. Log in to ServiceDesk Plus application using your user name and password. 
2. On the left hand side web client, there is a Search block as shown in the figure below: 

 

In Search in drop-down box, select Requests. In the home page and the requests module, 
this is selected by default.  

3. In the Enter Keyword text field, type the search string that you wish search for in the 
requests. 

4. Click Go or press the Enter key on your keyboard. All the requests that match the search 
string are listed. 

You can also do a column-wise search of the requests. To perform a column-wise search 

1. Click the search icon at the end of the request list view headers. This opens the search field 
just below every column that is visible in the list view.  

2. Enter the search key in field under the column of your choice. 
3. Click Go. The search results matching the search string(s) are displayed. 

 

Note: The search would return the results for any of the text fields of the request. You 
will not be able to search for a request based on any of the date fields of the request. 
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Multi site on Requests  

An organization can have branches spread across different regions and sites of the globe to handle 
various specialized activities. In this globally distributed environment, a request can be raised from a 
site to a technician located in another branch of the organization. The request is resolved based on 
the admin configurations (operational hours, holidays, SLA and business rules) of the site from which 
the request was raised. Hence with site base configuration, the request module experiences an 
immense change.  

If an organization has no branches and hence no sites configured, then while creating a new request 
then the default admin configurations  gets applied to resolve the request.  

Key entities in Request module  

Creating Requests  

• The admin configurations of the selected site in the new request form will get applied 
to the request.   

• The Groups and Technicians corresponding to the selected site will be listed. Groups 
acts as a filter in choosing the technician to resolve the request.   

• A request template with the group and technician pre filled with values needs to be 
re-selected on choosing the requester, if the group/technician is not associated to the 
requester's site.     

Editing Requests 

If a request needs to be routed to a technician in another site, then on selecting the site, 
the SLAs and business rules for the site will be applied and the due by time recalculated 
accordingly.   

Viewing Requests 

Technicians can view all the requests of a site if,  

• the technician is associated to the site and have the viewing permission as 
'All' in Configuring Roles.  

• the technician is associated to the site with the viewing permission as 'All in 
associated sites'. 
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Assigning Technicians 

ServiceDesk Plus provides you with an option to bulk assign requests to technicians. 
The request can be assigned to the technician if,  

• The technician is associated to the site where the problem persist. 
• The technician has the permission to view the requests in all sites. This can 

be done in Configuring Roles.  
 
If the technician is not associated to the site where the problem persist and if 
the technician has restricted view permissions then an error message occurs 
while assigning the request to the technician as shown below,  

 
 
 Scenario : Roles on Requests 

A requester from London raises a demo related request persisting in Sydney through self service 
portal of the ServiceDesk Plus application. By default, the admin configurations for London will be 
applied to the request. The request is handled by John, a technician in London. John can view and re-
assign the request,   

• If John is only associated to London with the viewing permissions as 'All', then he will be able 
to view the requests in all the sites of the organization. He will be able to assign the request to 
technicians associated in other sites but if he assigned the request to himself, then the site 
field automatically changes to London.  

• If John is only associated to London  with the viewing permissions as 'All in associated 
sites', then he will be able to view all the requests raised in London. He will not have the 
privilege to re-assign the request to technicians in other sites.  

• If John is associated to London and Sydney with the viewing permissions as 'All in associated 
sites', then he will be able to view all the requests raised in London and Sydney. He can re-
assign the request to request to a technician in Sydney but not to technicians in other sites of 
the organization.   
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On assigning the request to Amy, the technician in Sydney, the SLAs and business rules configurated 
for Sydney will be applied to the request and the due by time re-calculated. If Amy is assigned to a 
Group say, Support, then she can view and re-assign the request, 

• If Amy is associated to Sydney along with the viewing permissions as 'All in Group and 
assigned to him', then she will be able to view all the requests raised in the groups to which 
she is assigned.  

• If Amy is associated to Sydney and London with the viewing permission 'All his requests', 
then she will be able to view only the requests assigned to her. She will be able to re-assign 
the requests to other technicians in London and Sydney but will not be able to view the 
request as it does not fall under their permitted scope.  
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Problem Management 

This module will be available only in the ServiceDesk Plus Enterprise edition of the product. 

A problem is an unknown underlying cause of one or more Incidents. The objective of Problem 
Management is to minimize the adverse impact of Incidents and Problems on the business that are 
caused by errors within the IT infrastructure, and to prevent recurrence of Incidents related to these 
errors. In order to achieve this goal, Problem Management seeks to get to the root cause of Incidents 
and then initiate actions to improve or correct the situation. 

The Problem Management process has both reactive and proactive aspects. The reactive aspect is 
concerned with solving Problems in response to one or more Incidents. Proactive Problem 
Management is concerned with identifying and solving problems and known errors before incidents 
occur in first place. 

 

• Creating a New Problem 
• Viewing Problem Details 
• Editing a Problem 
• Closing a Problem 
• Picking a Problem 
• Assigning Technicians to a Problem 
• Problem Analysis 
• Problem Solutions 
• Adding Notes 
• Adding  Tasks 
• Adding Work Logs 
• Deleting Problem 
• Associating Incidents to Problem 
• Associating Changes to Problem 
• Adding Reminders 
• Viewing Reminders 
• Publishing Announcements 
• Send Notification 
• Printing Problem 
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Creating a New Problem 

The goal of problem management is to minimize the adverse impact of incidents and problems on the 
business that are caused by errors within the IT infrastructure and to prevent recurrence of incidents 
related to these errors. 

To create a new problem, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane.  
3. Click the New Problem button. This opens the New Problem form. Or click the Create New 

link at the left hand side of the page below the tabs then select the Problem option.  
4. Select the Reported By requester from the list by clicking on the Requester icon .This 

opens the requester list page and click the requester title. 
5. Select the Technician from the combo box. 
6. Select the Category, Sub Category and Item from the combo box. 
7. Select the Status of the problem say Open from the combo box. 
8. Select the Impact, Urgency and Priority of the problem from the combo box. 
9. Select the Due by Date and the Closed Date from the calender button. 
10. Select the affected IT Services from the list by clicking on the icon .This opens the 

Services Affected pop up box as shown below. Select the affected IT services and Save the 
changes.  

 

1. Select the Assets Involved with the problem by clicking the icon .This opens the 
Select Assets page. Select the Type of Assets or the category of assets to be 
involved from the combo box. Ex: Workstations, Routers, Switches and so on. Select 
the Available Assets under the selected type from the list and move to Assets 
involved using >> button. And Save the changes.    

2. Specify the Title of the problem in the given text field. This is a mandatory field. 
3. Specify the details about the problem in the Description field. 
4. If you have any file attachments for the problem click the Attach File button and 

attach files.  

Note: Maximum size of an attachment can be 10MB. 

5. Save the changes. 
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Viewing Problem Details 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click the Problems tab. This opens the problems list view page. 
3. Click the Title of the problem to view the problem details. This opens the problem details 

page. By default the problem details page opens in the Problem tab. 
 
From the problem details page, you can navigate to the previous or the next problem using 
the navigation buttons on the top right hand side corner. Using this, you need not return back 
to the list view page to view the next problem. 

Problem Tab 

The problem tab shows general details of the problem such as, Category, Technician, Status, Priority, 
Urgency, Impact, Requester, Reported Date, Due By Date, Closed Date, affected IT Services and 
Assets Involved. 

Click the Edit button to edit all the details of the change. You also have inline edit option for all the 
details. To modify the details of the problem click the details and choose the option from the combo 
box. 

Analysis Tab 

In the Analysis tab the technicians analyze the root cause and impact of the problem and attach the 
same in SDP as part of the problem. Also they specify the symptoms of the problem to identify the 
same problem in the future.  

Solution Tab 

In the solutions tab resolution for the problem is given as Work Arounds and Solutions. Work Arounds 
are temporary solutions that can be used by the technician till the actual solution is ready. Solutions 
are the permanent fixes to the problems raised.  

Incidents Tab 

The incidents tab shows the list of all associated incidents with the problem. You have Attach option 
to attach the incident with the problem. And the Detach Incidents option to detach associated 
incidents with the problem. 

History Tab  

The History tab shows the problem history from the time of its creation. It shows all the actions 
performed in the problem. The history tab also shows the incidents and the changes associated to the 
problem on clicking the Property View link available on the right hand side. The details that are 
displayed in the history are in the ascending order with the earliest performed action shown at the top 
of the page and the latest action at the bottom of the page.  
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Editing a Problem 

To edit a problem available in the ServiceDesk Plus Problem module 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane. This opens the problems list view page.  
3. Click the Title of the problem which you want to edit. This opens the Problem details page 

which list the Tasks that can be performed on the problem.  
4. Click the Edit link on the top of the page to modify the problem details. This opens the Edit 

Problem page. From this page you can add status of the problem from open to close, and 
also change the entire template to a new one apart from the regular editing of the problem 
details.      

Alternatively, you also have an inline edit option to modify the problem details in the view 
problem page. Click the edit icon  on the right side of each block which opens the problem 
form fields in editable format. After modifying the values, save the changes. This comes in 
handy when you need to edit the values of the entire block say Problem Details one by one.   

Modifying the Problem Details 

In the editable problem form you can change the problem details, such as Status of the problem as 
Closed or Open, Impact details, Urgency and Priority details. You can also modify affected IT 
Services and Assets Involved in the problem.   

Modifying Owner Details 

You can modify the owner details and technician details of the problem. You can also edit the 
Reported Date and Due by Date of the problem. If the problem has been closed, then the Closed 
date will be displayed beside this due by date.  

Modifying the Problem Category  

You can change the Category, Sub Category and Item of the problem. If the same was not 
appropriately chosen at the time of submitting then the problem can be selected now from the drop 
down list.  

Modifying the Problem Description 

You can modify the title and description of the problem to completely capture the actual nature of the 
task at hand.  

Appending Attachments 

If you wish to attach more files to the problem, click the Attach a File button and attach as many files 
as you wish and click Done. You can also delete the attachments that were already available in the 
problem by clicking the delete icon available beside the attachment. 
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Closing Problem 

If a requester is completely satisfied that his/her problem has been attended and completely solved, 
then the problem can be closed.  

To close a problem 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane.  
3. Click the Title of the problem in the Problems list page. This opens the problem details page. 
4. Click the Close Problem link under the Tasks block. This closes the problem. 

Note: If the mandatory fields are not entered then an error message is shown asking you to enter the 
value in the fields.         

You can reopen a problem from the closed state to open state. To do this, open the closed problem 
that you wish to reopen by clicking the edit button. Then change the status field from Closed to Open 
and save the changes. When a problem is opened from the closed state, you can change the Due By 
time of the problem. Also, the closed date is removed once the request is reopened. When this 
request is finally closed, the completed date is updated and the time taken to close is recalculated 
taking the reopened period into account. 

To close more than one problem at a time 

1. In the Problem list page, select the problem from the list by enabling the check boxes 
available beside the Problem Name. 

2. Now click the Close button. 

To view the closed requests  

1. From the Problem list page, select Closed Problems from the Filter drop-down menu. This 
lists all the closed problems. 

2. To view the closed problems which were assigned to you, select My Closed Problems. 
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Picking Up Problem 

ManageEngine ServiceDesk Plus provides an option to the technicians to self-pick up problem. If 
there are unassigned problems, the technicians can pick up any of the unassigned problems from the 
list. As the problems are picked up and answered quickly the waiting time to assign the problem to 
each technician and then closing the problem will be reduced. This in turn will increases the 
turnaround time and the efficiency of the IT help desk team.  

To pick up problems, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane. The unassigned problems will be in bold font. 
3. Select the problems you would like to pick up by enabling the check box. Click Pick up 

button. The selected problem will be assigned to you. (Or) 
4. You can also pick up problems after viewing the problem details. Click the title of the problem 

to open View Problem page. 
5. Click Assign tab. Select Pick Up option to pick up the problem. 
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Assigning Technician  

Each problem will be handled by a technician, who would be responsible for closing the problem.  

To assign a technician to the problem, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problem tab in the header pane. This opens the Problems list page. 
3. Click the Title of the problem for which you have to assign a technician. This opens the 

problem details page. 
4. Click the Actions combo box on the right hand side of the page ->Click Assign Technician 

link from the list. This opens Assign Technician to this Problem pop up page as shown 
below. Select the technician from the list and Assign the problem to the technician.  

 

5. Alternatively, you can also assign technician using inline edit option. Click the technician 
name shown in the problem details block. This opens the drop down box as shown below. 
Select the technician from the list and click the  icon to select the technician name else 
click cancel icon. 

  

 

You can also assign more than one problem at a time to a technician.  

To bulk assign problems to technicians 

1. In the Problems list page, select the problems to be assigned a technician by enabling the 
check box beside left side each of the problem title. 
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2. Click the Select Technician check box. Select the technician from the drop down list. 
3. Assign the technician. 
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Problem Analysis 

The goal of Problem Management is to find the root cause of the incidents and reduce the impact on 
the business by providing solutions and workarounds. In the problem analysis the technicians analyze 
the root cause and impact of the problem and attach the same in SDP as part of the problem. Also 
they can specify the symptoms of the problem to identify the same problem in the future. The 
following are the steps to understanding the cause of the problem, 

• Symptoms -  Evidences helping in identifying the problem. 
• Root Cause - Detecting the underlying cause of the incident. 
• Impact - Adverse effect of the problem on the business. 

To specify the Problem Analysis, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab -> click the title of the problem for which you need to specify the 

analysis. This opens the problem details page. 
3. Click the Analysis tab.  

Adding Impact details,  

1. Click the Add button. You can see the text area getting displayed for the impact 
details.  

2. Specify the impact details in the text field and Save the changes. You can see the 
details getting displayed below the title.  (OR)    

3. If you like to attach a file on the impact details instead of entering the details in the 
text field then click Attach File button to attach a file for the impact details. The 
maximum size of the attachment should be 10MB.   

Adding Root Cause,  

1. Click the Add button. You can see the text area getting displayed for the root cause. 
2. Specify the root cause in the given text field and Save the changes. You can see the 

details getting displayed below the title.  (OR)    
3. If you like to attach a file on the root cause instead of entering it in the text field then 

click Attach File button to attach a file for the root cause. The maximum size of the 
attachment should be 10MB. 

Adding Symptoms,  

1. Click the Add button. You can see the text area getting displayed for the symptoms. 
2. Specify the symptoms in the given text field and Save the changes. You can see the 

details getting displayed below the title.  (OR)    
3. If you like to attach a file on the symptoms instead of entering it in the text field then 

click Attach File button to attach a file for the symptoms. The maximum size of the 
attachment should be 10MB. 
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Problem Solutions 

Resolution for the problem can be given as Work Arounds and Solutions in ServiceDesk Plus. 
Workarounds are temporary solutions that can be used by the technician till the actual solution is 
ready. Solutions are the permanent fixes to the problems raised. The problem is considered as a 
known error when a solution or work around is added to a problem.  

To add resolution, 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click the Problems tab. This opens the problems list page. 
3. Click the Title of the problem for which you like to view the reminder. This opens the problem 

details page. 
4. Click the Solution tab. 

To Add Work Around,  

1. Click the Add button. You can see the text area getting displayed for the WorkAround 
details. Specify the temporary solutions for the problem. 

2. Save the details. You can see the details getting displayed.    
3. Click Attach File button to attach a file for the impact details. The maximum size of the 

attachment should be 10MB.  

To Add Solution 

1. Click the Add button. You can see the text area getting displayed for the Solution details. 
Specify the permanent fixes to the problems. 

2. Save the details. You can see the details getting displayed.    
3. Click Attach File button to attach a file for the impact details. The maximum size of the 

attachment should be 10MB.  
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Adding Notes 

If you like to add additional information including technical information based on your observations to 
a particular problem, then you can Add Notes to that problem. You can also use notes to update the 
status of the problem.  

To add a note to the problem, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane.  
3. Click the Title of the problem to which you would like to add a note. This opens the problem 

details page.  
4. Click the Add New combo box -> Select Note option. This opens Add Notes page as shown 

below,  

 

5. Enter your content in the text box. These notes are public. 
6. Save the details. The note is added at the bottom of the problem along with a date and time 

stamp. The name of the person who added the note is also displayed. 

You can add any number of notes to a problem. The added notes will be displayed in the 
ascending order. You can also edit or delete the notes that have been added. 
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Adding Tasks 

Using this option you can assign different tasks to different technicians. Task is a sub-unit of an 
activity. If a problem involves multiple technicians work, then the technician whoever receives the 
problem (owner of the problem) can assign different tasks to different technicians. 

To add tasks, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane.  
3. Click the Title of the problem to which you would like to add tasks. 
4. Click the Add New menu -> select Task option. This opens the Tasks window.  
5. Specify the Title of the task in the given text field. This is a mandatory field. 
6. Specify relevant information about the tasks in the Description field. 
7. Select the Scheduled Start Time from the calendar button. Also select the 

Scheduled End Time for the task from the calendar button. 
8. The Actual Start Time and End Time of the task will be entered by the technician 

doing (owning) the task.  

The actual start time and end time is the real time schedule of the task. The scheduled 
start time and end time specified by the problem owner is a tentative time schedule.        

9. Select the Owner of the task from the combo box. 
10. Specify the Status of the task. 
11. Specify any relevant comment about the task in the Comments field. 
12. If you wish to be reminded of the task previously then select the Email me before 

option and select the number of days from the combo box. This option will be 
selected based on the scheduled start time.  

13. Save the values. You can see a Tasks tab getting created next to the solution tab. All 
the tasks created for the problem will be listed under the tasks tab in descending 
order. The tasks assigned to other technicians can be viewed in their Task summary 
list in the home page.  

 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 111

Adding Work Logs 

You can enter the technicians time spent details for the problem using this option. The total time 
spent will exclude the time that the problem was kept on hold. It takes the time of creation to till the 
problem was closed. 

To Add Work Logs, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Select the Technician Name from the combo box.  
3. Specify the Executed Time (date & time) taken to resolve the problem from the calender 

button. 
4. The Technician Cost per hour will be fetched automatically from the technician details, 

which is a non-editable field. If you have already entered the per hour cost of the technician 
while adding the technician details, then the details will be fetched automatically. If you wish 
to change these values, you can do so manually.  

5. The Incident Cost will be automatically calculated taking the (total time spent to resolve the 
problem * Technician's cost per hour). 

6. If there are any extra charges specify in the Other Charges field.    
7. Using the above two data the Total Charges (Technician Charges + Other Charges) will be 

displayed automatically.  
8. Specify any relevant information about the time spent in the description field. 
9. Save the details. 
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Deleting Problem 

You have an option to delete individual problems or group of problems together.  

To delete individual problems 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane.  
3. Click the Title of the problem to be deleted in the problems list view page. This opens the 

Problem Details page.   
4. Click the Actions combo box on the top right hand side of the page.  
5. Click the Delete link from the list. A dialog pops up asking you to confirm on the delete 

process. 
6. Click OK to proceed. You can see the problem deleted from the list. 

To delete more than one problem at a time 

1. In the Problem list view page, select the problems to be deleted by enabling the check boxes.  
2. Click the Delete button. A dialog pops up asking you to confirm on the delete process. 
3. Click OK to proceed deleting Or click Cancel to abort deletion. 
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Associating Incidents to a Problem 

You have an option to associate Incidents to the problem. Similar Incidents to problem can be 
associated in order to track the number of incidents occurred for the same problem and also to track 
the priority and severity of the problem based on the number of incidents.   

To Associate Incidents, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab. This opens the Problem List View page. Click the problem title to be 

associated with the Incidents. This opens the problem details page.  
3. Click the Actions combo box on the top right side of the page. Click Associate Incidents 

option. This opens Associate Incidents to problem page as shown below, 

 

4. Select the type of requests to be displayed by selecting from the Show combo box on the top 
left hand side of the page. Ex: Open Requests or All Requests and so on. On selecting the 
request type the corresponding requests gets listed.  

5. Select the Incidents from the list by enabling the check box beside each incident. 
6. Click Associate Incidents to associate respective requests to the problem (particular 

selected problem). The associated incidents gets listed in the Incidents tab in the problem 
details page as shown below, 
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Associating Changes to Problem 

You have an option to associate Changes to the problem. Similar Changes to problem can be 
associated in order to track the number of changes occurred for the same problem.  

To Associate Changes, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab. This opens the Problem List View page.  
3. Click the problem Title to be associated with the Incidents. This opens the problem details 

page.  
4. Click the Actions combo box on the top right side of the page. Click Search Changes option. 

This opens Associate Problem to Changes page as shown below, 
 

 

Select the type of change to be displayed by selecting from the Filter Showing combo box on the top 
left hand side of the page. Ex: Open Change or All Change and so on. On selecting the change type 
the corresponding changes gets listed.  

Select the Changes from the list by enabling the check box beside each change. 

Click Associate button to associate respective changes to the problem (particular selected problem).  
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Adding Reminders 

You can add reminders to the problems using this option. All the pending tasks specific to the problem 
can be added as reminders. The technician can add these task list as a personal reminder to 
himself/herself. On adding these reminders they get displayed in My Reminder(s) under Quick 
Actions.  

To add reminders,     

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane. This opens the problems list page. 
3. Click the Title of the problems from the list. This opens the problems details page.  
4. Click on the Add New combo box on the top right side of the page. Click the Reminder link. 

This opens the Reminders page. Specify the content in the given text field. 
5. Select the reminder Date and Time by invoking the calendar icon. 
6. To be reminded of the task in advance, select the time from the Email me before combo box.  
7. The problem id is shown in non editable mode. 
8. Click Add button to add the reminder. You can see the reminder getting listed in the My 

Reminder(s) pop up window in ascending order.  
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Viewing Reminders 

You can view the reminders specific to each problem in this module.  

To view reminders, 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click the Problems tab. This opens the problems list page. 
3. Click the Title of the problem for which you like to view the reminder. This opens the problem 

details page. 
4. Click the Actions combo box -> Click the View Reminders option. This opens the Showing 

All Reminders Page as shown below. This lists all the reminders in ascending order based 
on the date. 

 

5. Once the task is completed you can change the state of the reminder from open to 
completed. To do this, select the reminder from the list to be closed by enabling the check 
box beside each of the reminder.  

6. Select the Change Reminder State To Completed then ->  click Change button to change 
the state. You can see the reminder striked off  to indicate the change.  
 
Alternatively, you can also view the reminders by, clicking Quick Actions link 

 -> My Reminder(s) option under the Reminders block. This opens the My 
Reminders pop up window as shown below. This shows all your reminders irrespective any 
specific module. 
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You can also add new reminders by clicking +Add New link at the bottom of the my reminders form. 
The new task is added and is listed along with the already existing tasks in the ascending order based 
on date and time. 

When you have completed the task, you can just strike out the task to indicate that it is completed by 
selecting the radio button  beside the task summary.  

You can also delete the task by clicking the delete icon beside  the task. 
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Publishing Announcements 

ServiceDesk Plus gives you an option to publish announcements while fixing the problem without 
breaking the work flow.  Say if you want to inform the company that, the mail server will be down for 
next five hours and your are fixing the problem then in this case you need not go to the home page to 
make an announcement you can publish the announcement from the problem module.  

To Publish Announcements, 

1. In the Problem details page click the Actions combo box and select the Make an 
announcement option. This opens the Add New page. 

2. The announcement Title and Description of the problem  gets displayed automatically. This 
is a mandatory field. You can also modify the title and description of the problem. 

3. Specify any relevant information about the announcement in the Description field. Also 
specify the result under the Resolution title.  

4. Specify the date and time to Show this announcement, between these dates from the 
calender button. If this field is not entered the announcement will be displayed in the 
dashboard for ever. 

5. To Show this announcement only to technicians select the check box. 
6. To Send this announcement as mail select the check box. 
7. Save the changes. You can see the announcement page as shown below. To view the next 

and previous announcement in the dash board click the Next and Previous buttons on the 
right side of the page. 

 

   

 

You can also edit and delete the announcement in the same page. 

To edit the announcement, 

1. Click Edit button. This opens the Edit Announcement form. 
2. Change the details of the announcement in form.  
3. Save the changes. All the changes made in the announcement will be saved. 
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To delete an announcement, 

1. To delete the announcement click Delete button. A dialog pops up asking you confirm on the 
delete operation. 

2. Click OK to delete. Or click Cancel to retain the announcement. 

Alternatively you can also publish announcements company wide or just to the technicians group from 
the Home page. The announcements are displayed just below the my view requests tab in the home 
page as shown below, 

All recent announcements will be displayed first based on the date. To view all the announcements 
(even completed ones), click the Show All button on the right side of the page.  

 

 

 

To add a new announcement 

1. Login to ServiceDesk Plus using the administrator / technician user name and password. 
2. In the login home page, if you have permissions to add an announcement, you will notice the 

Add New button in the announcements box as shown above. Click the button. The Add New 
Announcement dialog pops up. 

3. Enter the Announcement Title. This can be a short statement that describes the 
announcement. 

4. Type the Announcement Content in the text box provided for the same. 
5. Select the From date and To date using the calender icon beside the respective fields. 
6. If you wish to publish the announcement only to the technicians and do not wish to expose it 

to your requesters, then select the check box Show this announcement only to 
technicians. The announcement will be displayed in the home page with a lock beside it. 

7. If you wish to Send this announcement as mail then select the corresponding option by 
enabling the check box. 

8. Click Save. At any point of time, you do not wish to add the announcement, click Cancel.  

The announcement will be added and the pop-up will display the announcement details as entered by 
you. The announcement title will be displayed in the login home in bold text in the announcement box 
with a new icon beside it.  
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Send Notifications 

To send notifications specific to the problem to the CAB members,  technicians or to any concerned 
person then, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane. This opens the problem list view page.  
3. Click the title of the problem to which the notification has to be sent. This opens the problem 

details page.  
4. Click the Actions combo box and select the Send Notification link. This opens the Send 

Notification page. 
5. Specify the To and CC address in the given text field. 
6. Specify the Subject of the notification in the given text field. 
7. Specify relevant information about the notification in the Description field.  
8. Send the notification. 
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Printing Problem 

To print a problem,  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Problems tab in the header pane.  
3. Click the Title of the problem you would like to print. 
4. Click the Print Preview link on the right side Tasks block. The print preview page of the 

problem opens in a pop-up window. 

In the print preview page you can view the Impact Analysis, Root Cause, Symptoms, 
WorkAround, Solution, Problem Details Notes and their attachments.  

5. Click the Print menu item from the browser File menu. 
6. The default printer associated with your workstation is invoked. Set the required options and 

click OK. You can collect the printed copy of the problem at the printer that is linked to your 
workstation. 
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Change Management 

Changes arise as a result of problems, but many changes can come from proactively seeking 
business benefits such as reducing costs or improving services. The goal of Change Management is 
to ensure that standardised methods and procedures are used for efficient and prompt handling of all 
Changes, in order to minimise the impact of change-related incidents upon service quality and 
consequently to improve the day-to-day operations of the organization. 

A change request entails a considered approach to assessment of risk and business continuity, 
change impact, resource requirements and change approval. This approach is important to maintain 
the balance between the need for change against the impact of change. 

 

• Creating a New Change 
• Forward Schedule Change ( Calender View ) 
• Viewing Change Details 
• Editing a Change 
• Printing Change 
• Adding Notes 
• Adding Reminders 
• Viewing Reminders 
• Adding Tasks 
• Adding Work logs 
• Assigning Technician to a Change 
• Closing a Change 
• Deleting a Change 
• Associating Incidents to a Change 
• Associating Problems to a Change 
• Publishing Announcements 
• Send Notification 
• Change Planning 
• Recommending Change for CAB 
• Approving Change by the Change Manager 
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Creating New Change 

There can be different types of changes that can happen in an organization. It can be a Major, Minor 
or Standard change. For any change a request for change has to be sent to the change management 
team by creating a New Change. 

To create a new change, 

1. Log in to the ServiceDesk Plus application using your user name and password.  
2. Click the Create New link at the top left hand side of the page ->and select the Change 

option. This opens the New Change form. Or click the Changes tab and select the New 
Change button to open the New Change form. 

3. Select the Requested By requester from the list by clicking on the Requester icon . This 
opens the requester list page and click the requester title. 

4. Select the Technician from the combo box. 
5. Select the Category, Sub Category and Item from the combo box. 
6. Select the Status of the change say Open from the combo box. 
7. Select the Impact, Urgency and Priority of the change from the combo box. 
8. Select the Change Type from the combo box. Say Major. 
9. Select the Scheduled Start Time and Scheduled End Time from the calender button.  
10. Select the affected IT Services by the change from the list by clicking on the icon . This 

opens the Services Affected pop up box as shown below. Select the affected IT services 
and Save the changes.  

 

11. Select the Assets Involved with the change by clicking the icon . This opens the Select 
Assets page. Select the Type of Assets or the category of assets to be involved from the 
combo box. Ex: Workstations, Routers, Switches and so on. Select the Available Assets 
under the selected type from the list and move to Assets involved using >> button. And 
Save the changes.    

12. Specify the Title of the change in the given text field. This is a mandatory field. 
13. Specify the details about the change in the Description field. 
14. If you have any file attachments for the change click the Attach File button and attach files.  

Note: Maximum size of an attachment file can be 10MB. 

15. Save the changes. You can see the new change created in the change list view page. 
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Forward Schedule of Change 

The change home page shows two types of views, List View and Calendar View. The list view 
shows the list of all changes to be made. And the Calender View shows the changes with start & end 
schedule time marked in different colors based on the type.   

To view the schedule, 

1. Log into ServiceDesk Plus using your user name and password. 
2. Click the Changes tab in the header pane. This opens the change list view page by default as 

shown below. 

List View 

 

Forward Schedule of Change (Calender View) 

1. Click the Calendar View tab next to the list view tab in the home page. This opens the 
calender view of change as shown below. 

To display the changes in the Calender View, the changes should have the scheduled start 
time and end time.    
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• The Calender View displays all the scheduled changes for the entire month. Click the forward 
arrow  to go to the next month. Click the backward arrow  to go to the previous month. 

• You can choose the type of change from the Filter Showing combo box. Hence you can view 
the Open Changes, Approved Open Changes, All Changes and Completed Changes. 

• A thick strip will be running across the scheduled start date and end date of the change. The 
outward curve (    at the beginning of the strip indicates the start date. 
And the inward curve ) at the end of the strip indicates the end date. 

• The color of the strip depends on the type of the change. Say standard, major,minor and so 
on. 

• At the bottom of the page you have all the four change types with one N/A type displayed 
along with the check boxes. For ex: If you wish to view only the standard changes for the 
month in the calender view, then select the Standard check box and de-select the other 
change types. If you wish to view all the change types then select all the change type by 
enabling the check box.       

• The backward arrow in the strip  indicates the previous week 
continuation of the change.  

• And the forward arrow in the strip  indicates that the change will be 
continued for the next week. 

• On clicking at any part of the strip you will be able to view the change details page as shown 
below.  

 

In the change details page, 

� If there are any tasks associated with the change then the task status bar will also be 
displayed.  

� If all the tasks are completed then the status bar would be in green color.  
� Out of two tasks, if One task is complete and the other task is incomplete then the 

status bar would show half green color. 
� You will be able to view the number of tasks completed / the total number of tasks. 

Say 1tasks completed out of 2 tasks.   
� You will also be able to see the Status of the task and owner at the bottom of the 

page. If the status is completed then the bullet point would be in green color. If the 
status of the task is incomplete then the bullet point would be in red color. 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 126

• The calender can show only three changes in a particular date. If there are more than three 
changes in a date, then the calender will show the extra more changes in the text form as +n 
more as shown below.  

 

• Clicking the + n more text link, will list all the displayed changes in the calender, plus the 
extra more changes in the left hand side of the page as shown below. They can also be 
viewed by clicking the dates of the marked changes in the calender. Say by clicking the 
date  you will be able to view the list. 

 

• A calender on the top left hand side of the page, shows the current date marked in a box. All 
the changes in the current month will be underlined and bold. On clicking any of the 
underlined date will list all the scheduled change for the particular date below the calender. 

 

• Click the Week link at the Top of the page to view the weekly change schedule as shown 
below. Click the forward arrow  to view next week change schedules. Click the backward 
arrow  to view the previous week change schedules. 
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Viewing Change Details 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click the Changes tab. This opens the changes list page. 
3. Click the title of the change to view the change details. This opens the change details page. 

By default the change details page opens in the General tab. 

General Tab 

The general tab shows general details of the change such as, Category, Technician, Status, Priority, 
Urgency, Type, Impact, Requester, Start Time, End Time, affected IT Services. The Status field holds 
the state of the change such as Requested, Approved, Implemented, Reviewed and Closed The 
approval status denotes whether the change is approved or rejected. The change will be considered 
as approved and listed in the change calender only if the Approval Status is 'Approved'. The 
approval status is given in non-editable mode. 

Click the Edit button to edit all the details of the change. You also have inline edit option for all the 
details. To modify the details of the change click the details and choose the option from the combo 
box. 

Problems Tab 

The problems tab shows the list of all the associated problems with the change. You have Attach 
option to attach the problem with the change. And the Detach Problem option to detach associated 
problem with the change. 

Incidents Tab 

The incidents tab shows the list of all associated incidents with the change. You have Attach option to 
attach the incident with the change. And the Detach Incidents option to detach associated incidents 
with the change. 

Planning Tab 

The planning tab shows the planning phase of the change on how to go about the change. It shows 
the Impact details, Roll Out, Back Out plan and finally the Check List for the plan. 

Approvals Tab 

From the Approvals tab, the administrator can Add CAB Members and Send the change for 
Recommendation to the CAB members. Thus it helps to show the approval status of the change. 
Refer  

Implementation Tab 

Implementation page shows the task details of the change and the work log details of the change. 
You can also add, edit and delete new Task and new Work Log details. 

Review Tab  

From the review tab you can add post change assessment details or the evaluation results on how the 
change is made details are specified. It is basically a recap of the change.  
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To add review details Click the Add button. This opens the review text box. 

Specify the details in the text box and Save the details. You can see review details getting displayed 
under the title. And the name of the person who entered the details with date and time will be 
displayed on the right hand side of the page. 

To edit the review details click the Edit button next to the title. Edit the details and save the changes. 

If you would like to attach a file on the review details of the change, click Attach a File option and 
attach files.   

History Tab 

The History tab shows the change history from the time of its creation. It shows all the actions 
performed in the change. The history tab also shows the incidents and the changes associated to the 
problem on clicking the Property View link available on the right hand side. The details that are 
displayed in the history are in the ascending order with the earliest performed action shown at the top 
of the page and the latest action at the bottom of the page. 
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Editing a Change 

To edit the change available in the ServiceDesk Plus, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the changes tab in the header pane. This opens the changes list view page.  
3. Click the Title of the change to be edited. This opens the change details page which list the 

Tasks that can be performed on the change.  
4. Click the Edit link on the top of the page to modify the change details. This opens the Edit 

change page. From this page you can add status of the change from open to close, and also 
change the entire template to a new one apart from the regular editing of the change details. 
   

Alternatively, you also have an inline edit option to modify the change details in the view 
change page. Click the edit icon  on the right side of each block which opens the change 
form fields in editable format. After modifying the values, save the changes. This comes in 
handy when you need to edit the values of the entire block say change Details one by one.   

Modifying the Change Details 

In the editable change form you can change the change details, such as Status of the change as 
Closed or Open, Impact details, Urgency, Priority and Change Type details. You can also modify 
affected IT Services and Assets Involved in the change.   

Modifying Owner Details 

You can modify the Requested by details and Technician details of the change. You can also edit 
the Scheduled Start Time and Scheduled End Time of the change.   

Modifying the Change Category  

You can change the Category, Sub Category and Item of the change. If the same was not 
appropriately chosen at the time of submitting then the change can be selected now from the drop 
down list.  

Modifying the Change Description 

You can modify the title and description of the change to completely capture the actual nature of the 
task at hand.  

Appending Attachments 

If you wish to attach more files to the change, click the Attach a File button and attach as many files 
as you wish and click Done. You can also delete the attachments that were already available in the 
change by clicking the delete icon available beside the attachment. 
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Printing Change  

To print a change,  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab in the header pane.  
3. Click the Title of the change you would like to print. 
4. Click the Print Preview link on the right side Tasks block.  

In the print preview page you can view the Impact Analysis, Roll Out Plan, Back Out Plan, 
Checklist and Review. Then the Change details, Approval status and Notes and their 
attachments. 

5. The print preview page of the change opens in a pop-up window. Click the Print menu item 
from the browser File menu. 

6. The default printer associated with your workstation is invoked. Set the required options and 
click OK. You can collect the printed copy of the change at the printer that is linked to your 
workstation. 
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Adding Notes 

If you would like to add additional information including technical information based on your 
observations to a particular change, then you can Add Notes to that change. You can also use it to 
update the status of the change. These notes cannot be added by the requesters. The requesters can 
only view the notes.  

To add a note to the change, 

1. Log in to the ServiceDesk Plus application. 
2. Click the Change tab in the header pane.  
3. Click the Title of the change to which you would like to add a note. This opens the change 

details page.  
4. Click the Add New combo box -> Select Note option. This opens Add Notes page as shown 

below,  

 

5. Enter your content in the text box. These notes will be added to the change only by the 
technicians. The requesters will not be able to add the notes. These notes are public.  

6. Save the details. The note is added at the bottom of the change along with a date and time 
stamp. The name of the person who added the note will also be displayed. 

You can also add any number of notes to a change. The added notes will be displayed in the 
descending order with recently added note first. You can also edit or delete the notes that 
have been added. 
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Adding Reminders 

You can add reminders to the changes using this option. All the pending tasks specific to the change 
can be added as reminders. The technician can add these task list as a personal reminder to 
himself/her. On adding these reminders they get displayed in My Reminder(s) under Quick Actions.  

To add reminders,     

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab in the header pane. This opens the changes list page. 
3. Click the Title of the change from the list. This opens the change details page.  
4. Click on the Add New combo box on the top right side of the page. Click the Reminder link. 

This opens the Reminders page. Specify the content in the given text field. 
5. Select the reminder Date and Time by invoking the calendar icon. 
6. To be reminded of the task in advance, select the time from the Email me before combo box.  
7. The change id is shown in non editable mode. 
8. Click Add button to add the reminder. You can see the reminder getting listed in the My 

Reminder(s) pop up window in ascending order.  
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Viewing Reminders 

You can view the reminders specific to each change.  

To view reminders, 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click the Changes tab. This opens the changes list page. 
3. Click the title of the change for which you like to view the reminder. This opens the change 

details page. 
4. Click the Actions tab -> Click the View Reminders option. This opens the Showing All 

Reminders page as shown below. This lists all the reminders in ascending order based on 
the date. 

 

5. Once the task is completed you can change the state of the reminder from open to 
completed. To do this, select the reminder to be closed from the list by enabling the check 
box on the left side of each reminder.  

6. Select the Change Reminder State To Completed then ->  click Change button to change 
the state. You can see the reminder striked off  to indicate the change.  
 
Alternatively, you can also view the reminders by, clicking Quick Actions link 

 -> My Reminder(s) option under the Reminders block. This opens the My 
Reminders pop up window as shown below. This shows all your reminders irrespective any 
specific module. 
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You can also add new reminders by clicking +Add New link at the bottom of the my reminders form. 
The new task is added and is listed along with the already existing tasks in the ascending order based 
on date and time. 

When you have completed the task, you can just strike out the task to indicate that it is completed by 
selecting the radio button  beside the task summary.  

You can also delete the task by clicking the delete icon beside  the task.  
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Adding Tasks 

Using add tasks option you can assign different tasks to different technicians. Say if a change is 
reported by the requester the change might involve multiple technicians work. The change owner 
(manager) whoever received the change can assign different tasks to the different technician. 

To add tasks, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab in the header pane.  
3. Click the Title of the change to which you would like to add tasks. 
4. Click the Add New menu -> select Tasks option. This opens the Tasks window.  
5. Specify the Title of the task in the given text field. This is a mandatory field. 
6. Specify relevant information about the tasks in the Description field. 
7. Select the Scheduled Start Time for the task from the calendar button. Also select 

the Scheduled End Time for the task from the calendar button. 
8. The Actual Start Time and End Time of the task will be entered by the technician 

doing the task.  
9. Select the Owner of the task from the combo box. 
10. Specify the Status of the task. 
11. Specify any relevant comment about the task in the Comments field. 
12. If you wish to be reminded of the task previously then select the Email me before 

option and select the number of days from the combo box. 
13. Save the values. You can see the tasks getting displayed in the Implementation tab. 

All the tasks created for the change will be listed under the implementation tab under 
the Task Details title in descending order. The tasks assigned to other technicians 
can be viewed in their Task summary list in the home page.  
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Adding Work Logs 

You can enter the technicians time spent details for the change using this option. The total time spent 
will exclude the time that the change was kept on hold. It takes the time of creation to the change was 
closed. 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab. This opens the changes list page. 
3. Click the title of the change for which you like to enter the work log. This opens the change 

details page. 
4. Click the Add New combo box -> Select Work Log option from the list. This opens the Add 

Work Log page  
5. Select the Technician Name from the combo box.  
6. Specify the Executed Time (date & time) taken to resolve the change from the calender 

button. 
7. The Technician Cost per hour will be fetched automatically from the technician details, 

which is a non-editable field. If you have already entered the per hour cost of the technician 
while adding the technician details, then the details will be fetched automatically. If you wish 
to change these values, you can do so manually.  

8. The Incident Cost will be automatically calculated taking the (total time spent to resolve the 
problem * Technician's cost per hour). 

9. If there are any extra charges specify in the Other Charges field.    
10. Using the above two data the Total Charges (Technician Charges + Other Charges) will be 

displayed automatically.  
11. Specify any relevant information about the time spent in the description field. 
12. Save the details. 
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Assigning Technician to a Change 

Each change will be handled by a technician, who would be responsible for closing the change.  

To assign a technician, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Change tab in the header pane. This opens the Changes list page. 
3. Click the Title of the change for which you have to assign a technician. This opens the 

change details page. 
4. Click the Actions combo box on the right hand side of the page ->Click Assign Technician 

option from the list. This opens Assign Technician to this Change pop up page as shown 
below. Select the technician from the list and Assign the change to the technician.  

 

5. Alternatively, you can also assign technician using inline edit option. Click the technician 
name shown in the change details block. This opens the drop down box as shown below. 
Select the technician from the list and click the  icon to select the technician name else 
click cancel icon. 

  

 

You can also assign more than one change at a time to a technician.  

To bulk assign changes to technicians 

1. In the Changes list page, select the changes to be assigned a technician by enabling the 
check box beside left side each of the change title. 
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2. Click the Select Technician check box. Select the technician from the drop down list. 
3. Assign the technician. 

Picking Up Change 

ManageEngine ServiceDesk Plus provides an option to the technicians to self-pick up change. If there 
are unassigned changes, the technicians can pick up any of the unassigned changes from the list. 
This in turn will increase the turnaround time and the efficiency of the IT help desk team.  

To pick up changes, 

1. From the change list view page, select the changes you would like to pick up by enabling the 
check box. The unassigned changes will be in bold font. 

2. Click Pick up button. The selected change will be assigned to you. (Or) 
3. You can also pick up changes after viewing the change details. Click the title of the change to 

open View Change page. 
4. Click Assign tab. Select Pick Up option to pick up the change. 
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Closing Change 

To close a change, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab in the header pane.  
3. Click the Title of the change in the Changes list page. This opens the change details page. 
4. Click the Close Change link under the Tasks block. This closes the change. 

Note: If the mandatory fields are not entered then an error message is shown asking you to enter the 
value in the fields.  

To reopen the change        

You can reopen a changes from the closed state to open state. To do this,  

1. Click the title of the change. This opens the change details page. 
2. Click the Edit button. This opens the form in the editable format. 
3. Change the status field from Completed to Requested and save the changes made. 

When a changes is opened from the closed state, you should change the Created Time, 
Scheduled Start time and End time of the change. When the request is finally closed, the 
completed Time will be automatically updated.  

                                                                       (OR) 

4. Click the Status of the change in the form you have inline edit option for each of the change 
details. This opens the combo box as shown below, 

 

6. Select the status from the list and immediately the status of the change get's updated.   

To view the closed changes  

1. From the change list page, select Closed Changes from the Filter drop-down menu. This lists 
all the closed changes. 

2. To view the closed changes which were assigned to you, select My Closed Changes. 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 141

Deleting Change 

You have an option to delete individual change or group of changes together.  

To delete individual changes 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab in the header pane.  
3. Click the Title of the change to be deleted in the changes list view page. This opens the 

Change Details page.   
4. Click the Actions combo box on the top right hand side of the page.  
5. Click the Delete link from the list. A dialog pops up asking you to confirm on the delete 

process. 
6. Click OK to proceed. You can see the change deleted from the list. 

To delete more than one change at a time 

1. In the Change list view page, select the changes to be deleted by enabling the check boxes.  
2. Click the Delete button. A dialog pops up asking you to confirm on the delete process. 
3. Click OK to proceed. Or click Cancel to abort deletion. 
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Associating Incidents to a Change 

You have an option to associate Incidents with the change. Similar Incidents as in Change can be 
associated in order to complete the requests quickly rather than doing it one by one.   

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab. This opens the Change List View page. Click the change title to be 

associated with the Incidents. This opens the change details page.  
3. Click the Actions combo box on the top right side of the page. Click Associate Incidents 

option. This opens Associate Incidents to Change page as shown below, 

 

4. Select the type of requests to be displayed by selecting from the Show combo box on the top 
left hand side of the page. Ex: Open Requests or All Requests and so on. On selecting the 
request type the corresponding requests gets listed.  

5. Select the change from the list by enabling the check box beside each change. 
6. Click Associate Incidents to associate respective requests to the change (particular selected 

change). The associated incidents gets listed in the Incidents tab in the change details page 
as shown below, 
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Associating Problems to a Change 

You have an option to associate problems with the change. Similar problems as change can be 
associated in order to complete the requests quickly rather than doing it one by one.   

To associate problem, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab. This opens the Change List View page. Click the change title to be 

associated with the problems. This opens the change details page.  
3. Click the Actions combo box on the top right side of the page. Click Associate Problems 

option. This opens Associate Problems to Change page as shown below, 
4. Select the type of problems to be displayed by selecting from the Show combo box on the top 

left hand side of the page. Ex: Open Problems or All Problems and so on. On selecting the 
problem type the corresponding problems gets listed.  

5. Select the change from the list by enabling the check box beside each change. 
6. Click Associate Problems to associate respective problems to the change (particular 

selected change). The associated problems gets listed in the Problems tab in the change 
details page. 
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Publishing Announcements 

ServiceDesk Plus gives you an option to publish announcements while doing the change without 
breaking the work flow.  Say if you have to make an announcement to the company that the mail 
server will be down for next five hours and your are doing the change then in this case you need not 
go to the home page and make an announcement. You can directly publish the announcement from 
the change module.  

To Publish Announcements, 

1. In the Problem Details page click the Actions combo box and select the Make an 
announcement option. This opens the Add New page. 

2. Specify the Announcement Title in the given text field. This is a mandatory field. 
3. Specify any relevant information about the announcement in the Description field. Also 

specify the result under the Resolution title.  
4. Specify the date and time to Show this announcement, between these dates from the 

calender button. If this field is not entered the announcement will be displayed in the 
dashboard for ever. 

5. Select the check box to Show this announcement only to technicians . 
6. Select the check box to Send this announcement as mail . 
7. Save the changes. You can see the announcement page as shown below. To view the next 

and previous announcement in the dash board click the Next and Previous buttons on the 
right side of the page. 

 

You can also edit and delete the announcement in the same page. 

To edit the announcement, 

1. Click Edit button. This opens the Edit Announcement form. 
2. Change the details of the announcement in form.  
3. Save the changes. All the changes made in the announcement will be saved. 

To delete an announcement, 

1. To delete the announcement click Delete button. A dialog pops up asking you confirm on the 
delete operation. 

2. Click OK to delete. Or click Cancel to retain the announcement. 
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Alternatively you can also publish announcements company wide or just to the technicians group from 
the Home page. The announcements are displayed just below the my view requests tab in the home 
page as shown below, 

All recent announcements will be displayed first based on the date. To view all the announcements 
(even completed ones), click the Show All button on the right side of the page.  

 

 

 

To add a new announcement 

1. Login to ServiceDesk Plus using the administrator / technician user name and password. 
2. In the login home page, if you have permissions to add an announcement, you will notice the 

Add New button in the announcements box as shown above. Click the button. The Add New 
Announcement dialog pops up. 

3. Enter the Announcement Title. This can be a short statement that describes the 
announcement. 

4. Type the Announcement Content in the text box provided for the same. 
5. Select the From date and To date using the calender icon beside the respective fields. 
6. If you wish to publish the announcement only to the technicians and do not wish to expose it 

to your requesters, then select the check box Show this announcement only to 
technicians. The announcement will be displayed in the home page with a lock beside it. 

7. If you wish to Send this announcement as mail then select the corresponding option by 
enabling the check box. 

8. Click Save. At any point of time, you do not wish to add the announcement, click Cancel.  

The announcement will be added and the pop-up will display the announcement details as entered by 
you. The announcement title will be displayed in the login home in bold text in the announcement box 
with a new icon beside it.  
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Send Notifications 

To send notifications specific to the change to the CAB members, to change managers, technicians or 
to any concerned person then, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab in the header pane. This opens the change list view page.  
3. Click the title of the change to which the notification has to be sent. This opens the change 

details page.  
4. Click the Actions combo box and select the Send Notification link. This opens the Send 

Notification page. 
5. Specify the To and CC address in the given text field. 
6. Specify the Subject of the notification in the given text field. 
7. Specify relevant information about the notification in the Description field.  
8. Send the notification. 

 

 

 

 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 147

Change Planning 

The change plan is formulated to get started with the change process. It needs to have complete 
details about the reasons for considering the change that how this change can impact the business. 
The change planning stage needs to have following information so that change managers and CAB 
has all the details to make informed decisions. 

• Impact Analysis - Risk involved in implementing the change. 
• Rollout Plan - How the plan will be implemented. 
• Back Out Plan - Plan to restore things back to original state if plan fails. 
• Checklist - List of mandatory items required for the plan to succeed. 

To specify the change plan, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab. This opens the Change List view page. Click the title of the change for 

which you need to plan to make decisions. This opens the change details page. 
3. Click the Planning tab. You can view the change planning stages one below the other. 

To add the Impact details,  

1. Click the Add button. You can see the text area getting displayed for the impact 
details.  

2. Specify the risk involved in implementing the change in the given text area. 
3. Save the details. You can see the details getting displayed.    
4. Click Attach File button to attach a file for the impact details. The maximum size of 

the attachment should be 10MB.   

To specify the Roll Out Plan  

1. Click the Add button. You can see the text area getting displayed for the roll out plan. 
2. Specify how the plan will be implemented in the given text area. 
3. Save the details. You can see the details getting displayed below the title. 
4. Click Attach File button to attach a file for the impact details. The maximum size of 

the attachment should be 10MB. 

To specify the Back Out Plan  

1. Click the Add button. You can see the text area getting displayed for the back out 
plan. 

2. Specify the plan to restore things back to original state if plan fails in the given text 
field. 

3. Save the details. You can see the details getting displayed below the title. 
4. Click Attach File button to attach a file for the impact details. The maximum size of 

the attachment should be 10MB. 

To enter the Checklist 

1. Click the Add button. You can see the text area getting displayed for the check list. 
2. Specify the list of mandatory items required for the plan to succeed in the given text 

field. 
3. Save the details. You can see the details getting displayed below the title. 
4. Click Attach File button to attach a file for the impact details. The maximum size of 

the attachment should be 10MB. 
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Recommending Change by CAB 

The Change Advisory Board (CAB) is a body that exists to recommend changes and to assist Change 
Management in the assessment and prioritise of changes. As and when a CAB is convened, its 
members should be chosen who are capable of ensuring that all changes are adequately assessed 
from both the business and technical viewpoint. A technician or a requester can be a CAB member 
based on the organization structure. 

General Work Flow for approving a change 

• The CAB should be convened for a change. The CAB members can differ for each change. 
The CAB member can be a requester or a technician whoever is capable to asses from both 
the business and technical viewpoint. 

• Once the CAB is convened the change should be sent to the CAB members for 
recommendation. 

• The technician whoever receiving the change or assigned a change will be the owner of the 
change and he will send the change for recommendation to the CAB. 

• If the change is recommended by the CAB members, the CHANGE MANAGER should 
approve the change. The change manager can approve or reject the change irrespective of 
the recommendation of the CAB.   

• Only the approved change will be taken further by the technician to take necessary steps. 

To add CAB members and send for recommendation, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Changes tab. This opens the Change List view page.  
3. Click the Title of the change which you need to send for recommendations. This opens the 

change details page. 
4. Click the Approvals tab. You have to add CAB members, and send the change for 

recommendation. The CAB members has the authorization to recommend the change.  

To Add CAB Members 

5. Click the Add CAB Member button. 
6. Select the CAB from the combo box. 
7. Select the members list for the committee. The selected members will be responsible for 

approving the changes. 
8. Save the changes. You will get a confirmation message saying members added to the CAB 

successfully. 

Send the change for Recommendation 

9. Click Send for Recommendation button to send the change for approval to the CAB 
members. Only the members of the CAB can recommend a change. This opens the submit 
change for approval page. 

10. If the e-mail id is already configured for the CAB members then the Id would get automatically 
get listed in the To text field. This is a mandatory field. If the mail id is not configured refer 
Configuring Technicians.  

11. Specify the Subject in the given text field. This is a mandatory field. 
12. Specify the Description about the change in the given text field. 
13. Send the mail to the CAB members for approval. Once the mail is sent the CAB members 

would get a mail with the link to the form to approve the changes as shown below.  
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Administrator has requested your recommendations for this Change - Change Cards in the 
Server. Click here to view Change details 
http://shawnadams/approval/Approve.jsp?ITEMID=2&MODULE=Change&KEY=211873315245
93&USERID=4  

14. Click the link in the mail to open the form as shown below, 

 

15. Select Approve Recommend or Reject radio button based on the change details listed 
below the form.  

16. Specify the Comments in the given text field.  
17. Save the changes.  

Recommending the change directly from the Approval page 

If you are a member of the CAB after logging into ServiceDesk Plus, you can recommend the change 
from the Approval page directly by clicking the Take Action icon under the Recommendation title as 
shown below.  

  

This opens the Approve page. Recommend or Reject the change.  

Specify the Description and Save the changes. The status of the change becomes recommended. 
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Approving Change by the Change Manager 

Only the Change Manager has the authority to approve the change. Any technician with the SD 
change manager role permissions can approve the change.  A change manager can or could not be a 
member of the CAB. If needed the change manager can reject the change though the change is 
recommended by the CAB members. It is to the change manager's discretion whether to approve or 
reject the change.  

Once the change is recommended by the CAB members the Change Manager should Approve or 
Reject the change. Except for the Standard Change type all other change type should be approved 
the change manager. The standard change type is a pre-approved change type hence it does not 
require any approval from the change manager. Only the approved changes will be taken further to 
solve the issue.  

To Approve the Change by the Change Manager, 

1. Log in into ServiceDesk Plus using your user name and password. 
2. Click the Changes tab -> click the title of the change to be approved. This opens the change 

details page. 
3. Click the Approvals tab, you get a link on the top right hand side of the page to approve or 

reject the change as shown below, 

 

4. Click the Approve link to approve the change. This opens a dialog box. 
5. Specify the comments in the box and Save the details. 
6. Text in the link changes as Approved with the change manager name, date and time will also 

be displayed as shown below. At any time to reject the change, you can click the reject link 
next to the approve link. 

 

 

In the change details page Approval status of the change would show as Approved in a non 
editable format. Also on the top right hand side of the page the Approval status of the change 
would change as Approved.  
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Assets 

ManageEngine  ServiceDesk Plus helps to manage all your IT and Non-IT assets. ServiceDesk Plus 
offers a single view to track and manage all your assets with ServiceDesk Plus, you can track and 
manage ownership of 

• IT, Non-IT and Asset Components. 
• Software Asset Management 

IT & Non-IT Asset Management 

ServiceDesk Plus helps you to manage,  

• IT assets such as, workstations, switches, routers, printers, and access points  
• Non-IT assets such as basic fixtures, furniture, chairs, tables, projectors, and desk phones 
• Asset Components such as keyboards, software, software licenses and even your printer 

inks. 

Software Asset Management 

Software License Management 

ServiceDesk Plus helps you to manage software licenses installed across the enterprise. You 
can consolidate and manage all your software licenses from a single screen. ServiceDesk Plus 
will scan and automatically pickup license keys for Microsoft Windows and Microsoft Word. You 
can key-in all the licenses purchased earlier and track future purchase of software licenses 
through the Purchase module.  

Software Metering 

ServiceDesk Plus helps you to track the usability of the installed software across organization. 
It gives the count of rarely used, frequently used and occasionally used software.  

Software Compliance 

ServiceDesk Plus tracks purchased versus installed licenses helping you to ensure software 
license compliance. The scheduled scan alerts you when an unauthorized software installation 
is detected, ensuring software compliance on an on-going basis.  
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IT Assets 

All IP based assets are discovered under IT assets. The list of possible IT assets are given below, 

• Workstations  
• Laptops  
• Printers 
• Switches 
• Servers 
• Routers 
• Access Points 

 

• Adding New IT Assets 
• Editing Assets 
• Adding Assets to Groups 
• Assigning Assets to Department 
• Modifying the State of the Assets 
• Change log-in Credentials of IT Assets 
• Bulk Scan of IT Assets 
• Deleting Assets 
• Importing Asset Details from CSV 
• Viewing Asset Details 
• Copying Resources 
• Attaching Assets 
• Attaching Components 
• Attaching Documents 
• Assigning Assets to Users/Departments/Assets 
• Adding New Workstation 
• Bulk Scan of Newly Added Workstations 
• Changing Workstation as Server 
• Viewing Workstation Details 
• Print Preview of Workstations 
• Modify Type 
• Adding Software 
• Deleting Workstations 
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Adding IT Asset 

IT Assets other than workstations are configured under IT Assets. To add a new asset, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
This opens the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab in the header pane. This opens the Asset home page. 

3. Click Quick Actions link  on the top left hand side of the page -> 
Click Asset option from the drop down menu. (OR)  
 
Click IT Assets under Resources block on the left side of the page  

4.  -> Select any one of the listed IT assets link. e.g. 
Access points, printers etc. This opens the particular IT asset page. 

5.  Click New button. This opens Add Asset page. 
6. Select the Product Name of the asset from the combo box. If required, you can add 

a new product name by clicking Add New link beside the product name field. This is 
a mandatory field. 

7. Select the Vendor Name from the combo box. If required, you can add a new vendor 
by clicking the Add New link beside the vendor name text field.  

8. Specify the Asset Name in the given text field. This is a mandatory field. 
9. Specify the Asset Tag, Asset Serial No, Bar Code, Asset Cost in $ in the 

corresponding text fields. 
10. Specify the Acquisition Date & Expiry Date from the calendar button. 
11. Select the Site from the combo box. 
12. Specify the Location in the given text field. 
13. Specify the Asset State by selecting the current status of the asset from the combo 

box.  
 
If the asset is in Use state you need to associate or assign asset to department or 
user or asset. 

1. Allocate the asset to an Asset or to an User or to the Department by 
selecting any of the two radio button. Say Associate to Asset or Assign User/ 
or Department. 

2. If you choose to associate asset to an asset then select the asset name from 
the Choose Asset combo box. Or if you have chosen to assign to user or the 
department then select User or Department from the combo box.  

3. If the asset is leased select the check box Asset is Leased. If the asset is 
leased then specify the From and To date from the calendar button.    

14. Click Save button to save the changes. To save and add another asset click Save 
and add new button. 
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Editing Assets 

To edit the resource details, 

1. Log in to ServiceDesk Plus using your user name and password. 
2. Click the Assets tab -> select the IT Assets link on the left hand side of the page. This 

opens the list view page of the IT assets. 
3. Click the title of the IT asset to be edited. This opens the Asset details page. 
4. Click Edit button on the top right hand side of the page (Or) click the Actions combo box next 

to the edit resource button -> select the Edit option. This opens the Edit Asset page. 
5. Edit the Asset Details block such as Product Name, Asset Name, Tag, Serial No, Bar 

Code, Vendor Name, Cost, Acquisition Date, Expiry Date, and Location.  
6. Modify the Asset State details such as, Current usage status of the assets like In Use, In 

Repair and so on. Then the Associate the asset to User or Department details or Assign to 
User or Department details. 

7. Update the changes. You can see the assets details getting updated. 
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Adding Assets to Group 

You have two types of groups in ServiceDesk Plus say, Static group and Dynamic. Add to group 
option in asset list view page is to group bulk of assets. These assets will be grouped under the Static 
group by default. 

To Add IT Assets to group,   

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click any of the IT Assets link under the Resources block on the left hand side of the page. 

Select any one of the listed IT assets link. e.g. Access points, printers etc. This opens the 
particular IT asset page. 

3. Select the assets to be added to the group by enabling the check box. Click Actions button -
> Add to Group option. This opens the Add Resource(s) to page. 

4. By default you can group assets only to the static group. Either to the Existing static group 
or New static group can be added. 

5. If you would like to group the assets under existing static group then click the corresponding 
radio button. Select the group name from the combo box. 

6. Else, if you would like to add a new static group and group the assets, click New Group radio 
button. Specify the Group Name and relevant information about the group in the Description 
field.    

7. Click Save button to save the changes. 
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Assigning Assets to Department/Site 

 

Assigning IT Asset to Department 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Select the IT Assets title under the Resources block. Select the corresponding IT Asset link 
say, servers, workstations and so on. This opens the selected Assets list view page. 

4. Click on the Asset Name to be assigned to a Department/Site by enabling the check box.  

5. Click the Actions menu -> select Assign to Department option from the list. This opens Add 
Resource(s) to pop-up window.  

6. Select the Department Name from the combo box and Save the details. 

 

Assigning IT Asset to Site 

1. From the Asset list view page, click the Actions menu -> select Assign to Site option from 
the list. This opens Assign Resource(s) to Site pop-up window. 

2. Select the Site name from the combo box. 

3. Save the details. Else click Cancel button.  
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Modifying State for IT Assets  

To modify the state of IT Assets, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This 
opens the Assets list view page. 

4. Select the assets to be modified of their status by enabling the check box. Click the Actions 
menu and select the Modify State option. This opens the Modify State pop up window. 

5. Select the State from the combo box. For ex, In Store, In Use and so on. 

6. Save the changes. 

 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 159

Change log-in Credentials for bulk of IT Assets 

You can change the log-in credentials for bulk of assets. You have Global credentials and Local 
credentials. Global credentials are common login permissions for all the assets. Local credentials are 
private login permissions for an asset (generally used to restrict the access permissions to everyone). 

To change the login credentials, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Assets tab in the header pane. This opens the assets home page.  
3. Click IT Assets under Resources block on the left hand side of the page. Select the 

respective IT assets link. e.g. Access points, Printers and so on. This opens the 
corresponding IT asset page. 

4. Select the IT Assets to change the log-in credentials by enabling the check box. This opens 
the assets list view page. Click the Actions combo box --> and select the Change 
Credentials option. This opens the corresponding page. 

5. Select either Global Credentials or Local Credentials by selecting the radio button. 

Global Credentials 

1. On selecting the global credentials, select the Network from the combo box.  
2. Select the communication Protocol either SSH or Telnet option for linux workstations 

by enabling the corresponding radio button. 
3. If you would like to Scan Software in Linux Workstations then enable the 

corresponding check box. 
4. Specify the User Name and Password for the network. 
5. Save the details. If you would like to Save and Scan now click the corresponding 

option. 

Local Credentials 

1. On selecting the local credentials, specify the User Name and Password. 
2. Select the communication Protocol either SSH or Telnet option for linux workstations 

by enabling the corresponding radio button. 
3. If you would like to Scan Software in Linux Workstations then enable the 

corresponding check box. 
4. Save the details. If you would like to Save and Scan Now click the corresponding 

option. 
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Bulk Scan of IT Assets 

Scan now option is to scan group or bulk of assets for assets data. Each time when a new asset is 
added, instead of scanning all the assets, you can scan the newly added assets for resource details.  

If you have changed the credentials for the assets or if you want to specify the log-in credentials for an 
asset then select the Change Credentials option under the actions menu and specify the details. 
Then click Save and Scan now button for scanning the assets. 

To scan bulk of IT Assets,     

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Assets tab in the header pane. This opens the assets home page. 
3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This 

opens the Assets list view page. 
4. Select the assets to be scanned by enabling the check box. Click the Actions tab -> select 

Scan Now option. This opens the Scan wizard page with total number of scanned and failed 
assets. And you can view the asset details in the Resource details page. 
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Deleting Assets 

1. Log in to the ServiceDesk Plus application using your user name and password. 
This opens the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click IT Asset link under the resource block on the left hand 
side of the page. This opens the IT Assets list view page. 

3. From the assets list view page, select assets to be deleted by enabling the check 
box. 

4. Click Delete button to delete the selected assets. You can see the selected assets 
deleted from the list. 
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Importing Asset details From CSV 

ServiceDesk Plus helps you to import your asset details saved in CSV (Comma Separated values) 
format. If you have asset details in .XLS files, open it with Microsoft Excel and save it as .CSV files 
and then import it. 

1. From the Assets view list page, click the Import from CSV link. This opens the 
Resource Import Wizard page. 

2. Select the Resource Category from the combo box, IT or NON IT. This is a 
mandatory field. 

3. Select the Resource Type from the combo box.  

If you have selected Non-IT as resource category then the resource type would display 
components and assets. (OR) If you have selected IT as resource category then the 
resource type would display, components and IT Assets. Under IT Assets you have 
workstations and other IT-Assets. This is a mandatory field. 

4. Locate the .CSV file using the Browse button. 
5. Click on Step2 button to go to the next page. Click Previous button if you need to go 

the previous page. 
6. If you have selected the resource type as workstations then select the Workstation 

details from the combo box. Also specify the Asset Details by selecting from the 
combo box. The columns in .CSV file are populated in the select boxes beside each 
field label. Advent Net Manage Engine ServiceDesk Plus asset field’s needs mapping 
with the field names from the .CSV file. 

7. Map the Workstation Name for workstation details. For asset details map the 
Product Type, Product Name, Asset Name from the combo box. These are 
mandatory fields. 

8. Map the Model, Tag, Manufacturer, Operating System and Domain details for the 
workstation details. 

9. Map the Asset Tag, Asset Serial No, Bar Code, Vendor Name, Asset Cost, Warranty 
Expiry Date, Expiry Date, Location, Assigned to User, Assigned to Department from 
the combo box. 

10. Map the Acquisition Date field with the relevant field in the .CSV file. Also map the 
order of the acquisition date i.e. date/month/year available in the .CSV file. 

11. Click Step3 to go the next page. Click Previous button if you need to go the previous 
page. 

12. Click Import Now button to import the existing data from the .CSV file. Once the data 
is imported, you can see the Import Wizard page with result break-up.    
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Viewing IT Asset Details 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click IT Asset link on the left hand side of the page. This opens the IT 
Assets list view page. 

3. Click on the IT Asset name to view the IT Assets details. By default Resource Info tab details 
are displayed.  

Viewing Resource Info Details      

Resource Info tab displays the Resource Details such as,Resource Name, Tag, Bar Code, 
Serial No Region, Cost, Acquisition Date and many other details are displayed. 

Viewing Relationships 

This relationship tab shows the assets association to other Assets, Business Services, Users 
and Components.  

On clicking the tab -> click the Add Relationship button on the top right hand side of the page. 

Connection Relationship 

1. Click the Connection Relationship option from the list. This opens the Connection 
Relationship page. 

2. To connect the assets to other assets select the Assets radio button.  
1. Select the assets to be connected from the Asset List. 
2. Move the selected asset to the Connected Assets list using the >> button. 
3. Save the details. You can see the connected assets under the Connected to 

Assets block. 
3. To connect the assets to the Business Services select the corresponding radio 

button. 
1. Select the business services from the list to be connected to the assets such 

as, Email, Internet Access and so on. 
2. Move the selected assets from the Business Service list to the Connected 

Services list using the >> button. 
3. Save the changes. You can see the connected business services under the 

Business Services block. 

Usage Relationship 

1. Click the Usage Relationship option from the list. This opens the Usage Relationship 
page. 

2. Select the Assign the asset to User/Department radio button to associate the asset 
to the user/department. 

1. Select the User from the combo box. 
2. Select the Department to be associated from the combo box. 
3. If the Asset is Leased then select the corresponding check box. 
4. Save the changes. (Or) 

3. Select the Associate to Asset radio button to assign the asset to the asset.  
1. Choose Asset to be associated from the combo box. 
2. Save the details.  
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Container Relationship 

1. Click the Container Relationship option from the list. This opens the Container 
Relationship page. 

2. Select the Components radio button to associate the components to the user. Select 
the type of components to be displayed in the list by selecting it from the choose 
product combo box. 

3. Select the components from the Components List and move it to the Attached 
components list using >> button. 

4. Save the details. 

Viewing History of IT Asset 

Click on the History tab to view the IT Asset history. This gives the complete IT - Assets 
Resource Ownership History on date and State of the components.   

Request Details 

On clicking the Request Details page you will be able to view all the requests raised for the 
asset.  

On Clicking the request title you can view the details of the request, requester details, Assets 
belonging to the user, Time elapsed to solve the request, resolution for the request and history 
of the request 

Also you can send reply for the request or forward the request to the technician. You can 
Search associated problem and change or add new problem or change to the request. 

Viewing Contracts of the IT Asset  

Click on Contracts tab to view the contracts attached to the IT Asset. This gives the complete 
details about the contract such as, vendor name, support details, contract rules, expiry date, 
cost and other rules.  

Viewing Costs 

1. Click on the Costs tab to view the costs associated to the IT Asset.  
2. Click on Add Cost button at the right side of the page to add cost to the IT Asset.  
3. Select the Cost Factor from the combo box. For ex. Service Cost. This is a 

mandatory field. 
4. Specify the description about the cost in the Description field. Say if the cost factor is 

service cost you can specify important information about the service cost.   
5. Specify the Amount in $ in the Amount field. This is a mandatory field. 
6. Select the Date from the calendar button. This is mandatory field.  
7. Click on Add Cost button to add the cost. You can see the cost added to the IT Asset 

shown in the Other Costs list view page. 
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Copying Assets 

Using Copy Resource option you can make multiple copies of the resource and its details. On making 
multiple copies of the resource, it becomes easier for the technician to add bulk of similar assets. The 
technician need not manually enter all the resource details for each resource. The new copies of the 
resource will be assigned with new asset name and rest of the details is retailed as is.   

Example: 

If you have ten printers of the same configurations in your organization, then in this case, enter the 
configurations for one printer and save it. Then copy the same printer for ten times and add its 
configurations to other printers. 

To make multiple copies of the Resources, 

1. Click the Assets tab in the header pane. This opens the assets home page.  
2. Click IT Assets under Resources block on the left hand side of the page. Select the 

respective IT assets link. e.g. Access points, Printers and so on. This opens the 
corresponding IT asset page. 

3. Click the Title of the assets to be duplicated. This opens the Asset details page. 
4. Click the Actions menu on the right hand side of the page. Select Copy Resource option. 

This opens the Copy Resource pop up window as shown below, 

 

5. Specify the Number of Copies to be made for the resource in the given text field. 
6. Copy the resource. You can see the list of resource copies listed in the list view. 
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Attaching Assets 

To attach assets to the IT Assets, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Select the IT Assets link under the Resource block on the left hand side of the page. Select 
the corresponding IT Asset link say, Printers, Access Points and so on. This opens the Asset 
list view page. 

4. Click the title of the asset to be attached with an asset. This opens the asset details page. 

5. Click the Actions combo box -> select the Attach Asset option from the list. This opens the 
Attach Asset pop up window. 

6. If you would like to display the list of all assets or filter specific asset then select the assets to 
be displayed from the List combo box. Ex: Printer, Access Points and so on. Also select the 
type of asset such as asset in store, in use and so on from the of type combo box.  

7. You have two columns, such as Asset list and Attached Assets list. You have to select the 
assets to be attached from the assets list and move it to the attached assets list using the >> 
button. To remove the assets from the attached assets list use the << button. 
 
Example:  
If you would like to attach a printer to a workstation then select the list of assets to be 
attached from the assets list and move it to the attached assets list. 

8. Save the changes. If you would like to detach all the attached assets then select the Detach 
All option. 
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Attach Component 

To attach components to an asset, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane, this opens the assets home page. 

3. Select the IT Assets link under the Resource block on the left hand side of the page. Select 
the corresponding IT Asset link say, Printers, Access Points and so on. This opens the IT 
asset list view page. 

4. Click the Title of the asset to be attached with an component. This opens the asset details 
page. 

5. Click the Actions combo box -> select the Attach Component option from the list. This 
opens the Attach Component pop up window. 

6. If you would like to display the list of all components or filter specific components then select 
the components to be displayed from the List combo box. Ex: keyboard, mouse and so on. 
Also select the type of component such as component in store, in use and so on from the of 
type combo box.  

7. You have two columns, such as Component list and Attached Components list. You have 
to select the components to be attached from the components list and move it to the attached 
components list using the >> button. To remove the component from the attached component 
list use the << button. 

Example:  

If you would like to attach a keyboard and a mouse to a workstation then select the list of 
components to be attached from the component list and move it to the attached component 
list. 

7. Save the changes. If you would like to detach all the attached components then select the 
Detach All option. 
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Attach Documents 

To attach documents, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab in the header pane. This opens the Asset home page. 

3. Select IT Assets link under the resource block on the left hand side of the page. Select the 
corresponding IT Assets say, Printers, Routers and so on. This opens the IT asset  list view 
page.  

4. Click the Asset Name of the asset to which the document needs to be attached. This opens 
the Asset details page. 

5. Click the Actions combo box on the top right hand side of the page -> select the Attach 
Documents option. This opens the Attach File pop up window. 

6. Choose the file to be attached by clicking the Browse button. The maximum size of the 
attached file can be 10 MB. 

7. Click Attach File. The attached document will be listed in Asset details page under Attached 
Documents. The attached file can be deleted by clicking the delete icon beside file name. 
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Assigning IT Asset to User/Department/Asset 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This 
opens the selected Assets list view page. 

4. Click on the Asset Name to be assigned a user/department/asset. This opens the Asset 
details page. 

5. Click the Actions menu on the right hand side of the page -> click Assign option from the list. 
This opens the Assign/Associate page 

6. If you would like to assign the asset to user or department then, select Assign User and or 
Department radio button. Or if you would like to associate with an asset then select 
Associate to Asset radio button. 

Assign User and or Department 

1. On selecting this radio button, select the User name and Department name from the 
combo box. 

2. If the asset is leased then enable the Asset is Leased check box and specify the 
From and To date of the lease. 

Associate to Asset   

1. On selecting this radio button, Choose the Asset to be associated from the combo 
box. 

7. Save the details.  
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Add New Workstation 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab in the header pane. This opens the asset home page. 

3. Click IT Asset link under the resource block on the left hand side of the page. Select the 
corresponding assets say, Printers, Routers and so on. This opens the Asset list view page. 
Click New button. (OR)  

Click on Quick Create  tab on the top left hand side of the page -> click 
Workstation option. This opens the Workstation Configuration page. 

Computer Details 

4. Specify the Name of the computer in the name text field and select the Model of the 
workstation from the combo box. This is a mandatory field. Ex: Latitude D620. 

5. Specify the Service Tag & Manufacturer of the workstation in the given text field. 

6. Specify the Processor Count, Processor Info, Clock Speed and Manufacturer of the 
processor in the given text fields. 

7. Specify the RAM and Virtual Memory in (MB) the given text fields. 

8. Also specify the Name and Service Pack of the operating system in the corresponding fields.  

Resource Info Details 

9. Specify the resource info details such as, Resource Tag, Resource Serial No, Bar Code & 
Location in the given text fields. 

10. Select the Site and Vendor Name of the workstation from the combo box. 

11. Select the  Acquisition Date, Expiry Date & Warranty Expiry Date from the calender 
button.  

Asset State Details 

12. Select the status of the asset from the Asset State combo box. Ex: In Store, In Use and so 
on  

Network Adapter Details 

13. Specify the network adapter details such as, Network IP Address, MAC Address, NIC, 
Network, DNS Server name & Default Gateway  in the given text field.  

14. Select the Domain name from the combo box.  

15. If you would like to enable DHCP then select the check box. 

Input/Output Devices Details 

16. Also specify the input/output devices details of the workstation. Specify the Monitor Type, 
Mouse Type, Keyboard Type & their corresponding manufacturers in the respective fields. 

17. Save the details. If you would like to Save and Add New workstation then click the 
corresponding button.   
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Bulk Scan of Newly Added Workstation 

Using this option you can scan a new workstation added to the domain for its hardware and software 
details. This is very useful when you have to scan a single or a set of newly added workstations. In 
such case you don't have to scan the entire domain for adding the workstations to the network. 

To Scan New Workstation,    

1. Click on the Assets tab in the header pane -> click the Workstations link under the 
Resources tab on the left side of the page. This opens Workstations list view page. 

2. Select the Workstations to be scanned by enabling the check box -> Click the New Scan 
button next to the Actions menu. This opens the Scan Configuration page. 

3. Specify the Name/IP of the workstation. This is a mandatory field. 

4. Select the log-in credentials for the workstation by selecting either of the two radio buttons. 
Say Global or Local credentials. By default Global Credentials option will be selected.  

Global Credentials 

1. Select the Scan type from the combo box. Say Domain mode or Network mode. 

2. Select the Domain/Network name from the combo box. This is a mandatory field. 

3. Specify the Login Name and Password for the selected domain. 

Local Credentials 

1. Specify the local Login Name and Password. 

2. Select the Protocol to connect it to the workstation by enabling either of the two radio 
buttons. Say SSH or Telnet. 

3. If you would like to scan software in Linux workstation then select the corresponding check 
box.   

4. Click Scan to scan the workstation. Else click Cancel. 
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Changing Workstation As Server 

You can change workstation as server,   

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page.  

3. Click IT Assets under Resources block on the left hand side of the page. Click the 
Workstations link. This opens the workstations list view page. 

4. Select the workstations name to be changed as server by enabling the check box. 

5. Click the Actions menu and select the Change as Server option. This opens the Modify 
Device Type page as shown below, 
 
 

6. Select the Type of the server from the combo box.  

7. Save the details.  
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Viewing Workstation Details 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click Workstation link under IT Assets title on the left hand side of 
the page. This opens the workstations list view page. 

3. Click on the workstation name to view the workstations details. By default Resource Info tab 
details are displayed.  

Viewing Resource Info Details      

Resource Info tab displays the Resource Details & Workstation Details. Resource details such 
as Resource Name, Tag, Bar Code, Serial No etc. Workstation details such as Computer 
Name, OS version, Service pack, Processor details, memory information and many other 
details are displayed. 

Viewing Hardware Details  

Click Hardware tab to view the complete Hardware details of the workstation. The hardware 
tab is broadly divided in to four major blocks such as Workstation Details block, Network 
Details, Discs and Drive Details, Printer Details and Other Details.  

Under the workstation block you can view computer system, operating system, processor, 
memory and installed memory details. Under network block you can view the network adapters 
details. Under disks and drives block you can view the hard disks, logical drives and physical 
drives details. The printer details can be viewed under the printer details block. Under other 
details block you can view the keyboard, mouse, monitor, multimedia, ports, USB controllers 
details.    

Viewing Software Details    

Click Software tab to view the software details of the workstation. This opens the software 
details page with the list of all installed software’s in the workstation. By default the list of All 
Software will be displayed. 

Select the corresponding filter option from the Filter Viewing combo box. There are different 
status levels of the software, such as Excluded, Managed, Prohibited, Freeware, 
Shareware and Unidentified. You can select any of these status levels and filter the 
software’s listed. 

Click on the software title to view the software details such as,  number of licensed 
installations, number of unlicensed installations and number of Purchased licenses.  

If there are any license violations a warning message is displayed saying: License 
Violation. Software installations are more than purchased licenses.     

Viewing Relationships 

This relationship tab shows the assets association to other Assets, Business Services, Users 
and Components.  

On clicking the tab -> click the Add Relationship button on the top right hand side of the page. 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 174

Connection Relationship 

1. Click the Connection Relationship option from the list. This opens the Connection 
Relationship page. 

2. To connect the assets to other assets select the Assets radio button.  
1. Select the assets to be connected from the Asset List. 
2. Move the selected asset to the Connected Assets list using the >> button. 
3. Save the details. You can see the connected assets under the Connected to 

Assets block. 
3. To connect the assets to the Business Services select the corresponding radio 

button. 
1. Select the business services from the list to be connected to the assets such 

as, Email, Internet Access and so on. 
2. Move the selected assets from the Business Service list to the Connected 

Services list using the >> button. 
3. Save the changes. You can see the connected business services under the 

Business Services block. 

Usage Relationship 

1. Click the Usage Relationship option from the list. This opens the Usage Relationship 
page. 

2. Select the Assign the asset to User/Department radio button to associate the asset 
to the user/department. 

1. Select the User from the combo box. 
2. Select the Department to be associated from the combo box. 
3. If the Asset is Leased then select the corresponding check box. 
4. Save the changes. (Or) 

3. Select the Associate to Asset radio button to assign the asset to the asset.  
1. Choose Asset to be associated from the combo box. 
2. Save the details.  

Container Relationship 

1. Click the Container Relationship option from the list. This opens the Container 
Relationship page. 

2. Select the Components radio button to associate the components to the user. Select 
the type of components to be displayed in the list by selecting it from the choose 
product combo box. 

3. Select the components from the Components List and move it to the Attached 
components list using >> button. 

4. Save the details. 

Viewing History of workstation 

Click on the History tab to view the workstation history. This gives the complete Workstation 
Scan History and Resource Ownership History on date.   

Request Details 

On clicking the Request Details page you will be able to view all the requests raised for the 
asset.  

On Clicking the request title you can view the details of the request, requester details, Assets 
belonging to the user, Time elapsed to solve the request, resolution for the request and history 
of the request 
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Also you can send reply for the request or forward the request to the technician. You can 
Search associated problem and change or add new problem or change to the request. 

Viewing Contracts of the workstation  

Click on Contracts tab to view the contracts attached to the workstation. This gives the 
complete details about the contract such as, vendor name, support details, contract rules, 
expiry date, cost and other rules.  

Viewing Costs 

Click on the Costs tab to view the costs associated to the workstation.  

Click on Add Cost button to add cost to the workstation.  

Select the Cost Factor from the combo box. For ex. Service Cost. This is a mandatory field. 

Specify the description about the cost in the description field. Say if the cost factor is service 
cost you can specify important information about the service cost.   

Specify the Amount in $ in the Amount field. This is a mandatory field. 

Select the Date from the calendar button.  

Click on Add Cost button to add the cost. You can see the cost added to the workstation shown 
in the Other Costs list view page. 
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Print Preview of Workstation Details 

You can view the preview of the workstation details in printable format. 

To view the Preview of Workstation Details, 

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page.  

3. Click IT Assets under Resources block on the left hand side of the page. Select the 
Workstations link. This opens the workstation details page. 

4. Click the Workstation Name to view the preview of the workstation details. This opens the 
Workstation details page. 

5. Click the Actions menu on the right hand side of the page. Select Print Preview option. This 
opens the Resource Details pop up window. You can view the complete resource details, 
workstation details, network details, disks & drives details, printer details, other details, 
software details, installed service packs details, resources attached details, workstations scan 
history details, resource ownership history details, contracts details & costs details. 
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Modify Type 

To Modify Device type,     

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page.  

3. Click IT Assets under Resources block on the left hand side of the page. Select the 
Workstations link. This opens the workstation list view page. 

4. Click the Workstation Name to be modified of the device type. This opens the Workstation 
details page. 

5. Click the Actions menu on the right hand side of the page. Select Modify Type option. This 
opens the modify device type pop up window. 

6. Select the device type from the Modify Type combo box. 

7. Save the details. 
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Adding Software 

Using this option you can add multiple software to the workstation. 

To add Software to the workstation, 

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page.  

3. Click IT Assets under Resources block on the left hand side of the page. Select the 
Workstations link. This opens the workstation list view page. 

4. Click the Workstation Name. This opens the Workstation details page. 

5. Click the Actions menu on the right hand side of the page. Select Add Software option. This 
opens the Add Software pop up window. 

6. Select the software from the list to be added to the workstation. You can select multiple 
software to be added to the workstation using ctrl or shift keys. 

7. Save the details. Else Close the pop-up window. 
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Deleting Workstations 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click IT Asset link on the left hand side of the page. This opens the IT 
Assets list view page. 

3. From the Workstations view list page, select workstations to be deleted by enabling the check 
box. 

4. Click Delete button to delete the selected workstations. You can see the selected workstation 
deleted from the list.  
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Components 

A part of the asset (ie. associated with the asset) which does not stand alone are grouped under 
components. The list of all possible components are given below, 

• Keyboards 

• Mouse 

• Software’s 

• Software Licenses 

• Printer ink 

 

• Adding Components 

• Adding Components to Groups 

• Deleting Components 

• Viewing Components Details 

• Edit Components 

• Associate Assets 

• Copy Resources 

• Attach Documents 
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Adding Components 

1. Log in to the ServiceDesk Plus application using your user name and password. 
This opens the ManageEngine ServiceDesk plus home page. 

2. Click Quick Actions link  on the top left hand side of the page -> 
Click Asset option from the drop down menu. This opens Add Asset page. (OR) 
 
Click Asset Components under Resources on the left side of the page -> Select any 
one of the listed IT assets components link. e.g. Keyboards etc. This opens the 
particular Asset Component page. 

3. Click New button. This opens Add Asset page. 

4. Select the Product Name from the combo box. If required, you can add a new 
product name by clicking Add New link beside the product name field. This is a 
mandatory field. 

5. Select the Vendor Name from the combo box. If required, you can add a new vendor 
by clicking the Add New link beside the vendor name text field.  

6. Specify the Asset Name in the given text field. This is a mandatory field. 

7. Specify the Asset Tag, Asset Serial No, Bar Code, Asset Cost in $ in the 
corresponding text fields. 

8. Specify the Acquisition Date & Expiry Date from the calendar button. 

9. Select the Site from the combo box. 

10. Specify the Location in the given text field. 

11. Specify the Asset State by selecting the current status of the asset from the combo 
box.  
 
If the asset is in Use state you need to associate or assign asset to department or 
user or asset. 

1. Allocate the asset to an Asset or to an User or to the Department by 
selecting any of the two radio button. Say Associate to Asset or Assign User/ 
or Department. 

2. If you choose to associate asset to an asset then select the asset name from 
the Choose Asset combo box. Or if you have chosen to assign to user or the 
department then select User or Department from the combo box.  

3. If the asset is leased select the check box Asset is Leased. If the asset is 
leased then specify the From and To date from the calendar button.    

12. Click Save button to save the changes. To save and add another asset click Save 
and add new button. 
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Adding Components to Group 

You have two types of groups in ServiceDesk Plus say, Static group and Dynamic. Add to group 
option in component list view page is to group bulk of components. These components will be 
grouped under the Static group by default. 

To Add Components to group,   

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click any of the Components link under the Resources block on the left hand side of the 
page. This opens the components list view page. 

3. Select the components to be added to the group by enabling the check box. This opens the 
Add Resource(s) to page. 

4. By default you can group components only to the static group. Either to the Existing static 
group or New static group can be added. 

5. If you would like to group the components under existing static group then click the 
corresponding radio button. Select the group name from the combo box. 

6. Else, if you would like to add a new static group and group the components, click New Group 
radio button. Specify the Group Name and relevant information about the group in the 
Description field.    

7. Click Save button to save the changes. 
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Deleting Components  

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click Asset Components link under resource block on the left hand 
side of the page. This opens the components list view page. 

3. From the components list view page, select assets to be deleted by enabling the check box. 

4. Click Delete button to delete the selected assets. You can see the selected assets deleted 
from the list. 
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Viewing Components Details 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click Components link under on the left hand side of the page. This 
opens the components list view page. 

3. Click on the components name to view the components details. By default Resource Info tab 
details are displayed.  

Viewing Resource Info Details      

Resource Info tab displays the Resource Details such as, Resource Name, Tag, Bar Code, 
Serial No Region, Cost, Acquisition Date and many other details are displayed. 

Viewing History of Components 

Click on the History tab to view the components history. This gives the complete components 
Resource Ownership History on date and State of the components. 

Request Details 

On clicking the Request Details page you will be able to view all the requests raised for the 
Component. 

On Clicking the request title you can view the details of the request, requester details, Assets 
belonging to the user, Time elapsed to solve the request, resolution for the request and history 
of the request 

Also you can send reply for the request or forward the request to the technician. You can 
Search associated problem and change or add new problem or change to the request. 

Contracts Details 

Click on Contracts tab to view the contracts attached to the components. This gives the 
complete details about the contract such as, vendor name, support details, contract rules, 
expiry date, cost and other rules.  

Costs Details 

1. Click on the Costs tab to view the costs associated to the components.  
2. Click on Add Cost button to add cost to the components.  
3. Select the Cost Factor from the combo box. For ex. Service Cost. This is a mandatory 

field. 
4. Specify the description about the cost in the Description field. Say if the cost factor is 

service cost you can specify important information about the service cost.   
5. Specify the Amount in $ in the Amount field. This is a mandatory field. 
6. Select the Date from the calendar button. This is mandatory field. 
7. Click on Add Cost button to add the cost. You can see the cost added to the 

components shown in the Other Costs list view page. 
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Copying Resources 

Using Copy Resource option you can make multiple copies of the component and its details. On 
making multiple copies of the resource, it becomes easier for the technician to add bulk of similar 
components. The technician need not manually enter all the components details for each component. 
The new copies of the component will be assigned with new component name and rest of the details 
is retailed as is.  

Example: 

If you have twenty keyboards of the same configurations in your organization, then in this case, enter 
the configurations of one keyboard and save it. Then copy the same keyboard for twenty times and 
add its configurations to other keyboards. 

To make multiple copies of the Resources, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab, this opens the asset home page -> select the Asset Components link 
on the left hand side of the page. 

3. From the list view page of the Asset Components -> click the title of the asset component to 
be duplicated. This opens the asset components details page. 

4. Click the Actions combo box -> select the Copy Resource option. This opens the Copy 
Resource page as shown below, 

 

5. Specify the Number of Copies to be made for the resource in the given text field. 

6. Copy the resource. You can see the list of resource copies listed in the list view. 
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Editing Components 

To edit the resource details, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab -> select the Asset Components link under the resource block on the 
left hand side of the page. This opens the list view page of the asset components. 

3. Click the title of the Asset Components to be edited. This opens the Asset details page. 

4. Click Edit button on the top right hand side of the page (Or)  
 
Click the Actions combo box next to the edit resource button -> select the Edit option. This 
opens the Edit Components page. 

5. Edit the Asset Details block such as Asset Name, Tag, Serial No, Bar Code, Vendor Name, 
Cost, Acquisition Date, Expiry Date, and Location. The Product Name cannot be edited as 
it is linked to the product list created by the technician. 

6. Modify the Asset State details such as, Current usage status of the assets like In Use, In 
Repair and so on. Then the Associate the asset to User or Department details or Assign to 
User or Department details. 

7. Update the changes. You can see the components details getting updated. 
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Attach Documents 

To attach documents, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab in the header pane. This opens the Asset home page. 

3. Select IT Assets link under the resource block on the left hand side of the page. Select the 
corresponding IT Assets say, Printers, Routers and so on. This opens the IT asset  list view 
page.  

4. Click the Asset Name of the asset to which the document needs to be attached. This opens 
the Asset details page. 

5. Click the Actions combo box on the top right hand side of the page -> select the Attach 
Documents option. This opens the Attach File pop up window. 

6. Choose the file to be attached by clicking the Browse button. The maximum size of the 
attached file can be 10 MB. 

7. Click Attach File. The attached document will be listed in Asset details page under Attached 
Documents. The attached file can be deleted by clicking the delete icon beside file name. 
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Non IT Assets 

All non IP based assets are grouped under Non - IT assets. The list of all possible non-it assets are 
given below, 

• Projectors 

• Scanners 

• Tables 

• Chairs 

• Telephones 

 

• Adding Non-IT Asset 

• Editing Non-It Asset 

• Adding  Non-It Asset to Group 

• Assigning bulk Non-It Asset to Department/Site 

• Modify the State of Non-It Assets 

• Delete Non-It Asset 

• Viewing Non-It Asset Details 

• Assigning Non-It Asset to Users and/or Department 

• Copy Resources 

• Attach Asset 

• Attach Component 

• Attach Documents 
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Adding Non-IT Asset 

1. Log in to the ServiceDesk Plus application using your user name and password. 
This opens the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click Quick Actions on the top left hand 
side of the page -> Click Asset option from the drop down menu. This opens Add 
Asset page. (OR)  
 
Click Non-IT Assets under Resources on the left side of the page -> Select any one 
of the listed Non-IT assets link. e.g. Projectors, Scanners. This opens the particular 
Non-IT asset page. 

3. Click New button. This opens Add Asset page. 

4. Select the Product Name of the asset from the combo box. If required, you can add 
a new product name by clicking Add New link beside the product name field. This is 
a mandatory field. 

5. Select the Vendor Name from the combo box. If required, you can add a new vendor 
by clicking the Add New link beside the vendor name text field.  

6. Specify the Asset Name in the given text field. This is a mandatory field. 

7. Specify the Asset Tag, Asset Serial No, Bar Code, Asset Cost in $ in the 
corresponding text fields. 

8. Specify the Acquisition Date & Expiry Date from the calendar button. 

9. Select the Site from the combo box. 

10. Specify the Location in the given text field. 

11. Specify the Asset State by selecting the current status of the asset from the combo 
box.  
 
If the asset is in Use state you need to associate or assign asset to department or 
user or asset. 

1. Allocate the asset to an Asset or to an User or to the Department by 
selecting any of the two radio button. Say Associate to Asset or Assign User/ 
or Department. 

2. If you choose to associate asset to an asset then select the asset name from 
the Choose Asset combo box. Or if you have chosen to assign to user or the 
department then select User or Department from the combo box.  

3. If the asset is leased select the check box Asset is Leased. If the asset is 
leased then specify the From and To date from the calendar button.    

12. Click Save button to save the changes. To save and add another asset click Save 
and add new button. 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 190

Editing Non-IT Assets 

To edit the non-it assets details, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab -> select the Non-IT Assets link on the left hand side of the page. This 
opens the list view page of the IT assets. 

3. Click the title of the Non-IT asset to be edited. This opens the Asset details page. 

4. Click Edit button on the top right hand side of the page (Or) click the Actions combo box next 
to the edit resource button -> select the Edit option. This opens the Edit Asset page. 

5. Edit the Asset Details block such as Product Name, Asset Name, Tag, Serial No, Bar 
Code, Vendor Name, Cost, Acquisition Date, Expiry Date, and Location.  

6. Modify the Asset State details such as, Current usage status of the assets like In Use, In 
Repair and so on. Then the Associate the asset to User or Department details or Assign to 
User or Department details. 

7. Update the changes. You can see the assets details getting updated. 
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Adding Non-IT Assets to Group 

You have two types of groups in ServiceDesk Plus say, Static group and Dynamic. Add to group 
option in Non-IT asset list view page is to group bulk of Non-IT assets. These assets will be grouped 
under the Static group by default. 

To Add Non-IT Assets to group,   

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click any of the Non-IT Assets link under the Resources block on the left hand side of the 
page. This opens the Non-IT assets list view page. 

3. Select the Non-IT assets to be added to the group by enabling the check box. This opens the 
Add Resource(s) to page. 

4. By default you can group Non-IT assets only to the static group. Either to the Existing static 
group or New static group can be added. 

5. If you would like to group the Non-IT assets under existing static group then click the 
corresponding radio button. Select the group name from the combo box. 

6. Else, if you would like to add a new static group and group the Non-IT assets, click New 
Group radio button. Specify the Group Name and relevant information about the group in the 
Description field.    

7. Click Save button to save the changes. 
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Assigning Bulk Non-IT Assets to Department/Site 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Select the Non-IT Assets title under the Resources block. Select the specific Non- IT Asset 
link. This opens the Assets list view page. 

Assign Bulk of Assets to Department 

1. Click on the Non-IT assets to be assigned to a Department by enabling the check boxes. 
Click Actions menu -> select Assign to Department option. This opens Assign Resources 
to pop-up window. 

2. Select the Department Name from the combo box. 

3. Save the details. 

Assign Bulk of Assets to Site 

1. Click on the Non-IT assets to be assigned to a Site by enabling the check boxes. Click 
Actions menu -> select Assign to Site option. This opens Assign Resources to pop-up 
window. 

2. Select the Site Name from the combo box. 

3. Save the details. 
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Modifying the State of Non-IT Assets 

To modify the state of Non-IT Assets, 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click Non-IT Asset link on the left hand side of the page. This opens 
the IT Assets list view page. 

3. From the Assets list view page, select the asset to be modified by enabling the check box 
beside the asset title.  

4. Click the Actions combo box -> select the Modify State option. (OR)  From the Asset details 
page, click the Change link beside the Resource State on the right hand side of the page. 
This opens the Modify State page. 

5. Select the Modify State from the combo box. Ex: In Use, In Store and so on. 

6. Save the changes. 
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Deleting Non-IT Asset 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab on the header pane. This opens the Asset home page. 

3. Click Non-IT Assets link under Resource block on the left hand side of the page. This opens 
the Non-IT Assets list view page. 

4. Enable the check box beside the assets to be deleted. Click Delete button. 

5. A confirmation dialog appears. Click Ok to continue. You can see the selected assets deleted 
from the list. 
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Viewing Non-IT Assets Details 

1. Log in to the ServiceDesk Plus application using your user name and password. This opens 
the ManageEngine ServiceDesk plus home page. 

2. Click on Assets tab -> Click Non-IT Assets link under on the left hand side of the page. This 
opens the Non-IT Assets list view page. 

3. Click on the Non-IT Asset name to view the Non-IT Assets details. By default Resource Info 
tab details are displayed.  

Viewing Resource Info Details      
Resource Info tab displays the Resource Details such as, Resource Name, Tag, Bar Code, 
Serial No Region, Cost, Acquisition Date and many other details are displayed. 

Viewing History of Non-IT Assets 
Click on the History tab to view the Non-IT Assets history. This gives the complete Non-IT 
Assets Resource Ownership History on date and State of the Non-IT Assets. 

Request Details 
On clicking the Request Details page you will be able to view all the requests raised for the 
Non-IT Asset. 

On Clicking the request title you can view the details of the request, requester details, Assets 
belonging to the user, Time elapsed to solve the request, resolution for the request and history 
of the request 

Also you can send reply for the request or forward the request to the technician. You can 
Search associated problem and change or add new problem or change to the request. 

Contracts Details 
Click on Contracts tab to view the contracts attached to the Non-IT Assets. This gives the 
complete details about the contract such as, vendor name, support details, contract rules, 
expiry date, cost and other rules.  

Costs Details 
1. Click on the Costs tab to view the costs associated to the Non-IT Assets.  

2. Click on Add Cost button to add cost to the Non-IT Assets.  

3. Select the Cost Factor from the combo box. For ex. Service Cost, Purchase Cost 
etc. This is a mandatory field. 

4. Specify the description about the cost in the Description field. Say if the cost factor is 
service cost you can specify important information about the service cost.   

5. Specify the Amount in $ in the Amount field. This is a mandatory field. 

6. Select the Date from the calendar button. This is mandatory field. 

7. Click on Add Cost button to add the cost. You can see the cost added to the Non-IT 
Assets shown in the Other Costs list view page. 
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Assigning Non-IT Assets to Users and/or 
Department 

To assign assets to asset/users/departments, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab -> select the Non-IT Assets link on the left hand side of the page. This 
opens the list view page of the Non-IT assets. 

3. Click the title of the Non-IT asset to be assigned to users or departments. This opens the 
Asset details page. 

4. Click Assign button (Or) the Actions combo box on the top right hand side of the page -> 
select the Assign option. This opens the Assign/Associate page. 

5. Select the Assign the asset to User/Department radio button to associate it to the 
user/department. 

1. Select the User from the combo box. 

2. Select the Department to be associated from the combo box. 

3. If the Asset is Leased then select the corresponding check box. 

4. Save the changes. 

6.  Else select the Associate to Asset radio button to associate to the asset.  

1. Choose Asset to be associated from the combo box. 

2. Save the details.   

Once you save the details the page is refreshed with a message saying 'Owner assigned 
successfully for this resource'. 
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Copying Resources 

Using Copy Resource option you can make multiple copies of the resource and its details. On making 
multiple copies of the resource, it becomes easier for the technician to add bulk of similar assets. The 
technician need not manually enter all the resource details for each resource. The new copies of the 
resource will be assigned with new asset name and rest of the details is retailed as is.  

To make multiple copies of the Resources, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page.  

3. Click Non-IT Assets under Resources block on the left hand side of the page. Select the 
respective Non-IT assets link. e.g. Projectors, Scanners and so on. This opens the 
corresponding Non-IT asset page. 

4. Click the Title of the assets to be duplicated. This opens the Asset details page. 

5. Click the Actions menu on the right hand side of the page. Select Copy Resource option. 
This opens the Copy Resource pop up window. 

 

5. Specify the Number of Copies to be made for the resource in the given numeric field.  

6. Click Copy to make the copies of the Non -IT asset. The new copies of the Non-IT asset will 
be assigned with new asset name that will uniquely identify them. The rest of the information 
is retained as is. If required, you can also edit the resource details.  
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Attaching Assets  

To attach assets to the IT Assets, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab -> select the Non - IT Assets link on the left hand side of the page. This 
opens the list view page of the Non-IT assets. 

3. Click the title of the Non-IT asset to be attached to other assets. This opens the Asset 
details page. 

4. Click the Actions combo box on the top right hand side of the page -> select the Attach 
Asset option. This opens the Attach Asset page. 

5. You have two columns, such as Asset list and Attached assets list. You have to select the 
assets to be attached from the assets list and move it to the attached list using the >> button. 
To remove the asset from the attached asset list use the << button. 

Example:  

If you would like to attach a scanner to a list of workstations then select the list of workstations 
from the asset list and move it to the attached asset list. 

6. Save the changes. If you would like to detach all the attached assets then select the Detach 
All option. 

If you would like to display the list of all assets or a specific asset in the organization such as 
Linux workstations, Laptops D620 etc, then in this case select the assets to be displayed from 
the List combo box. Also select the type of asset such as assets in store, in use and so on 
from the of type combo box. 
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Attach Component  

To attach component to an Non -IT asset, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Assets tab in the header pane, this opens the assets home page -> select Non-IT 

Assets under Resources block on the left hand side of the page. Click the specific Non - IT 
asset link. This opens the Non-IT assets list view page. 

3. Click the title of the Non-IT asset to be attached with an component. This opens the Non-IT 
asset details page. 

4. Click the Actions combo box and --> select the Attach Component option from the list. This 
opens the Attach Component pop up window. 

5. If you would like to display the list of all components or filter specific components then select 
the components to be displayed from the List combo box. Ex: keyboard, mouse and so on. 
Also select the type of component such as component in store, in use and so on from the of 
type combo box.  

6. You have two columns, such as Component list and Attached Components list. Select the 
components to be attached from the components list and move it to the attached components 
list using the >> button. To remove the component from the attached component list use the 
<< button. 

Example:  

If you would like to attach a keyboard and a mouse to a workstation then select the list of 
components to be attached from the component list and move it to the attached component list. 

7. Save the changes. If you would like to detach all the attached components then select the 
Detach All option. 
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Attach Documents 

To attach documents to an Non-IT Asset, 

1. Log in to ServiceDesk Plus using your user name and password. 

2. Click the Assets tab -> select the Non-IT Assets link under the resource block on the left 
hand side of the page. This opens the IT asset  list view page.  

3. Click the title of the Non-IT asset to be attached to other assets. This opens the Asset 
details page. 

4. Click the Actions combo box on the top right hand side of the page -> select the Attach 
Documents option. This opens the Attach File pop up window. 

5. Choose the file to be attached by clicking the Browse button. The maximum size of the 
attached file can be 10 MB. 

6. Click Attach File. The attached document will be listed in Asset details page under Attached 
Documents. The attached file can be deleted by clicking the delete icon beside file name. 
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Software Asset Management 

ManageEngine ServiceDesk Plus discovers all installed software in the network. Asset managers 
have tough time managing personal, official and recreational software that is common in the 
workplace.  

• ServiceDesk Plus groups scanned software based on Managed, Open Source types etc. 

• Help in license management 

• Help in Group based on application 

• Software metering- which tracks the usage of the software in each workstation.  
 

 

• About Software 

• Adding New Software 

• Deleting Software 

• Changing Software Category 

• Moving Software 

• Viewing Software Details 

• Adding Software Licence 

• Associating Software Minor Versions 

• Emailing Users 
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About Software 

1. Click on Assets tab -> Click Software link under the Resource block on the left hand side of 
the page -> Scanned Software option. This brings up the Software list view page. By default, 
the list of All Software will be displayed. 

2. Select the corresponding filter option from the Viewing combo box. You can view the 
softwares with different status levels using filters. They are, 

• Excluded: Software that is omitted from use.   

• Freeware: Software that is provided without charge.  

• Managed: All licensed software comes under this software type.   

• Prohibited: Software that is prevented from use.  

• Shareware: Software that is available free of charge, may be distributed for 
evaluation with a fee requested for additional features or a manual etc. 

• Unidentified: Unknown softwares can be categorized under this software type. 
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Adding New Software 

To Add new Software, 

1. Log in to ServiceDesk Plus application using your user name and password.  

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Click Software title under Resources block on the left hand side of the page. Click the 
Scanned Software link. This opens the software list view page. By default the list of All 
softwares will be listed.  

4. Click the New button on the right hand side of the page. This opens Add Software form. 

5. Specify the Software Name in the given text field. e.g. Adobe Photoshop. This is a 
mandatory field. 

6. Specify the Version of the software. Say 7.1,7.2 etc. 

7. Select the Software Type from the combo box. Say Managed.  

8. Select the Software Category from the combo box. Say Graphics. This is a mandatory field. 

9. Specify relevant information about software in the Description field. 

10. Click Add button to add the software. You can see the newly added software getting listed in 
software list view page. 
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Deleting Software  

1. From the Software view list page, select the corresponding filter option from the Viewing 
combo box. By default the list of All Softwares will be displayed.  

2. Select the softwares to be deleted by enabling the check box.  

3. Click Delete button to delete the selected softwares. A pop up window pops up to get your 
confirmation on the delete operation. Click Ok to proceed. You can see the selected 
softwares getting deleted from the list.      
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Changing Software Category 

Using this option, you can change the existing category of the software. Ex: From Graphics software 
to Multimedia software so on.   

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page.  

3. Click the Software under Resources block on the left hand side of the page. Click Scanned 
Software link. This opens the software list view page. 

4. Select the corresponding filter option from the Filter Viewing combo box. By default the list of 
All Softwares will be listed. 

5. Select the software from the list to change the category by enabling the check box. Click 
Change Category button. This opens Change Software Category to pop-up window. 

6. Select the Software Category from the list say Accounting, Development etc. 

7. Click Save button to save the changes. 
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Moving Software 

Using this option you can change the current software type. Ex: If the current software type is 
Excluded then you can move the type to Managed.  

To change Software Type, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the Assets home page 

3. Click Software title under Resources block. Click the Scanned Software link. This opens 
the software list view page. 

4. Select the corresponding filter option from the Filter Viewing combo box. By default the list of 
All Softwares will be listed. 

5. Select the respective Move To software filter option from the combo box. Select the software 
to be moved from the list by enabling the check box. 

6. Click Move button to move the selected software to the specified category.   

[OR] 

1. From the Software list view page, click the software name to change software type. This 
opens the Software details page. 

2. Click the Actions tab and select Change Software type option from the list. 

3. Select the Software type from the list and click Change button to change the software type. 

Alternatively, you also have an option to change the software type by clicking the link 

 in the Software details page. 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 207

Viewing Software Details 

1. From the Software view list page, select Managed software type from the Filter Viewing 
combo box, to view the license details of the software. All the licensed software comes under 
Managed software type. 

2. Click on the software name to view the software details.  
3. In the software details page, You have the Product Name, Version, Manufacturer and 

Category. You can also change the category by clicking change link adjacent to the category. 
  

4. You can also view the purchased licenses details, Licensed users, Available Licenses and 
Unlicensed Installations. On having unlicensed installations you get a warning message for 
license violation as shown below, 

 

Licensed Installations 

Under Licensed Installations, you can view the workstation details, user details, software usage 
details, number of licensed installations and allocated licenses details. 

Un Licensed Installations 

Under Unlicensed installations, you can view the  list of unlicensed installations , users using the 
unlicensed software, usage of the software say frequently or occasionally etc can be viewed. 

Allocate Licenses to single machines 

1. Click on the Select software license icon -> Select software license page opens. 
2. Select the license name by enabling the radio button. 
3. Click Save button to save the changes. You can see the unlicensed installations 

changing to licensed installations and listed under the Licensed Installations column. 

Allocate Licenses to multiple machines 

1. Select the workstations to allocate licenses by enabling the check box. 
2. Click Allocate License button to allocate licenses to bulk of workstations. It takes all 

un allocated licenses and assign it to the workstations automatically.            

Purchased Licenses 

Under Purchased licenses, you can view the number of purchased licenses, license type, Installation 
details, license key details etc. 

To delete the purchased licenses,  

1. Select the purchased licenses from the list by enabling the check box. 
2. Click Delete button to delete the selected licenses. A window pops up to get your 

confirmation on the delete operation click Yes to proceed. You can see the softwares licenses 
getting deleted from the list. 
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Move Licenses 

To move licenses to selected site, 

1. Select the licenses to be moved to the site by enabling the check box. 
2. Select the site from the Move Licenses To check box. Click Move button to move the 

licenses. You can change site by selecting the site from the site option at the top left of the 
page.  
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Adding Software License 

1. Log in to ServiceDesk Plus application using your user name and password.  

2. Click the Assets tab in the header pane. This opens the Assets home page. 

3. Click Software title under Resources block on the left hand side of the page. Click Scanned 
Software link. This opens the scanned software list view page.   

4. Click on the software name to add license by enabling the check box. This opens the software 
details page. 

5. Click on Actions menu on the right hand side corner of the page. Click Add Software 
License option. This opens Add Software License page. 

6. Select the License Type from the combo box. Ex: Enterprise or Individual. Enterprise: Is for 
the entire organization (license for unlimited users), Individual: Is for each individual.(license 
for limited users). This is a mandatory field. 

Individual License 

1. Specify the Number of licenses in the given text field. This is a mandatory field. 

2. Specify the License Keys in the given text field. Say XBVJD,YCCYR,7DF28,JH2PX,MYT7M. 

 
Note: The license keys values should be in comma separated values format. 

3. Select the Vendor Name from the combo box. If the specified vendor is not available in the 
list click Add New link and specify the vendor details and save the changes.   

4. Select the Purchase Date from the calendar button. 

5. Select the Site name where the licensed software is installed, from the combo box.  

Enterprise License 

1. For enterprise license, specify the above mentioned details except for Number of licenses 
and Site Name. 

2. Click Save button to save the changes. You can see the license getting listed in the software 
license list view page. 
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Associating Software Minor Versions 

ManageEngine ServiceDesk Plus allows you to group minor versions of the software under major 
version.  
 
For e.g. A company buys AdobePhotoshop 7.0 with 4 licenses. The license is applicable for both 7.1 
and 7.2  versions and vice versa. In this case 7.0 is the major version and 7.1 and 7.2 are  the minor 
versions. The licenses purchased are the same for all the three versions. 

If Adobephotoshop 7.0 is installed in two different machines and 7.1 & 7.2 is installed in other two 
different machines. On scanning for Adobe Photoshop software before grouping, the ServiceDesk 
Plus shows the list as different single entries. The purchased licenses for the software would be as' 4 ' 
for the version 7.0 and ' 0 ' purchases for other versions (7.1 & 7.2). 
 
Using associate minor versions option you can group 7.1 & 7.2 minor versions under 7.0 major 
version. This shows the software list to be a single entry with the number of purchased licenses and 
installations. Thus helps you in avoiding individual entry for each version of the software. And also 
helps in easier management of the installed software for the assetmanager.    

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Click Software title under Resources block. Click Scanned Software link. This opens 
software list view page. 

4. Click the software name. This opens the software details page.   

5. Click on the Actions tab on the right hand side upper corner of the page. Click Associate 
Minor Versions option. This opens Associate minor versions page. 

6. Select the managed software (licensed) to be grouped of minor versions from the list. Click >> 
button to move the selected managed software to the Version Group list. By moving the 
selected managed software under Version Group, all the minor versions will be associated 
with the major version.         

7. Click Save button. You can see all the added minor versions getting displayed in the software 
details page under the title Software - All Versions.   
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Emailing Users 

ManageEngine ServiceDesk Plus has email options for the technicians to communicate to the users. 
Say, technicians communicate to the users for any event occurred or to get any information from 
users. 

To Email Users, 

1. Log in to ServiceDesk Plus application using your user name and password.  

2. Click the Assets tab in the header pane. This opens the Assets home page. 

3. Click Software under Resources block. Click Scanned Software link. This opens the 
software list view page.  

4. Click on the software name. This opens the software details page. 

5. Click on the Actions tab on the right side corner of the page-> click Email users option. This 
opens Email Users page.   

6. Specify the To email address in the given field. 

7. Specify the Subject and Description about the email in the respective fields. By default you 
have subject and description provided for the email.   

8. Click Send E-mail button to send the email to the user. 
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Adding Software Licenses 

ServiceDesk Plus helps you to manage software licenses installed across the enterprise. You can 
consolidate and manage all your software licenses from a single screen. ServiceDesk Plus will scan 
and automatically pickup license keys for Microsoft Windows and Microsoft Word. You can key-in all 
the licenses purchased earlier and track future purchase of software licenses through the Purchase 
module. 

To add software licenses for the existing software, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the assets home page. 

3. Click Software under Resources block on the left hand side of the page. This opens the 
software list view page. (OR) 
 

Click Quick Actions on the top left hand side of the page -> select 
Software License under Create New option. This opens Add Software License page. 

4. Select the Product Name from the combo box. Ex: Software. This is a mandatory field. 

If the product name is not available in the list select Add New link to add the product. specify 
the Product Name in the given field. This is a mandatory field. Choose the Managed software 
from the list and click >> button to move the selected software to the selected software list. 
This is also a mandatory field. Click Save to save the details. 

6. Specify the Number of licenses for the software in the given text field. This is a mandatory 
field. 

7. Specify the License Key(s) for the software in the given text box.  

8. Select the License Type from the combo box. Say Enterprise or individual. Enterprise: is for 
the entire organization (license for unlimited users) Individual: Is for the each 
individual.(license for limited users). This is a mandatory field. 

9. Select the Vendor Name from the combo box. If the specified vendor is not available in the 
list, then click Add New link and specify the vendor details and save the changes.   

10. Select the Purchase Date from the calendar button. 

11. If you would like to allocate the license to any site then select the site from the Allocate to list 
combo box.   

12. Click Save button to save the changes. You can see the license getting listed in the software 
license list view page. 

Editing Software Licenses 

1. From the Software license view list page, click the software license name to be edited. This 
opens the software details page. 

2. Click Edit tab on the right hand side of the page. (OR) Click on the Actions tab -> Click Edit 
option. This opens the Edit Software License page. 

3. Do the required changes and click the Update button to update the changes. Click Reset 
button to reset the changes. 
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Deleting Software Licenses 

1. From the software list view page, select the software licenses to be deleted by enabling the 
check box. 

2. Click Delete button. A confirmation dialog box pops-up, asking your confirmation on the 
delete operation. 

3. Click OK to proceed. You can see the software license deleted from the list.  
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Attach Document to Software Licenses 

To attach document to Software Licenses, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane, this opens the assets home page. 

3. Click the Software title under the Resources block on the left hand side of the page. Click 
Software licenses link, this opens the software licenses details page.    

4. Click the software license name to be attached with an document. This opens the software 
license details page.  

5. Click the Actions combo box -> select Attach Documents option from the list. This opens 
the Add/Remove Attachment pop up window. 

6. Click the Browse button to select a file. The maximum size of the attached file can be 10 MB. 

7. On selecting the file, click Attach File button to attach the document. 
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Viewing Service Packs 

ServiceDesk Plus helps in tracking all the service packs such as, hotfix, security update, installer etc 
on scanning the workstations.  

To view the Service Pack details, 

1. Log in to ServiceDesk Plus application using your user name and password.  
2. Click the Assets tab in the header pane. This opens the assets home page. 
3. Click Software title under Resources block. Click Service Packs link. This opens the service 

packs list view page. 
4. Click the service pack name to view the service pack details. This opens the service pack 

details page.  

In the service pack details page, you get the complete details about the service pack with number of 
installations and installation without service packs. It also provides information on the number of 
software the service pack applies to. 

Example: If the service pack Security Update for Windows XP is applicable for Microsoft 
Windows XP Professional and Microsoft Windows 2000 Professional then this software list would 
be displayed before the service pack installations list. 

 

 

 

 

Service Pack Installations 

Under this block you get the list of all service pack installations with the Workstation name, User 
name, Installed On and Installed By details. 

Software Installations without Service Packs   

Under this block you get the list of all software installations without the service packs with the 
Workstation name, User name, Software and Usage details. 
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Edit/Delete Service Packs 

To Edit Service Packs, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the Assets home page. 

3. Click the Software title under Resources block on the left hand side of the page. Click the 
Service Packs link. This opens the Service Packs list view page. 

4. Select the Service Pack name to be edited from the list. This opens the service pack details 
page.  

5. Click the Edit button on the right side corner of the page. This opens the Edit Service Pack 
page.  

Modify the Service Pack Name, Type and Description of the service pack. Also you can add 
software or service packs to the existing service pack list. To add to the list, select from the 
available list of software and move to the selected software using >> buttons.  

6. Click Save button to save the changes. 

To Delete Service Packs, 

1. Log in to ServiceDesk Plus application using your user name and password. 

2. Click the Assets tab in the header pane. This opens the Assets home page. 

3. Click the Software title under Resources block on the left hand side of the page. Click the 
Service Packs link. This opens the Service Packs list view page. 

4. Select the Service Packs from the list to be deleted. Click the Delete button. A pop up 
window pops up asking your confirmation on the delete operation. 

5. Click Ok to proceed. You can see the service packs deleted from the list.  
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Groups 

Manage Groups 

ManageEngine ServiceDesk Plus helps you to group assets based on asset properties.  You can 
group assets of users belonging to the same team and location.  Organizing assets based on groups 
gives you more fine-grained control and helps you manage assets efficiently. E.g. you can group 
assets based on OS, Service packs, Memory size and so on. When you are getting ready for 
migration you will be able to pinpoint assets with 256 MB RAM that need upgrade before rolling out 
Windows Vista. 

 

• Creating New Group 

• Removing Assets from a Group 

• Editing and Deleting Group 
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Creating New Group  

For easier channelization, users can be categorized under Static and Dynamic groups. 

Under Static group you define the group by listing its members. 

Under Dynamic group resources are grouped automatically based on certain criteria set by the 
administrator. 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Assets tab in the header pane. This opens the assets home page.  

3. Click Quick Actions link  menu on the top left side of the page. Select 
New Group under Asset - Groups from the list. [OR] 
 
Click Groups under Resources block on the left hand side of the page. Click New Group 
link. This opens the Create Group form.   

4. Specify the Group Name in the given text field. This is a mandatory field.   
5. Specify relevant information about the newly created group in the Description field. Say the 

group name is Test DL600 you can specify Test DL600 stands for Dell Lateral 600. 
6. Select any of the Group Type by enabling the radio button. Say Static or Dynamic group.  

Static Group: You define the group by listing its members. 
Dynamic Group: Resources are grouped automatically based on certain criteria. 

7. Click Save button to save the group. You can see the newly created group getting listed in the 
Create Group page.   

8. Once the group is created you have to add resources to the group.  

To add resources to the Static group, 

1. Select the filter criteria from the Showing combo box. Say for ex. You can select All Assets 
in Use.  

2. Specify the Search criteria in the given text field. 
3. Click Go button to list all resources based on the filter criteria. All the resources gets listed 

under Pick resources to add block. 
4. Select the resources to be added to the group by enabling the check box. 
5. Then click Add button to add resources to the group. You can see the selected resource 

added to the group, shown under Resources In group column.  

To add resources to the Dynamic Group, 

1. You define the filter criteria by selecting the Criteria and Conditions from the combo box. 
Select the Criteria from the combo box say for e.g. Resource Criteria or Workstation 
Criteria. 

2. Select Conditions from the combo box, which will be listed based on the selected criteria. 
3. Click Choose button to choose the resource or workstation criteria listed based on the criteria 

you have selected. For example: If you have selected resource criteria as Product Type and 
conditions as is then on clicking choose button you will get the list of all product types say 
scanners, keyboard, printers etc. 

4. Select any one of the Match Criteria by selecting either of the radio buttons. Say (And) or 
(OR) criteria. 

5. Select any of the listed Product Type and click Ok buttons to add to the group. You can see 
the group criteria getting listed. 

6. Click Save and View group button to view the list of all resources based on the filter criteria.  
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Removing Assets from Group 

To remove the existing resources from the group,  

1. From the Group list view page, select the resource name from the list by enabling the 
check box under the Resources in-group column. 

2. Click Remove from Group button to remove the resources. You can see the 
selected resource deleted from the list.  
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Editing & Deleting Groups 

To Edit Groups, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Assets tab in the header pane. This opens the Assets home page. 
3. Click Groups under Resources block on the left hand side of the page. Click Manage 

Groups link.  
4. From the Manage Group list view page, click Edit link. This opens Edit Group page.  
5. In the Edit Group form, the Group Type is in non editable text. Do the required changes and 

click Save.  

To Delete Groups,  

1. From the Manage Group list view page, click the corresponding Delete link to be deleted on 
the right hand side of the page. 

2. A pop up window pops up to get your confirmation on the delete operation. Click OK to 
proceed. You can see the group deleted from the list.    
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Purchase 

The Purchase module streamlines the procurement of required components and allows you to add 
them as unassigned assets. The Purchase module is tightly integrated with the Inventory. You can 
configure the vendor-related information and the products supplied by those vendors and their price 
quotes in ServiceDesk Plus. This information helps in making the choice of vendors while generating 
the Purchase Order (PO) by comparing the pricing of each vendor. The purchase process starts with 
a purchase request and is completed when the requested component or item has been purchased 
and reaches the requester of the purchase request. Below is the workflow that details the various 
steps involved in a purchase process. 

 

 

To reach the purchase module, log in to the ServiceDesk Plus application using your user name and 
password and click the Purchase tab in the header pane.  
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About Purchase Order 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click on Purchase tab in the header pane. This brings up the Purchase Orders list view page. 

By default the status of the Purchase Order will be 'All POs'.  
3. Select the corresponding filter option from the Filter Showing combo box. You can view 

purchase orders with different status levels using filters. They are, 

• All POs  
All Purchase Orders irrespective of the status will be listed. This is the default status 
on opening the purchase order list view.  

• Open POs 
The newly added Purchase Order will fall under this category. These POs are not 
submitted for approval. 

• POs Pending Approval  
The Purchase Orders which are submitted and waiting for approval from the 
purchase order approvers will be listed under this category.  

• Approved POs 
All the Purchase Orders which are approved but the purchase items are not yet 
received will be listed under this category.  

• Rejected POs 
All the Purchase Orders rejected by the purchase order approver gets listed under 
this category.  

• Partially Received POs 
Purchase Orders, which are partly received from the vendor, will be listed under this 
category. 

• Closed POs 
The Purchase Order gets listed under this category when the purchased items are 
fully received from the vendor.   

• Overdue POs 
Purchase orders not delivered and have exceeded the delivery date will be listed 
under this category.  

• POs due in next 7 days 
Outstanding Purchase Orders, expiring in next 7 days will be listed under this 
category.  

• POs due in next 30 days 
Outstanding Purchase Orders, expiring in next 30 days will be listed under this 
category. 

• Searched POs 
While searching for the Purchase Order under Search, the list of Searched POs will 
fall under this category. 
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Creating a New Purchase Order 

To create a new purchase order,  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. This opens the purchase order list view page.  
3. Click the New Purchase Order button available in the Purchase Order block.(OR) 

Click Quick Actions button in the home page --> click Purchase Order 

option under Create New . This 
opens the Add Purchase Order form. By default, the status of the Purchase Order while 
adding will be New PO, after which the status changes to Open. 

4. Specify the Order No in the given field. For ex: 140. This is mandatory field.  
5. Enter the PO Name say, Purchase of monitors, and the Required By Date by invoking the 

calender icon  . The PO name in mandatory field. 
6. Select the Vendor Name from the combo box. This is mandatory field. If the specified vendor 

name is not available in the list, click Add New link adjacent to the Vendor field and 
specify the vendor details like Name, Contact Information and Contact Person of the vendor. 
Click Save button to save the details. 

7. Select the Shipping and Billing Address from the combo box. You can also add the 
shipping and billing address by clicking the Add New link  . Enter relevant details in the 
pop up window. 

8. On selecting the Vendor, the corresponding Product Type and Products gets populated in 
the combo box. Select the Product type and the Products, the items gets listed one below the 
other along with the price details.  
 
You can also add new product to the specified vendor by invoking the icon  beside the 
product combo box. This opens the Products Details pop up window. Specify the Product 
Name and the Product Type of the item which are mandatory fields. Specify the Part No and 
the Price of the item in the given fields. Click Save, the item gets added to the list.   

9. By default, the check box beside the item will be enabled. Specify the price of the item if it is 
not mentioned and the quantity of items to be ordered in the text box. The cost calculations of 
the item changes accordingly to the number of items purchased. 

10. Under the general information block, select the Cost Center and the GL Code from the 
combo box. By default, the Requested By will be the name of the technician creating the PO. 
The Created Date and the Owner is in non editable text.  

11. Enter the description for the PO or any other information that you wish to add in the Remarks 
field. 

12. If there are any specific terms associated with the PO, enter the same in the Terms field. 
13. If you would like to attach a file then click Attach file button. 
14. Select the Approvers of the purchase order from the PO Approver(s) list pop window by 

clicking the icon .  
15. Specify the Signing Authority of the company in the respective field. 
16. Click Save the Purchase Order button to save the details. 
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Viewing a Purchase Order 

To view purchase orders,  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. This displays the list of All POs, by default. If you 

want to see a PO that is in any other state, then you need to choose corresponding state from 
the Filter Showing combo box.  

3. From the list of POs, click the PO Name link of the PO that you wish to view. 

The View Purchase Order displays the PO details in the same way as in create PO form. The PO 
header has the name of your organization, logo, and the mailing address. The Order No, PO Name, 
Required By date and the status can be viewed at the right hand side of the header.  

Next, consists of the details about the vendor, such as the vendor's name, address, phone number, 
fax, and the name of the contact person at the vendor location. Adjacent to this is the billing address 
and shipping address to which the invoice needs to sent and the assets needs to be delivered 
respectively. 

Finally, the items are listed along with the cost calculations. The item table lists the item name, part 
no, price ($) per quantity, quantity ordered, and the total cost for the quantity ordered. Below this 
table, the cost details for shipping and sales tax are displayed and the final total cost of the PO is also 
displayed.  

The General Information consists of, the Created Date, Owner of the PO, PO requested by, the cost 
center and the GL Code.  

If there were any remarks provided for the PO while creating it, they are displayed at the bottom, 
along with the terms of the PO, attachments and the PO Approver(s) List. The footer consists of the 
signing authority and Place.  

In case of closed POs in the view PO details page, you can also view the received items beside the 
ordered no of items in the Item List block.   
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Editing a Purchase Order 

To edit purchase orders,  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. This displays the list of All POs, by default. If you 

want to see a PO that is in any other state, then you need to choose corresponding state from 
the Filter Showing combo box.  

3. From the list of POs, click the PO # of the PO that you wish to edit. 
4. Click Actions button --> Edit Purchase Order. The edit PO form is similar to the create new 

PO form where you can edit the PO details. Edit the entries and proceed as elaborated in 
Creating a New Purchase Order section. 

5. Click Save Purchase Order to save the changes and sent the PO for approval to the 
concerned approvers. 
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PO Approval Process 

All purchase orders that are created are grouped under POs Pending Approval, if the approver is 
selected in the approvers list field. You need to approve the PO first before you can send the same to 
the vendor, receive items, and other such actions on the PO items. The PO approval process is 
initiated with a request for approval sent to the concerned authority and depending on the decision 
taken by the personnel to approve or reject the PO, the other operations can be performed on the PO. 

Submit PO for Approval 

To submit PO for approval,  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. This displays the list of POs Pending Approval, 

by default.  
3. From the list of POs, click the PO # of the PO that you wish to submit for approval. 
4. Click Submit for Approval link from the tasks block. The Submit for Approval dialog pops up. 
5. Select the check box Send mail notification, available just below the PO # that is displayed. 

The To and Subject fields will drop down. 
6. Enter the To mail ID. If needed you can modify the subject content manually, else you can 

change the same from the Notification Rules email template. 
7. Type in the message text for the mail notification in the Description field.  
8. Click Save. 

The mail notification is sent to the person who was addressed in the To field of the notification. The 
mail contains the link to the specific PO which needs approval. On clicking the link, it leads you to the 
login screen, where on providing the proper credentials, the PO awaiting approval opens. 

Approve / Reject PO 

Once a PO is submitted for approval, a mail notification is sent to the concerned authority requesting 
the approval for the PO along with the link to the PO.  

1. Click the link to open the PO. 
2. Log in to ServiceDesk Plus application using your user name and password or the 

administrator user name and password. The PO is displayed. 
3. You can choose to make changes in the PO if you wish to. Refer to Editing a PO section for 

more details. Or else, click Approve this PO link from the tasks block. The Approve this PO 
dialog pops up where you can enter your comments in the Description field and click Save. If 
you wish to send a mail notification, then select the check box Send mail notification, 
available just below the PO # that is displayed and enter the To address in the field provided. 

4. If you wish to reject the PO, then click Reject this PO link from the tasks block. The Reject this 
PO dialog pops up where you can enter your comments in the Description field and click 
Save. If you wish to send a mail notification, then select the check box Send mail 
notification, available just below the PO # that is displayed and enter the To address in the 
field provided. 

The POs that have been approved will be grouped under the Approved POs state while all the POs 
that have been rejected will be moved to Rejected POs status. From the Rejected POs state, you can 
either delete the PO completely from the system or reopen it for approval once again. You can also 
edit the POs that are in the rejected status. 
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Receiving PO Items 

Once the PO is approved, it is sent to the vendor to receive the ordered items. The ordered items can 
be received either partially or completely from the vendor. In both the cases you can have the receipt 
of the received items. On receiving the partial items from the vendor the purchase order can be 
marked as Partially Received and moved under Partially Received POs. And on receiving the 
complete items from the vendor, the purchase order can be moved under Closed POs. 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. This opens the Purchase Order list view page. 

To mark partially or completely receive items, 

1. From the Purchase Order list view page select the corresponding filter option from the Filter 
Showing combo box. By default, the list of All POs will be displayed. 

2. Select Approved POs from the Filter Showing combo box. Click the PO # Name for the 
received items. This opens View Purchase Order page. 

3. Click on the Actions tab and click Receive Items. The Receive Items dialog pops up. 
4. Enable the check box beside each of the received items. If only a part of the ordered items 

are delivered, then click the quantity of the item which is partially received and enter the 
quantities that have been received as shown below, 
 

 
  

5. Click Receive Items button. This updates the PO with the Received Quantity value and 
moves the PO under Partially Received POs. 

When a future shipment arrives, you can follow the above process to update the quantity of items that 
have been delivered. Once all the items have been received, the PO moves to the closed status. 

All the received items from the PO will be added as resources automatically. And the resources that 
are created from a particular PO will be associated to that particular PO. 

Associated Assets 

The purchased items received can be viewed and associated to groups.  

1. Click Actions tab -> Associated Assets link option. This will display all the assets that were 
created from the PO. 

2. Associate the assets to the group by enabling the check box beside the asset. Click Actions 
button --> Add to Group. This opens the Add Resource(s) to pop up window.  

3. Select the group from the existing list of groups or enable the radio button beside New 
Group, to add a new group. The asset gets associated to the corresponding group.  
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Printing a Purchase Order 

To print a purchase order, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. This displays the list of All POs , by default. If you 

want to print the POs from a different status, then select the status from the Filter Showing 
drop down list. 

3. Click the PO # of the purchase order which you wish to print. This opens the View Purchase 
order page. 

4. Click Actions button on the right of the task block --> Print Preview option. The Purchase 
Order details are displayed in a printable format in a pop-up window. 

5. Click Ctrl + P keys (OR) click Print from the browser menu to print the purchase order details. 
6. Set the required options and click Ok. 
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Deleting a Purchase Order 

To delete purchase orders, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. This displays the list of All POs, by default. If you 

want to delete PO that is in any other state, then you need to choose corresponding state 
from the Filter Showing combo box.  

3. Enable the check box beside the PO # of the purchase order that you wish to delete, in the list 
view. 

4. Click Delete button. The PO gets deleted from the available list. 

You can also delete individual POs by clicking the PO # and entering the PO details view. Click 
Actions button --> Delete Purchase Order option.    
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E-mailing the PO Owner 

When some unexpected events happen, the owner of the PO would want to be notified of them. For 
example, when the purchased items have not been delivered even beyond the required date, the PO 
owner must be notified of it, so that he can take necessary steps. ServiceDesk allows you to notify the 
owner of the PO by attaching the PO to the mail. 

To e-mail the PO owner, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click Purchase tab in the header pane. This opens the purchase order list view page. 
3. In the list of POs displayed, click the Purchase Order ID for which the e-mail notification 

needs to be sent. If you want to send an email to the owner of a PO in any other state, then 
choose the corresponding option from the Filter Showing combo box. 

4. Click Actions button on the right side of the page --> click Email the Owner under the notify 

block  
5. A Send Notification form is opened in a separate window with the To address filled with the 

PO owner's e-mail ID. The Subject reads as Notification for Purchase Order id <number>.  
6. If you want to inform anyone else about the PO details, then you can add their e-mail ID in the 

CC field. 
7. Enter the mail content in the Description field.  
8. You can attach any relevant documents by clicking Attach File button.  
9. Click Send. A message is displayed saying that the e-mail has been sent.  
10. Click Close to close the window. 
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E-mailing the Vendor 

On approving the Purchase Order by the concern technicians, an e-mail notification is sent to the 
vendor on the purchase of the items.  

To e-mail the vendor,  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Purchase tab in the header pane. 
3. In the list of outstanding POs displayed, click the Purchase Order ID for which the e-mail 

needs to be sent. If you wish to notify a vendor of a purchase order that is in a different state, 
then from the Filter Showing combo box, select the corresponding filter option, and click the 
purchase order ID that you need. 

4. On the right side, under the tasks block, click E-mail the Vendor. 
5. A Send Notification form is opened in a separate window with the To address filled with the 

vendor's e-mail ID. The Subject reads as Notification for Purchase Order id <number>.  
6. If you want to send the same notification to anyone else, then add their e-mail ID in the CC 

field. 
7. Enter the mail content in the Description field.  
8. Click Submit. A message is displayed saying that the e-mail has been sent.  
9. Click Close to close the window. 

  
 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 232

Searching in Purchase 

You can search for purchase orders (POs) with the search in purchase option of ServiceDesk Plus 
application.  

To search for POs, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. In the left side, in the search block, choose Purchase from the Search in combo box. If you 

are in the purchase section, then by default, purchase is selected. 
3. In the Enter Keyword field, type in your search string. 
4. Click Go or press the Enter key in your keyboard. The search results display all the purchase 

orders that match the search string. 
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Purchase Default Values 

You can set the Purchase Default Values such as the default currency, default tax rate, billing & 
shipping address, and terms & conditions of the purchase. To add purchase default values,  

1. Login to ServiceDesk Plus application using your user name and password. 
2. Click on the Admin tab in the header pane. 

3. In the Purchase/ Contracts block, click Purchase - Default Values icon . This opens the 
Purchase Default Values page. 

Adding Purchase Default Values  

1. Specify the Default Currency (For example, USD or $). This will be displayed in all 
the purchase orders (PO) generated and in any place where money is being used. 

2. Specify the Default Tax Rate (%) in the given text field. This will be the tax rate, used 
for calculating the sales tax in all the POs generated. If you wish to have a different 
tax rate for any specific PO, then enter the new rate while creating that particular PO. 

3. Specify the Signing Authority's name in the given text field. 
4. If you wish to have tax shipping as default value, then select the check box beside 

Tax Shipping field. 
5. Select the Shipping Address to which the PO items will be shipped and the Billing 

Address to which the invoice and bill needs to be sent from the combo box. 
6. Select the Cost Center department from the combo box. 
7. Select the Approver(s) name from the list.  
8. Enter the PO Terms & Remarks in the given text field. 
9. Specify the PO# Start From number in the text field. 
10. Save the settings. 
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Purchase Order Additional Fields 

You can configure purchase additional fields that need to appear in the new purchase order form. 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Admin tab in the header pane.  
3. In the Purchase/Contracts management block, click the Purchase - Additional Fields icon 

. This opens the Purchase - Additional Fields page. You can add four types of fields in the 
form: text, numeric, date/time and cost.  

4. To add the text fields, enter the label name in the form fields below the Label heading. If 
required, enter the description for the field. 

5. You can choose the type of text field that you wish to add by selecting the radio buttons.  
• Single-line text field: Allows you to add just a text field in the new purchase order 

form. 
• Multi-line text field: Allows you to add a text box where a lengthy description can be 

added in the new purchase order form. 
• Pick List: Allows you to add a combo box in the new purchase order form. Contents 

of the combo box can be added by specifying it in the text field and adding it to the 
list. This gives you an option to select from the list . In all the three cases, you can 
add default values for the text field in the space provided for the field.  

To add items for the pick list, enter the value in the text filed and click Add Item. To select the 
default selected value of the list, click on the value in the list. 

6. To add numeric fields, click the Numeric tab and then enter the label name in the form fields 
provided for the same. 

7. To add date/time fields, click the Date/Time tab and enter the required details. 
8. To add the cost field, click the Cost tab. You have two cost type fields, Add cost (for cost 

addition) and Subtract cost (for cost subtraction). Click the corresponding radio button to 
select the cost fields.  

9. Click Save. A message for successful creation of the fields is displayed. 

These fields (except for cost) appear under the General Information in the New Purchase Order 
form. To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete 
the label names that you wish to remove from the fields of the form and click Save. The respective 
fields that you deleted will be removed from the New Problem form.   
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General Ledger Code (GL Code) 

You can add all the general ledger codes using this option. A general ledger account will have a 
specific code for all transactions in the organization. On specifying the GL code you will be able to 
track the necessary information for a specific transaction.  

Example: If you like to know all your company's IT purchases for the November month 2007, then 
you can specify the GL code for IT purchases in november 2007 and get the details. 

1. Login in to ServiceDesk Plus application using your user name and password. 
2. Click on the Admin tab in the header pane. 

3. In the Purchase/Contracts management block, click GL Code icon .  This opens the GL 
Code List page. 

To Add GL Code 

1. Click the New GL Code link on the right hand side of the page. This opens the GL Code 
Details page. 

2. Specify the GL Code in the given fields. This is mandatory field. 
3. Specify any relevant information about the GL Code in the Description field. 
4. Click Add GL Code button to add the code to the GL Code list below. 

To Edit GL Code 

1. Click the Edit icon on the left side of the GL code. This opens the edit GL code page. 
2. Modify the value and save the details. 
3. Click Add GL Code button. 

To Delete GL Code 

1. Click the Delete icon  on the left side of the GL code.  
2. A dialog box pops up asking your confirmation on the delete process. Click Ok to proceed. 

You can see the GL Code deleted from the list. 
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Cost Centre 

Individual department or a group of department makes a Cost center. These cost centers are 
budgeted and tracked for the cost, income and allocation. These cost centers will be associated with 
the purchase order while making a new purchase in your organization. 

To add cost centre, 

1. Login in to ServiceDesk Plus application using your user name and password. 
2. Click on the Admin tab in the header pane. 

3. Click Cost Centre icon  under the Purchase/ Contract Management block. This opens the 
Cost Centre List view page. 

4. Click New Cost Centre link on the right hand side of the page. This opens Cost Centre 
Details page. 

5. Specify the Cost Centre Code in the given text field. This is a mandatory field. 
6. Specify the Name of the cost centre in the given text field. This is a mandatory field. 
7. Select the Department from the list. This is a mandatory field. 
8. Specify the Owner name in the given text field. This is a mandatory field. 
9. Specify the Description about the cost centre in the given text field. 
10. Click Add Cost Center button to add the cost center.  
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Notification Rules 

Notification Rules are helpful when an event has to be notified to the technicians.  

For ex. When Purchase order is overdue or Audit changes during discovery or Software under 
Compliance during discovery or when prohibited software is identified during discovery.  

When the above-mentioned situations are managed suitably, it not only helps technicians in efficient 
management of the assets but also brings in cost savings to the organization.  

Enabling Notification Rules 

1. Click on Admin tab -> Click Notification Rules icon  under the Asset Management block. 
This opens Notification Rules page. 

2. To set the notification rules select the relevant notification rules by enabling the check box. 
These notification rules are self-explanatory. 

3. Except for Purchase order Overdue, You can assign technicians to notify of the fault for all 
the other notification rules. 

4. To assign technician select Choose button, this brings up the Choose Technician Name 
page. 

5. Select as many as technicians from the list using ctrl or shift keys. 
6. Click OK button to save. You can see the selected technicians displayed in the choose 

technicians grayed out field. 
7. Click Save button to save the set notification rules. The notification to the administrator or to 

the technicians will be generally sent through email. 

Customize Message Template  

1. You have default message template for Purchase Order and Contracts. To customize email 
templates as per your requirement, 

2. In the Notification Rules page -> under Customize Message Template, there are two 
message templates available one for Purchase Order & other for Contracts.      

3. Click Email Template link beside the corresponding module. This opens Message Template 
page. In the Message Template edit form; the Notification Type is a non-editable mandatory 
field. 

4. You can change the Subject provided for the notification type. 
5. In the Message block, to add content variables that need to be a part of the notification, select 

the fields from the Database fields list and click >> button to move the database fields list to 
the Notification fields list. If you want to remove the fields from the Notification Fields list, 
then select the same and click << button. 

6. To order Notification Fields you can select Forward arrow or backward arrow button.  
7. On completing the modifications, click Save button to save the settings. 
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Contracts 

Every organization would maintain an annual maintenance contract with third-party vendors to 
maintain its infrastructure and function without any major downtime due to bad maintenance of the 
assets owned by it. ManageEngine ServiceDesk Plus gives you a provision to track such contract 
details, its date of commencement, and date of expiry, alert you with a reminder in advance about the 
expiry of the contract, the cost incurred for the purchase and renewal of the contract, the kind of 
maintenance support provided by the third party vendor, and the third party vendor name with whom 
the contract has been signed. Any other related documents to the contract can also be maintained 
along with these details as attachments to the contract. To open the contracts module, log in to the 
ServiceDesk Plus application using your user name and password and click the Contracts tab in the 
header pane. 

 

• About Contracts  

• Creating a New Contract 

• Viewing Contract 

• Editing and Deleting Contract 

• Viewing Contract Owner Details 

• Renewing Contract 

• Print Preview of Contract 

• E-mailing the Contract Owner 

• E-mailing the Vendor 

• Search Contracts 
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About Contracts 

1. Click on Contracts Tab. This brings up the Contracts view list page. By default, the list of 
Open Contracts will be displayed. 

2. Select the corresponding filter option from the Filter Showing combo box. You can view the 
contracts with different status levels using filters. They are, 

• Open Contracts 
Contracts which are active and yet to get expired comes under this category. 

• All Expired Contracts 
All the expired contracts will be listed under this category. 

• Contracts expired in last 30 days 
Contracts which expired in the last 30 days gets listed under this category 

• Contracts expiring in next 7 days 
Contracts, which will be expiring in next 7 days, will b listed under this category. 

• Contracts expiring in next 30 days 
Contracts, which will be expiring in next 30 days, will be listed under this category.  
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Creating a New Contract 

To create a new contract for asset,  

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click the Contract tab in the header pane. This opens the contracts list view page. 

3. Click the New Contract button in the contract index page. (OR) 
 

Click Quick Actions link  in the home page -> Click Contracts option 
under Create New. This opens the Add Contract form.  This form has three major sections: 
Contract Details, Contract Rules, and Notification Rules. 

4. Specify a name for the contract in the Contract Name field. This is mandatory field. 

5. Enter relevant Description for the contract in the respective text field. 

6. Select the Maintenance Vendor from the combo box listing all the vendor names available. 
This is mandatory field. If the vendor is not listed, then click Add New Vendor button beside 
the combo box. The Add New Vendor window pops up as shown below, 

 
  

1. Specify the name of the vendor in the given field. This is mandatory field. 

2. Enter a brief description about the vendor in the respective field. 

3. Specify the Contact Person in the given field. 

4. Click Save. The added vendor is selected and is displayed in the combo box. 
If you do not wish to add a new vendor then click Close.  

7. In the Support field below it, enter the details regarding the kind of support that will be 
provided by the vendor to you.  
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8. You can add files that are related to the contract and are necessary to be maintained and 
referred to along with the contract information. Click Attach File button. The Attach File 
window pops up as shown below, 

 

1. Click the Browse button to open the file selector window. 

2. Select the file that you wish to add and click the Attach File button. The 
selected file is added and is displayed in the same window just below the file 
selection field. The total size of the attachments should not exceed 10 MB. 

3. The attached file gets listed along with the File name and the size. The file 
can be deleted on clicking the Delete icon  beside the file name.  

9. In the Contract Rules section, you need to choose the assets that are to be maintained 
under this contract and mention the maintenance period and maintenance cost. Select the 
Assets that are covered under the contracts from the Maintained Assets list. 

10. To add more resources to the list, click Select Resources for this contract link. This opens 
Select Resources page. 

1. Specify the Resource Name or Product Type or Product in the search field. 

2. Click Search button to get the result. Select the required resources by 
enabling the check box. 

3. Click Add Items button to add the selected items. 

4. Click View Resources>> button to view the selected resources. 

5. Click Add Resources to Contract button to add resources to the Maintained 
Assets list. 

6. Click Remove Selected Resources icon to remove selected resources from 
the list.  

11. The Active period of the contract is a mandatory field where you need to enter the From and 
To date of the contract period. Choose the dates from the calender that can be invoked by 
clicking the icon.  

12. Enter the maintenance cost in terms of $ in the Maintenance Cost field. 

13. Select the check box beside Enable Notification. This displays the notification rules 
information. Here you need to select the technician who needs to be notified about the expiry 
of the contract and how many days before the expiry, the notification needs to be sent.  

14. Click Save. 
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Viewing a Contract 

To view a contract and its details, 

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is 
displayed.  

3. Select the status of the contract you wish to view using the Filter Showing combo box.  

4. Click the Contract Name link that you wish to view. This opens the View contract page.  

The Contract ID is a unique ID given to the contract during the time of its creation. This is system 
generated and is used to identify and track the contract uniquely. The contract details are grouped 
under three major heads: Contract Details, Contract Rules, and Notification Rules. Based on the 
entries made in the contract during the time of its creation, the details will be displayed in the 
respective section.  

In the Contract Rules block, the assets that are maintained under the current contract are displayed. 
These assets are hyperlink to display their respective details. Click any of the asset names to open 
the Edit Asset form. Here you can edit the required information and update the same. To know more 
on editing assets, refer to the Editing Asset Details section.  
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Editing and Deleting Contracts 

Editing Contract 

To edit a contract,  

1. Log in to the ServiceDesk Plus application using your user name and password or 
using admin login. 

2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is 
displayed.  

3. Select the status of the contract you wish to edit using the Filter Showing combo box. 
  

4. Click the Contract Name link that you wish to edit. This opens the View Contract 
page. 

5. Click the Edit button on the right hand side of the page. (OR)  
 
Click Actions combo box - > Edit Contract option. This opens the Edit Contract 
form.   

6. The existing details of the contract is displayed. As the contract ID is a system 
generated ID, it is not available in the edit contract form. You can edit all the other 
details. 

7. Once you are done with editing, click Save. If you entered wrong information and 
want to know what the initial values were, then instead of Save, click Reset.  

Deleting Contract 

To delete contract, 

1. Log in to the ServiceDesk Plus application using your user name and password or 
using admin login. 

2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is 
displayed.  

3. Select the status of the contract you wish to delete using the Filter Showing combo 
box.   

4. Click Delete on enabling the check box beside the contract.  
5. A pop up window confirming the delete operation appears. Click Ok to proceed. The 

contract will be deleted from the list.  
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Viewing Contract Owner Details 

By default, the owner of a contract is the person who enters the contract details into the application.  

To view the owner details, 

1. Log in to the ServiceDesk Plus application using your user name and password or using 
admin login. 

2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is 
displayed.  

3. Click the Contract Name link to view the contract owner details. This opens the View 
Contract details page.  

4. Click Actions combo box - > View Owner Details option. A pop up window containing the 
owner details such as, name, employee id, designation, contact information appears.  

5. Click Close to close the pop-up. 
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Renewing a Contract 

To renew a contract,  

1. Log in to the ServiceDesk Plus application using your user name and password or using 
admin login. 

2. Click the Contracts tab in the header pane. By default, the list of Open contracts is 
displayed. Select the status of the contract which you wish to renew using the Filter Showing 
combo box.   

3. Click the Contract Name link that you wish to renew. This opens the View Contract page. 
4. Click Actions combo box -> Renew Contract option. The Renew Contract form is displayed 

with the contract rules of the original contract. As the contract ID is a system generated ID, it 
is not available in the renew contract form. The contract name is appended with the word 
renewed. You can edit the name but ensure that the contract name is unique and does not 
have the old name.  

5. Enter the Description for the contract.  
6. Choose the maintenance vendor from the combo box. If the vendor is not listed, then click 

Add new link beside the combo box. The Vendor Details page pops up. Specify the name of 
the vendor, description, and the contact person name in the pop-up window. Save the 
changes. 

7. If you have any information on the type of support, enter the same in the Support text area.  
8. If there are any documents that you wish to attach to the contract, click the Attach File button. 

The Attach File window pops up.  
1. Click the Browse button to open the file selector window. 
2. Select the file that you wish to add and click the Attach File button. The selected file 

is added and gets listed along with the File Name and size. If you wish to delete any 
of the file then click the delete icon  beside the file. The total size of the 
attachments should not exceed 10 MB. 

9. Select the Assets that are covered under the contracts from the Maintained Assets list. To 
add more resources to the list,  

1. Click Select Resources link. This opens Select Resources page. 
2. Specify the Resource Name or Product Type or Product in the Search field. 
3. Click Search button to get the result.  
4. Select the required resources by enabling the check box.  
5. Click Add Items button to add the selected items.  
6. Click View Resources>> button to view the selected resources. 
7. Click Add Resources to Contract button to add resources to the Maintained Assets 

list. 
10. The Active period of the contract is a mandatory field where you need to enter the From and 

To date of the contract period. Choose the dates from the calender that can be invoked by 
clicking the icon.  

11. Enter the maintenance cost in terms of $ in the Maintenance Cost field. 
12. Select Enable Notification option by enabling the check box. On enabling you get the User 

list &  Notified User list. To notify users regarding contract expiry select the user from the 
User list and click forward >> button to move the user to the Notified User List. Specify the 
days before which the information has to be notified in the Notify before field.  

13. Select the check box, Disable all notifications for the old contract, to disable notifications 
of the old contract. 

14. Click Save. 
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Print Preview of Contract 

To print a contract,  

1. Log in to the ServiceDesk Plus application using your user name and password or using 
admin login. 

2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is 
displayed.  

3. Select the corresponding filter option from the Filter Showing combo box.  

4. Click the Contract Name that you wish to print. This opens the view contract page. 

5. Click Actions combo box -> click Print Preview option. The contract details are displayed in a 
printable format in a pop-up window. 

6. Click the Print option to print the contract details. 

7. Set the required options and click OK. 
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E-mailing the Contract Owner 

By default, the owner of a contract is the person who enters the contract details into the application.  

To send an e-mail to the owner, 

1. Log in to the ServiceDesk Plus application using your user name and password or using 
admin login. 

2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is 
displayed in the contract list view page.  

3. Click the Contract Name link of the contract you wish to e-mail the owner. This opens the 
view contract page. 

4. Click Actions combo box -> E-mail the Owner option.  A Send Notification window opens 
with the owner's e-mail ID in the To field. The subject reads as Notification for Contract ID 
<number>. 

5. If you wish to notify about the contents of the e-mail to anyone else also, then enter their e-
mail ID in the CC field. 

6. Enter the e-mail content in the Description area. 

7. Click Send. A message is displayed saying that the e-mail has been sent successfully. 

8. Click Close. 
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E-mailing the Vendor 

To notify the vendor,  

1. Log in to the ServiceDesk Plus application using your user name and password or using 
admin login. 

2. Click the Contracts tab in the header pane. By default, the list of Open contracts are 
displayed in the contract list view page.  

3. Click the Contract Name link of the contract you wish to notify the vendor. This opens the 
View Contract page. 

4. Click Actions combo box - > click E-mail the Vendor option. A Send Notification window 
opens with the vendor's e-mail ID in the To field. The subject reads as Notification for 
Contract ID <number>.  

5. If you want to send the same notification to anyone else, then add their e-mail ID in the CC 
field. 

6. Enter the e-mail content in the Description area. 

7. Click Send. A message is displayed saying that the e-mail has been sent successfully. 

8. Click Close. 
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Searching Contracts 

You can search for contracts with the Search in contracts option of the ServiceDesk Plus application.  

To search for contracts, 

1. Log in to the ServiceDesk Plus application using your user name and password or using 
admin login. 

2. In the search block on the left hand side of the page, choose Contract from the Search in 
combo box. If you are in contracts section, then by default, contract is selected. 

3. In the Enter Keyword field, type in your search string. 

4. Click Go or press the Enter key in your keyboard. The search result displays all contracts that 
match the search string. 

You can search for contracts based on the contract name, asset names added in the contract, and 
owner of the contract. 
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Solutions 

The ManageEngine ServiceDesk Plus application provides a facility to record the solutions for the 
received requests. The recorded solutions function as a knowledge base of solutions. Thus, when you 
receive a request, refer to the recorded solutions and solve it. This reduces the turnaround time in 
attending to the requests generated by the requesters and closing the same. 

All requesters and technicians who have permissions to view the solutions module can access this 
section of the application. The ServiceDesk Plus administrator can assign access privileges to the 
various technicians for the solutions section. This access privilege can vary from just view only 
privilege to full control privilege. For setting the access privileges to technicians, refer to the 
Configuring Technicians and Configuring Roles sections. Moreover, new technicians joining the 
organization can browse through these recorded solutions to have an idea of the frequently resolved 
problems. 

You can access the approved solutions even without logging in to the application, but will be able to 
view only those solutions that are published in the Self Service Portal. To access the knowledge base 
directly without having to login to the application, type the URL provided below in the address bar of 
the browser: 

http://<server name>:<port number>/sd/SolutionsHome.sd 

where, the <server name> is the name of the server where ServiceDesk Plus is installed and <port 
number> is the port where the application is running. 
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About Solutions 

1. Click on the Solutions tab. This brings up the Solutions view list page. By default, the list of 
All Solutions will be displayed. 

2. Select the corresponding filter option from the Filter Showing combo box. You can view the 
solutions with different status levels using filters. They are, 

• All Solutions 
All the solutions irrespective of the status can be viewed under this category. 

• Approved Solutions 
All the approved solutions will be listed under this category. 

• Approval Pending Solutions 
The Solutions which are sent for approval gets listed under this category. 

• Unapproved Solutions  
The Solutions which are not approved and has to be sent for approval will be listed 
under this category. 

• Rejected Solutions 
All the rejected solutions will be listed under this category. 
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Adding a New Solution 

The solutions module is a knowledge base with resolutions for various problems encountered by your 
help desk team. It can have solutions grouped under various topics for ease of locating the 
corresponding solution. You can add new solutions to the existing knowledge base.  

To add new solutions 

1. Log in to the ServiceDesk Plus application using your user name and password. 

2. Click the Solutions tab in the header pane. This opens the solutions list view page. By 
default, the list of all solutions gets displayed. Click New Solution button.(OR) Click Quick 
Actions -> Solutions under the Create New block. This opens the New Solutions page. The 
title, contents and the topics fields are mandatory fields.  

3. Enter a title for the solution you wish to add in the given text field. This can be a summary of 
the complete solution in one line that will exactly tell what the solution is all about. 

4. Enter the complete solution in the Contents text field.  

5. If this solution requires any additional files to support the article, then you can attach the same 
by clicking Attach File button. The Attach File window pops up as shown below, 

 

i.  Click Browse and select a file from the file chooser window. Click Open.  

ii. Click Attach File button. The attached file gets listed along with its size.   

iii. Repeat steps 1 and 2  to attach another file.  

1. The topic field is a combo box that lists all the available topics and sub-topics. Select the 
topic in which you wish to add the current solution. 

2. The keywords are optional, but the presence of a keyword for the solution will help in 
improving the search capability and will provide accurate search results. While entering 
multiple keywords, separate them with comma. 

3. To publish the solution in the self-service portal also, select the check box Publish this 
solution in Self-Service Portal also. 

4. Click Add. If you do not wish to add the solution then click Cancel. 
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Viewing Solution Details 

You can view the solution along with the solution details such as created by, created on, status and so 
on in the solution module. 

To view the solution details, 

1. Login to ServiceDesk Plus application using your username and password. 
2. Click Solution tab in the header pane. This opens the solution list view page. By default, the 

list of All Solutions gets displayed as shown below, 

 

3. Click the solution which you want to view from the solution list view page. This opens the 
View Solutions Details page as shown below, 
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4. The Solution Id and the Status gets displayed on the right hand side of the page. 
5. The Subject, Type and Category can be viewed along with the complete solution.   
6. The Keywords gets listed below the solution. If there are multiple keywords then they are 

separated by commas. 
7. The Solution Details such as Created By, Created On, Type, Views, Status and so on can 

be viewed under this block. The requester details can be viewed by clicking the created by 
link. 

8. The comments given to the solution on approving/rejecting can be viewed in Comments 
History. The status of the solution can also be viewed. 
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Editing a Solution 

To edit a specific solution,  

1. From the solutions list view page, click on the solution which you want to edit using the filter 
showing combo box. (OR) you can select the solution which you wish to edit by clicking the 
topic from browse by topics. All the solutions, irrespective of the status, available under that 
topic gets listed.  

2. Click the Edit button available on the right hand side of the view solutions details page. 

3. In the Edit Solutions page, make the necessary modifications. The title, contents, and the 
topic under which you wish to place the solution are mandatory fields. You can also add more 
attachments or delete existing ones.  

4. Click Save. If you want to drop the modifications made, click Reset. If you do not want to 
save the changes and get back to the solutions listing, click Cancel. 

5. On Saving the solution, the status of the solution shows Unapproved. The solution has to be 
submitted for approval to the concerned technician. To know more on refer Submit for 
Approval.  

Alternatively, to open the solution that you wish to edit, type the solution title in the keyword field of the 
search block and click Go or press the Enter key. The solutions matching the search string will be 
listed, from which you can choose the solution and edit the same. 
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Submit for Approval 

The newly added solutions has to be approved by the concerned technician, in order to be viewed by 
the requesters in the self service portal. To provide access permission to approve solutions refer 
Configuring Roles. 

To submit for approval, 

1. From the solutions list view page, select Unapproved Solutions from the filter showing 
combo box. The list of all Unapproved solutions gets displayed. 

2. Click the subject of the solution which you want to submit for approval. This opens the View 
Solutions page. The Status is shown as Unapproved below the Solution Id.  

3. Select Submit for Approval under the  Approve Actions combo box on the right hand side 
of the page. This opens Submit for Approval page. 

4. Select the To address by invoking the icon . This opens the Add users for Approval pop up 
window as shown below, 

 
  

• Enable the check box adjacent to the user whom you want to submit the solution for 
approval. 

• The To text field gets filled with the mail id of the corresponding administrator. 

5. The Subject and Description is entered as given in Notification Rules email template. If 
needed you can modify the subject and description content manually, else you can change 
the same from the Notification Rules email template under Helpdesk. 
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6. If there is any relevant files to be attached then, click Attach File button.  

7. Click Send to submit the solution for approval.  

The mail notification is sent to the person who was addressed in the To field of the notification. The 
mail contains the link to the specific solution which needs approval. On clicking the link, it leads you to 
the login screen, where on providing the proper credentials, the solution awaiting approval opens. To 
approve/reject solutions refer Approve/Reject Solutions. 
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Approve/Reject Solution 

On submitting the solutions for approval, a mail notification is sent to the concerned technician 
requesting the approval of the solution along with the solution link. The solution can be either 
approved or rejected. The approval access permission is given in Configuring Roles.    

To approve/reject solution, 

1. Click the link to open the solution.  
2. Login to the ServiceDesk Plus application using your username and password. This opens 

the view solution details page of the solution pending for approval. The status of the solution 
shows Approval Pending on the right hand side of the page.   

3. Click Approve Actions combo box -> Approve Solution. This opens the Approve 
Comments pop up window. Specify any related Comments in the field provided. Click 
Approve.  

4. If you wish to reject the solution then, select Reject Solution under Approve Actions. This 
opens Reject Comments pop up window. Specify comments, such as reason to reject the 
solution in the Comments field. Click Reject.   

To approve/reject bulk solutions, 

1. From the solution list view page, select Unapproved Solutions from the filter showing combo 
box. Enable the check box adjacent to the solutions which you want to approve/reject. 

2. Click Approve Actions combo box -> Approve Solution. This opens the Approve 
Comments pop up window. Specify any related Comments in the field provided. Click 
Approve.  

3. If you wish to reject the solution then, select Reject Solution under Approve Actions. This 
opens Reject Comments pop up window. Specify comments, such as reason to reject the 
solution in the Comments field. Click Reject.   

The approved solutions can be viewed by the requesters in the self service portal. The rejected 
solutions can be edited and sent for approval to the concerned technician. Thus the solution is not 
completely deleted from the list.   
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Delete Solutions 

To delete a specific solution  

1. From the solutions list view page, click on the solution which you wish to delete using the filter 
showing combo box. 

2. Alternatively, click the topic in which the solution you wish to delete is available. All the 
solutions available under that topic are listed. Alternatively, you can also search for the 
solution using the Search in Solutions feature. 

3. Click the Delete button available on the right hand side of the page. A confirmation dialog 
opens. 

4. To continue deleting, click OK; or else, click Cancel.  

To delete multiple solutions, 

1. Enable the check box adjacent to the solution in the solutions list view page.  
2. Click Delete button. A confirmation dialog opens.  
3. Click Ok to continue. The solution gets deleted from the list. 
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Search in Solutions 

ManageEngine ServiceDesk Plus allows you to search for solutions using its Search in Solutions 
option.   

To search for solutions, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. In the search block, choose Solutions from the Search in combo box. 
3. In the Enter Keyword field, type in your search string. 
4. Click Go or press the Enter key in your keyboard. The search results display all the solutions 

that match the search string.                                                                                       

Alternatively, from the solutions list view page, enter the search string in the Search Solutions text 
field. Click Search Solutions button. The list of solutions corresponding to the search string gets 
displayed.   

Another option to search solutions will be using the column-wise search option. To perform a column-
wise search   

1. Click the search icon  at the end of the solution list view headers. This opens the search 
field just below every column in the list view as shown below, 

 

2. Enter the search key in field under the column of your choice. You can enter keywords in 
more than one column to perform a combined column search. 

3. Click Go. The search results matching the search string(s) are displayed. 
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Browsing Solutions by Topic 

To browse for solutions using topics,  

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Solutions tab in the header pane. This opens the Solutions list view page. 
3. Hover over  combo box next to manage topics link. This opens the 

Categories window listing all the topics and their sub topics as shown below, 

 

4. To view all the sub topics, click >>Show All link on the right hand side of the page. This lists 
out the topics and sub topics in a logical manner.  

5. On clicking the topic, the solutions of the topic and its corresponding sub topics gets listed. 
Click the sub topic to view the solutions only in that sub topic.   
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Managing Topics 

You can add new topics, rename an existing topic, and move topics and subtopics to a different 
parent topic. This provides you the ability to organize your solutions in a logical manner that would 
meet your organization's needs.  

To manage topics 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Solutions tab in the header pane. 
3. In the Actions block, click Manage Topics link (OR) Click the Manage Topics link available 

in the Solutions list view page adjacent to the Browse by Topics combo box. The manage 
topics page is displayed with the available topics and their subtopics listed in the hierarchy. 
From here you can add, rename, move, and delete topics.  

Adding a New Topic 

To add a new topic 

1. In the Manage Topics page, click the Add New Topic button. The add new topic form is 
displayed just above the available topics list with the Topic Name and the list of parent topics 
as the two fields. If there are no topics available then the Choose a parent topic field will 
have the /Topic Root alone. 

2. Enter the name of the topic in the Topic Name field and choose the parent topic under which 
you want to place the new topic.  
For example - if you want to add the new topic as a main level topic, choose /Topic Root as 
the parent topic. Or else, choose any other topic as the parent topic. 

3. Click Add. The topic is added as subtopic to the parent that you chose and is displayed in the 
available topics list. A message is displayed stating that the new topic is added successfully. 

Renaming a Topic 

To rename a topic 

1. In the Manage Topics page, click the Rename link of the topic that you wish to rename. The 
Rename topic form is opened. 

2. Type the new name for the topic in the topic name field. 
3. Click Save.  

The changes made to the topic name are displayed in the available topics list and a message is 
displayed above the list. 

Moving a Topic 

To move a topic to a different parent  

1. In the Manage Topics page, click the Change Parent link in the row of the topic that you 
wish to move. The Change Parent Topic form is displayed. In the Choose the parent topic 
text box, by default, the current parent topic of the topic that is to be moved is selected.  

2. Select the new parent topic. 
3. Click Save. If you do not want to move the topic to a different parent topic, then click Cancel. 
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Note: You cannot move a topic as a subtopic to its current child topic 
itself. 

Deleting a Topic 

To delete a topic  

1. In the Manage Topics page, click the Delete link in the row of the topic that you wish to 
delete. A confirmation page opens. 

2. Click Confirm to delete the topic or click Cancel to retain the topic. If you click Confirm, then 
the topic is deleted and a message is displayed stating that the topic is deleted. 

When a topic is deleted, by default, the solutions present under the topic are also deleted and if there 
are any subtopics, then these are moved to the /Topics Root. You can later choose to move the 
topics as child topics to other parent topics. But if you want to override the default actions performed 
during the delete operation, move the subtopics of the topic which you plan to delete, under a different 
parent topic of your choice. Also, if you do not wish to delete the solutions that are available under the 
topic to be deleted, then you can move the solutions to other topics. For this, when you click the 
Delete link and are led to the confirmation page,  

1. Select the check box below the first point. This opens the topic list box, and enables you to 
move the reference of the solutions of the topic to a different parent topic of your choice. 

2. Select the parent topic of your choice from the list box. 
3. To move the subtopics to a different parent topic, select the check box below the second point 

in the confirmation page. 
4. In the topic list box, select the parent topic of your choice under which the subtopics of the 

current parent topic that is being deleted can be moved. 
5. Click Confirm. 

This deletes the topic after moving the solutions and subtopics from the deleted topic to the parent 
topic you selected.  

 

Note: You cannot move a subtopic of the topic that is going to be deleted, as a 
subtopic to another child topic of the same parent topic which is going to be deleted. 
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Configurations 

In ManageEngine ServiceDesk Plus, all types of application configurations are grouped under Admin. 
To access the various configuration options, log in to the application using the user name and 
password of an admin user and click the Admin tab in the header pane. If this is your first login after 
installing the ServiceDesk Plus application, then by default, configuration wizard is opened, and the 
screen displayed would be as below, 

 

 

 

To proceed with the configurations, follow the instructions provided in the configuration wizard. There 
are some default values given for various configurations. If you do not require these values, you can 
delete them and add your own values to suit your needs either in the wizard itself or at a later time by 
visiting the corresponding configuration group.  

You can exit the configuration wizard at any time. Clicking the Exit button closes the configuration 
wizard and takes you straightaway to the Admin Home page, where you can perform all the 
configurations. The Admin page looks as shown below: 
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s 

 

The various configurations are grouped under the following major heads:  

• Helpdesk Configurations 
• Asset Management 
• User Management 
• User Survey 
• General Settings 

Each of these configurations is explained in details in the following sections.  
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Helpdesk Configurations 

Various helpdesk related configurations need to be performed by the admin user, before the 
ServiceDesk Plus request module can be opened for real time functioning of fetching the IT help desk 
mails and tracking the same. The following helpdesk configurations need to be made for the new 
request form to capture meaningful information that can help the technicians solve the reported issue 
faster:  

1. Request category 
2. Request Status 
3. Request level 
4. Request mode 
5. Impact 
6. Urgency 
7. Request priority 
8. Request Type 
9. Configuring Additional Fields that need to appear in the new request form, so as to collect 

information very specific to your organization 
10. Request Closing Rules 
11. Request Template 

There are other configuration that need be done are:  

1. Organization details 
2. Mail Server settings 
3. Region 
4. Sites 
5. Operational hours of the organization in different sites 
6. Holidays 
7. Departments 
8. Configuring Business Rules 
9. Service Level Agreements 
10. Notification Rules 
11. Configuring Preventive Maintenance 
12. IT Services 

To access the helpdesk configurations:  

1. Login to the ServiceDesk Plus application with the Username and Password of a 
ServiceDesk Plus Administrator. 

2. Click the Admin tab in the header pane. 
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Request Form Customizer 

The new request form can be configured to suit the needs of your organization. It is highly 
customizable. You can add your own values to be set for the category of the request, priority of the 
request, level of request, and mode of the request. These will already have some default values in 
them. If you do not wish to have these then you can delete them and add new values or edit them to 
suit your needs. You can also add your own custom fields which will be available in the form. These 
custom fields can be of three types: text field, numeric field, and date field. You can use these to 
collect organization specific information for getting a better and clearer idea about the reported issue. 
Finally you can set the default values for the request form fields so that creating and submitting a new 
request if made easier. The subsequent sections of the document explain in detail the various 
customizations and configurations that can be done in the request form. 
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Configuring Category 
The requests can be grouped under proper Categories, Sub-categories and Items. 

For example: A request to install Adobe Photoshop can be put under the request Category as 
Software, Sub-Category as Adobe Photoshop and Item to be Versions 5.0,6.0 and so on. 
Similarly, if there is a problem in the functioning of the mouse, then it can categorized under the 
Category as Hardware, Sub-Category to be mouse  and Item to be scroll button not working. 

Depending on the need, you can create various such categories, sub-categories and item using this 
option. These categories,sub-categories and items will be listed in the drop-down menu in the New 
Request form.  

To configure category,  

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the HelpDesk Customizer icon . This opens the HelpDesk-
Category page where you can categorize the request in to category, sub-category and item. 
 You have the list of request form attributes that can be customized such as status,level,mode 
and so on is listed on the left side of the page.   

Create New Category, 

4. Click New Category button. This displays the category form. 
5. Specify the Category Name in the given text field. For ex. Software. This is the only 

mandatory field.  
6. Specify relevant information about the newly created category in the Description field. 
7. Select the technician to be assigned for the newly created category from the Assign To 

Technician combo box. All the issues related to this category will be assigned to the selected 
technician.  

8. Click Save button to save the details. You can see the category getting listed in the category 
list view below the form. 

9. Click Save And Sub Category button to save the details and add sub category to the 
category.  

Create New Sub-Category, 

10. Click New Sub Category button in the category list page to add sub-category to the category. 
Or click add sub-category icon  beside the category title in the list view . This displays 
the sub-category form.   

11. Specify the Sub Category name in the given text field. For ex. AdobePhotoshop. This is a 
mandatory field. 

12. Specify relevant information about the newly created sub category in the Description field. 
13. Select the Category from the combo box. For ex. Software. This is a mandatory field.  
14. Click Save button to save the values. You can see the sub-category getting listed under the 

selected category.    
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Create New Item, 

15. Click New Item button in the category list page to add item to the sub-category. Or click add 
new item icon beside the sub-category title in the list view. This opens the New Item 
form in which the you have category, sub-category and other details on top of the page.  

16. Specify the Item name in the given text field. For ex. versions. This is a mandatory field. 
17. Specify relevant information about the newly created item in the Description field. 
18. Select the Sub Category for the item from the combo box. For ex. software. This is a 

mandatory field. 
19. Click Save button to save the details. 
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Editing & Deleting Category 
1. Log in to the ServiceDesk Plus application using the user name and password of an admin 

user. 
2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the HelpDesk Customizer icon . This opens the 
Configuration Wizard page.  

4. Click the HelpDesk Customizer block at the left side of the page under the HelpDesk block. 
This opens the HelpDesk- Category page. 

Editing Category 

1. Click the edit icon beside the category name in the Category List page. This opens the 
edit category form. 

2. edit the details and save the changes. 

Editing Sub-Category 

1. Click the title of the category in the category list page. This opens the sub-category details 
page. 

2. Click the edit icon . This opens the edit sub-category form. 
3. Edit the details and save the changes.  

Editing Item 

1. Click the title of the sub-category to open the item details page. 
2. Click the edit icon . This opens the edit item form. 
3. Edit the details and save the changes.   

Delete Category 

1. From the Category List page, select the categories to be deleted by enabling the check box.  
2. Click delete icon beside the category name in the category list page. A pop window pops 

up to get your confirmation on the delete operation. 
3. Click OK to proceed. You can see the category deleted from the list. 

Delete Sub-Category 

1. Click the corresponding sub-category from the list. You can view the list of sub-categories for 
the category. 

2. Select the sub-category from the list by enabling the check box. 
3. Click Delete button to delete the selected sub-category. A pop window pops up to get your 

confirmation on the delete operation. 
4. Click OK to proceed. You can see the sub-category deleted from the list. 

Delete Item 

1. Click the corresponding item from the list. You can view the list of items for the category. 
2. Select the item from the list by enabling the check box. 
3. Click Delete button to delete the selected item. A pop window pops up to get your 

confirmation on the delete operation. 
4. Click OK to proceed. You can see the item deleted from the list. 
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 Configuring Status 
The requests that are received in ServiceDesk Plus will be taken up by the technicians and will be in 
various stages of completions. For ease of managing the requests and to know the status in which 
each of the received requests are in, ServiceDesk Plus allows you to create various request status 
under which you can group requests. These status can either be In Progress or Closed. While 
creating a status, you can also choose to stop the request timer for the status that is being created. 
Depending on the need of your organization, you can create various such status, which will be listed 
in the status drop-down menu in the New Request form.  
 
To open the status configuration page 

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Request Form Customizer icon . The next page 
displays the list of request form attributes that can be customized on the left menu and the 
category list page.  

4. Click Status from the left menu, or click the Next button on the top of the category list page. 
The Status List page is displayed. You can add, edit, or delete the request status. 

Add Status   

To add a request status  

1. Click the Add New Status link available at the right top corner of the Status list page. 
2. In the Add Status form, enter the name of the status in the Name field.  
3. Select the Type to which the status belongs. The status type allows you to identify the 

whether the status that you are adding is still in progress and hence should be a part of the 
open requests or should be moved to the closed requests. If the added status requires the 
timer of the request to be stopped, then you need to set the check box Stop timer.  

4. If you wish, you can enter the status Description. Please note that you cannot create two 
status with the same Status Name. 

5. Click Save. The new status is added. 

If you want to add more than one status, then instead of clicking Save, click Save and add new 
button. This adds the new status and reopens the add status form.  

At any point, if you decide not to add the new status, then click Cancel to get back to the status list. 
Clicking the View List link on the top right corner of the add status form will also take you to the status 
list view.  

Edit Status 

To edit an existing status  

1. In the Status List page, click the edit icon beside the status name that you wish to edit. 
2. In the Edit Status form, you can modify the name of the status. 
3. If the status belongs to the In Progress type, then you can choose to stop or start timer. If the 

request status belongs to the completed type then you cannot edit the type of the request 
status. 

4. If you wish you can edit the Description of the status. 
5. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel. 
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Even while editing a status, if you wish to add a new status, then click Save and add new button 
instead of clicking Save button after making the changes.  

Delete Status 

1. In the Status List page, click the delete icon beside the status name that you wish to 
delete. A confirmation dialog appears. 

2. Click OK to proceed with the deletion. If you do not want to delete the status, then click 
Cancel. 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 273

Configuring Level 
Request level is a measure to indicate the complexity of a request. For example, if the received 
request just has some information and does not require any action to be taken, then it can be 
classified as Level 1. If there is a minor level action, such as providing the requester some tips to 
resolve the issue, then it can be classified as Level 2, and so on. To open the request level 
configuration page 

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Request Form Customizer icon . The next page 
displays the list of request form attributes that can be customized on the left menu and the 
category list page.  

4. Click Level from the left menu. The Level List page is displayed. You can add, edit, or delete 
the request levels. 

Add Level   

To add a request level 

1. In the Level List page, click Add New Level link at the top right corner. 
2. In the Add Level form, enter the level Name. If you want, you can enter the level Description 

also. Please note that you cannot add two levels with the same name. Each level needs to be 
unique. 

3. Click Save. The new level gets added to the already existing list. 

If you want to add more than one level, then instead of clicking Save, click Save and add new button. 
This adds the new level and reopens the add level form.  
 
At any point, if you decide not to add the new level, then click Cancel to get back to the level list. 
Clicking the View List link on the top right corner of the add level form will also take you to the level 
list view.  

Edit Level 

To edit an existing level 

1. In the Level List page, click the edit icon beside the level name that you wish to edit. 
2. In the Edit Level form, you can modify the name and description of the level. 
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel. 

Even while editing a level, if you wish to add new level, then click Save and add new button instead 
of clicking Save button after making the changes.  

Delete Level 

1. In the Level List page, click the delete icon beside the level name that you wish to delete. 
A confirmation dialog appears. 

2. Click OK to proceed with the deletion. If you do not want to delete the level, then click 
Cancel. 
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Configuring Mode 
There are different modes of submitting a request to the IT help desk team. ServiceDesk Plus 
provides you the option of submitting the request through an online form. Instead, a requester can call 
up the IT help desk agent and inform him/her regarding an issue faced, where the help desk agent will 
ensure to log the details discussed over the phone call through the web-based form. The other mode 
by which you can submit a request is by sending a mail to the IT help desk team. The IT help desk will 
then log the details of the mail through the web-based form in the ServiceDesk Plus application. If 
there are other methods of reporting a request to the IT help desk team in your organization, you can 
add the corresponding mode. To open the mode configuration page 

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Request Form Customizer icon . The next page 
displays the list of request form attributes that can be customized on the left menu and the 
category list page.  

4. Click Mode from the left menu. The Mode List page is displayed. You can add, edit, or delete 
the request mode. 

Add Mode 

To add a request mode 

1. In the Mode List page, click Add New Mode link at the top right corner. 
2. In the Add Mode form, enter the Mode Name. If you want, you can enter the mode 

Description also. Please note that each Mode Name needs to be unique. 
3. Click Save. The new mode gets added to the already existing list. 

If you want to add more than one mode, then instead of clicking Save, click Save and add new 
button. This adds the new mode and reopens the add mode form.  
 
At any point, if you decide not to add the new mode, then click Cancel to get back to the mode list. 
Clicking the View List link on the top right corner of the add mode form will also take you to the mode 
list view.  

Edit Mode 

To edit an existing mode 

1. In the Mode List page, click the edit icon beside the mode name that you wish to edit. 
2. In the Edit Mode form, you can modify the name and description of the mode. 
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel. 

Even while editing a mode, if you wish to add new mode, then click Save and add new button instead 
of clicking Save button after making the changes.  

Delete Mode 

1. In the Mode List page, click the delete icon beside the mode name that you wish to delete. 
A confirmation dialog appears. 

2. Click OK to proceed with the deletion. If you do not want to delete the mode, then click 
Cancel. 
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Adding New Impact  
Impact is a measure of the business criticality of an Incident or a Problem. Impact is often measured 
by the number of people or systems affected. By default you have four Impact details listed in the list 
view.  

To add new Impact,  

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the HelpDesk Customizer icon . This opens the 
Configuration Wizard page.  

4. Click the Impact link at the left side of the page under the HelpDesk block. This opens the 
Impact page. 

5. Click New Impact link on the top right hand side of the page. This opens the Add impact 
details page.  

6. Specify the Name of the impact in the given text field.  
7. Specify the details about the impact in the given Description field.  
8. Save the changes.  
9. Click the Save and add new button to save the Impact and add another Impact.  
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Adding New Urgency    
Urgency is about the necessary speed of solving an incident of a certain impact. By default you have 
four Urgency details listed in this page.  

To add new urgency,    

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the HelpDesk Customizer icon . This opens the 
Configuration Wizard page.  

4. Click the Urgency link at the left side of the page under the HelpDesk block. This opens the 
Urgency page. 

5. Click on the New Urgency link on the right hand side of the page. This opens the Add 
urgency details page.  

6. Specify the Name of the Urgency in the given text field. This is a mandatory field.  
7. Specify the urgency details in the Description field.  
8. Save the changes.   
9. Click the Save and add new button to save the urgency and add another urgency.  
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Configuring Priority 
Priority of a request defines the intensity or importance of the request. To open the request priority 
configuration page 

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user.  

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Helpdesk Customizer icon  . The next page displays the 
list of request form attributes that can be customized on the left menu and the category list 
page.  

4. Click Priority from the left menu. The next page displays the available list of priorities. You 
can add, edit, or delete the request priorities. 

Add Priority 

To add a request priority, 

1. In the Priority List page, click the Add New Priority link at the top right corner. This opens 
the Add Priority form. 

2. Enter the priority name in the Name text field. The provided name has to be unique and 
cannot be duplicated. This is a mandatory field. 

3. If required, select the Color code to identify the priority by invoking the icon . The selected 
color has to be unique for every priority specified.  

4. You can enter a short description about the priority in the Description field. This can help in 
understanding the kind of priority associated with the name mentioned in the Name field.    

5. Click Save. The new priority is added to the already existing list. At any point you wish to 
cancel the operation that you are performing, click Cancel. 

Priority order is a number that is associated with the priority name. This defines the order in which the 
request received by the IT help desk team is to be handled. The requests that have a higher priority 
order are taken first before the other requests with lower priority are attended to.  

If you want to add more than one priority then, click Save and add new button. This adds the new 
priority and reopens the add priority form.  

 

Note: The priority name along with its color code can be view in the request list view page 
provided the priority check box is enabled in the column chooser. 

Edit Priority 

To edit an existing priority 

1. In the Priority List page, click the edit icon beside the priority name that you wish to edit. 
2. In the Edit Priority form, edit the fields you want to change. 
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel. 

Even while editing a priority, if you wish to add a new priority, then click Save and add new button 
instead of clicking Save button after making the changes.  
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Delete Priority 

1. From the Priority List page, enable the check box beside the priority name that you wish to 
delete.  

2. Click Delete button. A confirmation dialog appears. 
3. Click OK to proceed with the deletion. The priority gets deleted from the available list. If you 

do not wish to delete the priority, then click Cancel. 
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Priority Matrix  
The priority matrix helps you to determine the Priority automatically based on Impact and Urgency of a 
request. Impact is listed in the y-axis, and Urgency list in the x-axis of the matrix. Priority Matrix 
requires a one-time configuration by the Administrator.  
 
Once you set the Priority for specific Impact and Urgency in the priority matrix, when a requester 
selects a similar impact and urgency combination in the new request form, then the priority of the 
request will be determined based on the matrix. 

To set up Priority Martix, 

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user.  

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Helpdesk Customizer icon  . The next page displays the 
list of request form attributes that can be customized on the left menu and the category list 
page.  

4. Click Priority Matrix from the left menu. The next page displays priority matrix with impact list 
in the y-axis and the urgency list in the x-axis. 

5. From the Priority Matrix page, click the priority link against specific urgency and impact, this 
opens the drop down box. 

 

6. Select the corresponding priority from the list. The priority will be set for the particular Impact 
and Urgency combination. 

Example 

In priority matrix : If Impact is Affects Business and Urgency is High then Priority 
should be High. 
 
Result in request form : If requester/technician selects Affects Business for impact 
and high for urgency in the request then, the priority field gets filled automatically 
and displays as high.   
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Configuring Request Type 
Request Type is the type of request sent by the requester such as service request or request for any 
information. ServiceDesk Plus gives you the provision of configuring your request type other than the 
default options. This is essential while creating a new request under the request module.  

1. Login to ServiceDesk Plus application using the username and password of the admin user. 
2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the HelpDesk Customizer icon . This displays the list of 
request form attributes that can be customized on the left menu. 

Add Request Type 

To add a new request type, 

1. Click the Add Request Type link on the right hand side corner of the Request Type list page. 
This opens the Add Request Type form. 

2. Specify the name of the request type such as, Incident, Request for Information in the Name 
text field. This is mandatory field. 

3. Enter a brief description about the type of requests which fall under the category in the 
Description text field. 

4. Click Save, to save and return to the list view page. Click Save and Add New to save and 
create another request type.  

Edit Request Type 

1. From the Request Type list page, click the edit icon  beside the request type which you 
want to edit. This opens the Update- Incident page. 

2. Modify the changes in Name and Description text field. 
3. Click Save to save the changes. You can also Save and add a new request type by clicking 

Save and Add New. 

Delete Request Type 

1. From the Request Type list page enable the check box adjacent to the request type which 
you want to delete. 

2. Click Delete button. A confirmation message for the delete operation pops up. Click Ok to 
proceed. The request type gets deleted from the list.  
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Configuring Additional Fields 
Sometimes you may want to capture some additional details about an organization, for which, you 
need additional fields apart from the default fields in the New Request form. You can add your own 
fields using the Additional Fields configuration.  

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Request Form Customizer icon . The next page 
displays the list of request form attributes that can be customized on the left menu and the 
category list page.  

4. Click Request - Additional Fields from the left menu. The next page is a form that allows 
you to add the field labels and description of the field. You can add three types of fields in the 
form: text, numeric, and date/time. These three fields are available in three tabs as shown 
below: 

   
The default tab selected is Text.  

5. To add the text fields, enter the label name in the form fields below the Label heading. If 
required, enter the description for the field. 
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6. You can choose the type of text field that you wish to add by selecting the radio buttons. A 
Single-line text field allows you to add just a text field. The Multi-line text field allows you to 
add a text box where a lengthy description can be added. A Pick List allows you to add a list 
menu from which you can select. In all the three cases, you can add default values for the text 
field in the space provided for the same.  

7. To add items for the pick list, enter the value in the text filed and click Add Item. The value 
will get added to the list below. To select the default selected value of the list, click on the 
value in the list. 

8. To add numeric fields, click the Numeric tab and then enter the label name in the form fields 
provided.  

9. To add Date/Time fields, click the Date/Time tab and enter the required details. 
10. Click Save. A message is displayed saying that the additional field is successfully created. 

The new custom fields that you have added will appear in the New Request form under the 
Additional Request Details block.  
 
To delete the user-defined fields, follow the above steps till the 4th step. Then, delete the label names 
you wish to remove and the default entries made for them, and click Save. The respective fields that 
you deleted will be removed from the New Request form. 

On adding the field, the newly added fields has to be configured in the Request Template by Drag and 
Drop method. You can also preview your new request form by clicking the Request Template link in 
the left menu. 
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Request Closing Rules 
Request closing rules can be used to select the mandatory fields to be filled in by the technicians 
while closing the requests. You can also use it to confirm user acknowledgement to the technician 
and close requests either manually or automatically. 

To preset the request closing rules,  

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the HelpDesk Customizer icon . This opens the 
Configuration Wizard page.  

4. Click the Request Closing Rules link at the left side of the page under the HelpDesk block. 
This opens Request Closing Rules page. 

5. Select the mandatory fields for closing the request from the list by enabling the check box. 

Confirm User Acknowledgement 

On closing the request, the resolution is acknowledged by the requester through mail (if the option is 
enabled in Notification Rules). If you want to prompt a confirmation message to the technician asking 
if user has acknowledged the resolution then enable Yes, prompt a message radio button, else 
enable No, don't prompt a message radio button.  

Request Closing Process 

Manual Closing    

1. If you would like to close the request manually select the Manual radio button. 
2. Save the changes. On resolving the request each time you have to close the request 

manually.  

Automatic Close 

1. Select the Automated Close radio button to close the request automatically.  

In the automatic mode, 

• An email is sent to the requester when the Request is put in Resolved state 
• The Requester can Close the Request with the close link given or Re-open 

the Request by replying to the mail. 
• If the Requester takes no action the Request will be closed after the number 

of days specified in the combo box. 

2. Select the close resolved request after n number of days from the combo box. 
After the selected number of days the resolved requests will be closed automatically if 
the requester does not take any action.  

3. Save the details. 

Example: If you have selected Resolution as a mandatory field, then the technician fixing the 
problem, should enter the reason and solution for the problem in the resolution text field before 
closing the request, else an error message pops up asking you to enter the details in the resolution 
field. If Yes, prompt a message radio button is enabled then, a confirmation message is prompted to 
the concerned technician if user has acknowledged the resolution.    
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Request Template 
In real world, there is a need to support different types of request which might require different fields in 
the form layout. Request Template supports to configure different set of fields for different type of 
requests. Thereby creating individual form for each request template for the most frequently raised 
requests such as, printer problem or mail fetching problem. The fields can be pre filled with values so 
that a request can be created instantly.  

To open the request template form, 

1. Login to ServiceDesk Plus application using the admin username and password. 
2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click HelpDesk Customizer icon . This opens the Configurations 
wizard page. 

4. Click Request Template on left side of the page under the helpdesk block. This opens the 
Request Template list view page.  

5. Click Create New button. This opens the request template form viewed by the technician as 
shown below, 
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The request template form consists of three blocks namely, Header, Field list and the Canvas. 

• Header : The header consists of the Template Name, Comments and Show to 
requester check box and the Undo and Redo buttons. If you want the requester to 
view the form, enable 'Show to requester check box'. By default, this option is 
disabled. This status can be viewed in the list view page.  

• Field List : The field list consists of the list of fields and the add new field option.  
• Canvas : The canvas decides the form look and has drag and drop area.  

The following are the actions that can be performed in the form, 

• Form Customization 
- Add New fields 
- Drag and Drop fields 
- Setting Field Property 

• Request Preview 
- Technician View 
- Requester View 
- Add Tasks 

• Edit Request Template 
• Delete Request Template 

Form Customization 

The layout of the form can be customized by, add/remove fields, set field properties and re-arrange 
the fields in the Canvas for a request template.  

Add New Field 

1. You can add new fields by dragging the Add New Field option under the Drag and 
Drop field on to the canvas.  
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2. This opens the Add New Field pop up window as shown below, 

 

2. Select the type of field such as, text, numeric, by enabling the radio button beside it. 
3. In the text field settings block, specify the Label Name in the field provided. This is 

mandatory field. If required, enter the significance of the field in the Description text 
field.  

4. Select the type of the text field such as single-line, pick list. 
5. Click Ok, the field gets added in the dragged place in the canvas with the above 

specifications. 
 

 

The newly added fields are common for all the templates. The field name will also be same for 
all the templates. The newly added field can be edited or deleted only in Request - Additional 
Fields.  

 

Drag and Drop 

1. Drag the field from the Field List and drop it onto the canvas. The drop areas will be 
highlighted. The dragged field can be dropped only in the highlighted area. 

2. The fields in the form can also be re-arranged by dragging the field and placing it over 
an empty cell. The field can be placed only in the highlighted area. The request 
details can be moved as a whole block.  

3. If you want to Undo/Redo the changes then click the corresponding buttons.  
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Setting Field Properties 

You can customize the fields such as, status, priority, mode by either changing the field 
properties, that is, making the fields mandatory or closing the fields. Thus you can customize 
the entire form by keeping the relevant fields in the canvas for a template. To customize the 
form,  

1. Hover over the field, an Edit Field property and Field Close button will appears.  

2. Click the Edit Field Property button . A drop down appears containing the options, 

 

• Mandatory Field : The field can be made mandatory by enabling the check 
box adjacent to this option. 
Note: If the Item field is marked as mandatory then the category and the sub 
category will automatically be marked as mandatory. Similarly if the Impact 
details is marked as mandatory then the Impact field will automatically be 
marked as mandatory.  

• Requester can Set : On enabling this option, the requester can edit the fields. 
The 'requester can view' option automatically gets enabled.   

• Requester can View : The requesters can only view the field and cannot set 
nor edit values on enabling this option. 

 

Note: The fields such as request details, subject and description do not have 
field properties and hence can be only re-arranged in the canvas. 

3. Click Field Close button  to remove the field from the canvas and add it to the field 
list. The fields such as status, priority, description, subject and requester details does 
not have the Field Close option.  

On customizing the form layout, the fields are pre filled with values. Click Save. The template gets 
added to the available list in the Request Template list view page. To save and add tasks for the 
template, click Save and Add Task instead of Save.  

At any point, if you do not wish to add the request template and would like to get back to the list view 
page, click Cancel. Clicking the View List link on the top right corner of the request template form will 
also take you to the request template list view page.  
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The request template will get populated under the New Request link  . The 
created template is based on the Default Template. Click on the New Request link 

. This opens the Default Request Template form. This form cannot be deleted nor 
renamed. A request created through mail will also be based on this template. 

Request Preview 

On customizing the request form for both the requesters as well as technicians, you can see the 
preview for both the logins using this option. 

To see the request preview,  

1. From the Request Template list view page, click the Template name which you wish to 
preview. By default, the request template form for a technicians is opened. You can drag and 
drop fields in the canvas, re-arrange, add/remove and set properties for the field. 

2. You can view the request template form for a requester if the Show to requester option is 
enabled. To view the request template form for a requester, click the Requester tab on the 
top left hand side of the page. The header section is grayed and hence is non editable. In the 
requester preview page, certain fields are hid from the requester while the rest of the fields 
can only be re-arranged. 

  



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 289

3. You can view and add tasks related to the request template on clicking the Tasks tab. This 
displays the list of tasks for the template. You can add tasks by clicking Add Task button. To 
add task refer Add Task. 
 
For ex : The request template 'New Joinee' has a set of tasks to execute such as, enter his 
details in active directory, setting up his computer, settings up his location and so on, which 
needs to be entered under the Task tab. Hence the Schedule Start Time and End time and 
Actual start time and end time need not be specified.  

Edit Request Template  

You can edit the request template and also have a preview of  the request templates for a technician 
and a requester. 

1. Click on the request template name from the request template list view page. By default, the 
request template form for a technicians is opened.  

2. You can drag and drop fields in the canvas, re-arrange, add/remove and set properties for the 
field.  

3. You can view the request template form for a requester if the Show to requester option is 
enabled. To view the request template form for a requester, click the Requester tab on the 
top left hand side of the page.   

4. In the requester preview page, the fields can only be re-arranged. The header section will be 
grayed and hence will be non editable.  

5. You can also view and add tasks related to the request by clicking on the Task tab. This 
displays the list of tasks for the template. You can also add tasks by clicking Add Task 
button.  

Delete Request Template 

1. From the Request template list view page, enable the check box adjacent to the template 
which you want to delete.  

2. Click delete button, a pop up window appears confirming the delete operation.  
3. Click Ok to continue. The template gets deleted from the list. If the template is been used by a 

request then the template will be marked in grey indicating no further usage of the template in 
the request template list view page.  
 
To bring the form back to usage, disable' Template not for further usage' check box under 
the Header block of Edit Request Template form 

. 
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Configuring Organization Details 

You can configure your organization's details in the ServiceDesk Plus application. This information will 
be used in various cases. To configure your organization's details 

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Organization icon . The Organization Details form is 
displayed. 

4. Enter the Name of your organization. You cannot leave the name field empty. The other fields 
can be empty. But if you have the required information, then enter them as explained in the 
following steps. 

5. The description field can contain information about what your organization specializes. 
6. The next block collects the address of your organization. Enter the address details in the 

relevant fields, such as address, city, postal code, state, and country. 
7. If you have a common contact e-mail ID, then enter the same in the E-mail ID field. 
8. Enter the phone and fax number, and the URL of your company's web site. 
9. You can import the company logo and use that in places where the organization details are 

being used.  
1. Click Import Image button beside the Company Logo field. 
2. Click the Browse button and choose the image file from the file chooser window and 

click Open. 
3. Click Import. 

10. By default, the Use this image check box is enabled. If you do not wish to use this image, 
then disable the check box. 

11. Click Save. 

At a later time, if you wish to edit the information that you entered now, you can do so by following the 
same procedure explained above.  
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Configuring Mail Server Settings 

ServiceDesk Plus allows you to configure the incoming e-mail settings and the  outgoing e-mail 
settings such that it fetches the mails that are sent to the IT help desk team and sends 
notifications/feedback to the technicians, requesters, and vendors. ServiceDesk Plus Mail Server 
Settings enables you to do it.  

Incoming Mail Settings 

To configure the incoming e-mail settings 

1. Log-in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 
3. In the Helpdesk block, click the Mail Server Settings icon . The Mail Server Settings 

page displayed will be as shown in the figure, with the incoming e-mail settings tab selected 
by default: 
 

 

 

4. All the fields marked * are mandatory fields. Enter the server name, user name, password, e-
mail address, port, and the time interval in which the mail needs to be fetched periodically. 
The time period is in minutes. The e-mail type is a combo box from which you need to select 
the value. 

5. Click Save. On successful connection to the server, the success message is displayed and 
the UI changes as below: 
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To start fetching the mails, click the Start Fetching button. Once the mail fetching is started, the Save 
button in the incoming mail server settings is disabled. If you wish to change any of the settings, then 
you need to stop mail fetching, make the changes, save them and then restart the mail fetching. 

Outgoing Mail Settings 

To configure the outgoing mail settings 
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1. In the Email Settings page, click the Outgoing tab. The outgoing mail settings form is 
displayed as above. 

2. Enter the outgoing mail server name / IP address, reply-to e-mail address, and port. These 
three are the mandatory fields. 

3. If there is an alternate server, then enter its name in the Alternate Server Name / IP 
Address field.  

4. Enter the name of the sender in the Sender's Name field. 
5. Choose the e-mail type, which is usually SMTP. The Port associated to SMTP is 25 by 

default. 
6. If your SMTP server for outgoing mails require authentication, then select the check box 

Requires Authentication. 
7. Enter the User Name and Password in the respective fields. 
8. Click Save. 
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Configuring Regions 

Organizations can have various branches to handle various specialized activities. Such branches can 
be located at different regions and data from each of these branches need to be maintained in the 
same place. You can configure the various locations of your branches in the ServiceDesk Plus 
application. To open the organization regions configuration page, 

1. Login to the ServiceDesk Plus application using user name and password of an admin user. 
2. Click the Admin tab in the header pane. 

3. In the Organizational Details block, click the Regions icon . The next page displays the 
available list of regions. You can add, edit, or delete regions.  

Add Region 

  To add a new region,  

1. Click Add New Region link available at the top right corner of the Region list page. 
2. In the Add Region form, enter the Region Name. This is mandatory field.  
3. Specify brief description about the core activities taking place in the branch in the 

Description text field.  
4. Click Save to save and return to the list view. Click Save and Add New a to save and add a 

new region. At any point, if you do not wish to add the region and would like to get back to the 
location list, click Cancel.  

Edit Region 

To edit an already existing region, 

1. In the Region List page, click the edit icon beside the Region Name that you wish to edit. 
2. In the Edit Location form, modify the location name and its description. 
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel.  

Even while editing a region, if you wish to add another new region, then click Save and add new 
button instead of clicking Save button after making the changes.  

Delete Region 

1. In the Region List page, click the delete icon beside the Region Name that you wish to 
delete. A confirmation dialog appears. 

2. Click OK to proceed with the deletion. If you do not want to delete the region, then click 
Cancel. 

On deleting the region, the sites corresponding to the region along with the attributes such as groups, 
SLA, business rules, holidays and so on gets deleted. 
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Configuring Sites 

Organizations can have various branches to handle various specialized activities. Such branches can 
be located in different sites of a region and the data from each of these sites need to be maintained in 
the same place. You can configure various sites to a region in the ServiceDesk Plus application.  

 

Note: The administrator has the privilege to create a site. The Site Admin can 
View/Edit/Delete the sites to which he is associated from the Site List page.   

Add Site 

To add new site, 

1. Login to ServiceDesk Plus application using the username and password of the admin user..  
2. Click Admin tab in the header pane. 

3. In the Organizational Details block, click Sites icon. This opens the Site List page 
consisting of the lists of sites along with the regions. 

4. Click Add New Site link on the right hand side corner of the site list table. This opens the Add 
Site details page. 

5. Enter the Site Name in the respective text field. This is mandatory field. 
6. Provide brief information in the Description field about what your organization does in the 

above mentioned site. 
7. Select the Region and the Time Zone of the site from the combo box. The specified time 

zone will be essential in calculation the operational hours for the site. Hence the request 
raised in that site can be resolved within its operational hours. 

8. Specify the Address of the organization along with City, Postal Code, State and Country. 
9. Enter the Contact Information such as E-mail Id, Phone no, Fax no and the Web URL of 

your organization. 
10. The site might have different operational hours, holidays and so on. In such a case, enable 

Custom settings radio button of the corresponding fields you would like to customize. You 
can also copy the default setting for the site by enabling the Copy Default Settings radio 
button.  
Example : Suppose an organization has many branches say, one in Chennai and the other in 
New York. Both have different operational hours and holidays, and thus have different SLAs. 
In such a case, enable the radio button corresponding to the options in Custom Settings for 
the site. This will not copy the default settings and hence you can add these attributes 
separately for the corresponding sites.      

11. Click Save button to save the site details and return to the list view. Click Save and add new 
button to save and add another site. If you wish to cancel the operation then click Cancel. 

Edit Site 

To edit a site, 

1. From the site list page, click the edit icon  beside the site which you wish to edit. This 
opens the Edit-Site page with the existing data. 

2. You can modify all the fields in this page. Click Save to save the modified changes. Click 
Save and Add New to save and add another site.  
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Delete Site 

To delete site, 

1. Click the delete icon  beside the site which you want to delete from the site list page. A 
confirmation dialog appears 

2. Click Ok to proceed. The site gets deleted from the list of available sites. 
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Configuring Operational Hours 

You can set the operational hours of your organization situated in various sites. The operational hours 
for a site depends on the time zone configured for that site. The operational hours that you configure 
is used while calculating the request due by date and time. To set the organization's operational 
hours,  

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 
3. In the Organizational Details block, click the Operational Hours icon . The Operational 

Hours form is displayed as shown below, 

 
  

4. Select the site from the Operational hours for comb box. By default, the Operational hours 
for combo box will display Default Settings.  

 

Note:The Site Admin can set the operational hours for the sites to which he is 
associated. The sites can be selected from the Operational Hours for combo box. The 
Operational hours for combo box will appear if the site is configured in Admin- Sites. 

5. If your organization works round the clock, then select Round the clock (24 hours) radio 
button. If you do not work round the clock then, select the radio button beside Select 
Operational Hours. Specify the working hours of your organization by selecting the Start 
Time and the End Time from the drop down boxes.   

6. Now, select the days that your organization works by selecting the check boxes provided 
beside the days of the week. 

7. Click Save.  

You can also view the operational hours of a site by selecting the site from Operational Hours for 
combo box. 
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If you have already set the operational hours and wish to modify the same, you still need to follow the 
same procedure as specified above. But in this case, when you click Operational Hours from the 
Admin Home page, it will open the Operational Hours form with the details that have been set 
earlier. You can make the necessary modifications and then click on Save.  
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Configuring Holidays 

You can set the holidays of your organization that is situated in various sites using the Holidays 
option available in the Admin page. This has the list of holidays during which the firm would remain 
closed and is exclusive of the weekly holiday when the firm does not function. You can also set 
repeated holidays such as, New Years Day, to an organization in a site. Thus by doing so you need 
not manually add the holiday every year in the Holidays option.  

The holiday list along with the operational hours will be used for calculating the expected completion 
time of a service request, depending on the priority or SLA applicable to that request. To open the 
holiday configuration page,  

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Organizational Details block, click the Holidays icon . This displays the Default 
Settings of the available list of holidays. You can add, view, edit, or delete holidays for a 
particular site.  

 

Note:  The Site Admin can add and view the holidays to the site which he is 
associated.  To view the holidays in a particular site, select the site from the Holidays 
for combo box.  

If the sites are not configured then the Holidays for combo box will not appear. To 
configure the sites refer Sites under Organizational Details block.    

Add Holidays 

To add holidays in a site, 

1. Select the site for which you want to add the holiday from the Holidays for combo box. If the 
sites is not selected then the holidays gets added under Default Settings.   

2. Click Add New Holiday link available at the top right corner of the holiday list page. This 
opens the Add New holiday form. 

3. Select the Date on which you want to add the holiday by invoking the calender icon . This 
is mandatory field.   

4. Enter a brief description of the significance of the holiday in the Description text field.  
5. If the holiday occurs every year such as, 25th December (Christmas), then enable Check if 

this is recurring holiday check box. This will automatically add the holiday every year for the 
site.    

6. Click Save. If you do not wish to add the holiday and would like to get back to the holiday list, 
click Cancel. 

7. Clicking the View List link on the top right corner of the add holiday form will also take you to 
the holiday list view.  

Edit Holidays 

1. Select the site for which you want to edit the holiday from the Holidays for combo box. This 
lists out the holidays  for the corresponding site.  

2. Click the edit icon beside the holiday Date that you wish to edit. 
3. Modify the date and the description of the holiday, and enable/disable the 'check if this is 

recurring holiday' check box in the Edit Holiday form.  
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel.  
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Delete Holidays 

1. Select the site for which you want to delete the holiday from the Holidays for combo box. 
This lists outs the holidays in that site.  

2. Enable the check box beside the holiday Date which you want to delete from the holiday list 
page. Click the Delete button on the left hand side of the page. A confirmation dialog 
appears. 

3. Click OK to proceed with the deletion. If you do not want to delete the holiday, then click 
Cancel. 
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Configuring Department 

There can be various departments in an organization which can be situated in different sites and, 
each of these departments have a group of employees in them. In ServiceDesk Plus you can add, 
edit, or delete the various departments of your organization. These departments are essential while 
adding requesters and technicians since each requester or technician will be associated to a 
particular department of the organization. To open the department configurations, 

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Organizational Details block, click the Departments icon . This displays the 
available list of departments. You can add, edit, or delete departments.  

 

Note:The Site Admin can configure the department in the sites which he/she is 
associated. The list of departments associated to the site can be viewed by selecting 
the sites from the Departments for combo box. The Department for combo box will 
appear if the site is configured in Admin- Sites. 

Add Department 

To add a department for an organization in a site, 

1. Select the site for which you want to add the department from the Departments for combo 
box. By default, the department gets added under Default Settings.  

2. Click Add New Department link available at the top right corner of the Department list page. 
This opens the Add Department form. 

3. Enter the Department Name in the text field. This is mandatory field.  
4. Provide a brief Description about the department in the text field provided.  
5. Click Save. At any point, if you do not wish to add the department and would like to get back 

to the department list from the add department form, click Cancel.  

Edit Department 

To edit an existing department, 

1. Select the site for which you want to edit the department from the Departments for combo 
box. This lists out the available departments corresponding to the site. 

2. Click the edit icon beside the Department Name that you wish to edit. This opens the Edit 
Department form. 

3. Modify the department name and its description. 
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel.  

Delete Departments 

1. Select the site for which you want to edit the department from the Departments for combo 
box.  

2. Enable the check box beside the department name which you wish to delete from the 
department list page. Click Delete button. A confirmation dialog appears. 

3. Click OK to proceed with the deletion. If you do not want to delete the department, then click 
Cancel. 
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Configuring Business Rules 

You can define Business rules to various sites of an organization. This will enable you to organize the 
incoming requests (form and e-mail) and perform any action ranging from delivering them to group, to 
assigning status and other parameters of the requests.  

To open the Business Rule configurations page,  

1. Login to the ServiceDesk Plus application with admin username and password. 
2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Business Rule icon . The resulting page will display the 
available list of business rules under the Default Settings. You can add, edit, or delete 
business rules of a particular site. 

 

Note: The Site Admin can add and view the business rules to the site which he is 
associated. To view the business rules of a site, select the site from the Business 
Rules for combo box.  If the sites are not configured then the Business Rules for 
combo box will not appear. To configure the sites refer Sites under Organizational 
Details block.    

Add New Business Rule 

To add a Business Rule,  

1. Select the site to which you want to add the business rule from the Business Rule for combo 
box. Click Add New Business Rule link available at the top right corner of the Business 
Rules List page. This opens the Add Business Rule page as shown below, 
 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 303

2. The Add Business Rule form consists of two blocks namely, Business Rule Details and 
Business rule.  

Business Rule Details 

• Specify the Rule Name in the given text field. This name has to be unique and is a 
mandatory field. 

• Provide relevant information about the rule in the Description text field. 

Business Rule 

• Under this block, define the rules and criteria that need to be satisfied by the 
incoming request. Set the criteria by selecting from the Select Criteria combo box, 
and then choose conditions, and then the individual values that need to be matched 
by clicking the Choose button. This will open the values from the database for that 
particular parent criteria that you chose from the combo box. Choose the values you 
want and click Save.  
For example: If you want to match the requester name John, then select Requester 
Name in the Define rule combo box. Now select the condition is or is not from the 
drop down list. This list varies for each criteria. Then, click Choose button, to open 
the list of requesters in a pop-up window. Select the requester name from the list and 
click Ok. For multiple selection, press Shift or Ctrl key while selecting the names. 
The selected names will appear in the text box just before the choose button. 

• Click Add to Rules to add the defined rule to the rules table. 
• By default, the radio button Match ALL of the following is selected. If you do not 

want all of them to be checked but if it is enough if any one of the rules are matched, 
then select the radio button Match ANY of the following. After defining the rules, 
you need to define the actions that need to be performed on the request matching the 
criteria. 

• Choose the action that needs to be performed on the request from the Choose 
Action drop down list. 

• Click Choose button to the select the values for the chosen action.  
For example: If the action you had chosen was to Place in Group, then clicking the 
choose button will display the available groups in which the request can be placed. 
You need to select the group in which the request has to be placed and click OK. 

• Click Add. 

3. Click Save. If you want to add more than one business rule, then click Save & Go Next >>. 
This adds the business rule and reopens the add business rule form. 

At any point, if you do not wish to add the business rule and would like to get back to the business 
rules list from the add business rule form, click Cancel. Clicking the View List link on the top right 
corner of the add business rule form will also take you to the business rules list view.  

Edit Business Rule 

To edit an existing business rule  

1. In the Business Rules List page, click the edit icon beside the Business Rule Name that 
you wish to edit. 

2. In the Edit Business Rule form, you can modify all the fields mentioned in the add business 
rule form. 

3. To edit the Match the below criteria set, click the edit icon beside the individual criteria. 
The respective selection window is opened in a separate pop-up. You can choose more 
values or remove a few values by de-selecting them.  
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4. You can also delete a criteria completely. To delete a criteria, click the delete icon beside 
the individual criteria. 

5. In the actions to be performed, you can add or delete actions that need to be performed on 
the request that matches the criteria defined. 

6. Click Save to save the changes performed. At any point you wish to cancel the operation that 
you are performing, click Cancel.  

Even while editing a business rule, if you wish to add another new business rule, then click Save & 
Go Next >> button. 

Delete Business Rule 

1. From the Business Rule List page, enable the check box adjacent to the Business Rule 
Name that you wish to delete.  

2. Click Delete button. A confirmation dialog is opened. 
3. Click OK to proceed with the deletion. If you do not want to delete the business rule, then 

click Cancel. 

Organize Business Rules 

You can organize the business rule to appear in a particular order in the list view by following the 
steps below: 

1. Select the site form which you want to re arrange the order of the business rule from the 
Business Rules for combo box. Click Organize Business Rules link available above the list 
of business rules in the Business Rules List view. A pop-up window is opened with the list of 
available business rules in the order that is appearing the list view. 

2. Select a business rule, and click Move up or Move Down button beside the list. 
3. Click Save. 

Organizing the business rules decide the order in which the rule is applied on the incoming request. 
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Configuring Service Level Agreements 

You can have service level agreements (SLAs) defined for intra-organization service provided by the 
IT help desk team. These SLAs help evaluating the efficiency, effectiveness, and responsiveness of 
your help desk team. The SLAs can be defined for each individual, or departments, or workstations in 
a site. When requests from any of the three that are governed by an SLA is received by the 
application, the priority is automatically set based on the SLA rules. Also, if the request is not resolved 
within the time specifications of the SLA, then you can set the escalation rules also. To open the SLA 
configurations page, 

1. Login to the ServiceDesk Plus application with admin username and password. 
2. Click the Admin tab in the header pane. 

3. In the Organizational Details block, click the Service Level Agreement icon . This 
opens the SLA list page. You can add, edit, or delete SLAs.  

4. By default the all SLA based mail escalations will be enabled. If you wish you can Disable 
Escalations. 

5. You have set four SLA's High, Medium, Normal,Low SLA's by default. You can also add more 
SLA's to the list. 

 

Note: The Site Admin can configure the SLA for the sites to which he is associated by 
selecting the site from the Service Level Agreement for combo box. This lists out all 
the SLAs corresponding to that site. If the sites are not configured then the Service 
Level Agreement combo box will not appear. To configure the sites refer Admin- 
Sites.  

Add New Service Level Agreement 

To add an SLA 

1. Select the site to which you want to add the SLA from the Service Level Agreement for 
combo box. Click Add New SLA link available at the top right corner of the SLA list page. 
This opens the Add SLA form as shown below, 
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2. Specify the SLA Name in the text field provided. This is a mandatory field.  
3. If required, you can provide a corresponding description for the SLA. 
4. In the SLA rules block set the rules and criteria for the SLA. By default, the radio button 

Match ALL of the following is selected. If you do not want all of them to be checked but if it 
is enough if any one of the rules are matched, then select the radio button Match ANY of the 
following.  

5. Now, set the criteria by selecting from the Select Criteria combo box, and then choose the 
individual values that need to be matched by clicking on the choose button. This will open the 
values from the database for that particular parent criteria that you chose from the combo 
box. Choose the values you want and click Select. For example, if you want to match the 
requester name John, then select Requester Name in the combo box. Now click Choose 
button, to open the list of requesters in a pop-up window. Select the requester name from the 
list and click Select. For multiple selection, press Shift or Ctrl key while selecting the names. 
The selected names will appear in the text field just before the choose button. 

6. Click Add to Rules to add the defined rule to the Rules Set. 
7. Set the Resolution Time. If you want this duration to override the operational hours, the 

select the check box beside Should be resolved irrespective of operational hours. By 
selecting this, you will be overriding the operational hours of your organization and the due by 
time will be calculated from the creation time without taking into consideration the holidays 
and operational hours. 

8. If the request is not resolved within the specified resolution time, then you can set the 
escalation levels for notification. If you want to set the escalation levels, then select the check 
box available beside the Enable Level 1 notification. The level 1 notification expands. 
 

 

 

9. Click Choose button to choose the technicians to whom the SLA violation should be 
escalated. 

10. Select any one of the radio buttons to enter the date and time of the escalation. 
11. You can choose to escalate before the violation or after the violation. If you wish to 

escalate the SLA violation ahead to the technician then click Escalate Before option . Specify 
the number of days before the SLA violation is about to happen in the text box. This is to 
escalate to the technician about the onset of the violation. Also specify the time of escalation. 

12. Click Escalate After option to escalate after the violation. Specify the number of days after 
the SLA violation has occurred to escalate in the text box. Also specify the time of escalation. 
     

13. Click the Save button to save the SLA and return to the list view. you can set 4 levels of 
escalations.  

14. Click the Save and add new button to save the SLA and add another SLA. 
15. If you want to add more than one SLA, then click Save and add new, instead of clicking 

Save. This adds the SLA and reopens the add SLA form. 
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At any point, if you do not wish to add the SLA and would like to get back to the SLA list from the add 
SLA form, click Cancel. Clicking the View List link on the top right corner of the add SLA form will 
also take you to the SLA list view.  

Edit Service Level Agreement 

To edit an existing SLA, 

1. Select the site of the SLA which you wish to edit from the Service Level Agreement for 
combo box. This lists out all the SLA corresponding to that site. 

2. Click the edit icon beside the SLA Name that you wish to edit. 
3. In the Edit SLA form, you can modify all the fields mentioned in the add SLA form. 
4. Click Save to save the changes . At any point you wish to cancel the operation that you are 

performing, click Cancel.  

Even while editing an SLA, if you wish to add another new SLA, then click Save and add new button 
instead of clicking Save button after making the changes.  

Delete Service Level Agreement 

1. Select the site of the SLA which you wish to delete from the Service Level Agreement for 
combo box. The list of SLA corresponding to the site gets displayed. 

2. Enable the check box adjacent to the SLA which you want to delete. Click the Delete button. 
A confirmation dialog appears. 

3. Click OK to proceed with the deletion. If you do not want to delete the SLA, then click Cancel. 

Organize Service Level Agreements 

You can organize the SLA to appear in a particular order in the list view for a particular site by 
following the steps given below, 

1. Click Organize SLA link available above the list of SLAs in the SLA List view. A pop-up 
window is opened with the list of available SLAs in the order that is appearing the list view. 

2. Select an SLA, and click Move up or Move Down button beside the list. 
3. Click Save. 

Organizing the SLAs decide the order in which the SLA is applied on the incoming request. 
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Configuring Notification Rules 

ManageEngine ServiceDesk Plus allows you send notifications to requesters, technicians, and 
vendors. The notifications can be of two types: e-mail and SMS. These notification modes can be set 
across various modules of the application, such as requests, purchase, and contracts. There may be 
some default actions that you might want to perform when the state of any item changes. These 
default configurations can also be defined. To set the notification rules and the message template: 

1. Login to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Notification Rules icon . The resulting page is as 
below: 

 

4. To enable or disable any of the notification rules, select or deselect the check box beside 
each of the rules. 

5. You can also choose the technician(s) who need to be notified when a new request is 
created. For this, click Choose button. The list of technicians is displayed in a pop-up 
window. 

6. Select the technicians. For multiple selections, press Shift or Ctrl key and then select the 
technicians. 

7. Click OK. The selected technicians get listed in the text box beside the Choose 
technician(s) button. 
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You can customize the message template for each of the notifications. For this 

1. Click Customize Template link available beside the notification for which you wish to modify 
the content that is being sent. The resulting page is as below: 

 

 

2. You can change the subject and the message content by typing the text of your choice and 
also adding other variables that you wish to display as a part of the subject or message 
content. To add more variables, just click the corresponding variable from the list box beside 
the respective field. 

To customize the message template for purchase and contract notifications 

1. Click the Email Template link beside module (Purchase Order and Contracts) for which you 
want to customize. The Message Template form is displayed in editable mode.  
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2. The Notification Type field is non-editable. You can edit the description of given for the 
notification type. 

3. In the Message block, you can choose the database fields that need to be a part of the 
notification. From the Database Fields list, choose the fields that you wish to send as a part 
of the notification and click the >> button. If you wish to remove some fields from the 
notification content, then select those fields from the Notification Fields list and click the << 
button. 

4. Click Save. 
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Preventive Maintenance 

You can create a Preventive Maintenance Task for regular maintenance such as changing the printer 
toner every month or perform a regular service shutdown.  

To schedule a preventive maintenance task, 

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Preventive Maintenance Tasks icon . This opens the 
Configuration Wizard page.  

4. Click the Preventive Maintenance Tasks link at the left side of the page under the HelpDesk 
block. This opens Request Maintenance Tasks page.  

5. Click Add New PM Task link. This opens Add Preventive Maintenance Task page. You can 
create a preventive maintenance task in two steps. 

Creating a Task Template 

Task template has four blocks, Request details, Owner details, Requester details, Category details. 

1. Specify the Status of the request from the comb box. Ex. Open. 
2. Specify the Level of the request from the combo box. The level should be selected based on 

the priority. Ex. If the priority of the request is high then select Tier 1. 
3. Select the Mode from the combo box. This will be the mode of communication, to inform the 

technician. 
4. Select the Priority from the combo box.  For ex. High, Medium, Low etc. 
5. Select the Group from the combo box. This option is given to group the task template. Ex. 

Network, Hardware etc. 
6. Select the Technician from the combo box to assign the task and click the requester list icon 

to select the requester Name. This is a mandatory field. The other details such as Contact 
Number, Workstation ID and Department get filled automatically based on the requester 
details specified in the requester form. 

7. Select the Category, Sub Category and Item from the combo box.  
8. Specify the Subject line for the task in the given text field. Specify relevant information about 

the task in the given Description field. 
9. To attach a file to the task template click Attach a File button to attach files. 
10. You can add Resolution in the resolution text field. 
11. Click Next>> button for Task Scheduling. 

Task Scheduling 

To schedule a task, select the time frame from the listed options:  

Daily Schedule: To run a daily maintenance task, click Daily Schedule radio button.  

1. Select the Time at which the maintenance task should be scheduled from the combo box.  
2. Select the Date on when the maintenance task should be scheduled from the Calendar 

button. 
3. Save the details. 
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Weekly Schedule: To run a weekly maintenance task, click Weekly Schedule radio button. 

1. Select the day of the week by enabling the corresponding check box beside the day of the 
week. 

2. Else if you wish to schedule on all days of the week, then click Everyday check box. 
3. Select the Time frame to schedule the task from the combo box. 
4. Save the details.    

Monthly Schedule: To run a monthly maintenance task, click Monthly Schedule radio button. 

1. Select the month to run the task by enabling the check box beside Every Month.   
2. Select the Date on when the task should be scheduled from the combo box. 
3. Select the Time at which the task should be scheduled from the combo box. 
4. Save the details  

Periodic Schedule: To run a periodic maintenance task, click Periodic schedule radio button. 

1. Specify the day (s) in the given text field to schedule the maintenance task. i.e after every 
specified nth day the maintenance task will be executed. 

2. Save the details. 

One Time Schedule: To run a one time maintenance task, click One Time Scheduling radio button. 

1. Select the Date & Time on when the maintenance task should be executed. 
2. Save the details. 

For Example: 

If you wish to schedule a monthly task to change the printer cartridges, 

1. Select Monthly Schedule radio button. 
2. Select the check box every month. 
3. Choose the date from the combo box. Ex: 3rd of every month. 
4. Select the time from the combo box. Ex: 1500 hrs.  
5. Save this schedule. A task to change cartridge will be sent to you every month on 3rd at 1500 

hrs helping you to complete the regular maintenance task in advance without any request 
sent from the users. 
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IT Services  

You can list of all the available IT services in your organization using this option. All the affected IT 
Services on change will be selected from the list. The affected IT services list will be submitted to the 
CAB to infer the impact of the change also it can be recorded and used for future reference.    

To Add New IT Service,   

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the IT Services icon . This opens the Configuration Wizard 
page.  

4. Click on the New Service link on the right hand side of the page. This opens the Add IT 
Services details page.  

5. Specify the Name of the IT Service in the given text field. This is a mandatory field.  
6. Specify the IT Service details in the Description field.  
7. Save the changes.   
8. Click the Save and add new button to save the IT service and add another IT service.    
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User Management 

For making the ServiceDesk Plus available and usable for all your customers, you need to add 
requesters and technicians, and define their roles. This enables the requesters to log in to the Self-
Service Portal to check the status of the issues reported by them, submit requests, and search the 
knowledge base online. The added technicians can log in to the ServiceDesk Plus application and 
pick up requests, review and resolve requests assigned to them, add solution articles, and so on. The 
user management configurations allow you to add requesters, technicians, define roles, and login 
access permissions.  

The various user management configurations that you can perform are 

1. Configuring Roles 
2. Configuring Requester Additional Fields 
3. Configuring Requesters 
4. Configuring Technician Additional Fields  
5. Configuring Technicians 
6. Configuring Groups 
7. Configuring Active Directory Authentication. 
8. Configuring LDAP 
9. Configuring Leave Type 
10. Configuring Robo Technician 

To access the user management related configurations:  

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane. The Users block is below the Asset Management 
block. 
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Configuring Roles 

ManageEngine ServiceDesk Plus can be accessed by different people in your organization. The 
technicians accessing the application will have a defined role and hence have a defined set of tasks to 
execute. The roles for requesters is pre defined and hence roles configured in the Admin tab cannot 
be assigned to them. ServiceDesk Plus allows the administrator to configure the roles and assign 
these roles to the technicians using the application.  

To open the role configuration page:  

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  
3. In the Users block, click the Role icon . The next page displays the available list of roles. 

You can add, edit, or delete roles. 

Add Role 

To add a role,  

1. Click the Add New Role link available at the top right corner of the Role List page. This 
opens the Add Role form.  

2. Enter the Role Name in the given text field. The Role Name has to be unique and is a 
mandatory field.  

3. Set the access permissions for the role. To set the access permission, just select the check 
boxes beside the access levels defined for each of the modules of the application. 
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Example:If you want to provide add permissions for the requests and solution modules and 
only view permissions for the rest, select the check box below Add against the Requests and 
Solutions modules. For the remaining modules, select the check box below View. Selecting 
the Add check box automatically enables view permissions also. 

4. You can also choose to restrict the technician from viewing all the requests received by the 
application. To do this, select the corresponding radio button which will suit your need from 
the following: 

• All : The technician with this role can view all the requests and assets in 
ServiceDesk Plus. 

• All in associated Site: The Technician can view the requests and the assets 
of all his associated sites. To associate the site to the technician refer 
Technician. 

• All in Group & assigned to him: The technician will be restricted to view all 
the requests of the Group to which he/she belongs and also those requests 
that are assigned to him/her. 

• Assigned to him: The technician will be restricted to view the requests that 
are assigned to him/her. 
 
For ex : Site1 has two groups, say Group1 and Group2. Adam is a technician 
associated to group1 with All in group & assigned to him enabled, then he 
will be restricted to view all the requests in group1 and the requests assigned 
to him. He will have the privilege to re-assign the requests to technicians in 
his associated sites but once this is executed, the request will not be visible 
to Adam.  

5. You can also provide permission to approve solutions in the role by enabling the check box 
beside Technician allowed to Approve solution. Thus the technician assigned with this role 
will be able to approve solutions.   

6. Enter a brief description of the role in the Description field.  
7. Click Save. If you want to add more just one role, click Save and add new button.   

If you want to add more just one role, then instead of clicking Save, click Save and add new button. 
This adds the new role and reopens the add role form after displaying a message for the addition of 
the role.  

At any point, if you decide not to add the new role, then click Cancel to get back to the role list. 
Clicking the View List link on the top right corner of the add role form will also take you to the role list 
view.  

Edit Role 

To edit an existing role:  

1. In the Role List page, click the edit icon beside the role name that you wish to edit. 
2. In the Edit Role form, you can modify the name of the role, description, and the permissions 

associated with the role. 
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel. 

Even while editing a role, if you wish to add a new role, click the Save and add new button instead of 
clicking Save button after making the changes. The Add Role form opens after displaying a message 
that the changes are saved.  
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Delete Role 

1. In the Role List page, click the delete icon beside the role name that you wish to delete. A 
confirmation dialog is opened. 

2. Click OK to proceed with the deletion. If you do not want to delete the role, then click Cancel. 

 

Note: You cannot edit or delete the SDAdmin and SDGuest roles that are already defined 
in the application. They are the default administrator and requester roles defined. 
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Configuring Requester - Additional Fields 

By default, the New Requester form has the required fields, where you can enter important details 
about an organization. Sometimes, you may need some additional fields in the New Requester form. 
You can add your own fields using the Requester User Defined Fields configuration.  

 

To add your own custom fields in the new requester form:  

1. Login to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  

3. In the Users block, click the Requester - Additional Fields icon . The next page is a 
form, where you can enter the field label and description of the field. You can add three types 
of fields in the form: text, numeric, and date/time. These three are available in three tabs as 
shown below: 

 

4. To add the text fields, enter the label name in the form fields below the Label heading. If 
required, enter the description for the field. 
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5. You can choose the type of text field that you wish to add by selecting the radio buttons. A 
Single-line text field allows you to add just a text field. The Multi-line text field allows you to 
add a text box where a lengthy description can be added. A Pick List allows you to add a list 
menu from which you can select. In all the three cases, you can add default values for the text 
field in the space provided for the same.  

6. To add items for the pick list, enter the value in the text filed and click Add Item. The value 
will get added to the list below. To select the default selected value of the list, click on the 
value in the list. 

7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields 
provided for the same. 

8. To add date/time fields, click the Date/Time tab and enter the required details. 
9. Click Save. A message for successful creation of the fields is displayed. 

These fields appear under the grouping Additional Requester Details in the New Requester form. 
To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the 
label names that you wish to remove from the fields of the form and click Save. The respective fields 
that you deleted will be removed from the New Requester form.  
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Configuring Requesters 

You can add, edit, or remove the requesters in the ServiceDesk Plus application and also provide 
them with login permissions to access the self-service portal.  

To open the requester configuration page:  

1. Log in to the ServiceDesk Plus application with the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  
3. In the Users block, click the Requesters icon . The next page displays the available list of 

requesters. You can add, edit, or delete requesters. 

Add Requester 

To add a requester and provide login access to him/her, 

1. Click Add New Requester link available at the top right corner of the Requester List page. 
This opens the Add Requester form 

2. In the Personal Details block, enter the Full Name and Employee ID of the technician. The 
name is a mandatory field. Specify any relevant information about the requester in the 
Description text field. 

3. In the contact information block, enter a valid e-mail ID. If the requester has a phone and a 
mobile number, you can enter the same in the space provided for entering these values. 

4. Specify the department details such as, Site and the corresponding Department Name to 
which the requester belongs from the combo box. The requester has an option to view, only 
his requests, all his department requests or all the requests in the site to which he is 
associated. Select the options from the Requester allowed to view combo box. Specify the 
Job Title of the requester in the field provided.  

5. If you have added any organization-specific fields for the new requester form, those will be 
available under the Additional Requester Details block. Enter the relevant information. 

6. In the Self-Service Access Details block, enter the Login Name and Password, if you wish 
to provide self-service access to the requester. Enter the password again in the Re-type 
Password field. 

7. Certain requesters can also approve purchase order in an organization. Upon enabling the 
check box adjacent to Purchase Order Approvers, a link is sent to the requester to accept 
or reject the PO.  

8. Click Save. If you want to add more than one requester then, click Save and add new button.  

At any point if, you decide not to add the new requester, then click Cancel to get back to the 
requester list. Clicking the View List link on the top right corner of the add requester form will also 
take you to the requester list view.  

Import Requesters from Active Directory 

You can also import requesters from an active directory. To import requesters from active directory 

1. Click Import from Active Directory link in the Requester List page. The Import From 
Active Directory window pops up. 

2. From the list of domains that are listed in the Domain Name combo box, select the domain 
name in which the active directory from which you wish to import is installed. If the other 
details such as domain controller name, user name, and password have already been 
entered in the Domain scan page, then that will be populated automatically. Else enter the 
name of the domain controller in the Domain Controller Name field, login name and 
password in the corresponding fields. 
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3. Select the Fields for Import from the active directory by enabling the check box. 
4. Click Import Now !. The import wizard displays the various Organizational Units (OUs) 

available in that domain. Choose the specific OU from which you wish to import users by 
selecting the check box beside it. 

5. Click Start Importing. Once the import is complete, the data on how many records were 
added, how many overwritten, and how many failed to import will be displayed. 

Import Requester from CSV (Comma Separated Value) Files 

You can also add requesters by importing from CSV files. To import requesters from CSV file 

Step 1: Locate the CSV file 

1. Click Import from CSV link in the Requester List page. The Import Wizard opens in 
a pop-up window. 

2. Click the Browse button in the wizard. 
3. Select the CSV file in the file chooser window and click Open. 
4. Click Next. 

Step 2: Customize Mapping 

1. The CSV column names are populated in the select boxes beside each label. Map 
the ServiceDesk Plus requester fields with the field names from the CSV file.  

2. Click Next. 

Step 3: Import 

1. Click Import Now button. The values from the CSV file will be imported to the 
requester details. Once the import is complete, the data on how many records were 
added, how many overwritten, and how many failed to import. 

If at any point you wish to stop importing from the CSV file, click the Exit button. 

 

Note: Login name column will be the identifier for requesters. No two requesters can have 
the same login name. Hence the existence of a requester will be checked based on the 
login name value.  

 

So if by mistake there was any mismatch of fields during mapping, and a new import of 
CSV is performed, the records will be updated based on the login name value. If there 
were any records that did not have any login name at all or there was mismatch in the 
login name itself, then duplicate entries will be created. In these cases, delete such 
entries from the requester list and import again or manually edit the information available. 

Edit Requester 

To edit the requester details, 

1. In the Requester List page, click the edit icon beside the requester's full name that you 
wish to edit. The Edit Requester form is displayed with the existing details of the requester.  
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2. In the above form, you can modify all the fields displayed. You can also change the login 
name of the requester. 

3. Click Save. If you do not wish to modify any of the details, click Cancel. 

Change Requester Password 

You can change the requester's password while editing the requester details.  

1. To change the password of the requester, click the Reset Password link. The reset 
password window is opened.  
 

 
2. Below the Login Name display, enter the New Password in the text field. 
3. Click Reset Password. If you do not wish to change the password, click Close 

instead of Reset Password. 
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Change Requester to Technician 

You can change a requester to technician without having to delete the requester information 
and recreate the same as a technician. To change requester to technician 

1. Click the Change <requester name> as Technician link available at the top right 
corner of the edit requester form. The page refreshes to display the edit technician 
form. 

2. Change the roles assigned to the requester from SDGuest to any other role that you 
wish to provide the technician. 

3. Enter any other details that you wish to enter including the Cost per hour and so on.  
4. Click Save. If you do not wish to change the requester to technician, click Cancel 

instead of Save. 

If you want to continue adding technician after converting a requester to technician, then 
instead of clicking Save, click Save and add new button. This saves the technician details 
and reopens the add technician form after displaying a success message for changing the 
requester to technician. 

Associate Workstation to Requester 

You can also associate a workstation with the requester. To associate a workstation with the 
requester 

1. Click the Associate Workstation link available at the top right corner of the edit 
requester form. The associate workstation window is opened. 
 

 
2. In the Associate Workstation pop-up, select the workstations that you wish to 

associate with the requester from the Workstation List and move them to the 
Associated Workstations list by clicking the >> button. To dissociate workstations, 
select the respective workstations in the Associated Workstations list and click the 
<< button. If you wish to dissociate all the workstations, then click Dissociate All. 

3. After associating the required workstations, click Save Changes. 
4. A message is displayed. Click the Close button. 

Delete Requesters 

1. In the Requester List page, click the delete icon beside the requester's full name that you 
wish to delete. A confirmation dialog is opened. 

2. Click OK to proceed with the deletion. If you do not want to delete the requester, then click 
Cancel. 
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Search Requesters 

To search requesters 

1. In request list view, click on the alphabet with which the name of the requester starts. This 
lists the requesters whose name starts with that alphabet. 
 

 
2. If you are unsure of the starting letter, then you can type the name (first name or the last 

name, which ever you know) or email ID or any other parameter that will identify the requester 
in the field beside the Search Requester List. This lists the requesters whose details 
matches the search string that you entered. 

You can also search requesters from the Search available on the left menu in the other pages of the 
application. From the Search in combo box, select Requesters and type your search string in the 
Enter Keyword text field. Click Go or press Enter. The requester names that match the search string 
are listed in a separate pop-up window. 

Another option to search requesters will be using the column-wise search option. To perform a 
column-wise search 

1. Click the search icon at the end of the requester list view headers. This opens the search 
field just below every column that is visible in the list view.  

2. Enter the search key in field under the column of your choice. 
3. Click Go. The search results matching the search string(s) are displayed. 

Requester List View Customization 

To customize the requester list view 

1. Click the column edit icon available at the corner of the requester list headers. This opens 
the available columns that can be displayed in the list view. All those that are visible currently, 
will have the check box beside them selected. 

2. To remove a column, disable the check box beside the column name.  
3. To add a column to the list view, enable the check box beside the column name.  
4. To change the column order, click the up and down arrow after selecting the column that you 

wish to move. 
5. Click Save. 

This will add only those columns which you have chosen in the list view. You can also sort the list 
view based on columns. To sort requester list by column, click the column header. Clicking it once will 
sort it in ascending order. Clicking twice will sort the column in descending order.  
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Configuring Technician - Additional Fields 

By default, the New Technician  form has the required fields, where you can enter important details 
about an organization. Sometimes, you may need some additional fields in the New Technician form. 
You can add your own fields using the Technician User Defined Fields configuration.  

To add your own custom fields in the new technician form:  

1. Log in to the ServiceDesk Plus application with the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  

3. In the Users block, click the Technician - Additional Fields icon . The next page is a 
form, where you can enter the field label and description of the field. You can add three types 
of fields in the form: text, numeric, and date/time. These three are available in three tabs as 
shown below:  

 

4. To add the text fields, enter the label name in the form fields below the Label heading. If 
required, enter the description for the field. 
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5. You can choose the type of text field that you wish to add by selecting the radio buttons. A 
Single-line text field allows you to add just a text field. The Multi-line text field allows you to 
add a text box where a lengthy description can be added. A Pick List allows you to add a list 
menu from which you can select. In all the three cases, you can add default values for the text 
field in the space provided for the same.  

6. To add items for the pick list, enter the value in the text filed and click Add Item. The value 
will get added to the list below. To select the default selected value of the list, click on the 
value in the list. 

7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields 
provided for the same. 

8. To add date/time fields, click the Date/Time tab and enter the required details. 
9. Click Save. A message for successful creation of the fields is displayed. 

These fields appear under the grouping Additional Technician Details in the New Technician form. 
To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the 
label names that you wish to remove from the fields of the form and click Save. The respective fields 
that you deleted will be removed from the New Technician form.  
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Configuring Technicians 

The IT help desk team will have technicians who will be handling the requests posted/raised by 
various employees in the organization. You can add, edit, or remove the technicians from a site in the 
ServiceDesk Plus application and also provide them with various access privileges that suit their role 
and need.  

To open the technician configuration page, 

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  
3. In the Users block, click the Technicians icon . This opens the technicians list view page. 

Here you can add, edit, or delete technicians. 

 

Note: The Site Admin can add and view the technicians of the site to which he/she is 
associated by selecting the site from the Technicians for combo box. The Technicians 
for combo box will appear if the sites are configured. The sites can be configured in 
Admin- Sites.      

Add Technician 

To add a technician and associate a role with him/her,  

1. Click the Add New Technician link available in the top right corner of the Technician List 
page. This opens the Add Technician form. 

2. Enter the Full Name and Employee ID of the technician in the Personal Details block. The 
name is a mandatory field. 

3. In the contact information block, enter a valid e-mail ID and SMS Mail ID of the technicain. If 
the technician has a phone and a mobile number, you can enter the same in the space 
provided for entering these values. 

4. Enter the cost details of the technician in the Cost per hour field. 
5. Select the Department Name to which the technician belongs and enter his/her job title. 
6. You can associate multiple sites to a technician. Select the sites to which you want to 

associate the technician from the list of Available Sites and move it to Associate Sites by 
clicking >> button. Similarly you can also dissociate the sites. You can also 
associate/dissociate sites from the technicians in the Technicians list page. 
Note: If no site is associated to the technician, then Not in any Site automatically gets 
associated to that technician.  

7. You can also assign Groups to the technician. Select the groups from the list of Available 
Groups and move it Associated Group by clicking >> button.  

8. If you have added any organization-specific fields for the new technician form, those will be 
available under the Additional Technician Details block. Enter the relevant information. 

9. To provide login access to the technician with specific access privileges or enable 
administrative privileges for the technician, enable the check box beside Enable Login for 
this technician. This displays the Login Details block.  

10. Enter the Login Name and Password. Enter the password again in the Re-type Password 
field. All these fields are mandatory if login is enabled. Also note that the login name needs to 
be unique.  

11. Now you need to assign a role to the technician, which will define his access privileges to 
various modules in the application.  

• If you want the technician to have complete administrator access then select the radio 
button, Enable Administrator Privileges. This option will not be available when a 
Site Admin logs in to the application using his login credentials.  
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• If you want the technician to have complete administrator access for the above 
selected sites then select the radio button, Enable Administrator Privileges for the 
sites selected above. 

• Else, Enable Custom Privileges radio button and choose the roles from the list of 
Available Roles and move it to Assigned Roles by clicking >> button. If you want to 
remove any of the roles assigned, then select the role from the Assigned Role list 
and click << button. The selected roles will be removed. 

12. Click Save. If you want to add more than one technician then, click Save and add new 
button.  

If you decide to give the login access for the technician at a later time, you can save the technician 
details without the login details. For this, you need to stop with the step 5 and click Save. Later you 
can add the login details by editing the technician details.  
 
At any point, if you decide not to add the new technician, then click Cancel to get back to the 
technician list. Clicking the View List link on the top right corner of the add technician form will also 
take you to the technician list view.  

Edit Technician 

If you have added a technician without giving the login details, then you can enable the same by 
editing the technician's details. To edit a technician information, 

1. Select the site of the technician which you wish to delete from the Technicians for combo 
box. By default, the list of all the technicians is displayed. Click the edit icon beside the 
technician's full name that you wish to edit. If you have not enabled the login permissions, the 
edit technician form opens with a view similar to the add technician form. Enable the login 
permissions as mentioned in the add technician form (starting from step 6 onwards). 

2. If the login permissions have been added while adding the technician itself, then the edit 
technician form will look as shown below, 
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3. In the above form, you can modify all the fields displayed and also change the roles assigned, 
by adding or removing roles. (To add new roles, refer to the Configuring Roles section.) 

4. Click Save to save the changes performed. At any point, if you wish to cancel the operation 
that you are performing, click Cancel. 

Even while editing a technician, if you wish to add a new technician, then click Save and add new 
button after making the changes. The Add Technician form opens after displaying a message that 
the changes have been updated successfully. 
 
You can also change the password of the technician from the Edit Technician form.  

1. Click the Reset Password link available beside the Password field in the Edit Technician 
form. 

2. In the Reset Password pop-up, enter the New Password in the field provided below the 
login name. 

 

3. To send the reset password information to the user, select the check box below the New 
Password field.  

4. Click Reset Password. If you do not wish to change the password, click Close instead of 
Reset Password.  

5. In the Edit Technician form, click Save.  

While editing the technician details, you can also choose to remove his/her login permissions.  

1. In the Edit Technician form, below the password field, click the Yes link beside the Remove 
Login field. A confirmation window appears. 

2. Click Ok to proceed. A message is displayed informing the removal of the login permissions 
and the technician edit form is displayed without the login details. If you do not wish to remove 
the login permission, click Cancel. 

3. Click Save. 

Associate Technicians to Sites 

You can associate bulk technicians to sites using this option. If you have added the technician without 
associating the sites then the same can be done from the technicians list view page. 

1. From the technicians list view page, enable the check box adjacent to the technician for 
whom you want to associate site.  

2. Click Actions button --> Associate to Site option. The Associate Technician(s) to site pop 
up window appears. 

3. Select the Site to which you want to associate the technician from the combo box.  
4. Click Associate button. The technician gets associated to the site. 
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Dissociate Technicians from Sites 

You can dissociate bulk technicians from sites using this option. The added sites can also be 
dissociated from the technician from the technicians list view page. 

1. From the technicians list view page, enable the check box adjacent to the technician for 
whom you want to associate/dissociate site.  

2. Click Actions button --> Dissociate from Site option. The Dissociate Techncian(s) from 
site pop up window appears.  

3. Select the Site from which you want to dissociate the technician from the combo box.  
4. Click Dissociate button. A pop up window confirming the operation appears. Click Ok to 

proceed. The technician gets dissociated from the site.   

 

Note: Dissociating the technicians from a site will remove all their traces from SLA, 
Business Rules and Groups associated to that site. 

Delete Technicians 

1. Enable the check box beside the technician which you wish to delete from the Technician 
List page. Click the delete button. A confirmation dialog is opened. 

2. Click OK to proceed with the deletion. If you do not want to delete the technician, then click 
Cancel. 

 

Note: Delete icon will not be available beside the name of the technician who has 
currently logged in to the application. To delete that technician, you need to log out and 
log in as a different technician and then delete the details. Also, the administrator 
technician details can be deleted only by another technician with administrative privileges.
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Configuring Groups 

Request Groupss denote the location where the various incoming requests can be categorized and 
grouped. Each Group can have a group of technicians incharge of handling the requests pertaining to 
that Group You can configure these Groups in such a way that notifications can be sent to technician 
group who belong to the Group regarding a new request creation. These Groups will be listed in the 
drop-down menu in the New Request form.  
 
To open the Group configuration page 

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane. 

3. In the Helpdesk block, click the Groups icon . You can add, edit, or delete Groups. 

Add Group   

To add a request Group, 

1. Click the Add New Group link available at the right top corner of the Group list page. 
2. In the Add Group form, enter the group name in the Name field. This is mandatory field. 
3. Select the technicians that you wish to group under this Group from the Available 

Technicians list box and click >> button to move them to Technicians interested in this 
Group. 

4. You can choose the technicians of the Group to whom you wish to notify for a new request 
creation in the Group. To do this select the check box Send notification to Group 
technician(s) when a new request is added to this Group. This drops down the technician 
selection field. 

5. Click Choose button to open the List of Group Technician pop-up window. 
6. Select the technicians whom to wish to notify and click OK. 
7. To choose the technicians to send notification for unpicked requests in the Group, select the 

check box Send notification to technician(s) when a request in this Group is left 
unpicked. This drops down the technician selection field and time period configuration after 
which the notification will be sent. 

8. Click Choose button to open the complete list of technicians available in your help desk. 
9. Select the technicians from the list box and click OK. The technicians get listed in the field 

provided.  
10. Enter the time period, from the creation of the request in Group, after which the notification of 

unpicked requests will be sent to the selected technicians. 
11. If you wish to describe the Group in detail enter the same in the Description text box.  
12. Enter the Group E-mail id in the given text field. Multiple e-mail id for a group should be 

separated by commas or semi colon and needs to be unique.  
13. Specify the Sender's Name and the Sender's E-mail in the given text field. The senders 

name will be specified while sending e-mails.   
14. Click Save. The new Group is added. 

If you want to add more than one Group, then instead of clicking Save, click Save and add new 
button. This adds the new Group and reopens the Add Group form.  

At any point, if you decide not to add the new Group, then click Cancel to get back to the Group list. 
Clicking the View List link on the top right corner of the add Group form will also take you to the 
Group list view.  
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Note: Enabling the check boxes while adding Group does not ensure that the notification will 
be sent. This setting is just to choose the technicians to whom the notification needs to be 
sent and the time frame after which the unpicked request notification is to be sent. To 
actually send the notification, you need to enable the corresponding setting under the 
Notification Rules under the Admin tasks, which are: 

1. Notify Group technician by mail when request is added to Group. 
2. Notify technician by mail when request is unpicked in Group. 

Edit Group 

To edit an existing Group 

1. In the Group List page, click the edit icon beside the Group name that you wish to edit. 
2. In the Edit Group form, you can modify the name of the Group, the technicians belonging to 

the Groups, the notification settings, and description. 
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 

performing, click Cancel. 

Even while editing a Group, if you wish to add a new Group, then click Save and add new button 
instead of clicking Save button after making the changes.  

Delete Group 

1. In the Group List page, click the delete icon beside the Group name that you wish to 
delete. A confirmation dialog appears. 

2. Click OK to proceed with the deletion. If you do not want to delete the Group, then click 
Cancel. 
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Configuring Active Directory Authentication 

You can configure to authenticate the requester login with the active directory (AD). This provides you 
an advantage of not having to remember too many passwords. In you have configured AD 
authentication, then any password change that is made in the AD will also reflect in ServiceDesk Plus. 
So the requesters can login using the login name and password of the system.  

 

Note: Please ensure that before you start configuring the AD Authentication, you have 
already imported the requesters. Only if a user account is available in ServiceDesk Plus 
application, it will authenticate the password for that user account from the active 
directory. Hence, when none of the users have been imported from the active directory, 
the authentication cannot be done for the user account. 

To configure the Active Directory Authentication 

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  

3. In the Users block, click the Active Directory Authentication icon . Here you can 
enable or disable active directory authentication. By default the AD authentication will be 
disabled.  

4. If you have already imported requesters from the any of the domains in your network, then 
click Enable button.  

Even after enabling Active Directory (AD) Authentication, if you would like to bypass the AD 
Authentication, then in the application login screen, you need to select Local Authentication from the 
Domain list box after entering the login name and password, and then click Login button to enter 
ServiceDesk Plus. 

To configure the Pass - through Authentication, 

On enabling single sign-on, ServiceDesk plus directly authenticates your windows system user name 
and password . Hence you need not login over again to enter into ServiceDesk plus.  

1. Enabling Active Directory, activates the Pass-through authentication (Single Sign-on) option. 
2. If you like to activate single sign - on, select the Enable Pass-through Authentication 

(Single Sign-On) option.  
3. Save the authentication. You will get a confirmation message on the authentication. 

Note   

• To enable single sign-on, enabled domain should be two way trusted.  
• Single sign-on works only on Windows Internet Explorer. 

If you have not yet imported requesters from any of the domains, you can import them by clicking 
Import Requesters from Active Directory link. The Import From Active Directory window pops 
up. 

1. From the list of domains that are listed in the Domain Name combo box, select the domain 
name in which the active directory from which you wish to import is installed. If the other 
details such as domain controller name, user name, and password have already been 
entered in the Domain scan page, then that will be populated automatically. Else enter the 
name of the domain controller in the Domain Controller Name field, login name and 
password in the corresponding fields. 
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2. You also have an option to select the fields to import from the active directory. The unselected 
fields will not be imported. This is to avoid over ridding of the new values by the old values 
from the directory. 

3. Click Import Now !. The import wizard displays the various Organizational Units (OUs) 
available in that domain. Choose the specific OU from which you wish to import users by 
selecting the check box beside it. 

4. Click Start Importing. Once the import is complete, the data on how many records were 
added, how many overwritten, and how many failed to import will be displayed. 

Schedule AD import 

1. You have an option to schedule Active Directory import in specified number of days.  
2. Select the Schedule AD import check box. Specify the number of days in the text box. The 

requester details gets imported automatically once in specified number of days. 
3. Click saveADSync button to be in sync with the active directory. 
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Configuring LDAP authentication 

You can also import users from the LDAP server through the domain controller. On enabling the 
LDAP authentication, the users can login using their LDAP credentials. By default, the LDAP 
authentication will be disabled.  

 

Note: Ensure that before you start configuring LDAP authentication the users are already 
imported from the domain. The LDAP authentication supports both linux and windows users. 
On enabling LDAP authentication for windows users, the AD authentication gets disabled 
automatically. 

To import users from a New Domain, 

1. Login to ServiceDesk Plus application using your username and password. 
2. Click the Admin tab in the header pane.  

3. In the Users block, click the LDAP Authentication icon . By default, the LDAP 
authentication will be disabled.  

4. Click Add New Domain button under Domain Controllers block. This opens the Add New 
Domain Controller form as shown below, 

 

5. Specify the Domain Controller from where the users have to be imported in the Domain 
Controller text field. For ex: ldap://<server name>:<port number>. The default port is 389. 

6. Enter the User Name along with the Organizational unit (OU) in the given field. For ex, 
CN:john, CN=Users, DC=domain name, DC=com. 

7. Specify the Password in the respective field.   
8. Specify the Base DN which represents the distinguished base name such as, CN = Users, 

DC = domain name, DC = com.  
9. Specify the criteria which you want to apply on that particular domain controller in the search 

filter text field. For ex: mail=* will import users from the parameter mail in the specified domain 
controller.  

10. Select the LDAP Server Type from the combo box. For ex. OpenLDAP.  

 

Note: If you have chosen the Server type as default LDAP such as, Microsoft Active 
Directory, Novell eDirectory and OpenLDAP then the Login Attributes Label, Mail 
Attribute Label and Distinguished Name Attributed Label will appear in a non editable 
text.   
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11. If the LDAP Server Type is Others then, specify the Login Attribute Label and Mail 
Attribute Label in the respective fields.  

12. The Distinguished Name Attributed Label is similar to the Base DN. 
13. Click Save to save the domain controller. If you want to save and import the users, click Save 

and Import.   

You can also import users from the existing domain by clicking Import Now of the corresponding 
Domain Controllers. The existing data will be over written on importing the users from the same 
domain. Once the users are imported, Enable LDAP Authentication by selecting the check box. 

Click Save. The user can login to the application using his LDAP credentials.   

Edit Domain Controller 

1. Click domain controller name which you wish to edit. This opens the Add new domain 
controller form.  

2. Modify the changes and click Save. To save and import the users from the domain controller, 
click Save and Import. 

Delete Domain Controller 

1. From the domain controller list view page, enable the check box adjacent to the domain 
controller which you wish to delete. 

2. Click Delete button. A pop up window confirming the delete operation appears. Click Ok to 
continue. The domain controller gets deleted from the list.  

On deleting a domain controller, the users imported from that domain controller will not be able to 
login to the application using LDAP credentials.  
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Configuring Leave Types 

Leave types is the type of leave taken by the technician such as sick leave, casual leave and so on. 
This is essential while marking leave for the technicians in Scheduler. You can configure the type of 
leave using Leave Types option. To open the leave type configuring page,   

1. Login to ServiceDesk Plus application using your username and password.  
2. Click the Admin tab in the header pane. 

3. In the Users block, click Leave Types icon . This opens the Leave Types page 

Add Leave Type 

1. Click New Leave Type link on the right hand side of the leave type list view page. This opens 
the Add-Leave Type form.  

2. Enter the Name of the leave type in the given text field. For ex. Sick Leave, On Duty. The 
specified name has to be unique. This is mandatory field. 

3. Specify brief description about the leave type in the Description text field. 
4. Click Save. The leave type gets listed in the list view page. Click Save and Add New to save 

and add another leave type.    

Edit Leave Type 

1. From the Leave Types list view page, click the edit icon beside the leave type which you 
wish to edit. This opens the Update page. 

2. Modify the Name and the description field. 
3. Click Save. You can also save and add another leave type from Update page by clicking 

Save and Add New.    

Delete Leave Type 

1. From the Leave Type List view page, enable the check box adjacent to the leave type which 
you wish to delete. 

2. Click Delete button. A confirmation dialog appears. 
3. Click Ok to continue. The leave type gets deleted from the list. 
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Robo Technician 

Using Robo Technician you can reset the user password quickly & easily. This involves two steps 
process to reset the user password such as, 1) configure robo task 2) creating a request template. 

To open the robo technician page, 

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  

3. In the Users block, click the Robo Technician icon . On purchasing the license for the 
robo technician the Robo Task Configuration page is displayed. 

Configuring Robo Task 

1. Click Enable robo task option to perform the robo task operations by clicking the enable 
icon. By default the status of the robo task would be disabled. 

2. There are three blocks available in the configuring robo task page such as, Task Options, 
Action On Success & Action On Failure. In the Task Options block select Password Reset 
Type from the combo box.  You have four passwords reset types such as, 

Random Password: In this case the robo technician assigns a random password to the user. 

Typed Password: In this type the logged in technician will enter the password in the given text 
field. 

Same as the User Name: The robo technician will assign the same user name as password. 

Blank Password: In this type the password assigned will be a blank password. 

3. If you wish, you can select User must change password on next login check box. 
Generally this option should be enabled for security purpose. 

4. On resetting the password successfully you can configure the corresponding actions to be 
performed in the Action On Success block. Select the Request Status you wish from the 
combo box.  

5. Specify the Resolution Details in the text field. 
6. If the password-reset action is failed then you can configure the corresponding actions to be 

performed in the Action On Failure block. To assign the event to the currently logged in user 
select Assign to Invoker check box. 

7. Or you can assign it to the Group under which the problem is associated.  
8. And also you can assign the problem to the corresponding Technician.  
9. Specify the notes about the issue in the Notes text field. 
10. Click Save button to save the details. 
11. Click Save and go to Template button to go to the Request Template page.   

Creating a Request Template 

On installing Robo Technician it automatically creates a default Request Template for a particular 
Robo Task. You can also edit this request template based on your needs.  

Example: Say if a user requests technician for password reset, and if the technician has already 
configured robo task, then he can create a request to reset password using this default template.  
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Problem/Change Management  

The goal of Problem Management is to find the root cause of incidents and reduce the impact on 
business. The goal of Change Management is to control and manage approved changes with 
accepted risk. ServiceDesk Plus allows you to implement a comprehensive problem management and 
change management system. Problem/Change related configurations are: 

1. Problem Additional Fields 
2. Problem Closure Rules 
3. Change Type 
4. Change Status 
5. Change Advisory Board 
6. Change Additional Fields 
7. Change Closure Rules 

To access Problem/Change related configurations:  

1. Log in to the ServiceDesk Plus application using the user name and password. 
2. Click the Admin tab in the header pane. The problem/change management block is below the 

Help Desk block. 
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Problem Additional Fields  

You have pre-defined fields by default in the New Problem form to enter the details about the 
problem. If you need any additional fields in the New Problem form then, you can add your own 
additional fields using this option.  You can add text, numeric and date/time fields in the form. 

To add your own custom fields in the New Problem form:  

1. Login to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  
3. In the Problem/Change Management block, click the Problem - Additional Fields 

icon . This opens the Problem - Additional Fields page. You can add three types of fields 
in the form: text, numeric and date/time.  

4. To add the text fields, enter the label name in the form fields below the Label heading. If 
required, enter the description for the field. 

5. You can choose the type of text field that you wish to add by selecting the radio buttons.  
• A Single-line text field allows you to add just a text field.  
• The Multi-line text field allows you to add a text box where a lengthy description can 

be added.  
• A Pick List allows you to add a list menu from which you can select. In all the three 

cases, you can add default values for the text field in the space provided for the 
same.  

6. To add items for the pick list, enter the value in the text filed and click Add Item. To select the 
default selected value of the list, click on the value in the list. 

7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields 
provided for the same. 

8. To add date/time fields, click the Date/Time tab and enter the required details. 
9. Click Save. A message for successful creation of the fields is displayed. 

   
These fields appear under the grouping Additional Problem Details in the New Problem form. To 
delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label 
names that you wish to remove from the fields of the form and click Save. The respective fields that 
you deleted will be removed from the New Problem form.    
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Problem Closure Rules 

Problem closing rules can be used to select the mandatory fields to be filled in by the technicians 
while closing the problems and also includes optional rules that can be enabled by the technician on 
closing the problem.    
   
Example: If you have selected 'Associated Tasks should be closed' as a mandatory field in this 
page, then the technician whoever resolving the problem, should close all the related tasks to a 
problem and enter the details in the corresponding field before closing it. Else an error message pops 
up, asking you to fill the details in the field. If you have selected the optional rules as, E-mail all 
requesters affected by this problem and Close all associated incidents, on closing the problem a 
pop up window listing the selected optional rules appears. Based on the incident the technician can 
enable the check box corresponding to the optional rules.   

To configure the problem closing rules, 

1. Login to the ServiceDesk Plus application using the user name and password. 
2. Click the Admin tab in the header pane.  

3. In the Problem/Change Management block, click the Problem Closure Rules icon . 
This opens the Problem Closure Rules page.  

4. Select the Mandatory Fields from the list to be filled in before closing the problem by 
enabling the check box. 

5. Select the Optional Rules by enabling the check box. The selected rules will get listed to the 
technician on closing the problem. Based on the incident the technician can,  

• E-mail technician working on incidents associated with this problem : An e-mail 
notification is sent to the concerned technicians working on the incident associated 
with the problem.  

• E-mail all requesters affected by this problem : An e-mail notification is sent to all 
requesters who have raised requests concerning the problem.  

• Copy problem solution and workaround to all associated incidents : The 
solution to the problem and workaround is copied to all associated incidents. 

• Close all associated incidents : All the associated incidents is closed on resolving 
the problem.         

6. Save the details. 
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Change Type  

The change types shows the significant changes in the organization which involves cost and time. By 
default you have four change types and Standard is a pre-defined change type hence cannot be 
edited. And the Standard Change type is a pre-approved change type which will not require approval 
from the change manager.  
   
To add a new Change Type,   

1. Login to the ServiceDesk Plus application using the user name and password. 
2. Click the Admin tab in the header pane.  

3. In the Problem/Change Management block, click the Change Types icon . This opens 
the Change Type list page.  

4. Click on the New Change Type link. This opens the Add New page.  
5. Specify the Name for the change Type in the given text field, say Significant. This is a 

mandatory field.  
6. Select the Colour by clicking the colour icon to indicate the severity of the change. This is a 

mandatory field. 
7. Specify the Description about the change type in the description field.  
8. Save the changes. You can see the change type getting listed in the change type list view.  
9. Click the Save and add new button to save the Change Type and add another Change Type.  

        
   
   
   
   
  



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 343

Change Status  

Change Status shows the current state of the change in the organization. You have a list of default 
change status. Rejected is a pre-defined change status hence cannot be deleted.  
   
To Add New Status,    

1. Login to the ServiceDesk Plus application using the user name and password. 
2. Click the Admin tab in the header pane.  

3. In the Problem/Change Management block, click the Change Status icon . This opens 
the Status List page.  

4. Click on the New Status link on the right hand side of the page. This opens the Add Status 
page.   

5. Specify the Name of the status in the given text field.  
6. Specify the Description about the status in the given text field.  
7. Save the changes. You can see the new status getting listed in the status list page.  
8. Click the Save and add new button to save the Change Status and add another Change 

Status.    
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Change Advisory Board  

The Change Advisory Board (CAB) is a body that exists to approve changes and to assist Change 
Management in the assessment and prioritisation of changes. The members of the CAB are selected 
based on their expertise and capability to assess change adequately from business and technical 
point of view.  
   
To add new a CAB,   

1. Login to the ServiceDesk Plus application using the user name and password. 
2. Click the Admin tab in the header pane.  

3. In the Problem/Change Management block, click the Change Advisory Board icon . 
This opens the Change Advisory Board (CAB) page. 

4. Click New CAB button. This opens the Add CAB page.  
5. Specify the Name of the CAB in the given text field.  
6. Select the members of the CAB from the technicians list and move it to the members list 

using >> button.  
7. Specify the Description of the CAB in the description field and save the changes.  
8. Click the Save and add new button to save the CAB and add another CAB.  
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Change Additional Fields  

You have pre-defined fields by default in the New Change form to enter the change details in the 
form. If you need any additional fields in the New Change form then, you can add your own additional 
fields using this option.  You can add text, numeric and date/time fields in the form. 

 

To add change additional fields,  

1. Login to the ServiceDesk Plus application using the user name and password. 

2. Click the Admin tab in the header pane.  

3. In the Problem/Change Management block, click the Change Additional Fields icon . 
This opens the Change Additional Fields page. You can add three types of fields in the 
form: text, numeric and date/time. 

4. To add the text fields, enter the label name in the form fields below the Label heading. If 
required, enter the description for the field. 

5. You can choose the type of text field to add by selecting the radio buttons.  

• A Single-line text field allows you to add just a text field.  

• The Multi-line text field allows you to add a text box where a lengthy description can 
be added.  

• A Pick List allows you to add a list menu from which you can select. In all the three 
cases, you can add default values for the text field in the space provided for the 
same.  

6. To add items for the pick list, enter the value in the text filed and click Add Item. To select the 
default selected value of the list, click on the value in the list. 

7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields 
provided for the same. 

8. To add date/time fields, click the Date/Time tab and enter the required details. 

9. Click Save. A message for successful creation of the fields is displayed. 

 

These fields appear under the grouping Additional Change Details in the New Change form. To 
delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label 
names that you wish to remove from the fields of the form and click Save. The respective fields that 
you deleted will be removed from the New Change form.    
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Change Closure Rules 

Change closing rules can be used to select the mandatory fields to be filled in by the technicians 
before closing the changes.  
   
Example: If you have selected Impact as a mandatory field, then the technician whoever doing the 
change, should enter all the impact details of the change before closing it. Else an error message 
pops up, asking you to enter the details of the impact in the corresponding field.   
   
To select the mandatory fields,    

1. Login to the ServiceDesk Plus application using the user name and password. 

2. Click the Admin tab in the header pane.  

3. In the Problem/Change Management block, click the Change Closure Rules icon . 
This opens the Change Closure Rules page.  

4. Select the mandatory fields for closing the change from the list by enabling the check box.  

5. Save the details.  
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Asset Management 

The inventory module of the ServiceDesk Plus application enables you to keep track of the various 
assets available in your organization and their corresponding usage and availability. It also helps you 
monitor your assets online in any of the networks in your firm. This helps you in proactively planning 
your resource allocation and purchases. Before you start using the inventory module, you have to 
configure the inventory-related information. The inventory-related configurations are:  

1. Product Types details 
2. Products 
3. Vendors information 
4. Workstation - Additional Field 
5. Asset Additional Field for new asset form 
6. Software Types 
7. Software Category 
8. Resource State 
9. Scan for Windows PCs 
10. Scan for Linux PCs 
11. Audit Settings 

To access the inventory-related configurations:  

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane. The Asset Management block is just below the 
helpdesk block. 
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Configuring Product Types 

Each product purchased by a firm can be categorized into a specific product type. This is the high-
level categorization for the assets that are bought. For example, Adobe Photoshop or Macromedia 
Flash can be categorized under the product type Software, while HP Inkjet Printer can be categorized 
under the product type Printer. In general, product type is a parent category under which you can 
group each of the specific assets owned by your firm. Proper categorization helps in estimating how 
much has been spent for purchasing each of the product type assets (Printer, Scanners, etc.), how 
much assets in each of the product types are available in the organization and so on.  

To open the product type configuration page:  

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane.  
3. In the Asset Management block, click the Product Types icon . The next page displays 

the available list of product types. You can add, edit, or delete product types.  

Add Product Types 

To add product types:  

1. In the Product Types List page, click Add New Product Type link available at the top right 
corner. 

2. In the Add Product Type form, enter the Product Type Name. This name needs to be 
unique and this field cannot be blank. 

3. If required, add relevant Description for the product type. 
4. Click Save. 

If you want to add more than one product type, then instead of clicking Save, click Save and add new 
button. This adds the new product type and reopens the add product type form after displaying a 
message that the a new product type is added.  
 
At any point, if you decide not to add the new product type, then click Cancel to get back to the 
product type list. Clicking the View List link on the top right corner of the add product type form will 
also take you to the product type list view.  

Edit Product Type 

To edit an existing product type:  

1. In the Product Types List page, click the edit icon beside the Product Type Name that 
you wish to edit. 

2. In the Edit Product Type form, you can edit the product type name and the description. 
3. Click Save. At any point, if you wish to cancel the operation that you are performing, click 

Cancel.  

Even while editing a product type, if you wish to add new product type, then click Save and add new 
button instead of clicking Save button after making the changes.  
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Delete Product Types 

To delete a product type:  

1. In the Product Types List page, click the delete icon beside the Product Type Name that 
you wish to delete. A confirmation dialog is opened. 

2. Click OK to proceed with the deletion. If you do not want to delete the product type, then click 
Cancel. 
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Configuring Products 

The specific asset types are termed as products. For example, Dell Lattitude D600 is a product 
representing Dell Laptops. These products need to be added in the application so that they can be 
used while referencing from the various modules of the application, such as Inventory and Purchase. 
As and when you purchase any specific product belonging to a new asset type, you need to add the 
new product. Also, if a product needs to be discarded you can also remove it from the list by deleting 
the details of the same.  

To open the product configuration page:  

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane.  
3. In the Asset Management block, click the Products icon . The next page displays the 

available list of products. You can add, edit, or delete product. 

Add Product   

To add products:  

1. In the Product List page, click Add New Product link available at the top right corner. 
2. In the Add Product form, enter the Product Name. This field cannot be blank. 
3. If you know the manufacturer of the product, enter the same in the Manufacturer field. 
4. From the Product Type combo box choose the product type under which you wish to classify 

the product that you are adding. 
5. Enter the Part No. of the product. 
6. If required, add relevant Comments for the product. 
7. Click Save. A message is displayed and the product is added. Simultaneously, a Vendors tab 

is also added. This tab is to give a vendor association to the product. 
8. Click the Vendor tab. 
9. Click the Associate Vendor button to associate vendor with the product. This opens the 

Associate Vendor page. 
10. In the Associate Vendor form, choose the vendor name from the combo box provided and 

enter the price of the product. These are the two fields that are mandatory. 
11. If you know the warranty period of the product, enter it in the Warranty Period by choosing 

the number of years and months from the combo box. 
12. Choose the maintenance vendor. 
13. If you wish to add any comments, add it in the Comments text box. 
14. Click Save to save the details. The page is refreshed to display the vendor association 

information. Repeat the steps 9 - 14, till you have added all the vendors who supply this 
product. 

If you do not wish to associate the vendor now, then click Cancel. It goes back to the Product Details 
tab. 
 
If you wish to add more than one product, then in step 7, instead of clicking Save, click Save and add 
new button. This would add the product and open the add product form for you to add more 
products. In this case, the product vendor association needs to be done later. To get back to the 
product list page without adding the product or after completing the vendor product association, click 
View List link at the top right corner of the Add Product form.  
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Edit Product 

If you have added the product without associating the vendor with the product, then you will have to 
associate the vendor by editing the product information.  

To edit the product information:  

1. Click the edit icon beside Product Name in the Product List page. 
2. In the Edit Product form, you can edit all the form fields mentioned in the add product 

procedure. 
3. Click the Vendor tab and click the Associate Vendor button. 
4. Edit the required fields and click the Add button. 

Even while editing the product information, if you wish to see the product list page, click the View List 
link at the top right corner of the Edit Product form. Also if you want to add a new product, then in the 
product details tab, click Save and add new button. 

Delete Product  

To delete a product, it is necessary that the product vendor association is first removed and then the 
product is deleted. Also ensure that the particular product is not used elsewhere. Follow the steps 
below to delete a product:  

1. In the Product List page, click the edit icon beside Product Name. 
2. Click the Vendors tab. 
3. Click the delete icon beside the Vendors. A confirmation dialog is opened.  
4. Click OK to proceed with the deletion. Delete all the vendor associations of the product. 
5. Click view list link on the top right corner of the center pane. 
6. Now, click the delete icon beside the Product Name for which you removed the vendor 

association. A confirmation dialog is opened. 
7. Click OK to proceed with the deletion. If you do not wish to delete the product, click Cancel. 
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Configuring Vendors 

An organization can have business contacts with more than one vendor for buying the various 
resources of the organization. It is very essential for the firm to keep track of its vendors and the 
products supplied by these vendors. To configure these details, you can use the configuring vendors 
option available in the admin page.  

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Admin tab in the header pane.  

3. In the Asset Management block, click the Vendors icon . You can add, edit, or delete 
vendors. 

Add Vendors 

To add vendors:  

1. In the Vendor List page, click Add New Vendor link available at the top right corner. 
2. In the Add Vendor form, enter the Vendor Name. This name needs to be unique and this 

field cannot be blank. All the other fields are optional.  
3. Enter relevant Description for the vendor. 
4. Enter the Contact Name at the vendor location. 
5. Enter the address details of the vendor in the respective fields. 
6. Enter the vendor e-mail ID, phone, fax, and web URL. 
7. Click Save. A message is displayed and the vendor is added. Simultaneously, a Products 

tab is also added. This tab is for adding the list of products that are supplied by the vendor. 
8. Click the Products tab. 
9. Click Associate Product button. 
10. In the associate product form, choose the product name from the combo box and enter the 

price of the product. These are the two fields that are mandatory. 
11. If you know the warranty period of the product, enter it in the Warranty Period by choosing 

the number of years and months from the combo box. 
12. Choose the maintenance vendor from the combo box. 
13. If you wish to add any comments, add it in the Comments text box. 
14. Click Add. The page is refreshed to display the product association information. Repeat the 

steps 9 - 14, till you have added all the products supplied by this vendor. 

If you do not wish to add the product list after opening the associate product form, then click Cancel. 
It goes back to the Vendor Details tab. 
 
If you wish to add more than one vendor, then in step 7, instead of clicking Save, click Save and add 
new button. This would add the vendor and open the add vendor form for you to add more vendors. 
In this case, the product list needs to be added later. To get back to the vendor list page without 
adding the vendor or after adding the list of product supplied by the vendor, click View List link at the 
top right corner of the Add Vendor form.  
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Edit Vendor 

If you have added the vendor without adding the product list, then you have to add the list of product 
supplied by the vendor only by editing the vendor information.  

To edit the vendor information:  

1. Click the edit icon beside Vendor Name in the Vendor List page. 
2. In the Edit Vendor form, you can edit all the form fields mentioned in the add vendor 

procedure. 
3. Click the Products tab to add the list of products supplied by the vendor and follow the steps 

9 through 14 in add vendors. 

Even while editing the vendor information, if you wish to see the vendor list page, click the View List 
link at the top right corner of the Edit Vendor form. Also if you want to add a new vendor, then in the 
vendor details tab, click the Save and add new button.  

Delete Vendors 

To delete a vendor, it is necessary that the product vendor association is first removed and then the 
vendor is deleted. Also ensure that the particular vendor is not used elsewhere. Follow the steps 
below to delete a vendor:  

1. In the Vendor List page, click the edit icon beside Vendor Name. 
2. Click the Products tab. 
3. Click the delete icon beside the Products. A confirmation dialog is opened.  
4. Click OK to proceed with the deletion. Delete all the products listed. 
5. Click view list link on the top right corner of the center pane. 
6. Now, click the delete icon beside the Vendor Name for which you removed the product list. 

A confirmation dialog is opened. 
7. Click OK to proceed with the deletion. If you do not wish to delete the vendor, click Cancel. 
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Workstation Additional Fields 

You can define your own organization specific fields that need to appear in the new workstation form 
apart from the default fields. You can add text fields, numeric fields, and date/time type fields in the 
form. 

Adding Workstation Additional Fields   

Configuring Additional Text fields 

1. Click on Admin tab -> Click Workstation Additional Fields icon  in 
the Configuration Wizard page. This opens Workstation – Additional 
Fields page. You can configure 12 additional text fields for a 
workstation. 

2. By default the list of all additional text fields are displayed. Specify 
the Label for the Workstation Additional Fields. 

3. Specify any relevant information about the additional fields in the 
Description text field. 

4. Specify the Type of the text field by enabling the radio button. It can 
be either Single- Line, Multi – Line or drop down menu list. 

5. Specify the Default Values in the given text field.  
6. Click Save to save the settings.   

Configuring Additional Numeric fields 

1. Click on the Numeric tab. You can configure 4 additional numeric 
fields for a workstation. 

2. Specify the Label for the additional field. This is a mandatory field. 
3. Specify any relevant information about the additional fields in the 

Description text field. 
4. Click Save to save the settings. 

Configuring Additional Date/Time fields.                      

1. Click on the Date/Time tab. You can configure 4 additional fields for a 
workstation. 

2. Specify the Label for the additional field. This is a mandatory field. 
3. Specify any relevant information about the additional fields in the 

Description text fields. 
4. Click Save to save the settings. 
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Asset Additional Fields 

You can define your own organization specific fields that need to appear in the new asset form apart 
from the default fields. You can add text fields, numeric fields, and date/time type fields in the form. 

Adding Asset Additional Fields   

Configuring Additional Text fields 

1. Click on Admin tab -> Click Assets Additional Fields icon  in the 
Configuration Wizard page. This opens Assets – Additional Fields 
page. You can configure 12 additional text fields for an asset. 

2. By default the list of all additional text fields are displayed. Specify 
the Label for the asset additional fields. 

3. Specify any relevant information about the additional fields in the 
Description field. 

4. Specify the Type of the text field by enabling the radio button. It can 
be either Single- Line, Multi – Line or drop down menu list. 

5. Specify the Default Values in the given text field.  
6. Click Save to save the settings.   

Configuring Additional Numeric fields 

1. Click on the Numeric tab. You can configure 4 additional numeric 
fields for an asset. 

2. Specify the Label for the additional field. This is a mandatory field. 
3. Specify any relevant information for the additional fields in the 

Description field. 
4. Click Save to save the settings. 

Configuring Additional Date/Time fields.                      

1. Click on Date/Time tab. You can configure 4 additional fields for an 
asset. 

2. Specify the Label for the additional field. This is mandatory field. 
3. Specify any relevant information for the additional fields in the 

Description field. 
4. Click Save to save the settings. 
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Adding Software Type 

All different forms of software such as, licensed, prohibited, freeware, shareware, excluded and un-
identified software comes under this category.  

To Add New Software Type, 

1. Log in to ServiceDesk Plus application using your user name and password. 
2. Click the Admin tab in the header pane. This opens the Configuration Wizard page. 

3. Under the Asset Management block, click the Software Type icon . This opens the 
Software Type list page. By default you have list of six software type in ServiceDesk Plus. 
These default software cannot be edited or deleted. 

• Shareware: Software that is available free of charge, may be distributed for 
evaluation with a fee requested for additional features or a manual etc. 

• Freeware: Software that is provided without charge.  
• Prohibited: Software that is prevented from use. 
• Excluded: Software that is omitted from use.   
• Managed: All licensed software comes under this software type. 
• Un-Identified: Unknown softwares can be categorized under this software type. 

4. Click the New Software Type link on the right hand side of the page. This opens the 
Software Type Details page. 

5. Specify the Software Type name in the given text field. This is a mandatory field which will 
uniquely identify individual software type. 

6. Specify any relevant information about the Software Type in the Description field. 
7. Click Add Software Type button. This adds the software type to ServiceDesk Plus and gets 

displayed below the add software form.   
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Adding Software Category 

Different groups of software such as, software used for Accounting, Internet, Graphics, Multimedia, 
Operating System and so on are added to ServiceDesk Plus using this option. 

To Add New Software Category,  

1. Login in to ServiceDesk Plus application using your user name and password. 
2. Click the Admin tab in the header pane. This opens the configuration wizard page.  

3. Under the Asset Management block, click the Software Category icon . This opens the 
Software Category list page. By default you have nine software categories displayed in 
ServiceDesk Plus.    

4. Click New Software Category link on the right hand side of the page. This opens the 
Software Category Details page. 

5. Specify the Software Category name in the give text field. This is a mandatory field. 
6. Specify any relevant information about the category in the Description field.   
7. Click Add Software Category button to add the software category to ServiceDesk Plus. The 

added software category gets displayed below the form.        
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Adding Resource State 

Resource can be categorized based on its current status in the organization. Ex: Resource In Use, In 
Store, Expired and so on. 

To Add New Resource State, 

1. Click the Admin tab in the header pane. This opens the Configuration Wizard page.  

2. Under the Asset Management block click the Resource State icon . This opens the 
Resource State list page. 

3. Click the New Resource State link on the right hand side of the page. This opens the 
Resource Sate Details page. By default you have five resource state available in 
ServiceDesk Plus. You cannot edit or delete the resource state. 

4. Specify the Resource Sate name in the given text field. This is a mandatory field. 
5. Specify any relevant information about the resource state in the Description field. 
6. Click Add Resource State button to add the resource to the application. 
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Windows Domain Scan 

ManageEngine AssetExplorer automatically discovers all the Windows Domains in your network. You 
can select any or all of the listed domains and discover workstations listed under the domain by 
providing the required login name, domain controller and password. To add a new domain, 

Add A New Domain 

1. Click on Admin tab -> Windows Domain Scan icon  in the Configuration Wizard 
page. This opens the Domain view list page. 

2. Click on Add New Domain link on the right side corner of the Domain view list page. 
This opens Add Domain page.   

3. Specify the Domain Name in the given field. For ex. Acme. This is a mandatory field, 
which uniquely identifies the domain from the network. 

4. Specify the Domain Controller Name. This is the host name for the domain 
controller and the organizational units are listed only if the domain controller name is 
provided. For ex. winkmaster.  

5. Specify the Login Name. This is the user login name. For ex. Administrator 
6. Specify the Password for the user.   
7. Provide any relevant information pertaining to the domain details in the Description 

field. 
8. Click Save button to save the details. Click Save and Add New button to save the 

domain and add another domain. You can see the domain getting listed in the domain 
view list.  

9. Click Cancel button to cancel the details. 

 

Note: For the workstation scan to execute successfully the following things need to be 
true: WMI needs to be enabled in the workstation where the Asset Explorer server is 
running. COM/DCOM service needs to be switched on in all the workstations belonging to 
the windows domains..  

Scan Domains  

1. Click on Scan menu on the right side of the page -> Click Windows Domain Scan sub 
menu to go to the domain view list page. (Or) Select Admin tab -> Click Windows 
Domain Scan to go to the domain view list page.   

2. Click Scan Domain icon  of the particular domain to discover all workstations under 
the Windows Domain. This brings up the Domain Scan Wizard page. 

3. Choose the Organizational Units for which you want to import and guide you through 
the scan by enabling the check box. 

4. Click Start Scanning button to start the scanning process. You can get the complete 
reports of the scan, with successful and failed workstation list. 
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Network Scan 

Network scan allows you to discover networks that are part of your enterprise. These networks are 
scanned for Linux machines and other IP based IT assets ex: printers, routers, switches etc and they 
are grouped under this network.  

Add New Network  

1. Click on Admin tab -> Network Scan icon  in the Configuration Wizard page. 
This opens the Network view list page. 

2. Click on Add New Network link on the right side corner of the Network view list page. 
This opens Add Network page. 

3. Specify the Network Address in the given field. For ex. 192.168.27.0, this is a 
mandatory field, which uniquely identifies the network address. 

4. Specify the Login Name in the given text field. This login name should have telnet 
access across all machines in the organization. For ex. Administrator. 

5. Specify the Password for the user. 
6. Specify the Community String for the network address, ex: public or private 
7. Provide any relevant information pertaining to the network details in the Description 

field. 
8. Click Save button to save the details. Click Save and Add New button to save the 

network and add another network. You can see the network address getting listed in 
the network view list.   

9. Click Cancel to cancel the details.  

Scan Domains  

1. Click on Scan menu on the right side of the page -> Click Network Scan sub menu to 
go to the network view list page. (Or) Select Admin tab -> Click Network Scan to go 
the view list page. 

2. Click Scan Network icon  of the particular network to discover all network in the 
organization. You can get the complete reports of the scan, with successful and failed 
workstations. 
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Note: To scan the Linux workstations, the telnet service needs to be enabled in both the 
server and the client workstations. 

Edit Network 

If the login names and passwords of networks have changed, then you will need to modify the 
network details.  

To edit the network information:  

1. In the Network List page, click the edit icon beside the Network Address or the 
hyperlinked network address that you wish to edit. 

2. In the Edit Network form, you can modify the network address, login name, password, and 
description of the network. 

3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are 
performing, click Cancel.  

Even while editing a network, if you wish to add new network, then click Save and add new button 
instead of clicking Save button after making the changes.  

Delete Network 

To delete a network:  

1. In the Network List page, click the delete icon beside the Network Address that you wish 
to delete. A confirmation dialog appears. 

2. Click OK to proceed with the deletion. If you do not wish to delete the network, then click 
Cancel. 
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Audit Settings 

Audit settings help you to schedule periodic scanning of your network and enable regular cleanup of 
scanned information and set re-scanning interval for scanning workstation. 

Enable Scheduled Scan 

1. Click on Admin Tab -> Click Audit Settings icon  in the configuration wizard page. 
This opens Audit Settings form. 

2. Select Enable Scheduled Scan check box to configure regular scanning of the 
workstations. 

3. Set the Date and Time (hours & minutes) for scanning of workstations.  

Select any of the 5 radio buttons below the Enable Scheduled Scan sub-heading 
explained below:  

Scan Once 

Select the date on which you want to scan your network using the calendar icon. And 
set the time to scan on the chosen date. 

Daily Scan 

Select the time (hours and minutes) from the combo box to scan workstations on a daily 
basis. Then select the date from the calendar button to schedule scans. 

Weekly Scan 

In the weekly scan option, you can also choose to schedule a daily scan. Select 
Everyday checkbox to enable scan on all the days of the week. Or select the check box 
beside a particular day of the week. Then set the time (hours and minutes) of the scan 
to start the scanning process on the selected day of the week. 

Monthly Scan 

In the monthly scan option select the check box Every Month to scan every month 
throughout the year. Or you can also choose the months you want to scan by selecting 
the check box beside the name of the months. 

In the monthly scan option you can also choose to schedule a weekly scan by selecting 
the radio button Day, and specifying the scanning day of the week from the combo box. 
Or select the Date radio button and specify the date from the combo box. 

Finally select the time (hours and minutes) of the scan. 

Periodic Scan 

You can enter a random period of time to repeat the scan. Enter the number in the field 
provided. The scan will be performed on every specified nth day. Where n is the number 
you enter in the field. The default value is 7th day. 
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History Clean up 

You can enable regular cleanup of scanned information, by selecting the Enable Scan 
History Clean up check box and enter the number of days in the field provided for 
deleting the scanned information. 

Newly Added workstations  

You can also check for newly added workstations by performing a re-scan of your network. 
For this you need to select Check for newly added workstations check box and enter the 
number of days when the periodic re-scanning of your network will be performed. 

Once the details are specified save the changes. Click Reset button to reorganize the 
settings. 
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User Survey 

You can easily configure the customer satisfaction survey to collect information on various key 
parameters that you would like to measure about the support team and the response quality. You can 
define your own survey and the reports will be generated based on the survey that you have defined. 
You can also set the frequency of conducting the survey.  

The various survey related configurations that you can perform are 

1. Configuring Survey Settings 
2. Defining a Survey 

Apart from the above the you can also do the following survey related actions: 

1. Sending Survey for a Request 
2. Viewing the Survey Results 

Once you have completed configuring and defining the survey, you can have a look at the preview of 
the survey by clicking the Survey Preview link on the left menu or the Survey Preview icon in the 
Admin tab. 

To access the user survey related configurations 

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane. The User Survey block is below the Users block. 
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Configuring Survey Settings 

Survey settings enables you to configure the default values for welcome message, survey success or 
failure message, and thank you message. You can also choose to enable or disable a survey. If you 
enable a survey you can also schedule the periodicity of conducting the survey.  

To configure the survey settings 

1. Log in to the ServiceDesk Plus application with the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  

3. In the User Survey block, click the Survey Settings icon . The Survey Settings page is 
displayed. 

4. To enable the survey, select the check box Enable User Survey.  
5. Under the Survey Details block,enter the Welcome Message, which you wish to display as 

soon as the user reaches the survey page. or when the user is taking the survey. 
6. Email Content: Specify the purpose of the email in the Email Content text field. This content 

will be displayed in the mail sent to the requesters. $RequesterName & $SurveyLink are 
variables which changes based on the requester & application URL. 

7. Success Message: Enter the message that will be displayed once the survey has been 
successfully answered and submitted by the user. 

8. Failure Message: When the survey is taken by a person who has already submitted the 
answers for the survey, then you will have to display a failure message. You can enter the 
same in the Failure Message text area. 

9. Thanks Message: Enter the thanks message. This message will be displayed just before the 
submit button in the survey form. 

10. To schedule the survey, in the Schedule Survey block, choose the radio button that you wish 
to set as a criteria for sending the survey. The options are, 

• A request is closed: For closing every one request a survey mail will be sent     

• Requests are closed: Specify the number of requests to be closed of all the 
available requests in the text box. Once the specified number of requests is closed a 
survey mail will be sent.  

• Requests from a requester are closed: Specify the number of requests to be 
closed for a requester in the text box. Once the specified number is reached a survey 
mail is sent to the requester.  This text box can take only integer values as input.  

11. Click Save to save the survey settings. 
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Defining a Survey 

You can define your own survey by adding your own questions and satisfaction levels that will suit the 
needs of your organization and users.  

To define your survey 

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Admin tab in the header pane.  

3. In the User Survey block, click the Define a Survey icon . Here you can add, edit, or 
delete your survey questions and satisfaction levels. 

Add Survey Questions 

To add a survey questions 

1. Click the + Add Question button available in the Questions tab in the Define Survey page.  
2. In the Question pop-up window, type your question in the text area provided. 
3. Click Save. The question will get added in the Define Survey Questions tab.  

You can add any number of questions to the survey by following the above steps. As you keep adding 
questions it will get appended at the end of the list of questions. You can change the order of the 
questions by clicking the Move Up and Move Down link that is available beside each question. 

Edit a Survey Question 

To edit the survey question 

1. In the Questions tab, click the Edit link beside the question that you wish to edit. 
2. In the Question pop-up window, edit the question displayed in the text area. 
3. Click Save. The Define Survey page is refreshed to display the modifications made. 

Delete a Survey Question 

1. In the Questions tab, click Delete link beside the question that you wish to delete. A 
confirmation dialog pops up. 

2. Click OK to delete the question. 

 

Note: If you delete a question from a survey, then it will have an impact on the survey 
results that have been collected previously.  

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 368

Add Satisfaction Levels 

To add satisfaction levels that will be displayed as choices for each of the survey questions 

1. Click the Satisfaction Levels tab in the Define Survey page. 
2. Click + Add Level button. 
3. In the satisfaction level pop-up window, enter the satisfaction level in the text area provided. 
4. Click Save. The satisfaction level is added and the Define Survey page is refreshed to 

display the added satisfaction level. 

You can add any number of satisfaction level to the survey by following the above steps. As you keep 
adding the levels it will get appended at the end of the list of already added levels. You can change 
the order of the same by clicking the Move Up and Move Down link that is available beside each 
question. Satisfaction levels scales from good to bad, good at the top bad at the bottom. Moving up or 
down changes the satisfaction levels. 

Edit a Satisfaction Level 

To edit a Satisfaction level 

1. In the Satisfaction Levels tab, click the Edit link beside the satisfaction level that you wish to 
edit. 

2. In the satisfaction level pop-up window, edit the satisfaction level displayed in the text area. 
3. Click Save. The Define Survey page is refreshed to display the modifications made. 

Delete a Satisfaction Level 

1. In the Satisfaction Levels tab, click the Delete link beside the satisfaction level that you wish 
to delete. A confirmation dialog pops up. 

2. Click OK to delete the satisfaction level. 

 

Note: If you delete a satisfaction level from a survey or change its order, then it will have 
an impact on the survey results that have been collected previously.  
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Sending Survey 

If the survey is enabled in the survey settings, then a technician or the ServiceDesk Plus administrator 
can manually send a survey to the requesters once the survey is closed. 

To send the survey 

1. Log in to ServiceDesk Plus application using your user name and password or that of the 
ServiceDesk Plus administrator. 

2. Click the Requests tab. 
3. In the Request list view, select the filter Closed Requests or My Closed Requests. 
4. Click the request Title for which you wish to send the survey. 
5. Click Send Survey for this Request link available under the Tasks block. A success 

message that the survey has been sent for the request is displayed and the survey will be 
sent to the requester who created the request as a mail with a URL which opens the survey. 

 

Note: The following conditions need to be true for the Send Survey for this Request link to 
be visible: 

1. Either a technician or administrator should have logged in. 
2. The request must be closed. 
3. The User Survey must be enable in the Survey Settings. 
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Viewing Survey Results 

Once the requester completes the survey, the administrator and the requester who took the survey 
can view the survey results.  

To view the survey results 

1. Log in to the ServiceDesk Plus application using the user name and password of a 
ServiceDesk Plus administrator. 

2. Click the Requests tab. 
3. In the Requests list view select the Closed Requests or My Closed Requests filter. 
4. Click the request Title for which you wish to see the survey results. 
5. Click View Survey Results link available under the Tasks block. The survey results opens in 

a pop-up window. 
6. Once you have viewed the results, click the Close button. 

You can view the survey results filled in by the requester from this page. A survey is defined and a 
survey mail is sent to the requester. By sending the survey mail you ask the requester to answer the 
survey questions to improve the service provided by the technicians. The survey results answered by 
the requesters will be listed under this section. 

 

Note:  

1. The View Survey Results link appears only if the requester has completed taking 
the survey. Else this link will not be present. 

2. Once the survey is submitted, the responses cannot be changed. 

 

  
 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 371

Configuring Self Service Portal Settings 

Self-Service Portal settings has ten different settings to be configured in ServiceDesk Plus such as, 
Default Currency, Display Language, My Reminders, Requester List, Dynamic User Addition, Alias 
URL, Customize ServiceDesk and so on.  

To open the self service portal settings page, 

1. Login to ServiceDesk Plus using the user name and password of an admin user. 
2. Click the Admin tab in the header pane. 

3. Click Self Service Portal Settings icon  under the General block. 

Default Currency 

Specify the default currency in the given text field. This unit will be used in all the places where cost 
calculation is done. The default currency specified is $. 

Display Language 

ServiceDesk Plus supports different languages as part of the application. You can choose default 
language of your choice to be displayed in the application. To select the language of your choice, 

Click Browser default combo box. Select the language of your choice from the list.  

My Reminder(s) 

If you wish to show all your tasks as reminders to the requesters then select 'Yes' radio button else 
select 'No' option. The reminders will be shown in the home page. 

Requester List 

While entering the requester name in the new request form, the list of all available requesters will be 
automatically listed. If you wish to list the technicians name along with the requesters name then 
select 'Yes' else select 'No' button. 

Dynamic User Addition 

By default, when a user is not imported into the application but imported through Active Directory, 
then the user can login to the application using the AD credentials. This will automatically provide 
login access to the application. If you do not wish to provide dynamic user addition when the user is 
not imported into the application then enable the 'No' radio button.  

User Login Addition 

By default, if a mail fetched by the ServiceDesk Plus application has a requester name and email ID 
that is not available in the requester or technician list already, then the name is automatically added in 
the requester list and the login name and password is created. The first part of the e-mail ID is set as 
the name and the entire e-mail ID is set as login name and password. The requester can log in to the 
self-service portal and change his/her password. If you do not wish to provide login access to users 
created through email requests then enable the 'No' radio button. 
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Quick Create Settings  

If you wish to show the quick create section to the technicians in the home page, then enable the 
'Yes' radio button else select the 'No' button.  

Requester Details   

If you wish to allow requesters to edit their profile select 'Allow to edit their profile' else select 'Not 
allowed to edit their profile'. By default, all the workstations configured by the administrator will be 
listed in add new request form of the self service portal. If you want the requester to view the 
workstations associated to them then enable the check box 'Show workstation associated to 
requester in Self-Service Portal'.   

Solutions Settings 

By default, the solutions approver can approve their own solutions rather than submitting it for 
approval. If you wish the solution approver should not approve his own solution enable 'No' radio 
button.  

Alias URL  

To provide an alternate URL 

1. In the text field provided beside the http:// text, enter the URL (along with the port number if 
needed).  

2. Click the Open alias URL in a new window link just below the text field, to test if the alias URL 
works.  

Customize ServiceDesk 

You can customize the application by choosing to display your custom logo. You need to add the logo 
in two dimensions, one for the login page and the other for the header image that you see on the top 
left corner of the pages once you login. The login page image should be of the dimensions 252 px x 
61 px (W x H), while the header image needs to be 166 px x 46 px. 

To import the login page image,  

1. Click Import image ... button. 

2. Click Browse button. 

3. In the file chooser window, select the file that you wish to import and click Open. 

4. Click Import. 

The image that you just imported will be replaced instead of the login page image. Follow the same 
process for header image also.  

Click Save, to save the changes made in the settings. 
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Reports 

ManageEngine ServiceDesk Plus gives you a set of preset help desk, problem/change and asset 
reports and so on generated from the data available in the application.  

To view the various reports available in application 

1. Log in to the ServiceDesk Plus application using the user name and password of an admin 
user. 

2. Click the Reports tab in the header pane. The next page lists the various reports grouped 
under different heads. Along with the default reports you also create New Custom Reports, 
New Query Reports, New Scheduled Report.  

The following sections explain the various reports and the kind of data that each of these 
reports represents. 

• About ServiceDesk Plus 
• New Custom Report 
• New Query Report 
• New Scheduled Report 
• Custom Settings 
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About ServiceDesk Plus Reports 

Reports in ServiceDesk Plus can be classified as Helpdesk, Problem/Change, Request Timespent, 
Survey, Asset, Audit, Resources, Purchase, Contracts reports. 

Helpdesk Reports  
 
Reports by all requests    

These reports provide you with graphical view of all open and closed requests by category, 
group, created date, department, due date, level, priority, status, technician, status by category, 
status by level, status by priority, status by technician.  

Also they can be exported as HTML file, PDF file, XLS file and CSV file.  

To save the report in a particular folder click Save report as button. This opens the Save 
Report page. Specify the Report Name and if you wish the report to be viewed by all select 
Every One (Public) report. If you wish to view the report by just yourself (Private), select Just 
me button. 

Select the Folder name from the Save-in-Folder combo box. If you wish to add new folder click 
Add New Folder link. 

Specify the Description about the report in the given text field and Save the details. 

You can also Schedule reports, View query, mail this reports for these reports. These options 
are available for all the report types under each report title.  

Reports by completed requests 

These reports show the distribution of completed and closed requests. Similar to Report by all 
request, these reports are also generated based on various parameters such as category, 
group, department, due date, level, mode, priority and request date.   

Reports by SLA Violated requests 

These reports display the distribution of the requests that have violated the SLA that was 
applicable on them. You can view these violations based on the request category, group,  the 
department from which the request was generated, and the technician who handled the 
request and so on. 

Reports by pending requests 

This shows the distribution of all pending requests for a specific period of time, based on 
different parameters, such as priority, department, technician, category, due date, request date 
and so on.  

Request Summary requests 

These reports provide you with a high level view of the requests received and closed during a 
particular period, date-wise. The summary reports available are the received request summary 
reports by date and closed request summary reports by date. These reports are generated on 
the parameters of request received or closed by technicians, request received or closed in a 
specific category, priority, and mode. 
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Problem/Change Reports 

Reports by All Problems 

You get a graphical view as well as tabular view of all open, closed, on-hold and resolved 
problems based on different parameters such as category, status, priority, impact, technician 
and urgency.  

Reports on Pending Problems 

You get a graphical view as well as tabular view of all open and on-hold problems based on 
different parameters such as, category, priority, urgency and incidents counts.   

Reports on Completed Problems 

You get a graphical view as well as tabular view of all closed problems based on different 
parameters such as, category, priority, urgency, cost and incident counts. 

Reports by All Changes 

You get a graphical view as well as tabular view of all approval, approved, completed, 
implementation, planning, rejected, release, requested, review and testing changes based on 
different parameters such as, category, impact, status, change type, technician, time spent on 
change and priority.  

Reports on Pending Changes 

You get a graphical view as well as tabular view of all pending changes such as approval, 
approved, implementation, planning, release, requested, review and testing changes based on 
different parameters such as, category, priority, change type, urgency, incident counts and 
problem counts.  

Reports on Completed Changes 

You get a graphical view as well as tabular view of all completed changes based on different 
parameters such as, category, change type, priority, urgency, cost, incident counts and 
problem counts. 

Request Timespent Reports 

These reports provide information on the technician's time spent on requests and the cost per 
technician based on the time spent. You can group the report information based on category, 
department, requester and technician attending to the request. The time spent report by requester, 
gives you an idea on the cost per requester and the number of request.  
 
By default, the help desk reports will be created for the current week. You can choose any custom 
period of your choice or choose to create reports for last week, or this month, or for just this day. All 
these reports can be used for analysis purposes. For example, the reports mapped against the 
parameter technician can be used to measure the technician responsiveness and load handling 
capability.  
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Survey Reports 

These reports provide you with the summary details on the survey results based on various 
parameters. All these reports help in measuring the efficiency and effectiveness of the support team 
and take respective corrective actions. 

Under Survey reports you have, 

• Survey Overview Report which gives you the overall ratings of each of the questions in the 
survey based on the feedback of the users who took the survey. The ratings give you an idea 
about the value that is associated with the corresponding question. This report provides both 
tabular and a graphic representation of the results.  

• Survey Results by Category report has the survey information grouped based on the 
category. Against each category, the points gained by each of the survey questions will be 
tabulated. Depending on the kind of survey questions, this report will provide valuable 
information based on individual request categories.  

• Survey Results by Department has the survey information grouped based on the 
department from which the requests originated. The points for each question of the survey is 
mapped against the department name from where the request originated. 

• Survey Results by Level has the survey information grouped based on the level of the 
requests. The points for each question of the survey is mapped against the level of the 
request for which the survey was sent.  

• Survey Results by Mode has the survey information grouped based on the mode of the 
requests. The points for each question of the survey is mapped against the mode of the 
request for which the survey was sent. This also gives you an idea on the mode of request 
that is most frequently used to create a new request.  

• Survey Results by Priority has the survey information grouped based on the priority of the 
requests. The points for each question of the survey is mapped against the priority of the 
request for which the survey was sent.  

• Survey Results by Requester has the survey information grouped based on individual 
requester. This helps you in finding out which requester has sent the maximum number of 
requests and any other information based on your survey questions. This will give you an idea 
of the users perspective and help you in deciding about the corrective actions that need to be 
taken to make the support team more efficient and effective.  

• Survey Results by Technicians has the survey information grouped based on individual 
technicians. Each of the survey questions will carry some value and based on this value, the 
average value for the questions will be marked against the technicians. These points will 
enable you to objectively measure the technicians efficiency and effectiveness from the users 
perspective and take any corrective measures, if required.  

Asset Reports 

All Computers ( Workstation and Servers ) 

The workstation reports give you information about the various workstation-related metrics. 

• Computers  by Domain report tells you the computers grouping based on domains. Thus 
you get to know the number of computers in each of the domains in your organization 
network. 

• Computers  by Manufacturer report gives you a high-level distribution view of the computers 
used from different manufacturers.  

• Computers  by OS report gives you an overview on the percentage of computers belonging 
to each type of operating system. Thus you will also know the different types of Operating 
Systems in use in your organization. 
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• Computers  by Processor Manufacturer report gives you the graphical view as well as the 
tabular view of the computers by processor manufacturer. Thus it gives a count of all 
computers with processor vendor name used in your organization.  

• Computers  by Processor Type report will give a tabular view of all processor type in each 
computers used in your organization. 

• Computers  by Vendor report gives a graphical as well as the tabular view of all vendors for 
each the computers in your organization.           

• Computers with less than 256MB RAM and more than 256MB RAM gives the report of all 
computers in your organization with more than 256MB RAM and less than 256MB RAM.  

• Operating System by Region gives you the list of workstations that are grouped under a 
particular region but are not yet assigned to any user or department. The list of computers is 
also displayed in the tabular form just below the graph.  

• Unassigned workstations by Domain gives you the number of computers that are 
connected to the domains but are not assigned to any user or department or computer. The 
list of computers is also displayed in the tabular form just below the graph. 

Server 

• Server with less than 10% Free Disk space gives the report of all the servers in your 
organization with less than 10% free Disk space. 

• Servers with less than 512MB RAM gives the report of all the servers in your organization 
with less than 512MB RAM.  

Software 

Under software reports you have, Software Reports - Purchased Vs Installed software, 
Software by Category and Software by Manufacturer. Under software reports - purchased Vs 
Installed software you can view the list of all software purchased vs installed in each of the 
workstation in your organization. Under software by category you can view the list of all 
software classified under default software category. Under Software by Manufacturer you can 
have the tabular view of all software used in your organization listed based on the 
manufacturer of the software.  

Workstation Summary Reports 

Under workstation summary reports you have, Software Summary Report and Hardware 
Summary Report.  Software summary report provides you with the tabular view of all the 
software installed in each workstation. This includes all managed, unmanaged software. 
Hardware summary report provides you with all the hardware details of an workstation such 
as, memory details, drive information, hard disk information, physical drive information, network 
adapters and so on. Thus it gives a complete overview of all the software installed and 
hardware details of an workstation.     

Audit Reports 

Under audit reports you have audit history by workstation, audit history by time line, audit history by 
changes. The updated audit reports are available only by scanning the workstation. Audit history by 
workstation gives a complete report on the account of all actions taken place in a workstation. This 
provides detail report on both hardware and software details. Audit history by time line gives a 
detail overview of all actions taken place in a workstation for a specific time period. By default you can 
get only the current week report. Audit history by changes gives a complete report on all changes 
taken place in a workstation for the current week.  
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To get the audit report for previous weeks,  

1. Click the Edit button. This opens the Custom Reports. 
2. From the Date Filter block-> select the Scan Date option from the combo box -> select the 

duration by clicking During combo box which provides you with the last week, last month, this 
month, this quarter, last quarter or yesterday options to generate reports. (OR) if you wish to 
generate reports for a specific time period then select the From and To radio button and 
select the dates from the calender button. 

3. Click Run Report button. You can get report for the specified time period.   

Resources Reports 

Under resources reports you have, resources by product type, resources by vendor, resources types 
by site. Resources by product types gives the graphical view as well as the tabular view of all the 
resources (assets) available for all default and newly added product types. Resources by Vendor 
gives the graphical and tabular view of all the resources in the organization based on the vendor 
name. The name of the vendor will be in X-axis and the resource count will be in Y-axis.  Resource 
Types by Site lists all the available resources in your organization distributed across each sites of 
your company. 

Contract Reports 

Under contracts reports you have reports based on Active contracts, Contracts by Max value, 
Contracts by status, Contracts by vendor and Expired contracts. Active Contracts shows all the open 
contracts in your organization in a graphical and tabular view. Contracts by Max Value shows all the 
contracts which costs above 1000$ will be displayed in both graphical and tabular view. Contracts by 
Status shows the list of all contracts with its status level such as, open contracts, expired, expired in 
the last 30 days, expiring in next 7 days and expiring in next 30 days in a graphical and tabular view. 
Contracts by Vendor shows all the contracts with all status level but classified based on the vendor. 
Expired Contracts shows the list of all the expired contracts in your organization.    

Purchase Reports 

Under purchases you have reports based on  PO Vendors, PO by Ordered Date, PO by Required 
Date, PO by Status. Purchase orders by vendors gives the graphical view and tabular view of all the 
approved, pending for approval, partially approved, closed, overdue, po's due in next 7 days, po's due 
in next 30 days purchase orders classified based on the  vendor name. Purchase orders by ordered 
date gives the graphical view and tabular view of all the approved, pending for approval, partially 
approved, closed, overdue, po's due in next 7 days, po's due in next 30 days purchase orders 
classified based on the ordered date. Purchase orders by required date gives the graphical view 
and tabular view of all the approved, pending for approval, partially approved, closed, overdue, po's 
due in next 7 days, po's due in next 30 days purchase orders classified based on the required date.   
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Custom Reports 

ServiceDesk Plus enables you to create reports that meet your need if you are unable to find them 
from the list of out-of-the-box reports already available. To create your custom reports, 

1. Login to ServiceDesk Plus application with your user name and password. 
2. Click Reports tab in the header pane. 
3. Click New Custom Report  button in the reports home page. This opens the Custom Report 

page that will help you navigate through the various steps involved in the creation of a custom 
report. 

4. Specify the relevant Report Title in the given text field. This is a mandatory field.  
5. Choose the Report Type by selecting the radio buttons. You can create Tabular Reports, 

Matrix Reports, Summary Reports, Audit Reports. 
6. Choose the module (Request, TimeSpent, Problem, Change and so on) for which you wish to 

create the report. The audit History module will be enabled only for audit reports. This is 
applicable only for the tabular and matrix reports. For summary reports, audit reports default 
modules will be selected. 

7. Click Proceed to Report Wizard >> button. This opens the Display Columns page. This page 
differs for each report type. Each report type has to go through various steps before 
generating it as a customized report.  

To generate Tabular Reports 

Tabular reports are simple reports that allow you to list your data based on certain criteria. If you had 
selected the Tabular Reports option then you have five steps to create a complete customized 
tabular report. If you wish to skip a particular option then click the next tab and move to the next 
step.    

Display Columns 

The first step to create tabular reports is to select the display columns which need to be 
displayed in the tabular report. Select the columns from the Available Columns list box and 
click >> button to move them to Display Columns list box. Click the << button if you want to 
remove any column from the Display Columns list box.   

Click Next button. This leads you to the grouping of columns, where you can choose two 
levels of grouping.  

Filter Options 

1. If you are using the date/time filter criteria, select the date column name from the 
Select Column combo box.  

2. Select the period for which you want to generate the report. If you would like to 
generate report during this week, last week, this month, last month, this quarter, last 
quarter or today, yesterday then select the During radio button and select the time 
period from the combo box. (OR) If you wish to provide a custom period, then select 
the From and To date using the calender button. 

3. To use Advanced Filtering, select the column name such as, Requester name, 
region site and so on from the combo box. Select the criteria (is, is not, contains and 

so on) from the combo box. You can pick a value by invoking the icon . Select AND 
or OR option from the combo box to add more than one criteria. You can delete a 
criteria by clicking the delete icon .  

4. Click the Choose button and select the value for the column to add as a filter 
condition. 
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5. Click as Add to Filter button to add the filter condition to the filter set which gets 
listed under the Filter Set title.  

6. Click Next button to go to the grouping of data. 

Grouping Data  

From the Group by combo box, select the column based on which you wish to group the 
data. 

Select the Order by from the combo box.   

Click the Next button to go to the next stage. 

Column Summary 

You can get the column summary for all the columns in the report. If you wish to have the 
column summary displayed in the report, select the column summary options available for 
each column. The summary options differs for each column you have selected.  

Click the Next button to go the next option. 

Charts   

In addition to the tabular chart, if you wish to have a chart displayed for a particular column 
then, or you can skip this option and directly run the report. 

1. Select the chart type to be displayed from the combo box. 
2. Select the Axis column from the combo box to be displayed in the chart . This is a 

mandatory field. The data will be grouped in the chart based on the column selected. 
3. Select the Display Format from the combo box. For ex: in numbers or in percentage.  
4. Click Run Report button. 

On running the report you get a tabular report as well as the graphical view for the selected 
column data. 

To generate Matrix Reports 

Matrix reports provides the data in a grid manner (m x n format). It allows you to study different 
scenarios based on the chosen criteria. If you have selected matrix reports you have two steps to 
generate a complete matrix report. Click the Proceed to Report Wizard button to go to next page. 

Grouping Data 

You have simple grouping and advanced grouping option for matrix reports.  

Simple Grouping 

1. Click the Simple grouping tab. You have two options Top column information and 
left column information. Select the top column information from the combo box. 
This is a mandatory field. 

2. Select the left column information from the combo box. This is a mandatory field. 
3. Select the summarize column count from the combo box to get the column 

summary. 
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Normal Grouping 

1. Click the Advanced grouping tab. You have two options Column grouping and 
Group by. 

2. Select the Columns and Date format to be displayed from the combo box. Select 
the group by from the combo box. You have three options for group by to be 
displayed in the report. This is a mandatory field. 

3. Select the summarize column from the combo box.   
4. Select the period for which you want to generate the report. If needed you can also 

provide a custom period by choosing the from and to date manually. 
5. Click Next. 
6. To use Advanced Filtering, you first need to select the radio button for matching 

all the selected criteria or any one of them. Then from the column listing, select the 
various columns and set the match operator and mention the values for matching.  

Filter Options 

1. If you are using the date/time filter criteria, select the date column name from the 
Select Column combo box.  

2. Select the period for which you want to generate the report. If you would like to 
generate report during this week, last week, this month, last month, this quarter, 
last quarter or today, yesterday then select the During radio button and select the 
time period from the combo box. (OR) If you wish to provide a custom period, then 
select the From and To date using the calender button. 

3. To use Advanced Filtering, you first need to select the radio button for matching 
all the selected criteria or any one of them. Then from the column listing, select 
the various columns from the list and set the match operator and mention the 
values for matching the column as (is, is not, contains and so on) from the combo 
box.  

4. Click the Choose button and select the value for the column to add as a filter 
condition. 

5. Click as Add to Filter button to add the filter condition to the filter set which gets 
listed under the Filter Set title.  

6. Click Run Report button. You get a matrix report 

Request Summary Reports 

Summary reports are detailed reports that allow you to list your data based on certain criteria. To 
create a request summary report, select the corresponding radio button from the custom reports page 
and click the Proceed to Report Wizard button to go to next page. You have two steps to generate a 
complete request summary reports. 

Display Columns 

The first step to create request summary reports is to select the display columns which need 
to be displayed in the request summary report. Select the columns from the Available 
Columns list box and click >> button to move them to Display Columns list box. Click the 
<< button if you want to remove any column from the Display Columns list box.   

Click Next button. This leads you to the grouping of columns, where you can choose two 
levels of grouping.  
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Filter Options 

1. If you are using the date/time filter criteria, select the date column name from the 
Select Column combo box.  

2. Select the period for which you want to generate the report. If you would like to 
generate report during this week, last week, this month, last month, this quarter, last 
quarter or today, yesterday then select the During radio button and select the time 
period from the combo box. (OR) If you wish to provide a custom period, then select 
the From and To date using the calender button. 

3. To use Advanced Filtering, you first need to select the radio button for matching all 
the selected criteria or any one of them. Then from the column listing, select the 
various columns from the list and set the match operator and mention the values for 
matching the column as (is, is not, contains and so on) from the combo box.  

4. Click the Choose button and select the value for the column to add as a filter 
condition. 

5. Click as Add to Filter button to add the filter condition to the filter set which gets 
listed under the Filter Set title.  

6. Click Next button to go to the grouping of data. 

Audit Reports 

Audit reports are detailed history report that allow you to list your inventory history data based on scan 
time criteria. Click Proceed to Report Wizard button to go to the next page. This opens the Audit 
History Report page. 

You have three audit history reports options, on scanning the workstation you get the updated version 
of all the audit reports.  

• Audit history by workstation. 

Audit history by workstation gives a complete audit reports of the hardware and software 
details of the workstation. 

• Audit history by time line. 

Audit history by time line gives a detail overview of all the actions taken place in a workstation 
for a specific time period. 

• Audit history by changes. 

Audit history gives a complete report on all changes taken place in a workstation. 

Select any of the three audit history report options. Specify the scan date from the combo box. 

Click Run Report button. You get the audit history report.  
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Creating New Query Reports 

1. Click on the Reports tab. This opens the All Reports page. 
2. Click New Query Report button. This opens the Query Editor page.  
3. Select the Table Schema from the combo box say,  requests, timespent and so on. Click Get 

to view the table schema for the selected option. 
4. Specify the title of the report in the Report Title field. This is a mandatory field. 
5. Specify the query to be executed for getting reports in the Query field. This is a mandatory 

field. 
6. The logs will display all error messages on providing any wrong query. 
7. Click Run Report to run query report.  

Tips 

1. Date Formulae: DATE_FORMAT (FROM_UNIXTIME (COLUMN_NAME/1000),'%d-%m-%Y 
%k: %i') 'Column Alias'.  

2. Minutes Formulae: ROUND ((((COLUMN_NAME/1000)/60)) % 60) 'Minutes'.  
3. Hours Formulae: ROUND (((COLUMN_NAME/1000)/3600)) 'Hours'.  
4. Compare Date: COLUMN_NAME >= (UNIX_TIMESTAMP (DATE ('2006-07-24 00:00:00')) * 

1000).  
5. Convert Memory in GB: ((((MEMORY_COLUMN)/1024)/1024)/1024)  
6. Default Value For Null Data: COALESCE (COLUMN_NAME, 'Unassigned')  
7. Group by: Query statement will be ends with order by <column_index>  

Additional Field tables 

1. Request Additional Fields - WorkOrder_Fields  
2. Requester Additional Fields - Requester_Fields  
3. Technician Additional Fields - Technician_Fields  
4. Asset Additional Fields - Asset_Fields  
5. Workstation Additional Fields - Workstation_Fields 
6. Problem Additional Fields - Problem_Fields 
7. Change Additional Fields - Change_Fields  
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Scheduling Report Settings 

1. Click Reports tab. This opens the All Reports page. 
2. Click New Scheduled Report button. This opens Schedule Report Settings page. 
3. To generate report once click Generate Once radio button. Specify the date using the 

calendar button and Time from the combo box on which the report has to be generated. 
4. Select the report to schedule from the combo box. The list will display all the available 

reports such as, Reports by All requests, Reports by Completed requests, Reports by SLA 
Violated reports and so on. This is a mandatory field. 

5. Specify the E-mail ID of the person to whom the generated report has to be sent.  
6. Save the details. Scheduled reports gets displayed in the Schedule Reports page. 
7. To generate reports on a daily basis click Daily Report radio button and specify the From 

Date, Time, report to be scheduled and the e-mail address of the person to whom the 
report has to be sent. Save the details. 

8. To generate weekly report click Weekly Report radio button. Specify the days of the week on 
which you want to generate reports by selecting the check box. Or select Everyday check 
box to generate reports on daily basis. Also specify the time, report to schedule, and E-mail 
ID of the person to whom the generated report has to be sent. Save the details.   

9. To generate reports on a monthly basis click Monthly Report radio button. Specify the month 
on which the report has to be generated by enabling the check box. Or select Every Month 
check box to generate reports on monthly basis. Also specify the time, report to schedule, and 
E-mail ID of the person to whom the generated report has to be sent. Save the details. 
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Custom Settings 

The custom settings wizard helps you to customize the report column size. This helps to increase or 
decrease the tabular column size, matrix column size and modify the date and time format of your 
custom reports.  

1. Click Reports tab. This opens the All Reports page. 
2. Click the Custom Settings button. The Report Settings page pops up. 
3. If you wish to customize the Tabular column size, specify the size of the small text, large 

text, number size and date and time text. And update the changes. 
4. If you wish to customize the Matrix column size, specify the size of the cell width and cell 

height and update the changes. 
5. You can also change the date and time format to be displayed in the report. If you specify the 

format in the given text field as MM-dd-yyyy HH:mm then the result would be Date: 09-20-
2007 Time:03:20. 

6. To disable the links in reports enable the check box beside Disable links in report under 
General Settings block. To view one Group per page, enable the check box beside the 
same. 

7. Click the Update button to update the changes. While generating reports the customized 
report format will be  
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Appendix 

This topic explains the various features that are not grouped under any of the modules but can be 
used from the application.  

 

• System Log Viewer 
• Feedback 
• Personalize 
• Backup and Restore 
• Changing web server port 
• Troubleshooting 
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System Log Viewer 

You can view the error logs generated by the ServiceDesk Plus application online.  

To view the error logs 

1. Log in to the ServiceDesk Plus application using your user name and password. If you have 
the permissions to view the support information, you will see a Support tab in the header. 

2. Click the Support tab in the header pane.  
3. Click the System Log Viewer link available in the Support page. 

To view the individual error details 

1. In the Error Log list view page, click the hyperlinked Error Message. An error log window 
with the details of the error is opened. 

2. The Error Message field contains the complete error message. 
3. The Module field indicates the module in which the error occurred. 
4. The Occurred At field indicates the date and time when the error occurred. 
5. If the probable cause of the error is known, then the cause is displayed in the Probable 

Cause field. 
6. The Performed By field indicates the origin of the error. For example, if it is a system-

generated error, then the Performed By field contains System as its value. 
7. Click Close after viewing the details of the error message. 

None of these fields are editable. You can also search for a specific error log details with the help of 
the Search in feature. 

To search for error logs 

1. In the left menu, the search block is found at the bottom. If you are in the Error Log list view 
page, then by default, the System Log option is chosen in the Search in combo box. If not, 
then choose System Log. 

2. In the Enter Keyword text field, enter the search string. 
3. Press Enter on your keyboard or click Go. The search results will display all the error logs 

that match the search string.  
4. Click the error log of your choice to view the same. 

You can delete these error logs.  

To delete individual error logs 

1. In the Error Log list view, select check boxes beside the Error Messages that you wish to 
delete. 

2. Click Delete. 

If you want to delete all the existing error messages, then click the Delete All button.  
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Feedback 

If you are connected to the network you can send your feedback about ServiceDesk Plus immediately 
to our support team. 

To send your feedback, 

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click Feedback link available at the top left corner of the page. This opens the Feedback pop 

up window. 
3. The To address will be in non-editable format to our support team . Specify Your Name, Your 

email ID, Subject of the mail and Message mail content in their corresponding fields. 
4. Click Submit button to send the mail. 

  
 

 



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 389

Personalize 

You can localize your personalization such as display language, time zone and so on, as well as 
change your login password using this option. Apart from the option of changing password from the 
user management configurations, you can also change your individual password.  

1. Log in to the ServiceDesk Plus application using your user name and password. 
2. Click the Personalize link available at the top right corner of the page. This opens 

Personalize page which has two tabs which are, Personalize and Change Password as 
shown below, 
 

 

Personalize 

The personalize tab consists of display language, time zone, data format, time format and e-mail 
signature. 

• Display Language 
Select the language of your choice from the Choose Language combo box. The selected 
language will be you default display language in the application. All the data will be displayed 
in the language selected by you.  
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• Time Zone 
Since the organizations can be situated in various sites, every site has its particular time 
zone. Select the time zone of the site of your organization from the Select Time Zone combo 
box. The date and time will be set according to the selected time zone.   

• Date/Time Format 
Select the format of the date such as, Tue 16 Sep 2008, from the Set Date Format combo 
box. Similarly you can also set the time format from Set Time Format combo box. The 
selected date and time format will be displayed where ever date/time is considered 
For example: While creating a request, the request created on and due by time will be 
displayed in the selected  date and time format corresponding to the selected time zone. The 
same can be viewed under Problem, Change, Solution and Purchase modules.  

• E-mail Signature 
You can have your own personalized signature while replying to the mails using this option. 
Enter your signature in the text provided. Click Save. 

Change Password 

1. Click the Change Password tab in the personalize page. This displays the Change Password 
form. 

2. Enter your old password in the Current Password field. 
3. Enter your new password in the New Password field. 
4. In the Confirm New Password, enter the new password again. 
5. Click Save button. 
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Back up and Restore 

 

• In Windows 
• In Linux 

 

In Windows 

Follow the steps given below to take a back up of the ManageEngine ServiceDesk Plus data:  

1. Click Start -> Programs -> ManageEngine ServiceDesk Plus 5 -> Backup Data. A back up 
of the data and the file attachments that have been added to the application will be created. 

The back up file will be created in the <ServiceDesk>\backup directory. The file name for the back up 
file will be of the pattern BackUp_monthdate_year_hr_min.data. An example of the back up file name: 
BackUp_May20_2005_23_15.data 

To restore the back up data 

1. Go to <ServiceDesk>\bin directory. 
2. Execute the file restoreData.bat at command prompt as shown below: 

 
restoreData.bat <backup file name> 

The back up file name has to be the .data file from which you wish to restore the data. This will restore 
the data from the back up file. 

 

Note: The ServiceDesk Plus server needs to be shut down before you restore the 
data. 

In Linux 

Follow the steps given below to take a back up of the ManageEngine ServiceDesk Plus data:  

1. Go to <ServiceDesk>/bin directory.  
2. Execute the backUpData.sh file as given below: 

 
$ sh backUpData.sh 

The back up file will be created in the <ServiceDesk>/backup directory. The file name for the back up 
file will be of the pattern BackUp_monthdate_year_hr_min.data. An example of the back up file name: 
BackUp_May20_2005_23_15.data 

To restore the back up data 

1. Go to <ServiceDesk>/bin directory. 
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2. Execute the file restoreData.sh at command prompt as shown below: 
 
$ sh restoreData.sh <backup file name> 

The back up file name has to be the .data file from which you wish to restore the data. This will restore 
the data from the back up file. 

 

Note: The ServiceDesk Plus server needs to be shut down before you restore the 
data. 
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Changing Web Server Port 

 

• In Windows 
• In Linux 

 

In Windows 

Follow the steps given below to change the web server port where the ServiceDesk Plus server will 
be running:  

1. Go to <ServiceDesk>\bin directory. 
2. Execute the file changeWebServerPort.bat at command prompt as shown below: 

 
changeWebServerPort.bat <new port number> <http or https> 
 
The web server port will be reset to the new port number that you have specified. 
 
https - To start the ServiceDesk Plus server in https mode. 
 
http  - To start the ServiceDesk Plus server in http mode. By default,  executing the file as 
changeWebServerPort.bat <new port number>               will start the server in http mode. 

3. If the port number is occupied, you will be prompted to enter a different port number. If you do 
not wish to enter a different port number then press N on your keyboard to exit the 
application. Else press Y and enter a different port number that is unoccupied. 

This change will be effected only when you restart the server. To connect to the ServiceDesk Plus 
server after restarting, the new port number must be used.  

In Linux 

Follow the steps given below to change the web server port where the ServiceDesk Plus server will 
be running:  

1. Go to <ServiceDesk>/bin directory. 
2. Execute the file changeWebServerPort.sh at command prompt as shown below: 

 
$ sh changeWebServerPort.sh <new port number> <http or https> 
 
The web server port will be reset to the new port number that you have specified. 
 
https - To start the ServiceDesk Plus server in https mode. 
 
http  - To start the ServiceDesk Plus server in http mode. By default,  executing the file as 
changeWebServerPort.bat <new port number>               will start the server in http mode.  

3. If the port number is occupied, you will be prompted to enter a different port number. If you do 
not wish to enter a different port number then press N on your keyboard to exit the 
application. Else press Y and enter a different port number that is unoccupied. 

This change will be effected only when you restart the server. To connect to the ServiceDesk Plus 
server after restarting, the new port number must be used.  
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Troubleshooting 

This section gives you solutions for the problems faced while scanning for workstations in 
ServiceDesk Plus Inventory module. 

1. Either access denied for the user or the remote DCOM option might be disabled in the 
workstation. 

2. User does not have the access privileges to perform this operation. 
3. Remote DCOM option is disabled in the Server machine. 
4. Connection to RPC server in the workstation failed. 
5. One of the WMI components is not registered properly. 
6. Execution failure in the WMI Service of workstation. 
7. WMI Service is disabled in the workstation. 
8. Request for scan operation rejected by the workstation. 
9. Connection to Telnet Service in the workstation failed. 
10. Either Username or Password is incorrect in the workstation. 
11. Scan operation Timed out. 
12. The operation invoked is not supported in the current platform. 
13. General failure while performing the operation. 

Error Message 
Either access denied for the user or the remote DCOM option might 
be disabled in the workstation 

Cause 

This error message is shown when scanning of a Windows 
workstation fails due to any of the following reasons: 

1. The login name and password provided for scanning might 
be invalid in the workstation. 

2. Remote DCOM option might be disabled in the remote 
workstation. 

Resolution 

1. Check if the login name and password are entered correctly.
2. Check if Remote DCOM is enabled in the remote 

workstation. If not enabled, then enable the same.  
 
To enable DCOM in Windows 2000 Computers:  

1. Select Start > Run 
2. Type DCOMCNFG in the text field 
3. Click OK. 
4. Select Default Properties tab 
5. Check the box "Enable Distributed COM in this 

machine" 
6. Press OK 

To enable DCOM in Windows XP Computers:  

7. Select Start > Run 
8. Type DCOMCNFG in the text field 
9. Click OK 
10. Right Click on Component Services > Computers > 

My Computer 
11. Click Properties 
12. Select Default Properties tab in the frame that pops 
13. Check the box "Enable Distributed COM in this 

machine" 
14. Press OK 
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3. Check if the user account is valid in the target workstation. 
For this execute the following commands in the command 
prompt (of the server machine). 
 
net use \\<RemoteComputerName>\C$ 
 /u:<DomainName\UserName>  "<password>" 
net use \\<RemoteComputerName>\ADMIN$ 
 /u:<DomainName\UserName>  "<password>" 
 
Replace the relevant value within <>. Supply password 
within the quotes. 

If these commands show any error message, then the 
provided user account is not valid in that remote computer. 

 

Error Message 
User does not have the access privileges to perform this 
operation 

Cause 

Such error messages are shown, if the User ID provided 
for scanning does not have sufficient access privileges to 
perform the scanning operation. Probably, this user does 
not belong to the Administrator group of the workstation. 

Resolution 
Move the user to the Administrator Group of the 
workstation (or) Scan with an administrator (preferably a 
Domain Administrator) account. 

 

Error Message Remote DCOM option is disabled in the Server machine 

Cause Remote DCOM option might be disabled in the machine 
running ServiceDesk Plus Server. 

Resolution 

ServiceDesk uses Windows Management Instrumentation 
(WMI) to scan the remote workstations. WMI works over 
Remote DCOM and hence this option must be enabled for 
scanning the remote machines.  

 

To know how to enable DCOM in  Windows system refer to 
resolution of the error message Either access denied for the user 
or the remote DCOM option might be disabled in the workstation. 

 

Error Message Connection to RPC server in the workstation failed 

Cause 

This message is shown when a firewall is configured on 
the remote computer. Such exceptions mostly occur in 
Windows XP (SP-2), when the default Windows Firewall 
is enabled.  



AdventNet ManageEngine ServiceDesk Plus :: Admin Guide 
 

 

AdventNet, Inc. 396

Resolution 

Disable the default Firewall in the workstation. To disable 
the Firewall in Windows XP (SP2)  

1. Select Start->Run 
2. Type Firewall.cpl 
3. Click OK. 
4. In the General tab, click Off. 
5. Click OK.  

If  Firewall cannot be disabled then, we can lauch Remote 
Administration feature for administrators in the remote computer. 
The following command when executed in the target computer, 
can enable the feature: 

   

netsh friewall set service RemoteAdmin 
  

After scanning the computer, if required, the Remote 
Administration feature can also be disabled. The following 
command disables the feature: 

 

netsh friewall set service RemoteAdmin disable 

 

Error Message One of the WMI components is not registered properly 

Cause 

This message is shown if WMI is not available in the 
remote windows workstation. This happens in the 
Windows 9x, Windows NT and Windows ME. Such error 
codes might also occur in higher versions of Windows if 
the WMI Components are not registered properly. 

Resolution 

Install WMI core in the remote workstation. This can be 
downloaded from the Microsoft web site. If the problem is due to 
WMI Components registration, then register the WMI dlls by 
executing the following command at command prompt: 
 
winmgmt /RegServer 

 

Error Message Execution failure in the WMI Service of workstation 

Cause 

Such error messages are shown, when there are some 
internal execution failures in the WMI Service 
(winmgmt.exe) running in the remote workstation. 
Probably the last update of the WMI Repository in that 
workstation could have failed. 

Resolution Restart the WMI Service in the remote workstation To restart the
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WMI service in the workstation 

1. Click Start -> Run. 
2. Type Services.msc 
3. Click OK. 
4. In the Services window that pops-up, select "Windows 

Management Instrumentation" service and right-click on 
that. 

5. Click Restart. 

 

Error Message WMI Service is disabled in the workstation 

Cause This error message is shown when the WMI Service 
(winmgmt.exe) is not enabled in the remote workstation. 

Resolution 

Modify the property of WMI Service to Manual or Automatic from 
Disabled. 

1. Click Start -> Run. 
2. Type Services.msc 
3. Click OK. 
4. In the Services window that pops-up, select "Windows 

Management Instrumentation" service and right-click on 
that. 

5. Click Properties. 
6. If the Startup type is "Disabled", change it to 

"Automatic/Manual" and start the service. 
7. Restart the service. 

 

Error Message Request for scan operation rejected by the workstation 

Cause DCOM settings in Registry of the target workstation reject the 
scan request. 

Resolution 

Edit the Registry key value, as described below:  

1. Use Regedit to navigate to: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\OLE. 

2. Double-click the EnableDCOM value Name, a string (REG_SZ) 
data type. Set its data value to Y, even if it is already SET to Y. 

3. Click OK 
4. Shutdown and restart the computer. 
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Error Message Connection to Telnet Service in the workstation failed 

Cause 
Telnet Service might not be running in the target 
computer (or) Telnet Service is not running in default 
port 23. 

Resolution 
Discovering remote Linux Machines by ServiceDesk is 
done using Telnet. Ensure that Telnet is running in the 
remote workstations in the default port 23. 

 

Error Message 
Either Username or Password is incorrect in the 
workstation 

Cause The username and password provided to scan the 
remote workstation is incorrect. 

Resolution 

Discovering Linux Workstations, in ServiceDesk Plus is 
done using the Telnet. Provide a valid username and 
password that can successfully establish a telnet session 
with the target workstation. 

 

Error Message Scan operation Timed out 

Cause Target workstation did not respond within the default time 
limit. This might be due to some delay in the network. 

Resolution 
Try scanning the workstation, sometime later. If the same 
error message repeats, contact ServiceDesk Plus Support 
Team at support@servicedeskplus.com. 

 

Error Message 
The operation invoked is not supported in the current 
platform 

Cause Such error codes are shown if the workstation has an 
Operating System other than Windows or Linux. 

Resolution Currently, Network Discovery in ServiceDesk Plus 
supports Windows or Linux machines, only. 

 

Error Message General failure while performing the operation 

Cause Some unexpected exception occurred while, scanning the 
workstation. 

Resolution 

Contact the ServiceDesk support team at 
support@servicedeskplus.com with the Error log files. You 
can obtain the error log files from Support tab by clicking 
on the Support File link in the ServiceDesk Plus 
application. 
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